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Learn to configure products, set up pricing, and generate quotes quickly and accurately 
using Conga CPQ.
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CPQ Release Notes
Discover what's new in the latest release of Conga CPQ.

 

202408.1.0 Release Notes
Preview Documentation for Next Release

202408.1.0 Release Notes

In these release notes, you can find new features and enhancements and fixed and known 
issues for the CPQ 202408.1.0 release. For documentation updates, see What's New in CPQ 
Documentation.

To access the learning path, including overviews and demonstrations of this release’s 
updated features and enhancements, visit the Conga Learning Center.

System Requirements and Supported Platforms

For requirements and recommendations to consider before installing the Conga product 
suite, see the System Requirements and Supported Platforms Matrix.

New Features and Enhancements

The following features are new to Conga CPQ in this release.

This documentation may describe optional features for which you have not 
purchased a license; therefore your solution or implementation may differ from 
what is described here. Contact your customer success manager (CSM) or account 
executive (AE) to discuss your specific features and licensing.


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Finalization Checks with EnableFinalizationCheck
You can now control finalization checks using the custom setting "EnableFinalizationCheck" 
through the config system properties API. The default value is set to false.

GET api/revenue-admin/v1/flows/System/settings/ConfigSystemProperties .

When Enabled: Checks for pricing and configuration errors, executes finalization rules, 
and updates the cart status to "Finalized."
When Disabled: Skips certain configuration checks and finalization rules but ensures 
no pricing errors before finalizing the cart.

For more information, see Developer Hub.

Bundle Summary API for Lazy Loading
Administrators can now retrieve the structure of a bundle in the cart by using the Bundle 
Summary API. By passing the line number of the bundle, the API returns the bundle details, 
including option groups, child option groups, options, and any sub-bundles.

GET /api/cart/v1/carts/{cartId}/bundle/{lineNumber}/details

For more information, see Developer Hub.

Enhanced Attribute Lookup Fields in CPQ Config UI
You can view, search, and update attribute lookup fields on the CPQ Config UI. Dropdowns 
display lookup fields with a default record limit of 200 and adjustable up to 1000.

For more information, see Creating a Lookup Field.

Support for Order Line Item Activation to create Asset 
Line Item using Activate OLI API
Instead of activating order, you can activate Order Line Item to create Asset Line Item using 
Activate OLI API. You can create assets on individual activation of Order Line Item for 
standalone product with single charge type. For Bundle-options and multiple charge types, 
you must activate Order Line Item of the primary line and then Asset Line Item of entire 
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bundle-option and multiple charge types is created. For Ramp assets, you must activate 
Order line item of the primary ramp line. Bundle with sub bundle up to level 5 is supported.

All the custom fields of Order Line Item are copied to Asset Line Item. Attributes and Usage 
tiers entries are also copied. Asset Line Item history is created. The status of Order, Order 
Line Item and Asset Line Item is ‘Activated’.

Limitation: If you activate Order Line Item of a secondary charge type or option line, then 
the status is "Fulfilled" and Order status is "Partially Fulfilled". Later when you activate 
Order Line Item of the primary line then the entire asset line item is created.

POST /api/orders/v1/orders/{Id}/activate

For more information, see Developer Hub.

Control Bar for Quick Actions in CPQ Web UI
The enhanced CPQ Web UI features a Control Bar on the right side of the page. The 
following options are available on the control bar and allow you to perform:

Cart: This option allows you to add products.
Catalog: This option displays the high-level categories along with the description 
and reference image. On clicking the category, you are redirected to the category 
detail page. The Search a product option allows you to enter the product name, as a 
result, CPQ web UI lists the categories that the product is associated with.
Recommended Products: This option provides a list of recommended products by 
validating your quote.
Information: This option provides comprehensive details of the selected quote.
Documents: This option provides a list of documents generated and associated during 
the quote lifecycle.

Support of Smart Search in Field Picklist for Price 
Dimension
When creating a new Price Dimension, the 'Field' picklist now supports smart search and 
auto-suggestions, making it easier to locate and select fields.

For more information, see Creating a Price Dimension.
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Support for Asset Renew Operation using Activate 
Orders API with Constraint Rules
Asset Renew Operation, using Activate Orders API, with constraint rules to add or remove 
options is supported on Conga Platform for the assets that are created on the Platform.

POST /api/orders/v1/orders/{Id}/activate

For more information, see Developer Hub.

Support for Filtering Cart Related Fields using 
AssetLineItemCallback API
Filtering the cart related fields using AssetLineItemCallback API is supported on Conga 
Platform. This enables you to add logic based on cart related fields. The "cart Id" is passed 
from the Installed Product page to “Get assets” API.

Viewing Quote Related Details
The quote details page now displays its related information like line items and documents. 
This enables the sales representatives to get complete details of the quote on a single 
page.

Support for Asset Change Operation using Activate 
Orders API with Constraint Rules
Asset change operation, using Activate Orders API, with constraint rules is supported on 
Conga Platform for the assets that are created on the Platform.

POST /api/orders/v1/orders/{Id}/activate

For more information, see Developer Hub.
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Enhanced Promotions Admin UI
The left panel in the Promotions Admin UI now shows a tick mark only for sections with 
details, while sections without details keep their original icons.

Enhancement to Update Favorites API
The enhanced Update Favorites API allows you to add more products in public or self- 
created favorites as needed. To achieve this, the products you are adding to the favorites 
must be published on the product list you selected. This enhancement keeps the favorite 
configuration up to date when requirements change.

For more information, see Update a favorite API.

Support for Sync of Renewal Quote using API
When a subscription renewal quote is created on Salesforce it is synced to Conga Platform 
with the same data and is priced. Auto sync is enabled if the following criteria are satisfied.

Source Quote ABO Type = Renewal
Is Auto Accepted = False or Blank

If there is any change in the renewal quote on the platform, then reverse sync to the 
existing renewal quote on Salesforce is done.

Cart Revalidation Messages
The cart page now shows a validation error if you change a product's configuration, such 
as updating its expiry date or deactivating it. When you try to relaunch a saved cart in 
which these products are added before updating them, the cart page displays a validation 
message and removes such products from the option group if the criteria are unmet.
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Support for Editing and Deleting Personalized Views on 
Installed Products page
On the Installed Products page, you can create a new custom view by selecting the 
required columns in the Choose Cart Columns tab. The view helps you filter, and display 
asset line items based on the columns that you have selected. You can now edit and delete 
the view as required.

For more information, see Asset Features.

Handling Option Group Deletions in Product 
Configurations
You can delete an option group (Root or Child) based on the presence of associated 
products and the deleteHierarchy  parameter. For product option groups, the deletion 
removes the group and its children without affecting other related groups.

For more information, see Delete an Option Group API and Deleting an Option Group.

Support for Custom Fields during Suspend and Resume 
Operations
After the assets are purchased and there is a requirement to Suspend and Resume at a 
certain time, you can provide a reason or additional details on different fields during the 
transaction. The pop-up displays the start and end date, the selling term, and four custom 
fields to add reason or other details. These custom fields are coming from Asset Settings or 
API which are selected by the Admin. All the field values are displayed on the Suspended 
and Resumed lines on cart, also the entire record is read-only.

Support for Suspending Assets using CartCheckout API
CartCheckout API now supports creating order and order line items for suspended assets. 
The order line item shows the start and end date and the pricing is fetched from the asset. 
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On order activation the asset and order line items are in a Suspended state and the 
suspended start and end date is updated.

POST /api/cart/v1/carts/{cartId}/order

For more information, see Developer Hub.

Enhanced Sorting Feature on Catalog Page
You can specify additional product fields based on which products are sorted in ascending 
or descending order. To achieve this, you must update the ProductsSortingFields  with 
product fields in the request body while invoking Update custom settings associated 
with a flow  API. If you pass the empty values in ProductsSortingFields , the system 
fetches the product name label by default.

This enhancement provides more flexibility to view the products on the catalog page based 
on business requirements. Once you add the product fields to ProductsSortingFields, the 
catalog page displays those fields in the soring dropdown and the system also translates 
the labels of those fields and converts them to the language based on locale setting.

For more information, see Update custom settings associated with a flow.

View Applied Actions for Products via API
Administrators can now use the “Get the applied rules action” API to view actions applied 
to a product and its children during configuration, including related fields and rules that 
triggered these actions. This helps to retrieve the information why rules were applied.

GET /api/cart/v1/carts/{cartId}/applied-rule-actions

For more information, see Developer Hub.

View Constraint Rules Fired for a Product via API
Administrators can now use the “Get the applied rules action” API to view a list of 
constraint rules applied to a product and its children, along with related fields. This helps 
to retrieve the information why specific rules were triggered.

GET /api/cart/v1/carts/{cartId}/applied-rule-actions

For more information, see Developer Hub.
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Fixed Issues

The following issues are fixed in this release. If any actions are required, they will be listed 
in this table.

Case Number Conga Internal ID Description

NA CPQ-85597 Bundle asset options do not expand on the 
Installed Products page but are visible in the 
cart during operations.

NA CPQ-85364 The Attribute Value Matrix is not working after 
the data sync from Salesforce to Conga 
Platform.

NA CPQ-85363 While viewing the Attribute Value Matrices, the 
entries are displayed in an incorrect sequence.

HE-8 CPQ-84934 Product Attribute Rule does not work with Value 
Expression as line item FieldName. After data 
sync, Salesforce field names appear in the Value 
Expression field instead of the correct platform- 
specific fields.

00897400 CPQ-84654 Submit for Approval button remains disabled for 
specific bundle products in carts, even when 
Auto Approval criteria are met.

Known Issues

The following unresolved issues are known to Conga at the time of this release.

Conga Internal ID Description

CPQ-85847 Constraint rules using the "Not In" filter condition trigger 
incorrectly, activating even when the condition is not met. 
Rules without the "Not In" filter work as expected.
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Conga Internal ID Description

CPQ-85725 -

CPQ-85658 Attribute Value Matrices do not work when "IsWildcard" is set 
to false. This issue was observed after performing a data 
sync from Salesforce to the Platform.

CPQ-85590 When you try to open product details page from the catalog, 
you encounter rendering issue. This issue is observed for the 
products with picklist values.

CPQ-84857 Constraint rules, such as Max Quantity Validation, are not 
triggering as expected, despite meeting all conditions.

CPQ-83960 An error message appears from constraint rule, even when the 
required option is already added by default in the bundle.

Error: Please be sure to select only one Installation 

charge.

DOC ID: CPQRLP202408.1.0RN20240819

Preview Documentation for Next Release
We provide a preview code drop two weeks before the production deployment, giving you 
early access to the latest features and improvements. You can view the Preview Release 
Documentation in PDF.
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About CPQ
Conga CPQ is a sales tool for companies to generate quotes for orders quickly and 
accurately. Quote creation involves configuring products and services, pricing them, and 
generating quotes based on predefined rules. Conga CPQ produces accurate quotes 
making complex products, pricing, and business rules centralized, automatic, and available 
in real-time.

Conga CPQ is a CRM-agnostic solution available on Conga Platform. With an API-first 
approach, CPQ services (configuration, pricing, quoting) can be embedded into customer’s 
eCommerce, Direct Sales, and Partner Portals. Conga CPQ helps customers to streamline 
configuration and pricing across revenue lifecycle operations, providing faster scale and 
performance.

Conga CPQ provides the ability to offer self-service capabilities for guided configuration 
and contracted pricing embedded on any B2B eCommerce site. Conga CPQ provides 
customers the ability to choose which capability (configuration, pricing, quoting) they want 
to embed into their revenue lifecycle, at a pace that supports their business needs.
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What's New in CPQ Documentation
This section lists changes in the documentation to support each release.

202408.1.0

Docu 
ment

Publica 
tion 
Date

Topic Description

20240 
8.1.0

 

 

 

 

Deleting an Option 
Group

Added task topic for deleting option group and product 
option group.

Creating a Price 
Dimension

Added search support step for Field item.

Defining Benefits of 
a Promotion

Added a note related Rate Table under the Rate Type 
step.

Asset Features Updated the parity table to indicate the availability of 
editing and deleting personalized views on the Installed 
Products page.

202407.2.0
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Documen 
t

Publication 
Date

Topic Description

202407.2.0 05 Aug 
2024  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Managing Catalog New Topic.
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Documen 
t

Publication 
Date

Topic Description

 

 

 

 

 

 

 

Managing the Products Updated topic to re-structure the task 
topics.

Managing the Product 
Groups

Updated topic to re-structure the task 
topics.

Managing Price Lists Updated topic to re-structure the task 
topics.

Creating a Field 
Expression

Added a note for objects like Line Item, 
Product, and Attribute in the expression 
builder.

Configuring Price Matrix 
Entries

Added Field Expression steps for adding 
price matrix entries.

Adding Details to a Price 
List Item

Added Filter Expression steps for related 
pricing.

Configuring Column 
Settings

Added Price Waterfall column settings.

Associating Attribute 
Groups with a Product 

Create new attribute directly on the 
associated attributes page under 
products.

Associating Feature Sets 
with a Product

Create new feature set directly on the 
associated feature set page under 
products.

Associating Product 
Groups with a Product

Create new product group directly on the 
associated product group page under 
products.

Associating Categories 
with a Product

Create new category directly on the 
associated categories page under 
products.
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Documen 
t

Publication 
Date

Topic Description

Associate an Attribute to 
an Attribute Group

Create new attribute directly on the 
associated attributes page under 
attribute group.

Associating Dimension to 
the Dimension Set

New Feature

Managing Catalog Added actions available.

Managing the Product 
Groups

Added export feature under available 
actions.

Managing the Feature 
Sets

Added export feature under available 
actions.

Managing Field 
Expressions

Added export feature under available 
actions.

Managing the Constraint 
Rules

Added export feature under available 
actions.

Managing Price Lists Added export feature under available 
actions.

Deleting a Price List Added multiple deletion.

Deleting a Price 
Dimension

Added multiple deletion.

Managing Price 
Dimensions

Added export feature under available 
actions.

Managing the Price 
Waterfall

Added export feature under available 
actions.

Deleting the Price 
Waterfall

Added multiple deletion.
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Documen 
t

Publication 
Date

Topic Description

Managing the Promotions Added export feature under available 
actions.

Deleting a Promotion Added multiple deletion.

Deleting a Price Waterfall 
Ruleset

Added multiple deletion.

Managing Price Waterfall 
Rulesets

Added export feature under available 
actions.

Managing Deal Guidance Added export feature under available 
actions.

Deleting Color Bands Added multiple deletion.

Deleting Dimension Added multiple deletion.

Deleting Dimensions Sets Added multiple deletion.

Deleting Guidance Rule Added multiple deletion.

Configuring Storefront 
Settings

Added export feature under available 
actions.

Configuring Flow Settings 
to Override Global 
Settings

Added export feature under available 
actions.

Deleting Storefront 
Settings

Added multiple deletion.

Managing Price Rulesets Added export feature under available 
actions.

Deleting a Price Ruleset Added multiple deletion.

Deleting a Price Rule Entry Added multiple deletion.
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Documen 
t

Publication 
Date

Topic Description

Creating Price Rule Entries Added formula builder for adjustment 
amount source.

Creating Price Waterfall 
Ruleset Entry

Added formula builder for adjustment 
amount source.

Asset Features Updated the parity table to indicate the 
availability of creating personalized 
views on Installed Products page.

202407.1.1

Docu 
ment

Publica 
tion 
Date

Topic Description

202407 
.1.1

26 
Jul 
2024  

Creating an 
Attribute

Added List Views for Picklist and Multi Picklist.

Managing the 
Attributes and 
Attribute Groups

Added Attribute Views and Attribute Group Views. 

Managing Product 
Attribute Rules

Added Product Attribute Rule Views.

Managing the 
Option Groups

Added Product Option Groups Views.

Asset Settings Added Asset Restore Settings under General settings.

Asset Settings Added Renewal fields for Asset in Global settings.

Managing the Views New topic.

202406.2.0
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Docu 
ment

Publica 
tion 
Date

Topic Description

20240 
6.2.0

08 
Jul 
2024  

Creating a 
Constraint Rule

Multi-Select Picklist for "Match In" in Constraint Rule 
Creation.

Associating 
Categories with a 
Price List

Associated Category Sequence in Pricelist.

Configuring a 
Constraint Rule 
Using the Advanced 
Rule Setup

Removed RelatedLines value from Match In field.

Creating a Price 
Dimension

Added Custom Context Type for Price Dimension.

Cloning a Price 
Dimension

Added Custom Context Type for Price Dimension.

Associating Price 
Lists with a Product

Added "Price List Item column" in the Product Association 
page.

Creating Price 
Waterfall Charts

Added User Role Criteria for Waterfall Chart.

202406.1.0

Docu 
ment

Publica 
tion 
Date

Topic Description

20240 
6.1.0

 Configuring a 
Constraint Rule 
Using the Advanced 
Rule Setup

Added Match In Assets for Inclusion and Exclusion Action 
Types.

Associating 
Products with an 
Option Group

Added mass export action feature.
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Docu 
ment

Publica 
tion 
Date

Topic Description

Exporting 
Promotions

New feature.

Deleting a 
Promotion

Added mass delete action feature.

Config Settings Added Horizontal Attribute Group View configuration.

Configuring the 
Price Lists

Added clone feature.

Managing Price 
Lists

Mentioned about clone action.

Creating Price 
Waterfall Charts

Removed Is Editable field.

Managing the 
Products

Added info icon information which provides details of the 
associated entity..

Associating Feature 
Sets with a Product

Removed info icon information which provided details of 
the associated feature set.

Associating Option 
Groups with a 
Product

Removed info icon information which provided details of 
the associated option group.

Associating 
Attribute Groups 
with a Product

Removed info icon information which provided details of 
the associated attribute group.

Configuring the 
Products

Edited the Add New Product pop-up to New Product.

Associating Option 
Groups with a 
Product

Added remove associated option group with product 
feature.
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Docu 
ment

Publica 
tion 
Date

Topic Description

Associating Feature 
Sets with a Product

Added the resequencing feature for Associated feature 
sets.

202405.2.0

Docu 
ment

Publica 
tion 
Date

Topic Description

202405 
.2.0

 Managing Deal 
Guidance

Added Navigating Deal Guidance Rule.

Creating Guidance 
Rules

New feature.

Deleting a 
Dimension

Added creating dimension section.

Configuring the 
Products

Updated with uploading picture for a product.

Creating Price 
Waterfall Charts

Updated with clone function.

202405.1.0

Docu 
ment

Publica 
tion 
Date

Topic Description

202405 
.1.0

 Defining Coupons Added price dimension field to defining coupons for a 
promotion.

Associated Products 
under Attribute 
Groups

New Feature

Asset Settings Added the values for Asset application settings.
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Docu 
ment

Publica 
tion 
Date

Topic Description

Creating the Option 
Groups

"Where used" option for Option Groups

Configuring Product 
Groups

"Where used" option for Product groups

202404.2.0

Docu 
ment

Publica 
tion 
Date

Topic Description

20240 
4.2.0

 Adding Details to a 
Price List Item

Updated Price List Item with Related Price List Item.

Creating an 
Attribute Value 
Matrix

Added Scope and Matrix details for Attribute Value 
Matrix.

Managing Views Added the Asset Views for Asset Page.

Configuring Action 
Settings

Added the Price Waterfall Page configuration.

Creating a Color 
Band

Updated the fields as mandatory.

202404.1.0

Docu 
ment

Publica 
tion 
Date

Topic Description

20240 
4.1.0

 Asset Pricing 
Criteria

New Feature



Configure Price Quote (CPQ)

25 Copyright ©2024 Conga Corporation. All rights reserved.

Docu 
ment

Publica 
tion 
Date

Topic Description

 Adding Details to a 
Price List Item

Updated the List price field.

 Configuring the 
Price Lists

Removed the Cost Model field.

 Creating the Price 
Waterfall

Updated Manage Price Points topic to enable the 
checkbox element against the row when the row is 
disabled.

 Cart Settings Updated topic to remove Disable Cart Activity History 
and Disable Cart Asycn Notification settings as they are 
not supported in the Conga Platform flow. 

 Pricing Settings Updated topic to remove Enable Keyed Matrix Pricing 
setting as it is not supported in the Conga Platform flow. 

202403.3.0

Docume 
nt

Publicati 
on Date

Topic Description

202403.3 
.0

17 Apr 
2024  

 

 

 

Managing Price List 
Items

Added a note about how the products with 
multiple charge types are sequenced and 
displayed on the catalog page.

Managing the 
Promotions

Re-structured topic for a better documentation 
flow. 

Defining Limits of a 
Promotion

Updated topic with new UI and procedure.

Defining Coupons of a 
Promotion

New Topic.

202403.2.0
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Documen 
t

Publicatio 
n Date

Topic Description

202403.2. 
0

03 Apr 
2024  

 

 

Creating Price Waterfall 
Ruleset Entry

New Feature

Managing the Price 
Waterfall

Updated topic to add view option.

Cart Features Updated parity table to indicate the 
availability of the following features. 

Cart Size 
Upto 5000 Line Items   
Upto 10000 Line Items

202403.1.0

Documen 
t

Publicatio 
n Date

Topic Description

202403.1.0 20 Mar 
2024  

 

 

Creating Price Waterfall 
Rulesets

New Feature

Defining Benefits of a 
Promotion

New Feature

Cart Features Updated parity table to indicate the 
availability of the following features. 

Locale Support 
CPQ Data Translation (API)

Creating the Option Groups Updated topic to add a new section 
creating sub-option groups.

Config Features Updated parity table to indicate the 
availability of the following features. 

Replacement Constraint Rule 
Product Field Set
Product Option Group
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202402.2.1

Documen 
t

Publicatio 
n Date

Topic Description

202402.2.1 06 Mar 
2024  

 

 

 

 

 

 

 

Managing Price 
Waterfall Rulesets

Added the deletion feature.

Creating the Price 
Waterfall

Added a note.

Configuring Column 
Settings

Added a note

Creating Price Waterfall 
Ruleset

Creating and adding conditions to the price 
waterfall ruleset.

Creating the Price 
Waterfall

Delete waterfall charts.

Managing the Option 
Groups

Clone Option Groups.

202402.1.0

Documen 
t

Publicatio 
n Date

Topic Description

202402.1.0 23 Feb 
2024  

 

 

 

 

 

 

 

Managing the 
Promotions

Added the summary screen for promotions.

Creating the Price 
Waterfall Charts

Added the price point management for 
waterfall creation.

Associating Option 
Groups

Added a note for sequencing option groups.

Managing Price 
Waterfall Rulesets

New Topic.

Cart Features Updated Revalidation feature parameters.
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t

Publicatio 
n Date

Topic Description

Pricing Features Updated Price Waterfall feature 
parameters.
Added Reprice Quotes, Deal Maximizer, 
and Data Sync Features.

February' 24

Documen 
t

Publicatio 
n Date

Topic Description

February' 
24          

06 Feb 
2024  

 

 

 

 

 

Associating an Attribute 
to the Attribute Group

Added a note about the reordering 
attribute.

Configuring a Constraint 
Rule Using the Advanced 
Rule Setup

Added a note for condition criteria in Action 
Criteria field.

Cart Features Updated parity table to indicate the 
availability of the following feature. 

Validation Callback Class

Customizing CPQ on 
Conga Platform using 
Callback Classes

New Topic.

Validation Callback 
Class on Conga 
Platform

New Topic.

Recommendation 
Callback Class on 
Conga Platform

New Topic.

Option Filter Callback 
Class on Conga 
Platform

New Topic.

January' 24
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Documen 
t

Publicatio 
n Date

Topic Description

January' 
24          

04 Jan 
2024  

 

 

 

 

 

 

Managing Price 
Waterfall 

New Feature

Overriding Global 
Settings at a Flow Level

Added Use Enhanced CSS for Override 
Settings at Flow Level.

Configuring Column 
Settings

Added Cart Line Item as Display Type for 
Cart Page.

Configuring Action 
Settings

Added the Asset page in the Action Settings.

Configuring Column 
Settings

Added Asset Page column settings.

Pricing Settings Removed Multi Currency Management from 
the Advance Pricing section.

Managing the 
Promotions

New Feature.

December '23

Docum 
ent

Publicatio 
n Date

Topic Description

Decemb 
er '23

 

 

 

 

 

 

 

29 Nov 
2023  

Configuring Price Matrices Added a pop-up which shows dimension 
info when hovered upon dimension name.

Configuring Column Settings Removed Display Type column.

Configuring Action Settings Removed Display Type column.

Pricing Settings Removed Defer Pricing and External Pricing 
from Global Pricing.

Pricing Settings Removed Custom Deal Guidance Page 
from Advanced Pricing.
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Docum 
ent

Publicatio 
n Date

Topic Description

Config Settings Removed Constraint Rules section.

General Settings Removed Run Finalization Task in Async 
Mode field form Finalization and 
Approvals table.

Creating a Promotion New Feature

21 Nov 
2023  

 

 

 

 

Adding Miscellaneous 
Settings to A Price List Item

Added a note for sorting according to 
Period Number.

Creating Price Rulesets Added a note for info icon for Enable Date 
Range field.

Overriding Global Settings 
at a Flow Level

Added new fields for the override settings 
table.

Cloning A Price Dimension New Feature

Configuring the Installed 
Product Page

New Feature

November '23

Docum 
ent

Publicatio 
n Date

Topic Description

Novemb 
er '23

02 Nov 
2023  

Config User 
Preferences

Added a new field Pin Option Group by Default
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Publicatio 
n Date

Topic Description

01 Nov 
2023  

 

 

 

 

 

 

Config Settings Updated topic to add new setting Collapse All 
Leaf Option Groups.

Creating the Option 
Groups

Updated topic to add a new setting Expanded by 
Default and Attaching an Image features.

Configuring the 
Products

Updated topic to add details about creating a 
new product using the clone feature.

Cart Settings Updated topic to add details about Column 
Render Threshold option.

Managing the 
Constraint Rules

New topic. 

Managing Product 
Attribute Rules

Updated topic to add details about UI 
enhancements.

October '23

Docu 
ment

Public 
ation 
Date

Topic Description

Octo 
ber 
'23

 

 

 

26 
Oct 
2023  

Configuring Price Matrices Searching/Sorting a Matrix in the PLI.

Creating a Price Rule Searching/Sorting/Filter feature added to Price 
Rules.

Associating Price Lists with a 
Product

Added an info for charge type button.

Promotions New Feature

04 
Oct 
2023  

 

Cart Features Updated parity table to indicate the availability 
of the following features. 

Callbacks
Validation Callback (Cart UI and API)
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Docu 
ment

Public 
ation 
Date

Topic Description

Associating Feature Sets with 
a Product

New Topic

September '23

Docu 
ment

Publica 
tion 
Date

Topic Description

Septe 
mber 
'23

 Creating a Color Band New Feature

Septe 
mber 
'23

 Creating a Price List Item Added a note to mention a requirement under  
To Create a Price List Item.

Septe 
mber 
'23

 Pricing Features Updated parity table to indicate the 
availability of the following features. 

Multi-Currency
Use of Multi-Currencies (Cart UI)

Custom and Formula Fields
Formula Fields (Admin UI)

August '23

Docu 
ment

Publica 
tion 
Date

Topic Description

Augu 
st '23

 Managing the Rollup New Feature
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Docu 
ment

Publica 
tion 
Date

Topic Description

  Cart Features Updated parity table to indicate the 
availability of the following features. 

Locale
Metadata Translation (UI)

Cart Revalidation
Pricing Changes
Product Changes

  Catalog Features Updated parity table to indicate the 
availability of the following features. 

Visibility Rules (UI)

  Pricing Features Updated parity table to indicate the 
availability of the following features. 

Buy X Get X (API)
 Buy X Get Y (API)
For Every X, Get X (API)
For Every X, Get Y (API)
Line Item Promotions (API)
Summary Group Promotions (API)
Scope (API)
Criteria (API)
Benefits (API) (API)
Limits (API)
Coupons (API)
Sales Promotions (API)
Update Promotions/Coupons (API)
Delete Promotions/Coupons (API)
Apply Promotions (API)
Apply Coupons (API)
Remove Promotions (API)
Remove Coupons (API)

  Managing the Feature Sets New Feature

July '23
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Document Publication 
Date

Topic Description

July '23 05 Jul 2023   Cart Features Updated parity table to 
indicate the availability of the 
following features. 

Finalize Cart
Sync Finalize (UI)

Revalidate Cart
Revalidate Cart for 
Product Changes (API)
Revalidate Cart for 
Pricing Changes (API)

  Catalog Features Updated parity table to 
indicate the availability of the 
following features. 

Actions
Compare Products (UI)

  Config Features Updated parity table to 
indicate the availability of the 
following features. 

Inclusion Constraint Rule
Option Group Scope

Exclusion Constraint Rule
Option Group Scope

Option Configuration
Is Hidden (UI)
Is Picklist (UI)

Attribute Value Matrices
Product Scope (UI)
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Document Publication 
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Topic Description

  Pricing Features Updated parity table to 
indicate the availability of the 
following features. 

Usage Price Tiers
Adding New Price Tier 
(UI)
Modify Existing Price 
Tier (UI)
View-Only

Others
Locale

  Lookup Fields New topic.

  Creating a Lookup Field New topic.

  Configuring Action Settings Updated the topic with the 
availability of the Add New 
button.

  Configuring Column Settings Updated the topic with the 
availability of the Add New 
button.

  Associating Attribute Rules 
with a Product

New topic.

  Creating a Constraint Rule Added information about 
creating a specific type of rule 
directly from the drop-down 
arrow next to the Create 
New button.

  Configuring a Constraint Rule 
Using the Advanced Rule Setup

Added information about 
removing criteria.

  Managing Field Expressions New topic.

  Creating a Field Expression New topic.
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Document Publication 
Date

Topic Description

  Adding Charge Type Criteria to 
a Product

Added information about 
selecting custom fields.

  Configuring Price Matrices Added information about the 
Dimensions section.

  Configuring Price Matrix Entries Added information about 
selecting custom fields.

  Creating a Price Dimension Added information about 
selecting custom and formula 
fields.

  Creating a Price Ruleset Added information about 
updating a price ruleset with 
Condition & Charge Type 
Criteria.

  Creating Price Rule Entries Added information about 
selecting custom fields.

  Managing Deal Guidance New topic.

  Creating a Dimension Set New topic.

  Creating a Dimension New topic.

June '23

Document Publication 
Date

Topic Description

June '23 06 Oct 2023   Assigning the Configuration 
to the Collaborator or 
Queue

Added a note for the 
attachment field in the Quote 
Collaboration table.
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Document Publication 
Date

Topic Description

07 Jun 2023  

 

Catalog Settings Removed the settings that are 
not supported.

Config Settings Removed the settings that are 
not supported.

Cart Settings Removed the settings that are 
not supported.

Pricing Settings Removed the settings that are 
not supported.

Favorite Settings Removed the settings that are 
not supported.

General Settings Removed the settings that are 
not supported.

Object Summary View Settings Removed the settings that are 
not supported.

Configuring Action Settings New topic.

Configuring Column Settings New topic.

Managing Views New topic.

Associating Price Lists with a 
Product

Added information about 
adding charge type, charge 
type criteria, and matrices to 
PLI.

Managing the Attributes and 
Attribute Groups

New topic.

2024-07-25_06-11-25_.Creating 
an Attribute vJune-23

New topic.
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Document Publication 
Date

Topic Description

2024-07-25_06-12-10_.Creating 
an Attribute Group vMay-23

New topic.

Associating an Attribute to an 
Attribute Group

New topic.

Managing Product Attribute 
Rules and Attribute Value 
Matrices

New topic.

Creating a Product Attribute 
Rule

New topic.

2024-07-25_07-16-19_.Managin 
g Attribute Value Matrices 
vJune-23

New topic.

Creating an Attribute Value 
Matrix

New topic.

Managing Price List Items New topic.

Adding Charge Types to a 
Product

New topic.

Adding Charge Type Criteria 
to a Product

New topic.

Creating a Price List Item New topic.

Adding Default Pricing to a 
Product

New topic.

Adding Details to a Price List 
Item

New topic.
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Document Publication 
Date

Topic Description

Adding Miscellaneous Settings 
to a Price List Item

New topic.

Configuring Price Matrices New topic.

Configuring Price Matrix Entries New topic.

Managing Price Dimensions New topic.

Creating a Price Dimension New topic.

Managing Price Rulesets New topic.

Creating a Price Rule New topic.

Creating a Price Ruleset New topic.

Creating Price Rule Entries New topic.
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Document Publication 
Date

Topic Description

Cart Features Updated parity table for View 
cart read-only, Update 
Existing View, Delete Cart 
View, useAdvancedApproval, 
Mass update, and View 
summary group totalling.

Updated parity table to 
indicate the availability of the 
following features. 

Summary Group
Category
Product
Ad-hoc

Mass update
View cart read-only,
Update Existing View,
Delete Cart View,
useAdvancedApproval,
Mass update, and
View summary group 
totalling
Approvals

Cart level approvals
Line level approvals 

Catalog Features Updated parity table to 
indicate the availability of the 
following features.  

Add Favorites
Location
Deep Clone
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Document Publication 
Date

Topic Description

Config Features Updated parity table to 
indicate the availability of the 
following features. 

Recommendation 
Constraint Rules

Product Scope
Product Group Scope
Product Family 
Scope

Exclusion Constraint rule
Is Bundle Context

Inclusion Constraint Rule
Bundle Context

Validation Constraint Rule
Criteria
Field Set

Product Attribute Rules for 
Product group and product 
family: 

Hidden
Required
Reset

April '23
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Docu 
ment

Publicati 
on Date

Topic Description

April 
'23

05 
Apr 2023  

Cart APIs Added documentation for the following APIs:

GET /api/cart/v1/carts/{cartId}/  

status

POST/api/cart/v1/favorites

GET/api/cart/v1/favorites/{Id}

POST/api/cart/v1/favorites/{Id}/  

publish

DELETE/api/cart/v1/favorites/{Id}

POST/api/cart/v1/favorites

 

Updated documentation for the following 
APIs:

POST/carts/{cartId}/items

PATCH/carts/{cartId}/items

POST/quotes/{quoteId}/carts/activate

POST/carts/{cartId}/quote

Catalog APIs Added documentation for the following API:

GET/favorites

  Cart Features Updated Supported features table with the 
following newly supported features.

Filter Cart Lines
Cart Basic Search
Cart Advanced Search

Cart Actions
Copy Cart Lines

Cart View
Create New View
Update Existing View
Delete Cart View
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Docu 
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Publicati 
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Topic Description

  Config Features Updated Supported features table with the 
following newly supported feature

Validation Constraint Rules
Product Scope

  Catalog Features Updated Supported features table with the 
following newly supported features.

Favorites
Display Favorites
Search Favorites
Publish Favorites

  Deal Maximizer Setup APIs Added documentation for the following APIs:

DELETE/dimension-sets/  

{dimensionSetId}/dimensions

GET/dimension-sets/{dimensionSetId}/  

dimensions

GET/rules/{ruleId}/entries

DELETE/rules/{ruleId}/entries

DELETE/rules

PATCH/rules/{ruleId}/entries

GET/rules

DELETE/rules

PATCH/rules

Updated documentation for the following 
APIs:

POST/rules

  Creating Constraint Rules for a 
Product

Added the "Navigating the Constraint Rules 
Page" section.

  Associating Categories with a 
Product

New topic.

  Managing the Product Groups Added information about editing the layout.
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Docu 
ment

Publicati 
on Date

Topic Description

  Creating Constraint Rules for a 
Product Group

Added the "Navigating the Constraint Rules 
Tab" section.

  Managing the Constraint Rules Added information about editing the layout.

  Managing the Categories New topic.

  Managing the Option Groups New topic.

  Associating Products with an 
Option Group

New topic.

  Creating an Option Group New topic.

  Managing Price Lists Updated the "Navigating the Price Lists Page" 
section.

  Associating Categories with a 
Price List

New topic.

  Creating a Price List Item New topic.

March '23

Document Publication Date Topic Description

March '23 01 Mar 2023   Revenue Admin User Interface New topic

Configuring Application 
Settings

New topic

Configuring Global Settings New topic

Catalog Settings New topic

Config Settings New topic
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Document Publication Date Topic Description

Cart Settings New topic

Pricing Settings New topic

Favorite Settings New topic

General Settings New topic

Object Summary View Settings New topic

Configuring Flow Settings to 
Override Global Settings

New topic

Configuring the Flows New topic

Overriding Global Settings at a 
Flow Level

New topic

Product Administration New topic

Managing the Products New topic

Configuring the Products New topic

Associating Price Lists with a 
Product

New topic

Creating Constraint Rules for a 
Product

New topic

Associating Categories with a 
Product

New topic

Associating Product Groups 
with a Product

New topic

Associating Attribute Groups 
with a Product

New topic
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Document Publication Date Topic Description

Associating Option Groups with 
a Product

New topic

Managing the Product Groups New topic

Configuring Product Groups New topic

Associating Products with a 
Product Group

New topic

Creating Constraint Rules for a 
Product Group

New topic

Pricing Administration New topic

Managing Price Lists New topic

Configuring the Price Lists New topic

Cart APIs Added 
documentation for 
the following APIs:

POST/quotes/  

{quoteId}/ 

carts/activate

POST/carts/  

{cartId}/ 

items/clone

Updated 
documentation for 
the following APIs:

POST/carts/  

{cartId}/ 

finalize
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Catalog APIs Updated 
documentation for 
the following APIs:

POST/search

GET/  

categories/ 

{categoryId}

GET/categories
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Document Publication Date Topic Description

Catalog Setup APIs Added 
documentation for 
the following APIs:

POST/products/  

{parentID} 

product-group- 

members

DELETE/  

products/ 

{parentID} 

product-group- 

members

GET/products/ 

{id}/product- 

groups

GET/ 

categories/ 

{categoryId}/ 

products

GET/  

categories/ 

{categoryId}/ 

price-lists

POST/ 

products/ 

{productId}/ 

product- 

categories

DELETE/  

products/ 

{productId}/ 

product- 

categories
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Document Publication Date Topic Description

Deal Setup APIs Added 
documentation for 
the following APIs:

POST/  

colorbands

PATCH/  

colorbands

POST/rules/  

{ruleId}/ 

entries

POST/rules

POST/rules

GET/dimension-  

sets

GET/dimensions

DELETE/  

dimensions

PATCH/  

dimensions

DELETE/  

dimension-sets

PATCH/  

dimension-sets

POST/  

dimension-sets

POST/  

dimension- 

sets/ 

{dimensionSetI 

d}/dimensions

February '23
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ent

Publicati 
on Date

Topic Description

Februar 
y '23

08 
Feb 2023  

 

 

 

 

 

 

 

 

 

 

 

 

 

Cart APIs Added documentation for the following APIs:

POST/carts/{cartId}/finalize

Updated documentation for the following APIs:

POST/carts/{cartId}/items

PATCH/carts/{cartId}/items

DELETE/carts

DELETE/carts/{cartId}

POST/carts/{cartId}/order

POST/carts

Catalog APIs Added documentation for the following APIs:

POST/Search/typeahead

Updated documentation for the following API:

POST/search

GET/categories/{categoryId}/products

GET/products

Pricing Setup 
APIs

Updated documentation for the following API:

POST/price-lists

POST/matrices

POST/price-lists/{priceListId}/price-list-items

Deal Setup 
APIs

New topic

Integrating 
CPQ with the 
Conga 
Platform

New topic

Use Case: User 
Authentication 
to Conga 
Platform

New topic
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Docum 
ent

Publicati 
on Date

Topic Description

Use Case: 
Getting the 
Application 
Context

New topic

Use Case: 
Browsing the 
Catalog

New topic

Supported 
Features in 
CPQ

New topic

Cart Features New topic

Catalog 
Features

New topic

Config 
Features

New topic

Pricing 
Features

New topic

January '23

Docum 
ent

Publicati 
on Date

Topic Description

January 
'23

04 
Jan 2023  

 

 

 

 

 

 

Cart APIs Added documentation for the following APIs:

POST/carts/{cartId}/quote

GET/quotes/{quoteId}/carts/active

POST/carts/{cartId}/clone

Updated documentation for the following APIs:

GET/carts/{cartId}/items

POST/carts/{cartId}/items

POST/carts/{cartId}/order
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Docum 
ent

Publicati 
on Date

Topic Description

Catalog APIs Updated documentation for the following API:

POST/search

Catalog 
Setup APIs

Added documentation for the following APIs: 

GET/visibility-rule/{visibilityRuleId} 

GET/visibility-rule 

DELETE/visibility-rule/{visibilityRuleId}

 

Pricing Setup 
APIs

Updated documentation for the following APIs:

POST/price-lists/{priceListId}/prices

Settings APIs Added documentation for the following APIs: 

PUT/flows/{flowName}/settings/{settingName}/  

{childSettingName}

GET/flows/{flowName}/settings/{settingName}/  

{childSettingName}

PUT/flows/{flowName}/actions

Updated documentation for the following APIs:

POST/flows

Use Case: 
Building 
Quotes

New topic

Use cases: 
Working with 
Order APIs

New topic

Use Case: 
Updating an 
Order

New topic

December '22
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Docum 
ent

Publicati 
on Date

Topic Description

Decemb 
er '22

07 
Dec 2022  

 

 

 

 

 

Cart APIs Added documentation for the following APIs:

POST/carts/{cartId}/order

POST/carts/{cartId}/price

Updated documentation for the following APIs:

POST/carts/{cartId}/items

PATCH/ carts/{cartId}/items

DELETE/carts/{cartId}/items

Catalog APIs Added documentation for the following API:

POST/search

Catalog 
Setup APIs

Added documentation for the following APIs: 

DELETE/attributes

DELETE/attributes/{attributeId}

POST/constraint-rules/{ruleId}/conditions

POST/attribute-matrices 

POST/attribute-groups

PATCH/attribute-matrices 

GET/attribute-rules

GET/attribute-matrices 

DELETE/attribute-matrices 

POST/attribute-matrices

PATCH/visibility-rule

POST/visibility-rule

Updated documentation for the following APIs:

POST/constraint-rules/{ruleId}/conditions

PATCH/constraint-rules/{ruleId}/conditions

POST/constraint-rules/{ruleId}/actions

PATCH/constraint-rules/{ruleId}/actions
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Docum 
ent

Publicati 
on Date

Topic Description

Pricing Setup 
APIs

Added documentation for the following APIs: 

DELETE/rules/{ruleId}/rule-entries

GET/matrices 

GET/matrices/{matrixId}/matrix-entries

GET/price-dimensions

Updated documentation for the following APIs:

POST/price-dimensions

POST/price-lists

POST/price-lists/{priceListId}/prices

POST/rule-sets

POST/rule-sets/{ruleSetId}/rules

POST/rules/{ruleId}/rule-entries

DELETE/rules/{ruleId}/rule-entries

Settings APIs New topic

Use Case: 
Interacting 
with the Cart

New topic

Use Case: 
Retrieving 
Product 
Details

New topic

October '22

Docum 
ent

Publication 
Date

Topic Description

Octobe 
r '22

07 Oct 
2022  

Cart APIs New topic.

Catalog APIs Added documentation for attributes in the  GET/ 

products/{productId}  API.
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Publication 
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Catalog Setup APIs Added documentation for the following APIs:

POST/attribute-rules

POST/attribute-rules/{attributeRuleId}/ 

actions

PATCH/attribute-rules

PATCH/attribute-rules/{attributeRuleId}/ 

actions

DELETE/attribute-rules

PATCH/attribute-groups

POST/attribute-groups

DELETE/attribute-groups

POST/products/{productId}/attribute- 

groups

DELETE/products/{productId}/attribute- 

groups

POST/product-option-group/ 

{productOptionGroupId}/products

DELETE/product- 

optiongroup{productOptionGroupId}/ 

products
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Docum 
ent

Publication 
Date

Topic Description

Pricing Setup APIs Updated the description of the POST/api/  

admin/v1/matrices  API.
Added documentation for the following APIs:

DELETE/matrices

GET/rule-sets

POST/api/admin/v1/rule-sets

PATCH/api/admin/v1/rule-sets

DELETE/rule-sets

GET/rule-sets/{ruleSetId}/rules

POST/api/admin/v1/rule-sets/  

{ruleSetId}/rules

PATCH/api/admin/v1/rule-sets/  

{ruleSetId}/rules

DELETE/rule-sets/{ruleSetId}/rules

POST/matrices/{matrixId}/matrix-  

entries

PATCH/matrices/{matrixId}/matrix-  

entries

DELETE/matrices/{matrixId}/matrix-  

entries

POST/price-dimensions

PATCH/price-dimensions

DELETE/price-dimensions

GET/rules/{ruleId}/rule-entries

POST/rules/{ruleId}/rule-entries

PATCH/rules/{ruleId}/rule-entries

Order APIs New topic

September '22

Document Publication Date Topic Description

September '22 26 Sep 2022   Order APIs Removed the topic.

07 Sep 2022   All topics New guide
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CPQ for Administrators
This section explains how to configure CPQ on Conga Platform. This section describes the 
administrative tasks to be performed to enable the features in CPQ and covers the most 
common use cases for CPQ administration.

Select one of the following topics for more information:

Supported Features in CPQ
Setting up Salesforce Org with Conga Cloud Instance for CPQ
Revenue Admin User Interface
Customizing CPQ on Conga Platform using Callback Classes

Supported Features in CPQ
This section lists the features supported in CPQ on Salesforce and CPQ on Conga Platform:

Asset Features
Cart Features
Catalog Features
Config Features
Pricing Features

Asset Features
The following asset features are supported in this release:

Feature Sub-Feature Supported 
in 
Salesforce 
Classic/ 
Turbo

Supported in 
Conga 
Platform (API)

Conga 
Platform 
(Runtime-UI)

Conga 
Platform 
(Admin-UI)

Features 
 

Get List of Assets Yes Yes Yes N/A

Installed products 
page

Yes Yes Yes N/A

Search Assets Yes Yes Yes N/A
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Feature Sub-Feature Supported 
in 
Salesforce 
Classic/ 
Turbo

Supported in 
Conga 
Platform (API)

Conga 
Platform 
(Runtime-UI)

Conga 
Platform 
(Admin-UI)

Pagination Yes Yes Yes N/A

Installed products 
page Setting

Yes Yes N/A Yes

Hide/Unhide Asset 
Actions

Yes Yes Yes N/A

Submenu of Asset 
Action

Yes Yes Yes N/A

Primary Attribute Yes No Yes N/A

Installed products 
page: Create, 
edit, and delete 
personalized view

Yes Yes Yes N/A

Assets view Yes Yes N/A Yes

Termina 
te

Terminate 
Standalone 
without Billing

Yes Yes Yes N/A

Terminate 
Bundle-option 
without Billing

Yes Yes Yes N/A

Termination 
editable fields

Yes Yes Yes N/A

Terminate with 
Ramp

Yes Yes Yes N/A
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Feature Sub-Feature Supported 
in 
Salesforce 
Classic/ 
Turbo

Supported in 
Conga 
Platform (API)

Conga 
Platform 
(Runtime-UI)

Conga 
Platform 
(Admin-UI)

Terminate with 
Ramp-bundle 
option

Yes Yes Yes N/A

Change 
 

Change with 
Asset pricing

Yes Yes Yes N/A

Change without 
Asset pricing

Yes Yes Yes N/A

Change with 
Asset pricing 
criteria

Yes Yes Yes N/A

Change with 
Cancel option

Yes Yes Yes N/A

Change with 
Charge type 
criteria

Yes Yes Yes N/A

Change with Flat 
Price

Yes Yes Yes N/A

Change with Price 
Escalators

No Yes Yes N/A

Renew 
 
 
 

Renew with Asset 
pricing

Yes Yes Yes N/A

Renew without 
Asset pricing

Yes Yes Yes N/A

Renew with Asset 
pricing criteria

Yes Yes Yes N/A
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Feature Sub-Feature Supported 
in 
Salesforce 
Classic/ 
Turbo

Supported in 
Conga 
Platform (API)

Conga 
Platform 
(Runtime-UI)

Conga 
Platform 
(Admin-UI)

Renew with 
Renewal Uplift

Yes Yes Yes N/A

Ramp Renew Yes Yes Yes N/A

Renew with 
Charge type 
criteria

Yes Yes Yes N/A

Evergreen, Do Not 
Renew Concept

Yes Yes Yes N/A

Renew with 
Attributes

Yes Yes Yes N/A

Renew with Price 
Escalator

No Yes Yes N/A

Resume Resume API 
Signature

No Yes No N/A

Suspend Suspend API 
Signature

No Yes No N/A

Swap Support for Swap Yes Yes Yes N/A

Miscella 
neous

Delta Summation Yes Yes Yes N/A

Asset Line item 
Callback

No Yes N/A N/A

Asset Pricing 
Criteria

Yes Yes Yes N/A
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Feature Sub-Feature Supported 
in 
Salesforce 
Classic/ 
Turbo

Supported in 
Conga 
Platform (API)

Conga 
Platform 
(Runtime-UI)

Conga 
Platform 
(Admin-UI)

Change:Configur 
ation

Yes Yes Yes N/A

Change:Quantity 
only positive 
Quantity

Yes Yes Yes N/A

Delta Price 
Adjustments

Yes Yes Yes N/A

Change:Quantity 
only decrement 
Quantity

No Yes Yes N/A

Data Model 
Creation

N/A Yes N/A N/A

Asset Attribute 
forward sync from 
SFDC to Platform

NA Yes Yes N/A

All ABO 
operations with 
attribute

Yes Yes Yes N/A

Advanced 
Change and 
Renew Use cases

Yes Yes Yes N/A

Auto 
Renewal 
s

Auto Renewals Yes Oct '24 + Oct '24 + Oct'24
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Feature Sub-Feature Supported 
in 
Salesforce 
Classic/ 
Turbo

Supported in 
Conga 
Platform (API)

Conga 
Platform 
(Runtime-UI)

Conga 
Platform 
(Admin-UI)

Auto 
Renewal 
s 
Integrati 
on to 
Platform

Auto Renewals 
Integration to 
Platform

No Oct '24 + Oct '24 + N/A

On- 
demand 
Renewal 
s

On-demand 
Renewals

Yes Feb '25 + Feb '25 + Feb '25 +

Change: 
Split

Change: Split Yes Feb '25 + Feb '25 + N/A

Change: 
Marge

Change: Marge No Feb '25 + Feb '25 + N/A

Relate Relate No Feb '25 + Feb '25 + N/A

Relate 
Compon 
ent

Relate 
Component

No Feb '25 + Feb '25 + N/A

Cart Features
The following cart features are supported in this release:
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Feature Sub-Feature Supported in 
Salesforce 
Classic/ 
Turbo

Supported on 
Conga Platform 
(API)

Supported on 
Conga Platform 
(UI)

Launch Cart Create New Cart Yes Yes Yes

Launch Saved Cart Yes Yes Yes

Reconfigure 
Finalized Cart

Yes Yes Yes

Checkout Checkout to Quote Yes. 
Supported in 
Digital 
Commerce.

Yes Yes. Supported in 
Digital Commerce.

Checkout to Order Yes. 
Supported in 
Digital 
Commerce.

Yes Yes. Supported in 
Digital Commerce.

Activate Cart Activate Cart Yes Yes Yes

Cart Size Upto 100 Line Items Yes Yes Yes

Upto 500 Line Items Yes Yes Yes

Upto 2000 Line 
Items

Yes Yes Yes

Upto 5000 Line 
Items

No Yes Yes

Upto 10000 Line 
Items

No Yes Yes

Upto 25000 Line 
Items

No No No

Summary 
Group

Charge Type Yes Yes Yes
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Feature Sub-Feature Supported in 
Salesforce 
Classic/ 
Turbo

Supported on 
Conga Platform 
(API)

Supported on 
Conga Platform 
(UI)

Frequency Yes Yes Yes

Category Yes Yes Yes

Product (Product 
Fields)

Yes Yes Yes

Ad-hoc (Line Item 
Fields)

Yes Yes Yes

Clone Cart Clone Cart Yes Yes Yes

Filter Cart Lines Cart Basic Search Yes Yes Yes, by Product 
Name.

Cart Advanced 
Search

Yes Yes Yes

Abandon Cart Abandon with Cart 
Deletion

Yes Yes Yes

Abandon with 
Status Change

Yes Yes No

Cart Actions Copy Cart Lines Yes Yes Yes

Delete Cart Lines Yes Yes Yes

Mass Update Yes Yes * Yes *

Supports a maximum of 500 lines

Add More Products Yes Yes Yes

Close Cart Yes Yes Yes



Configure Price Quote (CPQ)

65 Copyright ©2024 Conga Corporation. All rights reserved.

Feature Sub-Feature Supported in 
Salesforce 
Classic/ 
Turbo

Supported on 
Conga Platform 
(API)

Supported on 
Conga Platform 
(UI)

Save Cart Yes Yes Yes

Cart Grid 
Feature

Display Column 
support

Yes Yes Yes

Display Action 
Support

Yes Yes Yes

Reordering Line 
Items

Yes Yes  Yes

Tool Tip Yes Yes Yes

Adjust column 
Width

Yes Yes Yes

Pagination & 
Infinite Scroll (Lazy 
Loading)

Yes Yes Yes

Cart View Create New View Yes Yes. Supports group 
by product.

Yes. Supports 
group by product.

Update Existing 
View

Yes Yes Yes

Delete Cart View Yes Yes Yes

Cart Flow Support Custom 
Cart Flow

Yes Yes Yes

Cart Lookup 
Field Support

Cart Lookup Field 
Support

Yes No No

Extensibility Custom Field 
Support for Cart 
Lines

Yes Yes Yes
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Feature Sub-Feature Supported in 
Salesforce 
Classic/ 
Turbo

Supported on 
Conga Platform 
(API)

Supported on 
Conga Platform 
(UI)

Formula Field On 
Line Item

Yes Yes Yes

Formula Field on 
Summary Group

Yes No No

Custom Field on 
Summary Group

Yes Yes Yes

Launch the 
Cart with 
Parameters

FlowName Yes Yes Yes

isCartTotalingDisa 
bled

Yes Yes Yes

styleSheetURL Yes Yes Yes

Mode (For 
Readonly)

Yes No Yes

asyncFinalize Yes No No

productOrderByCla 
use

Yes Yes Yes

useAdvancedAppro 
val (Approval 
Check) / 
SkipApprovalCheck

Yes Yes Yes

useAdvancedCurren 
cy

Yes No No

 useDealOptimizer Yes Yes Yes

Finalize Cart Sync Finalize Yes Yes Yes



Configure Price Quote (CPQ)

67 Copyright ©2024 Conga Corporation. All rights reserved.

Feature Sub-Feature Supported in 
Salesforce 
Classic/ 
Turbo

Supported on 
Conga Platform 
(API)

Supported on 
Conga Platform 
(UI)

Async Finalize Yes No Yes

Quote 
Summary On 
the cart

Quote Summary On 
the cart

Yes Yes Yes

Product 
Summary On 
Cart

Product Summary 
On Cart

Yes Yes Yes

Mini Cart Pricing Progress in 
Mini Cart

Yes Yes Yes

Remove Products 
from Mini Cart

Yes Yes Yes

By-pass Shopping 
Cart

Yes Yes Yes

Configure Mini Cart 
View

Yes Yes Yes

Pagination Yes Yes Yes

Finalize From 
MiniCart

Yes Yes Yes

Cart 
Revalidation

Revalidate Cart for 
Product Changes

Yes Yes Yes

Revalidate Cart for 
Pricing Changes

Yes Yes Yes

Revalidation 
Callback

Yes Yes Yes
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Feature Sub-Feature Supported in 
Salesforce 
Classic/ 
Turbo

Supported on 
Conga Platform 
(API)

Supported on 
Conga Platform 
(UI)

Callbacks Display Action 
Callback

Yes Yes Yes

Validation 
Callback

Yes Yes Yes

Approvals Line Level Approval Yes No Yes

Cart Level 
Approval

Yes No Yes

Deal Guidance Deal Guidance Yes Yes Yes

Cart 
Collaboration

Cart Collaboration Yes No No

Express 
Proposal

Express Proposal Yes No No

Cart Locking 
(Concurrent 
Access)

Cart Locking 
(Concurrent Access)

Yes No No

Recommended 
Product

View Recommended 
Product

Yes Yes Yes

Add Recommended 
Product

Yes Yes Yes

Locale Support Metadata 
Translation

Yes No Yes

CPQ Data 
Translation

Yes Yes Yes



Configure Price Quote (CPQ)

69 Copyright ©2024 Conga Corporation. All rights reserved.

Feature Sub-Feature Supported in 
Salesforce 
Classic/ 
Turbo

Supported on 
Conga Platform 
(API)

Supported on 
Conga Platform 
(UI)

Create 
Favorite 

Create/Save 
Favorite

Yes Yes Yes

Expand/ 
Collapse 
Bundle 

Expand/Collapse 
specific Bundles

Yes No Yes

Catalog Features
The following catalog features are supported in this release:

Feature Sub-Feature Supported 
in 
Salesforce 
Classic/ 
Turbo

Supported in 
Conga 
Platform (API)

Supported in 
Conga Platform 
(Catalog UI)

Categories Category Yes Yes Yes

Sub-Category Yes Yes Yes

Category Hierarchy Yes Yes Yes

Pagination Yes Yes Yes

Product List Yes Yes Yes

Default Options Yes No No

Product Information Yes Yes Yes

Product Fields Yes Yes Yes

Product Pricing Yes Yes Yes
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Feature Sub-Feature Supported 
in 
Salesforce 
Classic/ 
Turbo

Supported in 
Conga 
Platform (API)

Supported in 
Conga Platform 
(Catalog UI)

Filter Category Yes Yes Yes

Visibility Rules Yes Yes Yes

Search Search All Products Yes Yes Yes

Search All Categories Yes Yes Yes

Search Category Yes Yes Yes

Filter Search Results Yes Yes Yes

Typeahead Yes (Smart 
Search)

Yes No

Actions Add to Cart Yes Yes Yes

Add Multiple to Cart Yes Yes Yes

Configure Yes Yes Yes

Compare Products Yes Yes Yes

Favorites Favorites Category Yes NA Yes

Display Favorites Yes Yes Yes

Search Favorites Yes Yes Yes

Filter Favorites Yes Yes Yes

Add Favorite Yes Yes Yes

Delete Favorite Yes Yes Yes
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Feature Sub-Feature Supported 
in 
Salesforce 
Classic/ 
Turbo

Supported in 
Conga 
Platform (API)

Supported in 
Conga Platform 
(Catalog UI)

Publish Favorite Yes Yes Yes

Exclude Adjustments Yes Yes Yes

Other Add Another Yes Yes Yes

Sold as Option Yes Yes Yes

Must Configure Yes Yes Yes

Apply Inclusion Rules Yes Yes Yes

Apply Exclusion Rules Yes Yes Yes

Apply Validation 
Rules

Yes Yes Yes

Apply 
Recommendation 
Rules

Yes Yes Yes

Apply Replacement 
Rules

Yes (server- 
side 
constraint 
rules)

Yes Yes

Multi-Language 
Translation

Yes Yes Yes

Service Catalog Yes No No

Location Yes Yes Yes
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Config Features
The following config features are supported in this release:

Feature Sub-Feature Supported 
in 
Salesforce 
Classic

Supported in 
Conga 
Platform (API)

Supported in 
Conga 
Platform 
(Config-UI) 

Inclusion 
Constraint 
Rules

Product Scope Yes Yes Yes

Product Group Scope Yes Yes Yes

Product Family Scope Yes Yes Yes

Product Field Set Yes Yes Yes

Condition Criteria Yes Yes Yes

Action Criteria Yes Yes Yes

Option Group Scope 
(condition)

Yes Yes No

Match in Primary Lines Yes Yes Yes

Match in Options Yes Yes Yes

Match in Cart Options Yes Yes Yes

Match in Location Yes Yes Yes

Match in Related Lines Yes No No

Match in Service Asset Yes No No

Match in Asset Yes Yes Yes

Repeat Inclusion No No No
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Feature Sub-Feature Supported 
in 
Salesforce 
Classic

Supported in 
Conga 
Platform (API)

Supported in 
Conga 
Platform 
(Config-UI) 

Is Bundle Context Yes Yes Yes

Min/Max Rule Yes Yes Yes

Exclusion 
Constraint 
Rules

Product Scope Yes Yes Yes

Product Group Scope Yes Yes Yes

Product Family Scope Yes Yes Yes

Product Field Set Yes Yes Yes

Condition Criteria Yes Yes Yes

Action Criteria Yes Yes Yes

Option Group Scope 
(condition)

Yes Yes Yes

Match in Primary Lines Yes Yes Yes

Match in Options Yes Yes Yes

Match in Cart Options Yes Yes Yes

Match in Location Yes Yes Yes

Match in Related Lines Yes No No

Match in Service Asset Yes No No

Match in Asset Yes Yes Yes

Repeat Inclusion No No No

Is Bundle Context Yes Yes Yes
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Feature Sub-Feature Supported 
in 
Salesforce 
Classic

Supported in 
Conga 
Platform (API)

Supported in 
Conga 
Platform 
(Config-UI) 

Min/Max Rule Yes Yes Yes

Validation 
Constraint 
Rules

Product Scope Yes Yes Yes

Product Group Scope Yes Yes Yes

Product Family Scope Yes Yes Yes

Product Field Set Yes Yes Yes

Condition Criteria Yes Yes Yes

Action Criteria Yes Yes Yes

Option Group Scope 
(condition)

No No No

Match in Primary Lines Yes Yes Yes

Match in Options Yes Yes Yes

Match in Cart Options Yes Yes Yes

Match in Location Yes Yes Yes

Match in Related Lines Yes No No

Match in Service Asset Yes No No

Match in Asset Yes No No

Repeat Inclusion No No No

Is Bundle Context Yes Yes Yes
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Feature Sub-Feature Supported 
in 
Salesforce 
Classic

Supported in 
Conga 
Platform (API)

Supported in 
Conga 
Platform 
(Config-UI) 

Min/Max Rule Yes Yes Yes

Replacement 
Constraint 
Rules

Product Scope Yes* Yes Yes

Product Group Scope Yes* Yes Yes

Product Family Scope Yes* Yes Yes

Product Field Set Yes* Yes Yes

Condition Criteria Yes* Yes Yes

Action Criteria Yes* Yes Yes

Option Group Scope 
(condition)

No Yes Yes

Match in Primary Lines Yes* Yes Yes

Match in Options Yes* Yes Yes

Match in Cart Options Yes* Yes Yes

Match in Location No No No

Match in Related Lines No No No

Match in Service Asset No No No

Match in Asset No No No

Repeat Inclusion No No No

Is Bundle Context Yes* Yes Yes

Min/Max Rule Yes* Yes Yes



Configure Price Quote (CPQ)

76 Copyright ©2024 Conga Corporation. All rights reserved.

Feature Sub-Feature Supported 
in 
Salesforce 
Classic

Supported in 
Conga 
Platform (API)

Supported in 
Conga 
Platform 
(Config-UI) 

Recommendatio 
n Constraint 
Rules

Product Scope Yes Yes Yes

Product Group Scope Yes Yes Yes

Product Family Scope Yes Yes Yes

Product Field Set Yes Yes Yes

Condition Criteria Yes Yes Yes

Action Criteria Yes Yes Yes

Option Group Scope 
(condition)

Yes No No

Match in Primary Lines Yes Yes Yes

Match in Options Yes Yes Yes

Match in Cart Options Yes Yes Yes

Match in Location Yes Yes Yes

Match in Related Lines Yes No No

Match in Service Asset Yes No No

Match in Asset Yes Yes No

Repeat Inclusion No No No

Is Bundle Context Yes Yes Yes

Min/Max Rule Yes Yes Yes
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Feature Sub-Feature Supported 
in 
Salesforce 
Classic

Supported in 
Conga 
Platform (API)

Supported in 
Conga 
Platform 
(Config-UI) 

Option 
Configuration

Option Selection/ De- 
selection

Yes Yes Yes

View Bundle Hierarchy Yes Yes Yes

Min/Max Options Yes Yes Yes

Min/Max Total Quantity Yes Yes Yes

Is Hidden Yes Yes Yes

Is Picklist Yes Yes Yes

Modifiable Type Yes Yes Yes

Option Sequencing Yes Yes Yes

Default / Required Option Yes Yes Yes

Inclusion criteria No* No No

Min/Max Quantity Yes Yes Yes

Quantity: Default, 
Modifiable

Yes Yes Yes

Quantity: Auto Update Yes No No

Allow Cloning Yes Yes Yes

Config Type Yes Yes Yes

Auto-Adjust Price Yes No No



Configure Price Quote (CPQ)

78 Copyright ©2024 Conga Corporation. All rights reserved.

•
•
•

Feature Sub-Feature Supported 
in 
Salesforce 
Classic

Supported in 
Conga 
Platform (API)

Supported in 
Conga 
Platform 
(Config-UI) 

Product 
Attributes 
Display

Attribute: Read-Only, 
Hidden, Primary

Yes Yes Yes

Two-column Attribute 
Display

Yes Yes Yes

Three column Attribute 
Display

Yes Yes Yes

Product 
Attribute Rules

Product Scope: Product, 
Product Family, Product 
Group

Yes Yes Yes

Filter Criteria Yes Yes Yes

Action Types: Allow, 
Default, Hidden, Disabled, 
Required, Reset

Yes Yes. Supports 
the following 
Action Types 
for Product 
group and 
product family: 

Hidden
Required
Reset

Yes

Target Field: Product 
Attribute Value, Line Item, 
Product, Pricelist, Product 
Configuration

Yes Yes. Supports 
Product 
Attribute only.

Yes. Supports 
Product 
Attribute only.

Attribute Value 
Matrices

Product Scope: Product, 
Product Family, Product 
Group, Location

Yes Yes Yes
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Feature Sub-Feature Supported 
in 
Salesforce 
Classic

Supported in 
Conga 
Platform (API)

Supported in 
Conga 
Platform 
(Config-UI) 

Application Type: Default, 
Constraint, Force Set

Yes Yes Yes

Field 
Expressions / 
Rollup

Evaluation Context: 
Constraint Rule action, 
Record Update, Default 
Quantity, Rollup

Yes Yes Yes

Update Product Attribute 
and Line Item object fields

Yes Yes Yes

Rollup Group By Field: Line 
Item, Product Attribute

Yes Yes Yes

Callbacks Option Filter Callback Yes Yes Yes

Other Formula field support 
(Condition/action)

Yes Yes (Conga 
Platform)

No

Lookups (For example, 
Attributes)

Yes Yes (Conga 
Platform)

No

TurboPricing Integration Yes No No

ABO Flow support Yes No No

Service CPQ Yes No No

Multi-language support: 
For products & categories

Yes No No

Unified Cart No No No

Pricing Features
The following pricing features are supported in this release:
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

Pricing 
Calculat 
ion:

     

Pricing Bundle 
Product 
Pricing, 
Standalon 
e Product 
Pricing 
with basic 
details

Yes Yes Yes Yes

Multiple 
Charge 
Types

Yes Yes Yes Yes

Attribute- 
Based 
Pricing

Yes Yes Yes Yes

Charge 
Type 
Criteria

Yes Yes Yes Yes

Related 
Pricing

Yes Yes Yes Yes

Reprice 
Cart

Yes Yes Yes NA

Frequenc 
y

Use of 
Daily 
Frequency

No No 
Plan to 
implem 
ent.

No 
Plan to 
implem 
ent.

No 
Plan to 
implem 
ent.
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

Use of 
Weekly 
Frequency

No No 
Plan to 
implem 
ent.

No 
Plan to 
implem 
ent.

No 
Plan to 
implem 
ent.

Use of 
Frequencie 
s Monthly, 
Quarterly, 
Half 
Yearly, 
Yearly

Yes Yes Yes Yes

Price 
Dimensio 
ns

 Yes Yes Yes Yes

Manual 
Adjustm 
ents

Providing 
Manual 
Adjustmen 
ts with 
different 
Adjustmen 
t Types

Yes Yes Yes Yes

Auto- 
applied 
Adjustm 
ents

Price 
Matrices

Yes Yes Yes Yes

Price 
Rulesets

Yes Yes Yes Yes

Multiple 
adjustm 
ents

Multiple 
Adjustmen 
ts on the 
Cart Line 
Items

Yes Yes Yes NA
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

Group 
Adjustm 
ent 
Spread

 Yes Yes Yes NA

Price List Standard 
Price List

Yes Yes Yes Yes

Contract 
Price List

Yes Yes Yes Yes

Based on 
Price List

Yes Yes Yes Yes

Cart 
Actions

Copy 
Products

Yes Yes Yes NA

Mass 
Update

Yes Yes Yes NA

Favorites Yes Yes Yes NA

Pricing 
Informat 
ion

Summary 
Group 
Informatio 
n

Yes Yes Yes NA

Price 
Break-up 
Informatio 
n- Related 
Pricing

Yes Yes Yes NA
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

Price 
Break-up 
Informatio 
n- Usage 
Price Tiers

Yes Yes Yes NA

Usage 
Price 
Tiers

 Yes Yes Yes Yes

Default 
Quantity

Defaulting 
quantity 
for 
Bundles/ 
Multiple 
Charges

Yes Yes Yes Yes

Default 
Term

Defaulting 
term for 
Bundles/ 
Multiple 
Charges

Yes Yes Yes Yes

Default 
Quantity 
from

Defaulting 
Quantity 
from 
Product 
Attribute, 
Product 
Configurat 
ion and 
Advanced 
Formula

Yes Yes Yes Yes
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

Default 
Price 
from

Defaulting 
Price from 
Product 
Attribute 
and 
Advanced 
Formula

Yes Yes Yes Yes

Auto- 
cascade 
Selling 
term 
and 
Quantity

Auto- 
cascade 
Selling 
Term

Yes Yes Yes Yes

Auto- 
cascade 
Quantity

Yes Yes Yes Yes

Min/Max 
Price

Min/Max 
Price 
Applies to 
Base Price

Yes Oct '24 
+

Oct '24 
+

Oct '24 
+

Min/Max 
Price 
Applies to 
Extended 
Price

Yes Oct '24 
+

Oct '24 
+

Oct '24 
+

Proratio 
n

Allow 
Proration

Yes Yes Yes Yes

Price 
Method

Use of 
Tiered 
Rates

Yes Yes Yes Yes
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

Defer 
Pricing

Yes No 
Plan to 
implem 
ent.

No 
Plan to 
implem 
ent.

No 
Plan to 
implem 
ent.

Per Unit 
Price 
method

Yes Yes Yes Yes

Flat price 
Price 
method

Yes Yes Yes Yes

Price 
Type

Price Type 
- One Time

Yes Yes Yes Yes

Price Type 
- Per unit

Yes Yes Yes Yes

Price Type 
- Usage

Yes Yes Yes Yes

Price Type 
- Recurring

Yes Yes Yes Yes

Price 
Ramps

Auto Price 
Ramp 
Creation 
for - 
Bundle, 
Options 
and 
Standalon 
e Products

Yes Yes Yes NA
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

Create 
Price 
Ramps for 
Only 
options 
within the 
Bundle

Yes Yes Yes NA

Update 
Price 
Ramps

Yes Yes Yes NA

Delete 
Price 
Ramps

Yes Yes Yes NA

Allow Price 
Ramp 
Overlap

Yes Yes Yes NA

Price 
Escalator

Yes Yes Yes Yes

Price 
Ramps for 
Product 
with 
Related 
Pricing

Yes Yes NA NA
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

Price 
Ramps 
with 
Custom 
Frequencie 
s

Yes Yes NA NA

Multi- 
currency

Use of 
Multi- 
Currencies

Yes Yes Yes NA

Use of 
Dated 
Exchange 
Rates

Yes NA NA NA

Disable 
Currency 
Conversion 
Rate for a 
Price List

Yes Yes Yes Yes

Currency 
conversion 
enabled 
at a rule 
set level

Yes Yes Yes Yes

Cost 
Model

 No Oct '24 
+

Oct '24 
+

Oct '24 
+

Price 
Waterfa 
ll

Manage 
Price 
Waterfall 
(Pipeline)

Yes Yes Yes Yes
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

Manage 
Price 
Waterfall 
Ruleset

Yes Yes Yes Yes

Total/ 
Summary 
level 
Waterfall

No 
Plan to 
imple 
ment.

Oct '24 Oct '24 Oct '24

UOM/ 
Frequenc 
y 
Conversi 
on

Frequency 
Conversion

Yes Oct '24 
+

Oct '24 
+

Oct '24 
+

Use of 
UOM 
Conversion 
s

Yes Oct '24 
+

Oct '24 
+

Oct '24 
+

Use of 
Product 
specific 
conversion 
rates

Yes Oct '24 
+

Oct '24 
+

Oct '24 
+

Use of 
Product 
Family- 
specific 
conversion 
rates

No No 
Plan to 
implem 
ent.

No 
Plan to 
implem 
ent.

No 
Plan to 
implem 
ent.
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

Creation 
of 
Contract 
PL 
runtime

 Yes Oct '24 Oct '24 NA

Promotio 
ns:

     

Create 
Promotio 
ns

Different 
Promotion 
s Types 
and with 
different 
field 
details

Yes Yes NA Yes

 

-Buy X Get 
X

 

-Buy X Get 
Y

 

-For Every 
X, Get X

 

-For Every 
X, Get Y
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

 Line Item 
Promotion 
s

Yes Yes NA Yes

 Summary 
Group 
Promotion 
s

Yes Yes NA Yes

 Scope Yes Yes NA Yes

 Criteria Yes Yes NA Yes

 Benefits Yes Yes NA Yes

 Limits Yes Yes NA Yes

Coupons  Yes Yes NA Yes

Sales 
Promotio 
ns

 No 
Plan to 
imple 
ment.

Feb 
'25+

Feb 
'25+

Feb 
'25+

Update 
Promotio 
ns/ 
Coupons

 Yes Yes NA Yes

Delete 
Promotio 
ns/ 
Coupons

 Yes Yes NA Yes
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

Apply 
Promotio 
ns/ 
Coupons

Apply 
Promotion 
s

Yes Yes Yes NA

Apply 
Coupons

Yes Yes Yes NA

Remove 
Promotio 
ns/ 
Coupons

Remove 
Promotion 
s

Yes Yes Yes NA

Remove 
Coupons

Yes Yes Yes NA

Approva 
l

Approval 
check of 
Cart and 
line item 
approval

Yes Yes Yes NA

My 
Approval 
Dashboar 
d

Yes Yes Yes NA

Approve/ 
Reject/ 
Reassign 
Approvals

Yes Yes Yes NA

Quote 
Approval 
on Conga 
platform

Yes Oct' 24 
+

Oct' 24 
+

NA
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

Callbac 
ks:

     

Callbac 
ks

Pricing 
Callback

Yes Yes  Yes NA

Product 
Filter 
Callback

Yes Yes  Yes NA

Recommen 
dation 
Callback

Yes Yes  Yes NA

Adjustmen 
t Spread 
Callback

No Yes  Yes NA

Adjustmen 
t line item 
callback

Yes Yes Yes NA

Product 
Attribute 
Callback

No Yes Yes NA

Related 
Pricing 
Callback

Yes Yes Yes NA

Display 
Action 
Callback

Yes Yes Yes NA
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

Action 
Callback

Yes Oct '24 Oct '24 NA

Validation 
Callback

Yes Yes Yes NA

Action 
Invoker 
Callback 
Class

No NA NA NA

Revalidati 
on 
Callback 
Class

No Yes Yes NA

AssetLineIt 
em 
Callback 
Class

No Yes Yes NA

Quote life 
cycle 
Callback 
Class

No Oct'24 
+

Oct '24 
+

NA

Custom 
Fields

Support 
for Custom 
Field as 
Price 
Dimension 
in Price 
Matrices & 
Price Rule 
sets

Yes Yes Yes NA
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

Support 
for Custom 
Field used 
as Charge 
type 
Criteria, 
Ruleset 
Header 
Criteria, 
Criteria 
based 
price 
matrices, 
Criteria 
based 
price rules

Yes Yes Yes NA
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

S 
u 
p 
p 
o 
rt 
f 
o 
r 
C 
u 
s 
t 
o 
m 
Fi 
el 
d 
u 
s 
e 
d 
a 
s 
C 
o 
n 
s 
tr 
a 
in 
t 
R 
u 
le 
C 
ri 
t 
e 
ri 
a

Y 
e 
s

Y 
e 
s

Y 
e 
s

N 
A
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

S 
u 
p 
p 
o 
rt 
f 
o 
r 
C 
u 
s 
t 
o 
m 
Fi 
el 
d 
u 
s 
e 
d 
a 
s 
P 
ri 
c 
e 
di 
m 
e 
n 
si 
o 
n 
in 

Y 
e 
s

Y 
e 
s

Y 
e 
s

Y 
e 
s
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

P 
r 
o 
m 
o 
ti 
o 
n 
s 
a 
n 
d 
A 
d 
v 
a 
n 
c 
e 
d 
c 
ri 
t 
e 
ri 
a 
in 
p 
r 
o 
m 
o 
ti 
o 
n 
s
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

Display 
Custom 
Field on UI 
(Line item, 
Adjustmen 
t Line Item, 
Price 
Breakup, 
Usage 
Price Tiers, 
Summary 
Group, 
Config 
Page).

Yes Yes Yes Yes

Formula 
Fields

Suppor 
t for 
Custo 
m Field 
that is 
a 
Formul 
a used 
as 
Price 
Dimen 
sion in 
Price 
Matric 
es & 
Price 
Rule 
sets

Yes Yes Yes Y 
e 
s
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

Note: 
Nested 
formula 
are not 
supported 
on 
Platform

Suppor 
t for 
Custo 
m Field 
that is 
a 
Formul 
a used 
as 
Charg 
e type 
Criteri 
a, 
Rulese 
t 
Heade 
r 
Criteri 
a, 
Criteri 
a 
based 
price 
matric 
es, 
Criteri 
a 
based 
price 
rules

Yes Yes Yes Y 
e 
s
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

 Suppor 
t for 
Custo 
m Field 
that is 
a 
Formul 
a used 
as 
Constr 
aint 
Rule 
Criteri 
a

Yes Yes Yes Y 
e 
s

 Suppor 
t 
Custo 
m Field 
that is 
a 
Formul 
a used 
in 
pricing 
callba 
ck & 
other 
callba 
cks.

Yes Yes Yes Y 
e 
s
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

 Support 
for Custom 
Field or 
Custom 
Field that 
is a 
Formula 
used as 
Price 
dimension 
in 
Promotion 
s and 
Advanced 
criteria in 
promotion 
s

Yes Yes Yes Yes

 Display 
Custom 
Field that 
is a 
Formula 
on UI (Line 
item, 
Adjustmen 
t Line Item, 
Price 
Breakup, 
Usage 
Price Tiers, 
Summary 
Group, 
Config 
Page).

Yes Yes Yes NA
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

 Formula 
Fields 
support 
with 
Adjustmen 
t Amount 
Source

Yes Oct '24 Oct '24 Oct '24

 Formula 
Fields 
support on 
Related 
Pricing 
with 
Related 
Adjustmen 
t Amount 
Source

Yes Oct '24 Oct '24 Oct '24

Custom 
Object

Support 
for Custom 
object

Yes Yes NA Yes

Service 
Hooks/ 
Custom 
Action/ 
custom 
pages

Spport for 
Service 
hooks and 
custom 
actions

Yes Yes Yes Yes

Workflo 
w Rules

Support of 
workflow 
processes 
(Basic - 
MVP)

Yes Yes Yes Yes
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

 Support of 
workflow 
processes 
(Advanced 
)

Yes Yes Yes Yes

Deal 
Maximiz 
er

 Yes Yes Yes Yes

Reprice 
Quote

 No Oct '24 
+

Oct '24 
+

NA

Data 
Sync

Master 
data sync 
from 
salesforce 
to 
Platform

Yes Yes NA Yes

Reverse 
sync from 
Platform 
to 
salesforce 
on Cart 
Finalize

Yes Yes NA Yes

Inflight 
Cart from 
salesforce 
to 
Platform

Yes Oct '24 NA NA
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Feature Sub- 
feature

Turbo 
Pricin 
g

Cong 
a 
Platfo 
rm 
(API)

Conga 
Platfo 
rm 
(Cart- 
UI)

Conga 
Platfo 
rm 
(Admi 
n-UI)

Favorite 
Data from 
Salesforce 
to 
Platform

Yes Oct '24 NA NA

Image 
Data from 
Salesforce 
to 
Platform 
(Product, 
Category 
ec)

Yes Yes NA Yes

Setting up Salesforce Org with Conga Cloud 
Instance for CPQ
To set up Conga CPQ with the Conga platform, you must perform several configurations 
for both the Salesforce org and the Conga platform.

An administrator can be any of the following persona: Customer Administrator, Partner 
Administrator, or any other administrator assigned the responsibility of setting up 
Salesforce org with the Conga platform. In this topic, this persona is referred to as the 
Customer Administrator.

The Customer Administrator is responsible for completing the entire setup process with 
assistance from the Conga CloudOps team. 
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•

•

•
•
•
•
•

•
•
•

Or 
de 
r 

Task Owner

1 Tenant Onboarding  This task is owned by the customer administrators and Cloud Ops 
team.

Customer Administrator: Reaches out to the Conga service 
team to log a service ticket for tenant onboarding.
CloudOps team: Initiates tenant onboarding process based on 
the service ticket.

2 Configuring Salesforce 
org

Customer Admin

3 Configuring Conga 
Platform

Customer Admin

4 Configuring Revenue 
Admin Settings

Customer Admin

 

Tenant Onboarding
Configuring the Salesforce Org
Configuring the Conga Platform
Configuring Revenue Admin Settings
Creating a Quote from the Proposal

Tenant Onboarding
This topic outlines all the necessary steps for tenant onboarding. Both the Conga 
CloudOps team and customer admin are involved in this process. 

Prerequisites

You have provided the following information to your Conga support representative:

Your 18-digit Salesforce org ID.
The administrator's first name, last name, and email ID.
Your Salesforce org domain name. To view the domain details of your Salesforce org, 
go to Setup > enter my domain  in the Quick Find box and click My Domain. 
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•
•

1.
2.

3.

1.

2.
3.
4.

To onboard a tenant
Generally, your Conga support representative will log a tenant onboarding request with 
the following details.

Salesforce org and admin details: 
Salesforce org ID, the Admin User's first name, last name, and email ID.

On successful onboarding, the admin user receives a confirmation email containing Conga 
Org details, Conga IDP login credentials, and a one-time password.

To change the password
Click the Login URL (Go to URL) in the welcome email. 
Enter the username and password (Password for first-time login) in the welcome 
email. 
Click Sign-in and follow the on-screen instructions to change the password.

After changing the password, you must configure the external integrations and Conga API 
connections (API to API connection and UI to API connection) in the Conga platform and 
generate the client ID and client secret, which you will later use to formulate the client ID 
and client secret when configuring an auth.provider and SPAClient ID when creating a new 
admin setting.

To configure the external integration 
The External Integration tab allows administrators to view and manage users authorized 
through external organizations. You can add one or more external integrations; but, you 
can make only one as a default IDP.

Log in to the Conga Platform as an admin user. A Conga Platform welcome page is 
displayed. 

Click the Admin Console tile. A Platform Administration page is displayed.
Click Organization.
Open the External Integrations tab and click Add New, raising the Add New External 
Integration screen. 
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5.

6.

7.

8.
9.

10.

1.

2.

3.
4.

1.

Choose Identity Provider (Salesforce or Salesforce Sandbox) from the drop-down list 
and click Authorize, to open the selected IDP's login screen.
Log in with your onboarded Salesforce org credentials. 
If you get any access-related prompts during this process, please allow full access. 
When you log in, the selected identity provider's external identifier auto-populates 
the External ID field.
Enter the type of this integration in the Type text field. It is a free-form text field. You 
can add types such as Dev, QA, UAT, Prod, etc.
Add the description.
Enable the Default IDP toggle to make it a Default External Integration IDP.
Click Save.

To configure an API to API connection
You must establish an API-to-API connection between your Salesforce org and Conga 
Platform. This connection ensures seamless communication and data exchange between 
your Salesforce org and Conga Platform. 

On the Organization page, click the Conga API Connections tab and Add API-to-API 
Connection.
Enter values in the following fields: 

Field Description

External 
Integratio 
n

Select the respective External Identifier for which you want to configure the 
connection. The external identifier list is populated based on the External 
Integrations you added on the External Integrations page.

Client 
Name

Enter the client's name.

Descriptio 
n

Enter the appropriate description.

Click Save & Generate Client Secret to generate the Client ID.
Click Copy next to Client ID and Client Secret. Use these details when configuring a 
new auth. provider. 

To configure UI to API connection
On the Organization page, click the Conga API Connections tab and Add UI-to-API 
Connection.
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2.

•

•

3.
4.

Enter values in the following fields: 

Field Description

External 
Identifier

Select the respective External Integration for which you want to configure 
the connection. The external identifier list is populated based on the external 
integrations that you added on the External Integrations page.

Client 
Name

Enter the client name.

Description Enter the appropriate description.

Redirect URI Enter the following RLP cart page URI.

https://<CustomerOrgDomainName>--conga-ccpq.vf.force.com/  

apex/RLPCart  

Cors Origins Enter your Salesforce org's base URL. 

https://<CustomerOrgDomainName>.my.salesforce.com

Back 
Channel 
Logout URI

Leave the field blank.

Front 
Channel 
Logout URI

Leave the field blank.

Click Save & Generate Client Secret to generate the Client ID.
Click Copy next to the Client ID. This is your SPA Client ID, and use it when Creating a 
New Admin Setting.

Next Step: Configuring the Salesforce Org

Ensure the < CustomerOrgDomainName > name is replaced with the 
actual org domain name. To view the domain details of your 
Salesforce org, go to Setup > enter my domain  in the Quick Find box 
and click My Domain. 



Ensure the < CustomerOrgDomainName > name is replaced with the 
actual org domain name.


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•
•
•
•
•
•
•
•
•
•
•

•
•

1.

Configuring the Salesforce Org
After completing tenant onboarding, use the configurations in this section to access new 
CPQ APIs on the Conga Platform using the Salesforce UI and synchronize data 
automatically from Salesforce to the Conga Platform. Review the following topics for more 
information.

Installing Conga CPQ (RLS) Package
Creating a New Admin Setting
Creating a New Auth Provider
Configuring Remote Site Settings
Creating a New Static Resource
Creating the Configure Products Button for RLS Flow
Enabling OAuth Settings
Creating a Connected App
Configuring a Deep Clone Button on Proposal
Configuring View Cart (Read Only) Button on Proposal
Configuring My Approval Button on Proposal Detail Page

Installing Conga CPQ (RLS) Package

You must verify that the onboarded Salesforce org has all the dependency packages. 

Start with the Installing Conga CPQ (RLS) Package topic and follow the steps for the 
successful org setup.



The Conga CPQ (RLS) package is required to integrate and synchronize your CPQ data with 
the Conga Platform.

Prerequisites

Conga Community portal credentials
Installation key

Contact the Conga support team for the installation key.

To view the installed packages on your Salesforce org
Login to your Salesforce org.
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2.

3.

1.
2.
3.

4.

Go to Setup > in the Quick Find box, enter Installed Packages  and select it. A list of 
installed packages is displayed.
Verify the version number against the packages as mentioned in the following. 

Ord 
er

Package Version Number

1 Conga Base Library 4.243 or later

2 Conga Contract Lifecycle Management 14.696 or later

3 Conga Configuration & Pricing 15.2062 or later.

4 Conga Quote Management 13.262 or later.

5 Conga Quote Configuration Integration 15.399 or later

To install or upgrade the dependency packages, refer to the Installing CPQ Packages for 
the order of the package installation. After ensuring the installation of the above 
dependant packages, you must install the following package.

Product Latest Certified Version 
Name

Latest Certified Version 
Number

Conga CPQ (RLS) (New) 2.1.80 2.80

Login to the Conga Community portal.
Go to Get Started > Install Center.
In the My Packages navigation link, click CPQ. A list of CPQ-related packages is 
displayed. 
On the CPQ (RLS) tile, click the environment where you want to install the packages. 
Click Install in Production to install the packages in your production environment. 
Click Install in Sandbox to install the packages in your sandbox. 
To install any specific version, click Details on the package tile, and select the 
required version > click Install in Production to install the packages in your production 

To Install the Conga CPQ (RLS) package
Install the latest version of the Conga CPQ (RLS) package. Refer to the latest CPQ on 
Conga Platform release notes for the packages. 
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5.

6.
7.

•

•

•

8.

environment. Click Install in Sandbox to install the packages in your sandbox. A 
Salesforce login screen is displayed.
Enter login credentials and click Log In. Use the onboarded Salesforce org login 
credentials.
Enter the installation key provided by Conga. 
Select the profile for which you want to install the package. Conga recommends that 
you select Install for All Users.

Install for Admins Only: This is the default setting. Apply this access level to 
disable all object permissions. 
Install for All Users: Apply this access level to assign users permissions to read, 
create, edit, delete, view all, and modify all, for all objects in the CPQ package. 
Install for Specific Profiles: Apply this access level to assign permissions to 
specific users to read, create, edit, delete, view all, and modify all, the pricing- 
related objects in the CPQ package. 

Click Install.

 

Next Step: Creating a New Admin Setting.

Creating a New Admin Setting
Admin Settings are system properties that have different values, and you can use them for 
different purposes. You must configure admin settings to meet the business objectives of 
your implementation along with Custom Settings.

Field Description

SPAClientId A single-page application ID. Enter the SPAClientId that you generated after 
configuring the UI To API configuration.

Organizati 
onId 
(optional)

Enter the Conga Organization ID that you captured after tenant onboarding. To 
view the organization ID, see the "To capture Conga Organization Display Name 
and Organization ID" section in Tenant Onboarding.

Organizati 
onFId 
(optional)

Your Conga organization's friendly ID. Friendly ID is formatted as <Conga org 
display name-org Id>. For more information, see the "To capture Conga 
Organization Display Name and Organization ID" section in Tenant Onboarding.

UserId 
(optional)

Enter the user ID that is created on the Conga Platform. To view the user ID on the 
Conga Platform, log in to Conga Platform as administrator, then go to Admin 
Console > Users > Click on the desired username. 



Configure Price Quote (CPQ)

112 Copyright ©2024 Conga Corporation. All rights reserved.

•
•
•
•

•
•
•
•

•
•
•

•
•
•
•

•
•
•
•

•
•
•

Field Description

InstanceUR 
L

Conga organization instance URL. Use any of the following URLs per your Conga 
instance:

For production instance:
NA: https://prod-rls10.congacloud.com
EU: https://login.congacloud.eu/
AU: https://login.congacloud.au/

For Preview instance:
NA: https://preview-rls09.congacloud.com
EU: https://rls-preview.congacloud.eu/
AU: https://rls-preview.congacloud.au/

For staging instance: https://rls-stg.congacloud.io
For qa instance: https://rls-qa.congacloud.io
For dev instance: https://rls-dev.congacloud.io

UIInstance 
URL

Conga Organization UI instance URL. Use any of the following URLs per your Conga 
instance:

For production instance:
NA: https://prod-rls10.congacloud.com/ecpqui
EU: https://login.congacloud.eu/ecpqui
AU: https://login.congacloud.eu/ecpqui

For preview instance:
NA: https://preview-rls09.congacloud.com/ecpqui
EU: https://rls-preview.congacloud.eu/ecpqui
AU: https://rls-preview.congacloud.au/ecpqui

For staging instance: https://rls-stg.congacloud.io/ecpqui
For qa instance: https://rls-qa.congacloud.io/ecpqui 
For dev instance: https://rls-dev.congacloud.io/ecpqui
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Field Description

UpsertQuot 
esEndpoint 
URL

The upsert quotes URL. 

For production instance:
NA: https://prod-rls10.congacloud.com/api/quote/v1/quotes/upsert-quote
EU: https://login.congacloud.eu/api/quote/v1/quotes/upsert-quote
AU: https://login.congacloud.au/api/quote/v1/quotes/upsert-quote

For preview instance: 
NA: https://preview-rls09.congacloud.com/api/quote/v1/quotes/upsert- 
quote
EU: https://rls-preview.congacloud.eu/api/quote/v1/quotes/upsert-quote
AU: https://rls-preview.congacloud.au/api/quote/v1/quotes/upsert-quote

For staging instance: https://rls-stg.congacloud.io/api/quote/v1/quotes/upsert- 
quote 
For qa instance: https://rls-qa.congacloud.io/api/quote/v1/quotes/upsert-quote
For dev instance: https://rls-dev.congacloud.io/api/quote/v1/quotes/upsert-quote

LoginURL Your Conga Platform login URL. 

For Production instance: 
NA: https://login-rls.congacloud.com/
EU: https://login-rls.congacloud.eu/
AU: https://login-rls.congacloud.au/

For preview instance:  
NA: https://login-rlspreview.congacloud.com/
EU: https://login-rlspreview.congacloud.com/
AU: https://login-rlspreview.congacloud.au/

For staging instance: https://login-rlsstg.congacloud.io
For qa instance: https://login-rlsqa.congacloud.io
For dev instance: https://login-rlsdev.congacloud.io

Enter the following endpoints only when you use X-Author for Excel, Conga Sign, and Composer 
applications along with CPQ. These endpoints are specific to the connected environment. Reach 
out to the Conga CloudOps team for the endpoints.

XAEndpoin 
t 

For production: https://xauthor-prod-rls10.congacloud.com

For preview environment: 

For staging environment: https://xauthor-stg.congacloud.io 

SignEndpoi 
nt

https://coreapps-rlspreview.congacloud.com



Configure Price Quote (CPQ)

114 Copyright ©2024 Conga Corporation. All rights reserved.

1.
2.
3.

4.

Field Description

ComposerE 
ndpoint

https://coreapps-rlspreview.congacloud.com

To configure a new admin entry
Click the App Launcher icon ( ), enter Admin, and select Admin.
Click New.
Enter the following details:

Field Value

Name APTS_RLPInstanceSettings

Value Leave this field blank.

Code Enter the code. Below is an example of a code whose values are specific to the 
connected/preview environment. 

{

"SPAClientId": "technicalpublicationteam-spa",

"OrganizationId": "c7552ce4-a380-45b0-9c8a-022d2eafa7df",

"OrganizationFId": "auert00000004wfoai-c7552ce4- 

a380-45b0-9c8a-022d2eafa7df",

"UserId": "769d5e44-ef45-cb0d-dd3c-1f046feded1c",

"InstanceURL": "https://preview-rls09.congacloud.com",

"UIInstanceURL": "https://preview-rls09.congacloud.com/ecpqui",

"UpsertQuotesEndpointURL": "https://preview-rls09.congacloud.com/api/ 

quote/v1/quotes/upsert-quote",

"LoginURL": "https://login-rlspreview.congacloud.com",

"XAEndpoint": "https://xauthor-stg.congacloud.io",

"SignEndpoint": "https://coreapps-rlspreview.congacloud.com",

"ComposerEndpoint": "https://coreapps-rlspreview.congacloud.com"

}

Click Save. Your new admin setting is saved and added.

Next Step: Create a new Auth. Provider
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Creating a New Auth Provider
Authentication providers allow you to configure external identity providers to authenticate 
users in your Salesforce org. This feature allows users to log in to Salesforce using their 
credentials from another trusted system, streamlining the login experience and improving 
security. This provider is particularly useful when users already have accounts with 
external identity providers, and you want to integrate with their existing authentication 
mechanisms. 

Prerequisites

Field Description

Consumer Key Consumer key and consumer secret are Client ID and Client Secret generated 
while configuring Conga API-to-API connection after onboarding your tenant.

Consumer Secret

Authorization 
Endpoint URL

Enter the authorization endpoint URL. 

Enter the region-specific Authorize Endpoint URL:

For example:

Preview Environment:

NA: https://login-rlspreview.congacloud.com/api/v1/auth

EU: https://login-preview.congacloud.eu/api/v1/auth

AU: https://login-preview.congacloud.au/api/v1/auth

Production Environment: 

NA: https://login-rls.congacloud.com/api/v1/auth

EU: https://login.congacloud.eu/api/v1/auth

AU: https://login.congacloud.au/api/v1/auth
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Field Description

Token Endpoint 
URL

Enter the token URL. Use any of the following URLs as per your Conga 
instance to access the OAuth2 token service.

Enter the region-specific token endpoint URL:

For example:

Preview Environment:

NA: https://login-rlspreview.congacloud.com/api/v1/auth/connect/token

EU: https://login-preview.congacloud.eu/api/v1/auth/connect/token

AU: https://login-preview.congacloud.au/api/v1/auth/connect/token

Production Environment: 

NA: https://login-rls.congacloud.com/api/v1/auth/connect/token

EU: https://login.congacloud.eu/api/v1/auth/connect/token

AU: https://login.congacloud.au/api/v1/auth/connect/token

 

To configure a new auth. provider
Go to Setup > Open the Authentication Providers page by enter  Auth. Providers  in 
the Quick Find box and clicking Auth. Providers in the results.
Click New and select Open ID Connect from the Provider Type drop-down menu.
Enter the admin setting name, APTS_RLPInstanceSettings which was created in the 
previous topic (Creating a New Admin Setting). For example, APTS_RLPInstanceSettings. 
The URL Suffix name is generated automatically based on the Auth. provders name.
Enter the connected environment's consumer key and consumer secret, authorize 
endpoint URL, and token endpoint URL, as mentioned in the prerequisites. Leave the 
remaining fields as they are. 
Click Save.

 

Next Step: Configuring Remote Site Settings
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Configuring Remote Site Settings
Remote Site Settings are a security feature that controls access to external web resources 
from your Salesforce organization. These resources can include services, APIs, or websites 
that your Salesforce org needs to communicate with. By default, Salesforce blocks calls to 
external URLs from within its platform due to security considerations. However, you can use 
Remote Site Settings to explicitly allow these calls. Remote site settings help you maintain 
a secure environment while allowing your Salesforce organization to interact seamlessly 
with external web resources as needed for your business processes. 

In this case, you must create the following remote site settings.

RLPLoginURL
RLPInstanceURL

Prerequisites

Remote site URL for RLP login
Remote site URL for RLP instance

Reach out to the Conga CloudOps team for the details.

To configure remote site settings
Go to Setup, enter Remote Site Settings  in the Quick Find box, and select it.
Click New Remote Site.
Enter the following details:

Remote Site Name: Enter a remote site name. For Example,  RLPLoginURL .
Remote Site URL: Enter the remote site URL. The remote site URL will be specific 
to the associated RLP environment. For example: 
For a preview Environment: https://login-rlspreview.congacloud.com 
For a production Environment: https://login-rls.congacloud.com
Disable Protocol Security: Leave this checkbox unselected.
Description: Enter a description.
Active: Select the checkbox.

Click Save & New.
Enter the following details:

Remote Site Name: Enter a remote site name. For example,  RLPInstanceURL .
Remote Site URL: Enter the remote site URL. The remote site URL will be specific 
to the associated RLP environment. For example:  
For a preview environment: https://preview-rls09.congacloud.com. 
For a production environment:  https://prod-rls10.congacloud.com
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Disable Protocol Security: Leave this checkbox unselected.
Description: Enter a description.
Active: Select the checkbox.

Click Save.

 

Next Step: Creating a New Static Resource

Creating a New Static Resource
Static resources in Salesforce enable you to upload and reference various types of content, 
such as archives (.zip and .jar files), images, style sheets, JavaScript, and other files, 
specifically for use within your Salesforce organization. After onboarding a tenant, you 
must request the service team for the static resource file which you will use as a resource 
file to upload while creating a new static resource. 

Create a New Custom Static Resource: Ensure you create a new custom static 
resource in the target organization. The existing static resources from managed 
packages are outdated and do not work, which causes errors. 
Update Mapping File with Custom Fields: If you want to sync any custom fields from 
the SFDC Proposal to the Conga Platform Proposal then add that field to the static 
resource file and also create that field on the Conga platform. 
Verify Fields in Conga Platform: Ensure that the fields you add to the mapping file 
already exist in the Conga Platform. If not, you encounter a “metadata for field xxx 
not found” error.

Prerequisites

Quote field name mapping file.
Click the QuoteFieldNameMap.json file. The mapping file is automatically 
downloaded and saved in your system.  

To Create a Static Resource in a Salesforce Org
Go to Setup > App Setup > Develop > Static Resources.
Click New and enter QuoteFieldNameMap  in the Name field.
Click Choose file and upload the mapping file.
In the Cache Control dropdown, select one of the following values.

Do not change the file name and file type while saving this mapping file. 
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Private: Select this to restrict API access to authenticated users only.
Public: Select this to share static resource data cached on the Salesforce server 
with other users in your organization.

Click Save. 

The fields mentioned in the static resource file will be synced to Platform Quote during 
Proposal creation. 

Next Step: Creating the Configure Products Button for RLS Flow

Creating the Configure Products Button for RLS Flow
Create the Configure Products button to initiate the quote-to-cash process in the RLS flow. 

To create a Configure Products button
Go to Setup > Object Manager and search for the Quote/Proposal object.
Click Quote/Proposal. A quote details page is displayed.
In the left menu, click Custom Fields & Relationships  and then click New. The New 
Custom Field page is displayed.
In the Step 1. Choose the field type page choose Formula as Data Type and 
click Next.
In the Step 2. Choose the output type page, enter the flow name as required. For 
example, Configure Products(RLS Flow)  in the Field Label. For Formula Return 
Type, choose Text.
In the Step 3. Enter the formula page, copy the following formula and paste it under 
the Simple Formula tab. Click Check Syntax to validate the formula. 

IF ( LEN( Apttus_QPConfig__PriceListId__c ) > 0 , HYPERLINK("/apex/ 

Conga_CCPQ__RLPCart?boid="&Id& "&flow=system&idp=Salesforce", IMAGE("/resource/ 

Apttus_QPConfig__Button_Configure", "Configure Products"),"_self"), NULL)

Click Next.
In the Step 4. Establish field-level security page, Select the profiles to which you want 
to grant edit access to this field via field-level security and click Next.

•

•

Enter the name of your flow setting in the"flow" parameter in the above 
formula. In our example, it is "system".
Update the "idp" parameter in the formula based on the org type. Use 
"Salesforce" for production orgs and "SalesforceSandbox" for sandbox 
orgs.


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Choose the page layouts on which you want to display this field and click Save.

 

Next Step: Enabling OAuth Settings

Enabling OAuth Settings
You must set up the OAuth and OpenID flows for your connected app. 

If you turn on this setting, then the whole org is affected.

To enable OAuth settings
Navigate to Setup > Settings > Identity > Oauth and OpenID Connect Settings. A list 
of flows is displayed. 
Turn on the Allow OAuth Username-Password Flows setting, if it is not enabled. 

Creating a Connected App

Creating a Connected App
You must configure a connected app in the onboarded Salesforce org to provide 
authentication and authorization for the Conga Platform services.

Prerequisites

Callback URL of your Salesforce org: The callback URL is your domain URL (Setup > My 
Domain).

To view your current domain URL:

Go to Setup.
Enter my domain  in the Quick Find box and select My Domain.
Copy the URL from My Current Domain URL. This URL is specific to the instance you 
are connected to. For example, <Domain Name>.my.salesforce.com. 

Next Step: 
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To create a connected app
Log in to the Salesforce portal as an administrator.
Go to Setup. In the Quick Find box, Enter App Manager and click App Manager in the 
suggestions .  The Lightning Experience App Manager page appears.
Click New Connected App.
Fill in the following details in the Basic Information section.

Field Description

Connected 
App Name

Enter the connect app's name, which displays in the App Manager and on its 
App Launcher tile. For example, RLSInstance.

API Name The API name is generated automatically based on the name of the 
connected app.

Contact 
Email

Enter the email address of the administrator managing the connected app. 

Fill in the following details in the API (Enable OAuth Settings) section.

Fields Description

Enable OAuth 
Settings

Select this to define the OAuth settings. When you enable this field, 
additional settings are displayed under the API (Enable OAuth 
Settings) section.

Enable for 
Device Flow

Select this to enable the connected app for an external application.

Callback URL The callback URL is your current domain URL. Refer to the prerequisites 
section to know your domain URL.

When you select the Enable for Device Flow field, the callback URL is 
generated by default. Add your current domain URL to the callback URL.

You can also add other URLs in separate lines. 

Use Digital 
Signatures

Leave this option unchecked.

Selected 
OAuth Scope

Select Full access (full) and move to Selected OAuth Scopes by clicking 
the Add arrow.
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Fields Description

Require Secret 
for Web Server 
Flow

Select this to require the connected app to provide a consumer secret for 
authorization.

Require Secret 
for Refresh 
Token Flow

Select this option to include the connected app’s client secret in the 
refresh token flow's authorization request. If you do not select this option 
and a connected app sends the client secret in the authorization request, 
Salesforce still validates it.

Enable Client 
Credentials 
Flow

Select this option to let this connected app use the OAuth client 
credentials flow. 

Enable 
Authorization 
Code and 
Credentials 
Flow

Select this option to let this connected app use the authorization code 
and credentials flow. This flow is supported only for Experience Cloud 
users. 

Leave all other fields blank. Click Save. 
 

After you create a connected app, the system generates a consumer key and consumer 
secret to enhance the security of your connected app. The consumer key serves as a unique 
identifier for the customer within the Salesforce system, while the consumer secret 
validates the ownership and authorization associated with the consumer key.

To capture consumer key and consumer secret
Log in to the Salesforce portal as an administrator.
Go to Setup. In the Quick Find box, Enter  App Manager  and click App Manager in the 
suggestions.
Find the connected app, click the drop-down ( ) icon, and then select View.
Next to Consumer Key and Secret, click Manage Consumer Details. 
You are prompted to verify your identity using one of your registered methods.

Changes can take up to 10 minutes to take effect. 
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In the Consumer Details section, click Copy next to Consumer Key and Consumer 
Secret and save them for future use.

 

Next Step: Configuring the Conga Platform

Configuring a Deep Clone Button on Proposal
You can deep-clone the existing quote using the Deep Clone (RLS) button on the Quote 
detail page. Cloning a quote copies all the information from the existing quote, including 
line items and proposal header information asynchronously. You can deep-clone a quote 
when you need multiple draft options of the same quote or need to make changes (for 
example, extend the quote expiry date) to a finalized quote before sending it out to the 
customer.

To make the deep clone button available on the quote or proposal details page, you must 
complete the following configurations.

To Create a New Global Action Button for Deep Clone
To Add a Global Action Button on Salesforce Mobile and Lightning Experience Actions Layout
To Add a Deep Clone (RLS) Button on the Quote Details Page
To Clone an Existing Quote

To Create a New Global Action Button for Deep Clone
Go to Setup. In the Quick Find box, Enter  Global Actions  and click Global Actions in 
the suggestions. A list of global actions is displayed.
Click New Action and enter the values as mentioned below.

Action Type: Custom Visualforce
Visualforce Page: BOClone [Conga_CCPQ__BOClone]
Height: 250px
Standard Label Type: None
Label: It is a free text. Enter the label name to display on the deep clone button. 
For example, Deep Clone (RLS).
Name: The name is generated automatically based on the label. 
Description: Enter the summary about the new action button. 

Click Save.

After creating a deep clone button, ensure that you have the new global action (deep clone 
(RLS) available on the Salesforce mobile and lightning experience actions layout. Hence, 
you can view the deep clone button as an action on the proposal page.
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To Add a Global Action Button on Salesforce Mobile and 
Lightning Experience Actions Layout

Go to Setup. In the Quick Find box, Enter Publisher Layouts and click Publisher 
Layouts in the suggestions. A Publisher Layouts page is displayed.
In the global layout section, click Mobile & Lightning Actions.
Drag and drop the new global action (Deep Clone (RLS)) to the Salesforce mobile and 
lightning experience actions layout. 
In the global layout section, click Save.

The new global action button is now available on the lighting actions layout and you must 
add a deep clone (RLS) button on the quote details page.

To Add a Deep Clone (RLS) Button on the Quote Details Page
Go to Setup > Object Manager.
Click Quote/Proposal. A quote/proposal object details page is displayed.
In the left pane, click Page Layouts. A list of page layouts is displayed.
Click Proposal Layout.
In the Proposal Layout section, click Mobile & Lightning Actions.
Drag and drop the Deep Clone (RLS) to the Salesforce mobile and lightning experience 
actions layout. 
In the global layout section, click Save.

To Clone an Existing Quote
Navigate to your existing quote.
Click the Deep Clone (RLS) button. A new quote is generated with a unique quote 
number whose Status is Draft, and Configurations status is Saved.

Configuring View Cart (Read Only) Button on Proposal
This feature allows you to open your Product Configuration in read-only mode. In read-only 
mode you are only able to see the line items in the cart, you cannot edit any fields. All the 
action buttons are disabled in a read-only cart. To open the read-only cart, you can use a 
separate Configure Product button with read-only access on the Quote Details page that 
your admin must configure. When you open a cart in read-only mode, no new product 
configuration is created on the Quote Details page.
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You can perform the following tasks in a read-only cart:

Search for products on the cart.
Open or create new Cart Views.
Use advanced filters.
Save Cart Views with the filters.
Close the cart

You can open a cart in read-only mode even when the pricing of the line item is pending. 
When you open such a cart, the priced line items are displayed and a progress bar is 
displayed with the status of the ongoing pricing process of the remaining line items. The 
action buttons remain disabled until you exit the read-only mode.

To Configure the View Cart (Read Only) Button on the 
Proposal Details Page

Go to Setup > Object Manager.
Click Quote/Proposal. A quote/proposal object details page is displayed.
In the left pane, click Fields & Relationships. A list of fields and relationships is 
displayed.
Click New.
In the Step 1. Choose the field type page choose Formula as Data Type and 
click Next.
In the Step 2. Choose the output type page, enter the flow name as required. For 
example, View Cart Read Only (Platform) in the Field Label. For Formula Return Type, 
choose Text. Click Next.
In the Step 3. Enter the formula page, copy the following formula and paste it under 
the Simple Formula tab. Click Check Syntax to validate the formula. 

IF ( LEN( Apttus_QPConfig__PriceListId__c ) > 0 , HYPERLINK("/apex/ 

Conga_CCPQ__RLPCart?boid="&Id&"&mode=readOnly&flow=system" , IMAGE("/resource/ 

APTS_ViewCart", "View Cart"),"_self"), NULL)

Click Next.
In the Step 4. Establish field-level security page, select the profiles to which you want 
to grant edit access to this field via field-level security, and click Next.
Choose the page layouts on which you want to display this field and click Save.
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Configuring My Approval Button on Proposal Detail 
Page
RLS approval is an aura component with a lightning button named "My Approvals" that 
directs you to the My Approvals page. Using Lightning App Builder, you can add this 
component to any object's record detail pages.

Prerequisites:

Basic Knowledge of using Salesforce Developer Console. For more information, see 
Using the Developer Console. 
Update the APTS_RLPInstanceSettings admin setting with the approvals endpoint 
URL, https://<connected_environment>/approvals/. The endpoint URL is specific to the 
environment you are connected to.  
For the QA environment: https://rls-qa.congacloud.io/approvals/.
Create an apex class, such as RLSApprovalsHandler.cls. All required profiles should 
be granted access to this new class.
Create an aura component, such as RLSApprovals.cmp
Include the component on the detail page of the record.

To create an apex class:
Log in to Salesforce > click the setup ( ) icon > Developer Console. A developer 
console page is displayed.
Click File > New > Apex Class. 
Enter the name of the Apex class as RLSApprovalsHandler and enter the following 
code. 
RLSApprovalsHandler.apxc

public with sharing class RLSApprovalsHandler {       

    @AuraEnabled   

    Public static String getSessionID(){

        return UserInfo.getSessionId();

    }

}

Click File > Save.
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To create an aura component
Log in to Salesforce > click the setup ( ) icon > Developer Console. A developer 
console page is displayed.
Click File > New > Lightning Component. 
Enter the Name as RLSApprovals.
Add required configurations to the new component available under the component 
configuration.
Click Submit and enter the following code. 
RLSApprovals.cmp

<aura:component controller="RLSApprovalsHandler" implements="force:appHostable, 

flexipage:availableForAllPageTypes,flexipage:availableForRecordHome,force:hasRe 

cordId,force:lightningQuickAction,force:hasSObjectName" access="global" >    

    <aura:attribute name="sObjectName" type="String" />

    <aura:attribute name="recordId" type="String" />

    

    <div style="border: 1px solid lightgray; padding: 5px; margin-bottom: 10px; 

border-radius: 5px;background-color:white">

        <div style="margin-left: 7px; margin-bottom: 7px; color: black; font- 

weight: 700; font-size: 16px;">

            <span>

                RLS Approvals

            </span>

        </div>

        <div class="full forcePageBlockSectionRow">

            <p class="full forcePageBlockItem forcePageBlockItemView" style="wi 

dth:100%;text-align:center">

                <div class="slds">

                    <div class="slds-grid slds-wrap">

                        <div class="slds-col  slds-size_1-of-12 ">                            

                            <a aura:id="myapproval" onclick="{! 

c.callMyApprovals}" class="HideLine">

                                <lightning:icon iconName="standard:approval" 

 size="medium" alternativeText="Approvals"/>

                                <br/> 

                                <span class="osOutputLabel">My <br/>Approvals</ 

span>

                            </a>

                        </div>

                    </div>
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                </div>

            </p>

        </div>

    </div>  

</aura:component>

Click File > Save.
The RLSApprovals component details are displayed in the right pane. 
Click CONTROLLER. An RLSApprovalsController tab is displayed. Enter the following 
code. 
RLSApprovalsController.js

({        

   callMyApprovals : function(component, event, helper) {

        helper.callMyApprovals(component);        

    }   

})

Click File > Save.
From the RLSApprovals right pane, click HELPER. 
RLSApprovalsHelper.js

({      

    callMyApprovals : function(component, event, helper) {

        var recordId = component.get("v.recordId");

        var sObjectName = component.get("v.sObjectName");

        // the below URL needs to be changed according to the environment of 

testing. eg: rlsstg, rlsqa..

        var redirectUrl = "https://rls-dev.congacloud.io/approvals/my- 

approvals";

        var coreApps= component.get("c.getSessionID");

        coreApps.setCallback(this, function(response) {

            var state = response.getState();      

            if (state === "SUCCESS") {

                var params = {};

                var sessionId = response.getReturnValue();

                params.sessionId = sessionId;

                params.recordId = recordId;

                params.sObjectName = sObjectName;

                params.url = redirectUrl;
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                this.navigate(component, event, helper, params);

            }

        });

        $A.enqueueAction(coreApps);

    },  

    navigate : function(component, event, helper, params) {

        var urlEvent = $A.get("e.force:navigateToURL");

        urlEvent.setParams({

            "url": params.url+'?recordId='+params.recordId+'&sObjectName='+para 

ms.sObjectName+'&sessionId='+params.sessionId

        });

        urlEvent.fire();

    }

})

Click File > Save.

To include an RLS Approval component on a Salesforce 
object:

Log in to Salesforce > Go to Setup > Object Manager.
Click Quote/Proposal. A quote/proposal object details page is displayed.
From the left pane, click Ligthing Record Pages. A quote proposal record page is 
displayed.
Click Edit.
From the left pane, drag and drop RLSApprovals (available under the Custom list) to 
the right pane. 

Configuring the Conga Platform
After configuring your Salesforce org, you must configure Conga Platform.

To launch Conga Platform
Click the Login URL (Go to URL) in the welcome email. 
Enter the username and password. 
Click Sign-in. A Launch your Conga Experience Page is displayed. 
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Click Admin Console. A Platform Administration page is displayed.

 

Managing External Integrations and Conga API Connections
Adding a New User
Configuring DataSync Infrastructure
Running DataSync

Managing External Integrations and Conga API 
Connections
The External Integration tab allows administrators to view and manage users authorized 
through external organizations. You can add one or more external integrations; however, 
you can make only one as a default IDP.

To add a new external integration
Log in to the Conga Platform as an admin user. A Conga Platform welcome page is 
displayed.
Click the Admin Console tile. A Platform Administration page is displayed.
Click Organization.
Open the External Integrations tab and click Add New, raising the Add New External 
Integration screen. 
Choose Identity Provider (Salesforce or Salesforce Sandbox) from the drop-down list 
and click Authorize, to open the selected IDP's login screen.
Log in with your onboarded Salesforce org credentials. 
If you get any access-related prompts during this process, please allow full access. 
When you log in, the selected identity provider's external identifier auto-populates 
the External ID field.
Enter the type of this integration in the Type text field. It is a free-form text field. You 
can add types such as Dev, QA, UAT, Prod, etc.

Start with the Adding a New User topic and follow the steps for the successful setup.
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Add the description.
Enable the Default IDP toggle to make it a Default External Integration IDP.
Click Save.

To configure an API to API connection
You must establish an API-to-API connection between your Salesforce org and Conga 
Platform. This connection ensures seamless communication and data exchange between 
your Salesforce org and Conga Platform. 

Login to the Conga Platform as an Admin User.

Click the App Launcher ( ) icon from the top-left corner > Admin 
Console > Organization.
Go to the Conga API Connections tab.
Open the Conga API Connections tab and click Add API-to-API Connection.
Enter values in the following fields: 

Field Description

External 
Integratio 
n

Select the respective External Integration for which you want to configure the 
connection.

Client 
Name

Enter the client's name.

Descriptio 
n

Enter the appropriate description.

Click Save & Generate Client Secret to generate the Client ID.
Click Copy next to Client ID and Client Secret. 
Save them for future use.

To configure UI to API connection
Login to the Conga Platform as an Admin User.

Click the App Launcher ( ) icon from the top-left corner > Admin 
Console > Organization.
Go to the Conga API Connections tab.
Click Add UI To API Connection.
Enter values in the following fields: 



Configure Price Quote (CPQ)

132 Copyright ©2024 Conga Corporation. All rights reserved.

•

•

6.
7.
8.

Field Description

External 
Identifier

Select your Salesforce org ID for which you want to configure the 
connection. The external identifier list is populated based on the External 
Integration that you added. For more information, see External 
Integrations.

Client Name Enter the client name.

Description Enter the appropriate description.

Redirect URI Enter the UI Callback Endpoint (URI of the RLPCart page). It is the site to 
which identification and access tokens are sent. 

https://<your Salesforce org domain>--conga-ccpq.vf.force.com/ 
apex/RLPCart 
 

Cors Origins Enter the Domain Name present in the callback endpoint. It is the base 
URL of the origin server to enable cross site request.

For example: 

https://<your Salesforce org domain>.my.salesforce.com

Leave other fields blank. 
Click Save & Generation Client ID to generate the Client ID.
Copy the Client ID. Use this client Id as a SPAClientId while creating a new admin 
setting as part of Salesforce confgurations. 

The UI to API connection is configured and activated. You can Deactivate or Reactivate any 
of the Conga API Connections by using the respective hyperlink under the Actions column, 
and Edit the configuration by clicking the External Identifier hyperlink on the list page.

 

Next Step: Adding a New User

You can also include comma-separated fully qualified multiple 
URLs if required.


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Adding a New User
You can manage Conga Platform users using the User Administration user interface. The 
Users tab allows you to:

Create, update, and manage users.
Import user information.
Assign roles to users.
Set default options for users. For example, locale, time zone, date and time format, 
and other preferences.

To create a new user
Log in to the Conga Platform as an admin user.

Click the App Launcher ( ) icon from the top-left corner, then go to Admin Console > 
Users. 
A list of users is displayed.
Click Add to add a new external user. The User Details screen appears.
Enter values in the following fields:

Field 
Nam 
e

Description

User 
Type

Select an external user from the dropdown list.

Exter 
nalId

Enter the user's external ID. This can be any unique alphanumeric text used to 
identify the user. This ID is used when migrating users from one environment to 
another. You can enter up to 2000 characters in this field.

User 
Name

Enter the user's unique user name. The Conga IDP user uses this username to log 
onto the Conga Platform. You can enter up to 255 characters in this field.

•

•

For the Salesforce identity provider user, the user's unique 
Salesforce ID (18 digits) must be added as an external ID. For more 
information on how to get the 18-digit user ID, see Getting 
Salesforce User ID.
ExtetnalId is optional for Conga IDP users.


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Field 
Nam 
e

Description

First 
Name

Enter the user's first name. You can enter up to 255 characters in this field.

Last 
Name

Enter the user's last name. You can enter up to 255 characters in this field.

Email Enter the user's email address. It must be a valid email address in the form: 
test@abc.com, test@abc.in, etc. You can enter up to 255 characters in this field.

Role Enter the keyword to search and select the appropriate role to be assigned to a 
new user. A role is assigned to users performing similar tasks and consists of a set 
of permissions. For more information, see Managing Roles and Permission Groups.

Permi 
ssion 
Group 
s

Select permission group(s) from the list. Permission groups are assigned to users for 
additional access that is not part of the selected role. Permission groups determine 
a given user's access to objects and records, and permissions to perform actions in 
the Conga Revenue Lifecycle Platform.

Timez 
one

Enter the keyword to search and select the time zone from the list.

Local 
e

Enter the keyword to search and select the locale from the list.

Curre 
ncy

Enter the keyword to search and select the currency from the list.

Alias Enter the user's alias name. You can enter up to 255 characters in this field.

If you do not provide a time zone, the application uses the organization's 
time zone and assigns it to the user.



If you do not provide a locale, the application uses the organization's 
locale and assigns it to the user.



If you do not provide a currency, the application uses the organization's 
currency and assigns it to the user.


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Field 
Nam 
e

Description

Lang 
uage

Enter the user's language. For example, en-IN . You can enter up to 255 characters 
in this field.

Addre 
ss

Enter the user's full address. You can enter up to 64000 characters in this field.

Phone 
Numb 
er

Enter the user's phone number. You can enter up to 255 characters in this field.

Click Save.

Newly created users are in an active state by default. Based on the Timezone, Locale, and 
Currency selections, the Positive Currency Format, Negative Currency Format, Short Date 
Format, Log Date Format, Time Format, Decimal Symbol, Digit Group, Digit Grouping 
Symbol, and Negative Number Format information will be added to the new user. All of 
these fields can be changed while editing the user.

Activating or Deactivating Users
An administrator can activate or deactivate existing users from the user details page. Users 
can be granted role-based activation and deactivation access. A deactivated user cannot 
log in to the Conga Platform Administration portal.

To activate or deactivate a user
Log in to the Conga Platform as an admin user.

Click the App Launcher ( ) icon from the top-left corner and go to Admin Console > 
Users. 
A list of users is displayed.
Click the More ( ) icon next to the user name and select Activate or Deactivate.

Next Step: Configuring DataSync Infrastructure

The Conga IDP user receives a Welcome email that includes the username, the 
first-time login password, and organization information. The user can 
generate a new password using the default first-time login password.


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Configuring DataSync Infrastructure
After completing the external integration (Salesforce or Salesforce Sandbox) and adding 
admin users, the next step is to synchronize data from the source system to the Conga 
Platform. Before synchronizing, you must connect the source and target systems. This 
section describes the required configurations.

To configure data sync infrastructure
Log in to the Conga Platform as an admin user. A Conga Platform welcome page is 
displayed.
Click the Admin Console tile. A platform administration page is displayed.
Click DataSync.
Click the More ( ) icon on the Data Sync UI, and then click Settings. The Settings page 
is displayed. By default, the Salesforce Settings tab is selected.
In the Salesforce Settings tab, enter the values in the following fields:

Field Description

Userna 
me

Enter your Salesforce account username.

Passwo 
rd

Enter your Salesforce account password. When you enter the password, dots 
replace the characters for security reasons. To see or hide the characters, click 
the eye icon.

Token 
URL

Enter the token URL. You may use either a Preview or production instance URL to 
access the OAuth2 token service.

Preview URL: https://test.salesforce.com/services/oauth2/token
Production URL: https://login.salesforce.com/services/oauth2/token
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Field Description

Secret Enter the security token in this field. When you enter the security token, dots 
replace the characters for security reasons. To see or hide the characters, click 
the eye icon.

To get the secret, reset the security token associated with the Salesforce account. 
After the security token is reset, the new security token is sent to the email 
address specified in the Salesforce personal settings. For step-by-step 
instructions, see Reset Your Security Token.

If you are unable to see the option to reset your security token, see 
Troubleshooting.

Client 
ID

Enter the consumer key generated after creating the connected app.

Client 
Secret

Enter the consumer secret generated after creating the connected app. When you 
enter the client secret, dots replace the characters for security reasons. To see or 
hide the characters, click the eye icon.

For more information on creating a connected app and getting the client ID and 
secret, see Create a Connected App.

Domain 
URL

Enter the domain URL for the Salesforce portal. We recommend using the classic 
URL format that ends with ".salesforce.com."

For example, use https://<domainname>.develop.my.salesforce.com/ URL instead 
of  https://<domainname>.lightning.force.com/ URL.

Salesfor 
ce API 
Version

It is advisable to mention the latest API version. For more details on getting the 
API version information, see Find Salesforce Edition and API version.

Click Save.
Click the Platform Settings tab.
Enter the values in the following fields:

The system does not currently support URLs in Lightning Mode format, 
which end with ".lightning.force.com".


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Field Description

Client 
ID

Client 
Secret

Enter the client ID and client secret generated after creating the API-to-API 
connection.

When you enter the client secret, dots replace the characters for security reasons. 
To see or hide the characters, click the eye icon.

For more information on creating the API-to-API connection and getting the client 
ID and secret, see To Configure API to API Connection.

Token 
URL

Enter the region-specific Conga Platform token URL.

For example:

Preview Environment:

NA: https://login-rlspreview.congacloud.com/api/v1/auth/connect/token

EU: https://login-preview.congacloud.eu/api/v1/auth/connect/token

AU: https://login-preview.congacloud.au/api/v1/auth/connect/token

Production Environment: 

NA: https://login-rls.congacloud.com/api/v1/auth/connect/token

EU: https://login.congacloud.eu/api/v1/auth/connect/token

AU: https://login.congacloud.au/api/v1/auth/connect/token

Click Save.
Click the Custom Settings tab. A list of Flows and Settings are displayed.
Click all CPQ-related flows and settings.

 

Next Step: Running DataSync

Running DataSync
After you onboard your tenant, all the CPQ and CRM OOB objects in Salesforce are 
automatically mapped to the Conga Platform. Once the configurations on both Salesforce 
and Conga Platform are completed, sync the master data objects like Products, 
Categories, Pricelists, Accounts, Opportunities etc to the RLP object database using the 
Data Sync tool.
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To run data sync manually
Log in to the Conga Platform as an admin user. A Conga Platform welcome page is 
displayed.
Click the Admin Console tile. A platform Administration page is displayed.
Click DataSync. The Mapped Objects for Data Sync page appears.  

Click Sync Now. The Sync Now window appears.

Field Description

Sync Type Select the synchronization method that suits your 
needs:

Full: Resyncs all records, including previously 
synced ones.
Incremental: Syncs only new records or those 
not on the Conga Platform yet.

Sync Attribute Data Enable this toggle to sync attribute data (which may 
include fields, metadata, or additional information) 
associated with the object.

Click OK. The data sync process begins, and you are redirected to the Run History tab.
Click Run History to view sync details and any associated errors. 
 

Conga recommends enabling one master object at a time and then performing 
a data sync. 



Select Full if you are running data sync for the 
first time for the selected objects. 



The system displays a validation alert if the entered Salesforce and Platform 
Settings information is invalid. 



To perform a datasync for order line items in bulk, ensure that the feature flag 
 platform-enable-datachange-stream-notifications is enabled for your org. If not, 
reach out to the Conga support team to enable the flag for your org. 


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Use Case: Running DataSync for the Product Object
Log in to the Conga Platform as an admin user. A Conga Platform welcome page is 
displayed.
Click the Admin Console tile. A platform administration page is displayed.
Click DataSync. The Mapped Objects for Data Sync page appears. 
On the Data Sync user interface, click the More ( ) icon > click Disable All. A 
confirmation pop-up is displayed. Click Yes.
Turn on the Is Enabled? option next to the Product object.
Click Sync Now. The Sync Now window appears.

Field Description

Sync Type Select the synchronization method that suits your 
needs:

Full: Resyncs all records, including previously 
synced ones.
Incremental: Syncs only new records or those 
not on the Conga Platform yet.

Sync Attribute Data Enable this toggle to sync attribute data (which may 
include fields, metadata, or additional information) 
associated with the object.

 

Click OK. The data sync process begins and you are redirected to the Run History tab, 
where you can view sync details and any associated errors.
You can verify the sync status by clicking on the pipeline ID in the run history tab. If 
the data sync fails, click the Errors button to download the error report.
Follow the same procedure for other required master objects. 

A successful data sync for all master objects indicates your Salesforce organization is 
connected to the Conga Platform.

Select Full if you are running data sync for the 
first time on the product object. Otherwise, 
select Incremental.



The system displays a validation alert if the entered Salesforce and Platform 
Settings information is invalid. 


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Next Step: Configuring Revenue Admin Settings

Configuring Revenue Admin Settings
After running the data sync on all CPQ and CRM master objects, perform the following 
configurations on the CPQ on Conga Platform to load appropriate pages for various 
sections, such as Catalog, Configuration, Cart, and Asset.

The following are the minimum required configurations to create quotes using Conga RLS. 
You can also make additional configurations to the following settings based on your 
business requirements.

Configuring Revenue Admin Application Settings
Configuring Flow Settings

Configuring Revenue Admin Application Settings

Configuring General Settings
Log in to the Conga Platform as an admin user.

Click the App Launcher ( ) icon from the top-left corner and go to Revenue Apps. A 
Proposals page is displayed.
In the left navigation pane, click the Revenue Admin Icon.
Under ADMIN SETUP, go to Application Settings > Global Settings > General.
Enter the following details. 

Setting Description

System Global

Keep Abandoned 
Carts

Turn this setting ON to indicate whether abandoned carts must be 
kept. 

Bypass Shopping Cart Turn this setting ON to bypass the shopping cart. CPQ displays 
the Update Price and Finalize buttons and hides the Go To 
Pricing button on the configuration page.

Field Precision
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Setting Description

Percentage Field 
Precision

Enter a number to specify decimal places for percentage precision. 
For example, number 5.

Currency Field 
Precision

Enter a number to specify decimal places for currency precision. 
For example, number 5.

Quantity Field 
Precision

Enter a number to specify decimal places for quantity precision. 
For example, number 5.

Term Field Precision Enter a number to specify decimal places for selling term precision. 
For example, number 5.

Finalization and Approvals

Auto Finalize On Cart 
Approval

Turn this setting ON. This indicates whether the cart is auto- 
finalized. CPQ automatically finalizes the cart when approved 
and ready for finalization. 

Auto Sync On Cart 
Approval

Turn this setting ON. This indicates whether the cart is auto- 
synchronized. CPQ automatically synchronizes the cart when 
approved and ready for finalization.

Click Save.

Configuring Catalog Settings
Log in to the Conga Platform as an admin user.

Click the App Launcher ( ) icon from the top-left corner and go to Revenue Apps.  A 
Proposals page is displayed.
In the left navigation pane, click the Revenue Admin icon.
Under ADMIN SETUP, go to Application Settings > Global Settings > Catalog.
Enter the following details and click Save. 

Setting  Description

Display Settings 
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Setting  Description

Enable Location Turn this setting ON. This enables users to select a 
location for a cart. Line items will have the current cart 
location assigned to them.

Disable Add Another Turn this setting OFF. Turning this setting on prevents the 
user from adding multiple instances of the same product.

Hide Configure Action Turn this setting OFF. Turning this setting on hides the 
Configure action for a product on the catalog page.

Listed Products Column 2 Select Product Description from the dropdown.

Listed Products Column 3 Select Product Family from the dropdown.

Hide Single Top Category Turn this setting ON. This hides the top category. This is 
useful only when you have a single root category and 
want a cleaner look for its child categories, without the 
root category.

Enable Category Filter Turn this setting ON. This enables Narrow Your Search 
category filtering during product search. It filters the 
categories based on search results and displays them in 
the Narrow Your Search area. For example, if the search 
result has products from only two categories, the Narrow 
Your Search section displays only those two categories.

Hide Product Image Turn this setting OFF. Turning this setting on hides the 
product image from the catalog page.

Configuring Config Settings
Log in to the Conga Platform as an admin user.

Click the App Launcher ( ) icon from the top-left corner and go to Revenue Apps. A 
Proposals page is displayed.
In the left navigation pane, click the Revenue Admin Icon.
Under ADMIN SETUP, go to Application Settings > Global Settings > Config.
Enter the following details and click Save.
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Setting Description

Display Settings

Hide Price Column Turn this setting ON to disable the price column from the options page. By 
default, this setting is turned off.

Listed Options 
Column 2

Enter the API name of the product field to be displayed in the Listed Options 
section.

Listed Options 
Column 3

Enter the API name of the product field to be displayed in the Listed 
Option section.

Show Option 
Quantity

Turn this setting ON to display the quantity in the body of the options pages.

Disable Add To 
Cart for Option 
Products

Turn this setting ON  to hide the Add To Cart and Configure buttons for an 
option product on the catalog page. 
This is helpful to prevent your sales representative from selling an option 
product without its bundle product.

Show Tab View Turn this setting ON to display option groups in a tab view instead of sections 
on the options page.

Bundle 
Description Field

Enter the field names from the product object to be displayed as bundle 
description.

Enable Option 
Page Search

Turn this setting ON to allow option search on the bundle configuration page.

Collapse All Leaf 
Option Groups

Turn this setting ON. This option defines whether the child option groups inside 
a bundle are expanded or collapsed by default. 

Miscellaneous

Enable Field 
Expressions

Turn this setting ON to enable field expressions.
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Configuring Cart Settings
Log in to the Conga Platform as an admin user.

Click the App Launcher ( ) icon from the top-left corner and go to Revenue Apps. A 
Proposals page is displayed.
In the left navigation pane, click the Revenue Admin Icon.
Under ADMIN SETUP, go to Application Settings > Global Settings > Cart.
Enter the following details and click Save.

Settings Description

Display Settings

Enable Auto Sequencing For 
Options

Turn this setting ON to enable auto-sequencing for options. If you 
do not turn this setting on, the sequencing of option line items on 
the cart will be based on the user selection sequence rather than 
the bundle options sequence.

Show Recommended Products 
Cart View

Turn this setting ON to display the recommended products 
component in the Cart Detail View page. 

Product Display Max Length Enter the maximum number of characters to be displayed for the 
product name on the cart page. If the product name exceeds the 
maximum length, CPQ displays an ellipsis or wraps the product 
name. The default value is 21. 

Show Attributes In Cart Turn this setting ON to display the specified attributes applicable 
to the line items in the cart. Attributes appear in the product 
dialog.

Expand Bundles In Cart Turn this setting ON to expand all attributes and options of a 
bundle product in the cart.

Hide Copy Action Turn this setting ON to hide the copy action in the cart view.

Group By Fields Enter the API names of those line item fields that are of the type: 
Lookup, Formula Fields, and Text. These line item fields are 
displayed under the Group By drop-down on the cart page.

Hide Grand Total Turn this setting ON  to hide the grand total line on the cart page.
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Hide Subtotals In Cart Turn this setting ON to hide subtotals in the cart view.

View Cart Total Custom 
Fields

Enter the list of custom fields from the summary group object to 
be displayed in the custom view cart page. Each field API name 
must be separated by a comma or a new line.

Disable Cart Activity History Turn this setting ON to disable the generation of activity history in 
product configuration. If you turn this setting on, CPQ does not 
add entries to the Activity History-related list when you create, 
finalize, or reconfigure a product configuration.

Disable Cart Async 
Notification

Turn this setting ON to disable the email notifications you receive 
after completion of any async operation such as cart finalization 
and pricing in every type of quote or agreement.

Enable Contextual Totals Turn this setting ON to display the subtotals and totals section 
at the bottom of the cart page.

Grid Render Threshold Enter the number of rows to load when the cart grid renders. This 
setting improves the grid scroll performance, with a default value 
of 20. You must adjust the value based on the number of lines 
displayed on the cart.

Hide Cart Views Turn this setting ON to hide cart views on the cart.

Hide Cart Views Creation Turn this setting ON to hide cart view creation. 

Column Render Threshold Enter the number of columns to load when the cart grid renders. 
This setting improves to improve the grid horizontal scroll 
performance, with a default value of 10. Must be adjusted to a 
higher value based on the number of columns displayed in a cart.

Enable Paginated Grid Turn this setting ON to enable pagination for the cart grid.

Field Set Settings  

Line Item Fields to Revalidate 
Invalid Price List Items

Select the line item fields to be used to revalidate invalid price list 
items. This field set controls a list of display fields in the 
revalidation pop-up for price list item changes.
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Settings Description

Line Item Fields to Revalidate 
Product Structures

Select the line item fields to be used to revalidate product 
structures. This field set controls the list of display fields in the 
revalidation pop-up for product structure changes.

Advanced Settings

Enable Optional Items Turn this setting ON to enable optional items in the cart.

Max Allowed Lines For Mass 
Actions

Enter the maximum number of line items (supported by the 
product) to be allowed for performing mass actions on the cart 
page.

Run Validation Callback On 
Add

Turn this setting ON to invoke the Validation Callback when 
adding a product.

Save On All Actions Turn this setting ON to save the configuration when you perform 
any action on the cart page.

Mini Cart Settings

Hide Selected Products 
Column1

Turn this setting ON to hide the column that displays the product 
name.

Selected Products Column2 Enter the API name of the line item field to be displayed in the 
selected products section.

Example value: ProductId__r.ProductCode

Selected Products Column3 Enter the API name of the line item field to be displayed in the 
selected products section.

Example value: ProductId__r.ProductCode

Selected Products Column4 Enter the API name of the line item field to be displayed in the 
selected products section.

Example value: ProductId__r.ProductCode

 

Next Step: Flow Settings
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1.

2.

3.

•
•

1.

2.

3.
4.
5.

Configuring Flow Settings
When you launch the flow settings, the Flow Settings page is displayed. All the existing 
flows are listed on this page with their details. There are various functionalities available 
for you to manage the flows.

Navigating the flow settings
Log in to the Conga Platform as a revenue admin user.

Click the App Launcher ( ) icon from the top-left corner and go to Revenue Apps. A 
Products page is displayed.
Go to ADMIN SETUP > Application Settings > Flow Settings. A list of flows is displayed.

 

Cart Page Settings
Catalog Page Settings

Cart Page Settings
You can configure system flows to make specific actions available on the cart page.

To configure the flow settings
Log in to the Conga Platform as a revenue admin user.

Click the App Launcher ( ) icon from the top-left corner and go to Revenue Apps. A 
Products page is displayed.
Go to ADMIN SETUP > Application Settings > Flow Settings. A list of flows is displayed.
Click System. A Flow Settings page is displayed. By default, a Cart Page is selected.
In the Action Settings tab, enter the following minimum settings required to load the 
cart page.

Start with the Cart Page Settings topic and follow the steps.

The following are the minimum required settings (display actions, column settings, 
etc.) that you must configure to make them available on the cart page.



• Click Add New or the add icon (  to add an action (custom button). )
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7.

•
•
•
•
•
•
•
•
•

8.

Action Action Label 
Name

Display As Action 
Area

Is Enabled Always 
Display

GenerateDocu 
ment

GenerateDocu 
ment

Action Center Yes Yes

EditPriceAgree 
ment

EditPriceAgree 
ment

Action Center Yes Yes

Finalize Finalize Action Center Yes Yes

Abandon Abandon Action Center Yes  Yes

Save Save Action Center Yes Yes

QuickSave QuickSave Action Center Yes Yes

Click Save.
Click the Column Settings tab. The following column settings are displayed.

Cart Line Item
Total Columns
Price Ramp
Usage Price Tier
Tiered Price
Related Price
Adjustment Line Item
Mass Update
Agreement Price Rule

In the Cart Line Item settings, enter the following and click Save.

Field Name Style Style Class Is Editable

BasePrice text-align:right aptCurrency Yes

Quantity text-align:right aptQuantity Yes

•

•

Click the delete icon (  to delete an action. The delete icon is visible 
only for custom actions added by you.
Drag the display actions using the icon   next to a display type to 
rearrange the cart action sequence for the cart page.

)
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9.

10.

11.

Field Name Style Style Class Is Editable

SellingTerm text-align:right; 

width:60px;

aptQuantity Yes

NetPrice text-align:right aptCurrency Yes

StartDate text-align:right Leave blank Yes

EndDate text-align:right Leave blank Yes

ExtendedPrice text-align:right aptCurrency Yes

In the Total Columns settings, enter the following and click Save.

Field Name Style Class Is Editable

AdjustmentType aptAdjustmentType Yes

AdjustmentAmount aptAdjustmentAmount Yes

In the Price Ramp, enter the following and click Save.

Field Name Is Editable

Quantity Yes

Selling Term Yes

SellingFrequency Yes

ExtendedPrice Yes

AdjustmentTyoe Yes

AdjustmentAmount Yes

StartDate Yes

EndDate Yes

In the Usage Price Tier, enter the following and click Save.
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12.

13.

14.

Field Name Is Editable

TierStartValue Yes

TierEndValue Yes

UsageRate Yes

FlatPrice Yes

IsIncluded Yes

In the Tiered Price, enter the following and click Save.

Field Name Is Editable

Sequence Yes

TierStartValue Yes

TierEndValue Yes

In the Related Price, enter the following and click Save.

Field Name Is Editable

Related ChargeType Yes

In the Adjustment Line Item settings, enter the following and click Save.

Field Name Is Editable

Type Yes

AdjustmentAppliesTo Yes

AdjustmentType Yes

AdjustmentAmount Yes

BenefitQuantity Yes

RunningTotalAdjustedPrice Yes
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15.

16.

1.

2.

3.
4.
5.
6.

In the Mass Update settings, enter the following and click Save.

Field Name Is Editable

Quantity Yes

AdjustmentType Yes

AdjustmentAmount Yes

StartDate Yes

EndDate Yes

In the Agreement Price Rule settings, enter the following and click Save.

Field Name Is Editable

Sequence Yes

Next Step: Catalog Page Settings

Catalog Page Settings
You can configure action settings for flows to be available on the catalog page.

To configure catalog page settings
Log in to the Conga Platform as a revenue admin user.

Click the App Launcher ( ) icon in the top-left corner and go to Revenue Apps. A 
Products page is displayed.
Go to ADMIN SETUP > Application Settings > Flow Settings. A list of flows is displayed.
Click System. A Flow Settings page is displayed.
Click Catalog Page.
Enter the following in the Action Settings page. These are the minimum settings 
required to load the catalog page.
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Action Action Label 
Name

Display As Action 
Area

Is Enabled Always 
Display

InstalledProdu 
cts

InstalledProdu 
cts

Action Right Yes Yes

CompareProdu 
cts

CompareProdu 
cts

Action Center Yes Yes

GoToPricing GoToPricing Action Center Yes Yes

UpdatePrice UpdatePrice Action Center Yes  Yes

Finalize Finalize Action Center Yes Yes

CloseCart CloseCart Action Center Yes Yes

Abandon Abandon Action Center Yes Yes

Save Save Action Center Yes Yes

QuickSave QuickSave Action Right Yes Yes

Click Save.

Now, you can test the quote creation process in the Revenue lifecycle solution (RLS) flow. 

Next Step: Creating a Quote from the Proposal

Creating a Quote from the Proposal
After configuring the required settings on the Conga Platform, you can test and verify the 
quote creation flow using the RLS flow. To achieve this, you must log in to the onboarded 
Salesforce org to create a new quote or proposal.

Prerequisites

You have associated the products with the price list you are using for a new quote. 
For more information, see Associating Price Lists with a Product.
All required products associated with the price list you are using for new quotes are 
activated and published. For more information, see Configuring the Products.
The account you are using for a new quote has been synced with the Conga 
Platform. 
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2.

3.
4.

5.

6.

7.

8.

9.

10.
11.
12.
13.

14.

Document generation is configured for a quote in the Salesforce org. For more 
information, see Configuring Document Generation for Quote.

You can use the Conga CPQ on the Salesforce interface to enter the necessary information 
and prepare a quote/proposal request or draft. To complete the quote/proposal, you must 
enter details relevant to the proposal. Some of the fields, identified with either a red 
vertical line or asterricks, are required to save the proposal record. If the required details 
are not entered or incorrect details are entered, the system displays validation rule errors 
at the top of the page, highlighted in red.

To create a quote or proposal
Log in to Salesforce.

Click the App Launcher ( ) icon from the top-left corner and enter Conga CPQ , and 
select Conga CPQ.
Go to the Proposals tab and click New. 
Enter the proposal and opportunity names in the Propoosal Name and Opportunity 
fields.
Enter an account and price list information in the Account and Price List fields. 
The price list determines the categories and products you see in the configuration. The 
account is auto-populated if the proposal is created from an opportunity.
Click Save. Navigate to the new quote you just created and proceed with product 
selection.
Click the Configure Products button you created for RLS flow, raising the catalog 
page.
Select the products from the catalog page. By default, you do not see products on the 
catalog page if you have not configured the catalog page with the price list selected 
for your proposal. Hence, place the cursor in the Find Products search box and click 
Enter on your keyboard. A list of products associated with the selected price list is 
displayed.
Add required products to the cart. Some of the products may require configuration. 
Click the Configure button to complete the product configuration.
Click the Mini-cart ( ) icon to view the summary of added products.
In the mini-cart, click View Cart to launch the cart in grid view.
Click Finalize to create a new proposal and open the proposal and quote details.
In the Actions section, click Send Proposal to open the doc gen page where you can 
view the generated proposal and such other options as adding supported documents. 
Click Email to display a Send Email pop-up window.
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15.

16.
17.

18.
19.

•
•
•

•

•
•
•
•
•
•

Enter To and select Email folder, Email Template. The Subject text box is 
automatically generated.
Click the Mark Proposal as "Presented" checkbox and click Merge Fields.
Click Send. The acceptor will receive an email with the proposal details to verify. 
After the quote/proposal has been presented to the trading partner either manually 
or via email, the Accept button is enabled. Selecting Accept signifies that the trading 
partner has accepted the quote.
In the Actions section, click Accept. The Approval Stage changes to Accepted.
Do one of the following:

To create an agreement, click Create Agreement.
To create an agreement with line items, click Create Agreement with Line Items.
To synchronize the quote with an opportunity, click Synchronize with 
Opportunity.

Synchronizing Quote/Proposal With Opportunities: Synchronization 
ensures that both the quote/proposal and opportunity accurately reflect 
the current state of the quote. A best practice for sales pipeline reports 
and forecasts in Salesforce is to display the amount of revenue and the 
products or services that are forecasted to be sold.

The contracting process begins with the creation of an agreement. 

Revenue Admin User Interface
Accessing the CPQ Admin Home Page on Conga Platform
Configuring Application Settings
Managing the Views
Product Administration
Pricing Administration
Diagnostics

Accessing the CPQ Admin Home Page on Conga 
Platform
The Conga Revenue Lifecycle Platform offers a streamlined login process by leveraging an 
external Identity Provider (IDP). This IDP integration is established through the widely 
adopted OAuth 2.0 protocol, facilitating seamless communication between the application 
and the external identity provider. Additionally, you have the option to sign in using a SAML 
username.
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1.

This approach eliminates the need to create new login credentials specifically for the 
Conga Platform application. Instead, you can utilize your existing credentials from trusted 
third-party identity providers or your SAML username for Signin.

 

Prerequisites

Your Salesforce org must be onboarded on the Conga Revenue Lifecycle Platform. Contact 
your Conga Representative for the onboarding.

To Sign-in to the Conga Revenue Lifecycle Platform
Open the Conga Revenue Lifecycle Platform URL in the web browser. For example, 
https://<org Instance URL>.congacloud.io/cadmin.  
It will redirect you to the Conga Platform login screen. 

You can log in to the same organization with different user credentials using two 
separate tabs in a single browser window.


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2.
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4.

•
•
•

•

Select the Identity Provider option from the list to sign in using IDP credentials or enter 
your username to use SAML to log in.

Click Sign In or Continue depending upon the Sign In method you have selected. 
You are redirected to the respective Identity Provider or Single Sign-On login screen.
Enter your username and password and click Log In. 
If you forgot your password, follow the selected Identity Provider or Single Sign-On 
process to reset your password. 

 

Configuring Application Settings
This section provides information on configuring application settings.

Configuring Global Settings
Configuring Storefront Settings
Configuring Flow Settings to Override Global Settings

Configuring Global Settings
Global Settings are default CPQ settings that are applicable to every user. If you need to 
change the CPQ behavior for certain flows or use cases, you can override the settings at a 
flow level.

Catalog Settings

•
•
•
•
•

Conga Platform supports the following identity providers:
Microsoft
Salesforce
Salesforce Sandbox
Dropbox
Conga IDP





Configure Price Quote (CPQ)

158 Copyright ©2024 Conga Corporation. All rights reserved.

•
•
•
•
•
•
•
•

1.
2.

Config Settings
Cart Settings
Pricing Settings
Favorite Settings
General Settings
Object Summary View Settings
Lookup Fields
Asset Settings

Catalog Settings
Go to ADMIN SETUP > Application Settings > Global Settings > Catalog.
Enter the following details and click Save.

Setting  Description

Display Settings 

Enable 
Location

Turn this setting on to enable users to select a location for a cart. The line items will 
have the current cart location assigned to them.

Disable 
Add 
Another

Turn this setting on to disable the user from adding multiple instances of the same 
product.

Hide 
Configure 
Action

Turn this setting on to hide the Configure action for a product on the catalog page.

Listed 
Products 
Column 2

Select the product field name to be displayed in the listed products section.

Listed 
Products 
Column 3

Select the product field name to be displayed in the listed products section.

Hide Single 
Top 
Category

Turn this setting on to hide the top category. This setting is useful only when you 
have a single root category and want to have a cleaner look for all of its child 
categories, without the root category.
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Setting  Description

Enable 
Category 
Filter

Turn this setting on to enable Narrow Your Search category filtering during product 
search. It filters the categories based on search results and displays them in the 
Narrow Your Search area. For example, if the search result has products from only 
two categories, the Narrow Your Search section displays only those two categories.

Hide 
Product 
Image

Turn this setting on to hide the product image from the catalog page.

Config Settings
Go to ADMIN SETUP > Application Settings > Global Settings > Config.
Enter the following details and click Save.

Setting Description

Display Settings

Hide Price Column Turn this setting on to disable the price column from the options page. By 
default, this setting is turned off.

Listed Options 
Column 2

Enter the API name of the product field to be displayed in the listed options 
section.

Listed Options 
Column 3

Enter the API name of the product field to be displayed in the listed options 
section.

Show Option 
Quantity

Turn this setting on to display the quantity in the body of the options pages.

Disable Add To 
Cart for Option 
Products

Turn this setting on to hide the Add To Cart and Configure buttons for an 
option product on the catalog page. 
This is helpful to prevent your sales representative from selling an option 
product without its bundle product.

Show Tab View Turn this setting on to display option groups in a tab view instead of sections 
on the options page.

Bundle 
Description Field

Enter the field names from the product object to be displayed as bundle 
description.
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Setting Description

Enable Option 
Page Search

Turn this setting on to allow option search on the bundle configuration page.

Collapse All Leaf 
Option Groups

To define whether the child option groups inside a bundle are expanded or 
collapsed by default. Turn this setting to save the option group collapse or 
expanded info in config.

Horizontal 
Attribute Group 
View

To display as many attribute groups as possible in a single line in the bundle 
and Option before moving to the next line. By default, the value for this 
setting is false.

Miscellaneous

Enable Field 
Expressions

Turn this setting on to enable field expressions.

Cart Settings
Go to ADMIN SETUP > Application Settings > Global Settings > Cart.
Enter the following details and click Save.

Settings Description

Display Settings

Enable Auto Sequencing For 
Options

Turn this setting on to enable auto sequencing for options. If you 
do not turn this setting on, the sequencing of option line items on 
the cart will be based on the user selection sequence rather than 
the bundle options sequence.

Show Recommended Products 
Cart View

Turn this setting on to display the recommended products 
component in the Cart Detail View page. 

Product Display Max Length Enter the maximum number of characters to be displayed for the 
product name on the cart page. If the product name exceeds the 
maximum length, CPQ will display the ellipsis or wrap the product 
name. The default value is 21. 



Configure Price Quote (CPQ)

161 Copyright ©2024 Conga Corporation. All rights reserved.

Settings Description

Show Attributes In Cart Turn this setting on to display the specified attributes applicable 
to the line items in the cart. Attributes appear in the product 
dialog.

Expand Bundles In Cart Turn this setting on to expand all attributes and options of a 
bundle product in the cart.

Hide Copy Action Turn this setting on to hide the copy action in the cart view.

Group By Fields Enter the API names of those line item fields that are of the type: 
Lookup, Formula Fields, and Text. These line item fields are 
displayed under the Group By drop-down on the cart page.

Hide Grand Total Turn this setting on to hide the grand total line on the cart page.

Hide Subtotals In Cart Turn this setting on to hide subtotals in the cart view.

View Cart Total Custom 
Fields

Enter the list of custom fields from the summary group object to 
be displayed in the custom view cart page. Each field API name 
must be separated by a comma or a new line.

Enable Contextual Totals Turn this setting on to display the subtotals and totals section at 
the bottom of the cart page.

Grid Render Threshold Enter the number of rows to load when the cart grid renders. This 
setting improves the grid scroll performance, with a default value 
of 20. You must adjust the value based on the number of lines to 
be displayed on the cart.

Hide Cart Views Turn this setting on to hide cart views on the cart.

Hide Cart Views Creation Turn this setting on to hide cart views creation. 

Column Render Threshold Enter the number of columns to load when the cart grid renders. 
This setting improves to improve the grid horizontal scroll 
performance, with a default value of 10. Must be adjusted to a 
higher value based on the number of columns displayed in a cart.

Enable Paginated Grid Turn this setting on to enable pagination for the cart grid.
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Settings Description

Field Set Settings  

Line Item Fields to Revalidate 
Invalid Price List Items

Select the line item fields to be used to revalidate invalid price list 
items. This field set controls list of display fields in the 
revalidation pop-up for price list item changes.

Line Item Fields to Revalidate 
Product Structures

Select the line item fields to be used to revalidate product 
structures. This field set controls list of display fields in 
revalidation pop-up for product structure changes.

Advanced Settings

Enable Optional Items Turn this setting on to enable optional items in the cart.

Max Allowed Lines For Mass 
Actions

Enter the maximum number of line items (supported by the 
product) to be allowed for performing mass actions on the cart 
page.

Run Validation Callback On 
Add

Turn this setting on to invoke the Validation Callback when 
adding a product.

Save On All Actions Turn this setting on to save the configuration when you perform 
any action on the cart page.

Mini Cart Settings

Hide Selected Products 
Column1

Turn this setting on to hide the column that displays the product 
name.

Selected Products Column2 Enter the API name of the line item field to be displayed in the 
selected products section.

Example value: ProductId__r.ProductCode

Selected Products Column3 Enter the API name of the line item field to be displayed in the 
selected products section.

Example value: ProductId__r.ProductCode
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Settings Description

Selected Products Column4 Enter the API name of the line item field to be displayed in the 
selected products section.

Example value: ProductId__r.ProductCode

Pricing Settings
Go to ADMIN SETUP > Application Settings > Global Settings > Pricing.
Enter the following details and click Save.

Setting Description

Global Pricing

Custom Pricing Fields Enter the custom field API name from the line item object to be 
displayed on the cart page. To add more than one field name, 
separate the names by a new line or a comma.
When you makes any changes to these custom fields, CPQ is set to 
reprice before clicking Review and Finalize.

Hide Dates For One Time 
Charge

Turn this setting on to hide the dates for price list items of type One 
Time charge.

Hide Evergreen End Date Turn this setting on to hide the end date for Evergreen proposals.

Totaling and Sub Totaling

Totaling Group Type Select the default value for the summary group type picklist. 
Supported values are: 

Category: When you add a product to the cart from the lowest 
leaf category where it is associated, the Category Hierarchy 
column in the Line Items related list is populated with its bread- 
crumb trail. This is useful to identify the exact category from 
where the product was added, in case if the product is 
associated with multiple categories
Product
Ad Hoc

The default value is Category. For Product-based totaling, 
the Product Totaling Hierarchy setting is required.
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Setting Description

Disable Charge Type 
Totaling

Turn this setting on to disable the totaling of charge types.

Adhoc/Product Totaling 
Hierarchy

Enter the list of product fields that represent the product totaling 
hierarchy. Each product field API name must be separated by a 
new line. This is applicable only when product based totaling is in 
effect. 

For Ad-hoc totaling, enter the line item fields that represent a 
totaling group. If this field is blank, the Bundle Family will be used 
by default.

Matrix and Ruleset

Auto Refresh Usage Tier Turn this setting on to enable modifiable usage tiers to 
automatically re-calculate tier price upon PLI change.

Enable Matrix Pricing For 
Options

Turn this setting on to enable matrix pricing for options. This may 
be used to optimize performance when options do not use price 
matrices in the organization. The default value is false (disabled).

Precision

Enable Base Price Rounding Turn this setting on to enable CPQ to round list price and base 
price fields in the line item using the currency field precision setting.
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Setting Description

Enable Custom Rounding Turn this setting on to enable rounding of selling term and price in 
each price calculation step.

Rounding of Selling Term: This setting considers the precision of 
selling term defined in the Term Field Precision setting and 
rounds the selling term consistently both on the UI and in 
backend calculation.
Rounding of Pricing: This setting rounds the price in each price 
calculation step considering the precision defined for each 
currency, both on the UI and in backend calculations. The 
amount in price calculation steps (for list price, base price, 
adjusted price, and net price only after each step such as price 
matrix, price ruleset, line level manual adjustment, group 
adjustment) is calculated considering the precision of the 
currency.

Rounding Mode Select the currency rounding mode in pricing calculations. This 
setting rounds adjustments before calculating the base price. 
Supported values are:

UP: Rounds the currency to the next number. For example, 21.2 is 
rounded to 22.
DOWN: Rounds the currency to the previous number. For 
example, 21.8 is rounded to 21.
HALF_UP: Rounds the currency to the next number if the decimal 
is equal to or greater than 5. For example, 21.5 to 21.9 is rounded 
to 22.
HALF_DOWN: Rounds the currency to the previous number if the 
decimal is equal to or smaller than 5. For example, 21.1 to 21.5 is 
rounded to 21.
HALF_EVEN: Rounds the currency to the nearest even number. 
For example, 23.5 is rounded to 24 and 22.5 is rounded to 22.

Adjustment 

Max Adjustment Lines Enter the maximum number of adjustment lines allowed for a line 
item.

Price rounding at backend occurs only for the base price, 
adjusted price, and net price when this setting is enabled.


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Setting Description

Enable Adjustment Spread Turn this setting on to enable the adjustment on a bundle to 
spread to its options.

Enable Base Price 
Adjustment

Turn this setting on to enable unit level price adjustment for the 
Base Price of the product in the cart.

Advance Pricing

Product Option Price Order Enter the order of execution of option pricing (with adjustments) in 
conjunction with the price rule set and matrices. Supported values 
are:

First: CPQ applies the adjustments before the price rulesets and 
after price matrices.
Last: CPQ applies the adjustments after the price rulesets. This 
is the default value.

Related Price Scope Enter a value to perform the related pricing calculations over the 
entire cart or confine the calculations to a bundle product only. For 
example, if the price of an option product is a percentage of 
another option product in the same bundle, consider the following 
scenarios with Related Price Scope = Cart and Bundle:

Cart: The pption price is based on the price of all the instances 
of the related product in the cart, whether it is in the same 
bundle or a standalone, or in another Bundle.
Bundle: The option price is based on the related product 
instances within the same bundle.
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Setting Description

Selling Term Calculation 
Method

Indicates the method to calculate the selling term for line items on 
the cart page.

Supported values are:

Calendar: The selling term is calculated based on the calendar. 
This is the default method.
Billing Preference: The selling term is calculated based on the 
billing preferences. You can price transactions based on the 
term calculated according to the user’s preferred start day 
instead of it always being the first of the month. 
When the Conga Billing package is installed, you must set 
the Selling Term Calculation Method setting to Billing 
Preference. CPQ then calculates the selling term based on the 
billing preferences.

Enable Price Matrix Audit 
Trail

Turn this setting on enable CPQ to create audit trail entries when 
adjustments are applied on the Line Item through Price Matrices. 
The audit trail entries are created on the Adjustment Line Item 
object.

Enable Price Rule Audit Trail Turn this setting on enable CPQ to create audit trail entries when 
promotions are applied on the Line Item through Price Rules. The 
audit trails entries are created on the Adjustment Line Item object.

Favorite Settings
Go to ADMIN SETUP > Application Settings > Global Settings > Favorite.
Enter the following details and click Save.

Setting Description

Disable Favorites Turn this setting on to disable the Favorites category on the 
catalog, Save As My Fav button on the cart and any UI elements 
related to Favorite Configurations on catalog, configuration and 
cart pages. By default, this setting is turned off.
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Setting Description

Listed Favorite 
Configuration Column1

Select the favorite configuration field to be display on the catalog 
page for your favorite configuration records. You can enter a 
maximum of one API name. If you have a requirement of displaying 
one more field, use the Listed Favorite Configurations Column 2 
setting.

Listed Favorite 
Configuration Column2

Select the favorite configuration field to be displayed on the 
catalog page for your favorite configuration records. You can enter 
a maximum of one API name.

Favorite Filter Fields Select the fields from the favorite configuration object to be used as 
filters on the catalog page.

Favorites Display Label Enter a label for favorites. This label is displayed as a category 
name on the catalog page. If this field is blank, CPQ defaults the 
label to "Favorites".

Show Favorite as First 
Category

Turn this setting on to display your favorites category as the first 
category displayed in the default catalog view.

Favorite Category Image Upload an image for your group of favorite configuration category. 
This image is displayed under your favorite category (as entered in 
Favorites Display Label) on the catalog page.

General Settings
Go to ADMIN SETUP > Application Settings > Global Settings > General.
Enter the following details and click Save.

Setting Description

System Global

Keep Abandoned Carts Turn this setting on to indicate whether abandoned carts must be 
kept.
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Setting Description

Bypass Shopping Cart Turn this setting on to bypass the shopping cart. CPQ displays 
the Update Price and Finalize buttons and hides the Go To 
Pricing button on the configuration page.

Line Items Per Page Enter the number of line items to be displayed on the Cart page 
and Installed Products page. The default value for this field is 10. 

Field Precision

Percentage Field Precision Enter a number to specify decimal places for percentage 
precision.

Currency Field Precision Enter a number to specify decimal places for currency precision.

Quantity Field Precision Enter a number to specify decimal places for quantity precision.

Term Field Precision Enter a number to specify decimal places for selling term 
precision.

Finalization and Approvals

Auto Finalize On Cart 
Approval

Turn this setting on to indicate whether the cart is auto finalized. 
CPQ automatically finalizes the cart when approved and ready 
for finalization.

Auto Sync On Cart Approval Turn this setting on to indicate whether the cart is auto 
synchronized. CPQ automatically synchronizes the cart when 
approved and ready for finalization.

Object Summary View Settings
You must configure object summary view settings to display the summary information for 
the proposal (cart header), product, and account.

If there is no Object Summary Setting configured, only the name will be displayed by 
default when you open the Proposal, Product, and Account summary pop-up.

Go to ADMIN SETUP > Application Settings > Global Settings > Object Summary 
View. The Object Summary View page is displayed.
Configure the following details and click Save.
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For Proposal Summary

Field Name Description

Name Enter the name as "Proposal Summary".

Object Name Select the object name as "Proposal".

Display Fields Select proposal field names. You can select any field from 
the proposal.

When you click the proposal name on the catalog page, you will see proposal summary 
with the fields configured in Proposal Summary.

For Product Summary

Field Name Description

Name Enter the name as "Product Summary".

Object Name Select the object name as "Product". 

Display Fields Select product field names. You can select any field from 
the product.

When you click the product name on the catalog page, you will see product summary page 
with the fields configured in Product Summary.

For Account Summary

Field Name Description

Name Enter the name as "Account Summary".

Object Name Select the object name as "Account". 

Display Fields Select account field names. You can select any field from 
the account.
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When you click the account name on the catalog page, you will see account summary 
page with the fields configured in Account Summary.

Lookup Fields
Lookup field settings provide an ability to filter lookup records through filter criteria based 
on the immediate parent on which the lookup field is defined.

Managing Lookup Fields
When you launch the Lookup Fields page on the UI, all the existing lookup fields are listed 
on this page along with their details. There are various functionalities available for you to 
manage the lookup fields.

Lookup Fields Search

You can narrow down the lookup fields list using the search feature. You can either define 
search criteria to search for a range of lookup fields or use the lookup fields search option.

Basic Search

In basic search, you can search for a lookup field using keywords. For example, you can 
search using the name of the lookup field. 

In the Search this list field, enter a keyword related to your lookup field details such 
as lookup field name.
Click the search icon   or press Enter. CPQ returns all lookup fields that contain 
that keyword in the lookup field details.

Advanced Search

In advanced search, you can search for a lookup field using a search query.

Click the Advanced Search icon  . The Advanced Search pop-up is displayed.
Enter the following details: 

Field: All lookup field are available in the drop-down list such as Text, 
Checkbox, Date, Date/Time, Number, Percent, Picklist, Multi-Select Picklist, 
Currency.
Operator: Operators that are available for selection helps create the filter 
expression. Operators are displayed based on the field types. For example, a 
picklist value will display equal to and not equal operators and a text field will 
display equal to, not equal to, starts with, contain, does not contain operators. 
If it is a multi-value picklist, the application displays include and does not 
include operators.
Value: Enter a value.

Click Add Criteria if you want add more criteria in the advanced search.
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Turn the Logic button on if you have more than one criteria and enter a value in 
the Logic field.
Click Apply to enable the search filter. CPQ returns all lookup fields that match the 
criteria.

Sorting lookup fields

You can sort the lookup fields by clicking the column names. The lookup fields are sorted in 
descending order using the last modified date. Every time you click the column name, the 
sorting switches between ascending and descending order. You can adjust the column 
width by dragging the columns. Hover near the column boundaries till two-way arrow 
appears. Click when the arrow appears and drag left or right to adjust the column width.

Actions available on this page

Click Create New to create a lookup field.

Click the ellipsis icon   next to the lookup field name to edit or delete a lookup field.
Click the lookup field name link to open the lookup field details page.

Items per page

At the bottom of the page, you can see the total count of lookup fields available. You can 
control the number of lookup fields to be displayed on each page. You can select the 
number of lookup fields from a predefined list. You cannot configure this list. By default, you 
see 20 records on each page.

By default, you can sort 10, 20, 30, 50, and 100 lookup fields per page using the Rows per 
page drop-down. This feature works in association with the search and filter functions to 
display search records per page. You can use the < and > buttons to move to the next or the 
previous pages. You can also jump to a certain page using the page search component.

Creating a Lookup Field
You can create multiple duplicate lookup settings for the same Object-Field 
combination. When you retrieve lookup records, any of these settings might be used 
randomly, resulting in lookup records to vary.
The acceptance criteria specify a maximum limit of 1000 records. So, you can retrieve 
up to 1000 records regardless of the total record count for that entity. 
Use only supported operators in filter criteria when creating LookupFieldSettings. The 
supported operators are ==, !=, and OR.

To create a lookup field
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Go to ADMIN SETUP > Application Settings > Global Settings > Lookup Fields.
Click Create New.
Enter the following details:

Field Description

Name Enter a name for the lookup field.

Object Name Select the name of the object where the lookup field exists. 
The supported value is a Line Item.

Lookup Field Name Select the name for the lookup field. This is the name of the 
lookup field on the Line Item object.

Lookup Display Columns Select the names of columns to be displayed on the lookup 
pop-up. You can select multiple columns.

Filter Criteria Enter a formula to filter lookup values. The formula must be 
a valid expression to further filter down the search results for 
a lookup.

Click the f(x) button to view the filter criteria pop- 
up.
Enter a filter criteria and click Add. The supported 
operators are :-, ==, !=, OR.

Lookup Record Limit Enter the maximum number of records to query for the lookup 
field drop-down. By default, the value 200 is entered and you 
can specify up to 1000.

Enable Quick View Turn this setting on to enable CPQ to populate the values in 
lookup fields on the cart page. If you disable the setting, the 
sales representative must search the values. CPQ 
performance is optimized if you disable this setting as the 
lookup values are retrieved on the cart page only when the 
sales representative clicks the search icon. Conga 
recommends disabling the setting for lookup fields with a 
large number of lookup records and also only enabling the 
setting for a maximum of two lookup fields on the cart.

Click Save.

To edit a lookup field

Go to ADMIN SETUP > Application Settings > Global Settings > Lookup Fields. The 
Lookup Fields page is displayed.



Configure Price Quote (CPQ)

174 Copyright ©2024 Conga Corporation. All rights reserved.

2.

3.
4.

1.

2.

3.

1.
2.

•
•
•
•
•

Click the ellipsis icon   next to the lookup field name and click Edit. The lookup field 
details page is displayed.
Edit the required fields.
Click Confirm.

To delete a lookup field

Go to ADMIN SETUP > Application Settings > Global Settings > Lookup Fields. The 
Lookup Fields page is displayed.

Click the ellipsis icon   next to the lookup field name and click Delete. The Delete 
Lookup Field Setting pop-up is displayed.
Click Confirm.

Asset Settings
Go to ADMIN SETUP > Application Settings > Global Settings > Asset.
Enter the following details and click Save:

Setting  Description

General Setting 

Default Asset 
Pricing 
Indicator

Turning on this setting Indicates whether asset pricing is enabled by default for 
asset-related line items.

Hide Assets 
Action

Select one or more actions to be hidden on the installed products page. Selected 
actions will be hidden from the users. All the actions are displayed if the value is 
empty. Select from:

Cancel
Relate
Swap
Renew
Terminate
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Setting  Description

Submenu 
Action

Select one or multiple actions to be displayed in the asset action submenu 
dropdown. Select from:

Change Merge
Change Split
Change Configuration
Relate Component
Change Quantity

Asset Source Indicates the account source which the asset line items will be retrieved from. 
Select from:

Bill To
Ship To
Sold To

Show Assets Decide which assets to display from the current, parent, or child assets of the 
current asset's account. Use a comma-separated string of Parents and Children. 
If empty, only assets related to the context account are shown.

Filter Fields Enter the Asset Line Fields to be displayed on the filter. Supported values are text 
fields and End Date.

Show Account 
Filters

Turn on this setting to display the accounts filter on the installed products page.

Hide Co-term Turn on this setting to hide the co-term end date on the renew.

Apply Adj To 
Current 
Contract 
Term

Turn on this setting to keep the discounting limited to the current contract term.

Enable 
Default 
Quantity For 
ABO Item

Turn on this setting to enable the default quantity for the ABO item.

Enable Price 
Rule for 
Assets

Turn on this setting to enable the price rule adjustments to the assets.
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Setting  Description

Asset Restore 
Fields

Select the fields to be restored during Amend and Renew operations, with the 
system restoring original asset values for these fields and defaulting Start and 
End dates from assets.

Renewal

Base Price 
Defaulting 
Method For 
Renewal

Indicates how the base price should be defaulted when the asset is renewed. The 
supported Values are: Net Unit Price (default if not specified) Higher Of Contract 
Unit Price / Net Unit Price Lower Of Contract Unit Price / Net Unit Price.

Default 
Renewal Term

When the value is provided use this value as the renewal term for Renewing 
products. The number signifies months to renew as the end date.

Renew One 
Ramp

Turn on this setting to renew only one ramp line item based on the new term in 
order of renewal term in the asset line item, default renewal term in installed 
product setting and selling term in the asset line item.

Renewal 
Business 
Object Type

Select the quote or agreement object used in renewal product configuration. 
Select from: 

Proposal (Default)
Agreement

Renewal 
Execution 
Mode

Select the mode of Renewal Quote/Agreement generation. Select from:

Auto (Default)
On Demand

Renewal 
Group Fields

Select one or multiple asset line item fields to group for Renewal quote/ 
agreement. 

Renewal Lead 
Time

Enter the renewal lead time in number of days to satisfy On-demand renewal 
Quote/agreement generation. This is assets expiration days from system date.

Amend

Enable One 
Time Change

Turn on this setting to allow users to make changes to one timeline item.
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Setting  Description

Bypass Must 
Configure

Turn on this setting to allow to selection of multiple assets for Amend operation 
including must required bundle asset.

End Date 
Preferences 
For Co-term

Select the end date preferences for the Co-term. the supported values are use 
Custom Date, Use Proposal EndDate, and Retain Current Asset End Date.

Change-Split 
Asset Actions

Specify the actions that can be performed on a split asset. The supported values 
are Amend, Renew, and Swap.

Purchase 
Identification 
Criteria

Identify the fields that determine the eligibility for co-term and the cumulation of 
the quantity. A list of comma-separated asset line item fields that determine the 
eligibility for co-term and quantity cumulation.

Merge Action 
Criteria Fields

List of asset line item fields separated by comma to enable merge asset action.

Termination

Same Day 
Cancellation

Turn on this setting to check out the Same Day Cancellation option will provide 
behaviour where cancellation will be done on the same day, unchecking it will 
mean Cancellation will be using cancel day + 1 behaviour.

Editable 
Fields For 
Cancelled 
Lines

A comma-separated list of editable asset line item fields for cancelled lines.

Configuring Storefront Settings
You can configure storefronts. 

Navigating the Storefront Settings Page
When you launch the storefront settings, the Storefront Settings page is displayed. All the 
existing settings are listed on this page with their details. There are various functionalities 
available for you to manage the storefront settings.
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Storefront Setting Search
Search for the storefront to narrow down the storefront list using the Search this list box. 
Enter a keyword related to your storefront details such as storefront name. Search this list 
box returns all the storefronts that contain that keyword in the storefront details.

Actions available on this page
Click Create New to create a new storefront.

Click the ellipsis icon   to edit or delete an existing storefront.
Click the storefront name link to open the storefront details page.
Export the selected storefront settings. For more information, see Exporting Records.

Items per page
At the bottom of the page, you can see the total count of storefront settings available. You 
can control the number of storefront settings to be displayed on each page. You can select 
the number of storefront settings from a predefined list. You cannot configure this list. By 
default, you see 20 records on each page.

By default, you can sort 10, 20, 30, 50, and 100 storefront settings per page using the Rows 
per page drop-down. This feature works in association with the search and filter functions 
to display search records per page. You can use the < and > buttons to move to the next or 
the previous pages. You can also jump to a certain page using the page search component.

Creating Storefront Settings

To create a Storefront setting
Go to ADMIN SETUP > Application Settings > Storefront Settings. The Storefront 
Settings page is displayed.
Click the Create New button. The Add new storefront popup is displayed.
Enter the following details:

Field Description

Storefront Name Enter a name for the Storefront.

Channel Type Select the the type of channel.
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Field Description

Default Account Enter the account used for guest users or if user is not 
associated to an account.

Default Pricelist Select the price list. The storefront will show catalog 
based on this unless the cart or the account has a 
different price list.

Guest User ID Enter the account associated with guest users on this 
storefront.

Default Flow Select the flow houses settings for enabling features like 
system and testflow in the storefront.

Click Create. A storefront setting is created.

 

 

To delete a Storefront Setting
Go to ADMIN SETUP > Application Settings > Storefront Settings
The Storefront Settings page is displayed.
Search for the storefront setting you want to delete.

Click the ellipsis icon   next to the storefront setting name and click Delete. The 
Remove Storefront page is displayed.
Click Confirm.

 

To edit a Storefront Setting
Go to ADMIN SETUP > Application Settings > Storefront Settings
The Storefront Settings page is displayed.
Search for the storefront setting you want to delete.

Help

There is a Help info button which, when clicked, directs users to the relevant 
documentation.


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Click the ellipsis icon   next to the storefront setting name and click Edit. The 
selected storefront setting page is displayed.

Click the delete icon   to remove the feature. 
Click Remove All to remove all features.
Make changes to these fields if required:

Field Description

Default Locale The storefront will use this locale if user doesn't have 
locale or they are guest user.

Storefront Name Enter the name of the storefront.

Default Price List Select the price list. The storefront will show catalog 
based on this unless the cart or the account has a 
different price list.

Channel Type Select the the type of channel.

Default Flow Select the flow houses settings for enabling features 
like system and testflow in the storefront.

Default Account Enter the account used for guest users or if user is not 
associated to an account.

Guest User ID Enter the account associated with guest users on this 
storefront.

Click Save.

Deleting Storefront Settings
You can delete storefront settings that are no longer required for your business 
requirements. 

To delete a storefront setting
Go to ADMIN SETUP > Application Setting > Storefront Setting. The storefront 
settings page is displayed.
Search for the storefront setting and do one of the following: 



Configure Price Quote (CPQ)

181 Copyright ©2024 Conga Corporation. All rights reserved.

•

•

•

3.

•

•
•

•

To delete a single storefront setting, click the ellipsis icon (  next to the rollup 
name, and click Delete.
To delete multiple storefront settings, click the checkboxes next to the name 

column, and click the ( ) icon.
To delete all the storefront settings, click the checkbox in the header row next to 

the name column, and click the ( ) icon.
Click Confirm.

Configuring Flow Settings to Override Global Settings
You can configure flows to override global settings. Flow settings are required so that 
appropriate pages are loaded for various sections (such as Catalog, Configuration, Cart, 
and Asset).

Navigating the Flow Settings Page
When you launch the flow settings, the Flow Settings page is displayed. All the existing 
flows are listed on this page with their details. There are various functionalities available 
for you to manage the flows.

Flow Search
Search for the flow to narrow down the flow list using the Search this list box. Enter a 
keyword related to your flow details such as flow name. Search this list box returns all the 
flows that contain that keyword in the flow details.

Actions available on this page
Click Create New to create a new flow.

Click the ellipsis icon  to edit or delete an existing flow.
Click the flow name link to open the flow details page where you can define override 
settings.
Export the selected flow settings. For more information, see Exporting Records.

Items per page
At the bottom of the page, you can see the total count of flows available. You can control 
the number of flows to be displayed on each page. You can select the number of flows from 
a predefined list. You cannot configure this list. By default, you see 20 records on each page.

)
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By default, you can sort 10, 20, 30, 50, and 100 flows per page using the Rows per 
page drop-down. This feature works in association with the search and filter functions to 
display search records per page. You can use the < and > buttons to move to the next or the 
previous pages. You can also jump to a certain page using the page search component.

Configuring Action Settings
You can configure display action setting for various flows for:

the cart page so that the respective action is available on the cart page
the config page so that the respective action is available on the bundle and attribute 
page
the catalog page so that respective action is available on the catalog page

To configure action settings
Go to ADMIN SETUP > Application Settings > Flow Settings.
Click the required flow name link. The Flow Settings page is displayed.
Under FLOW SETTINGS, click one of the following options:

Cart Page: To configure actions on the cart page.
Catalog Page: To configure actions on the catalog page.
Config Page: To configure actions on the config page.
Asset Page: To configure actions on the asset page.
Price Waterfall Page: To configure actions on the price waterfall page.

Click the Action Settings tab, enter the following details:

Field Description

Action  Select this to set the action as an action button. You 
cannot edit it. 

For custom action addition, this field is defaulted with 
“CustomAction”+Sequence#. For example, 
CustomAction16. 
This column is freezed as the first column.

Action Label Name It is populated based on the action you selected.

This field is editable only for custom actions added by 
you. You can enter a text for label.
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Field Description

Display As Select an option for how the action must be displayed. It 
defines whether an action must be displayed as Action or 
Task.

Supported values are:

Action
Task
Action and Task
Sidebar Action
Nav Link
Help

Action Area Select a position of the action. Supported values are:

Center
Left
Right
More

Action Class Style Enter a class style name for the action. For example,

apt-selected-btn
apt-left-btn
apt-right-btn

Action Page This field is editable only for custom actions added by 
you. For custom actions, custom Visualforce pages can be 
invoked for respective actions with Action Params.

Action Param This field is editable only for custom actions added by 
you. For a few actions, parameter value can be passed 
such as Express Quote.

Behaviour  This field is editable only for custom actions added by 
you. Select a behavior where to open the page. Supported 
values are:

Dialog Window
New Window
Self
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Field Description

Action Type This field is editable only for custom actions added by 
you. Supported values are:

Quick Redirect
Save
Quick Save
Generate
Submit For Approvals

Is Enabled Turn this setting on to enable the action. It is applicable 
for all actions.

Always Display Turn this setting on to enable permanent display of the 
action regardless of the Action Type setting. It is 
applicable for all actions.

Click Add New or the add icon  to add an action (custom button).
Click the delete icon  to delete an action.

Drag the display actions using the icon  next to a display type to rearrange the cart 
action sequence for the cart page.
Enter an action name in the Search this list box and press enter to search an action.
Click Discard Changes to discard the changes you made to this page.
Click Save.

Configuring Column Settings
You can configure display column setting for various flows for different display types such 
as Cart Total Line Item and Price Ramp.

Go to ADMIN SETUP > Application Settings > Flow Settings.
Click the required flow name link. The Flow Settings page is displayed.
Under FLOW SETTINGS, click one of the following options:

Cart Page: To configure columns on the cart page.
Catalog Page: To configure columns on the catalog page.
Config Page: To configure columns on the config page.
Asset Page: To configure columns on the asset page.
Price Waterfall: To configure columns on price waterfall.

The delete icon is visible only for custom actions added by you.
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Click the required display type. Supported display types are:
For Cart Page

Display Type Purpose

Cart Line Item You can configure the list of fields to display on 
the Cart Line Item.

Total Columns You can configure a list of fields to display on the 
Cart Summary Group.

Price Ramp  You can configure a list of fields to display on the 
Price Ramp pop-up on the cart.

Usage Price Tier You can configure a list of fields to display on the 
Usage Price Tier pop-up on the cart.

Tiered Price You can configure a list of fields to display on the 
Tiered Price pop-up on the cart.

Related Price You can configure a list of fields to display on the 
Related Price pop-up on the cart.

Adjustment Line Item You can configure a list of fields to display on the 
Adjustment Line Item pop-up on the cart.

Mass Update You can configure a list of fields to display on the 
Mass Update pop-up on the cart.

Agreement Price Rule You can configure a list of fields to display on the 
Agreement Price Rule on the cart.

For Asset Page

Display Type Purpose

Asset Line Item You can configure list of fields to display on the 
Asset Line Item.

Asset Termination You can configure list of fields to display on the 
Termination intermediate page.

For Price Waterfall 
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Display Type Purpose

Waterfall Elements You can configure list of fields to display on the 
Waterfall Elements.

Enter the following details:

Field Description

Field Name Select a field from the respective entity.

Style Enter a value. 

For example, text-align:right, text-align:left, and 
width:60px

Style Class Enter a value. 

For example, aptCurrency, aptQuantity, and 
aptAdjustmentType

Header Style Enter a value. 

For example, width:200px

Is Editable Turn this setting on to make the field name column 
editable.

Click Add New or the add icon ( ) to add a column.
Click the Delete icon ( ) to delete a column.
Enter a field name in the Search this list box and press enter to search a field.

•

•
•
•
•
•
•

For Asset Termination section, you will have the following fields in the picklist.
Termination Date (default field, user should not be able to delete this 
field)
Billed Through Date
Total Billing
Invoiced
Pending billing
Estimated Credit
fields from “Editable fields for Cancelled lines”. For more information on 
this, see Asset Settings.


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Drag the display columns using the icon ( ) next to a display type to rearrange the 
cart action sequence for the cart page.
Click Discard Changes to discard the changes you made to this page.
Click Save.

Configuring the Flows
This section provides information on configuring flows.

Creating a flow
Go to ADMIN SETUP > Application Settings > Flow Settings.
Click Create New. The New Flow pop-up is displayed.
Enter the following details:

Flow Name: Enter a name for the flow.
Description: Enter a description for the flow. 

Click Create.

A flow is created and saved.

Editing a flow
Go to ADMIN SETUP > Application Settings > Flow Settings.
Search for the flow you want to edit.

Click the ellipsis icon  next to the flow name and click Edit. The Edit Flow pop-up is 
displayed.
Edit the description and click Save.

Deleting a flow
Go to ADMIN SETUP > Application Settings > Flow Settings.
Search for the flow you want to delete.

Click the ellipsis icon  next to the flow name and click Delete. The Remove Flow 
Setting pop-up is displayed.
Click Confirm.

Managing Views
You can configure views for various flows to define the list of columns available for various 
views for various users, roles, and profiles.

Go to ADMIN SETUP > Application Settings > Flow Settings.



Configure Price Quote (CPQ)

188 Copyright ©2024 Conga Corporation. All rights reserved.

2.
3.

•
•
•
•
•
•

4.
5.

1.
2.
3.
4.

Click the required flow name link. The Flow Settings page is displayed.
Under FLOW SETTINGS, click one of the following options and complete the settings:

Cart Page: To configure the actions on the cart page.
Catalog Page: To configure the actions on the Catalog page.
Config Page: To configure config page views on the cart page.
Asset Page: To configure Asset Views on the asset page.
Override Settings: To configure Cart Views on the cart page.
Price Waterfall: To configure Cart Views on the cart page.

Click Discard Changes to discard the changes you made to this page.
Click Save.

Overriding Global Settings at a Flow Level
You can override the global settings (settings defined at system level) at a flow level so 
that you can define a specific CPQ behavior at the flow level.

Go to ADMIN SETUP > Application Settings > Flow Settings.
Search for the flow in which you want to define override settings.
Click the flow name link. The flow details page is displayed.
Enter the following details for override settings:

Setting Description

Hide asset actions Enter comma-separated values of Increment, Amend, Renew, and 
Cancel actions. Listed actions will be hidden from the users. You 
can configure asset actions at each asset line item.

Service line split criteria Enter comma-separated values of asset line item which define the 
split criteria for asset-related line items.

This setting only supports API names of the fields created on the 
Related Line Item object only. These fields can be formula fields 
and can fetch their values from asset line item and product 
through formula expressions.

CSS override Enter the name of the static resource to override CSS in the 
catalog, attributes, options, and cart pages.

Listed products column 2 Enter the API name of the product field to be displayed in the 
listed options section.
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Setting Description

Listed products column 3 Enter the API name of the product field to be displayed in the 
listed options section.

Expand bundled items in 
cart.

Turn this setting on to expand all attributes and options of a 
bundle product in the cart.

Items per page Enter the number of browsed or searched products to show on the 
product selection page.

Selected products per page Enter the number of selected products that you want to display 
on the configuration pages. 

Option items per page Enter the number of displayed option products to show in the cart 
page. 

Catalog products per page Enter the number of catalog products that you want to display on 
the Catalog page. 

Managing the Views
The Conga Platform application allows you to save your filtered view of a record and set it 
as the default view, so there is no need to reselect the filters every time you open 
the grid (list) view. 

To save your personalized view
Log in to the Conga Platform as an admin user.
Go to the page containing the grid view you want to filter.

Valid values are: 5, 10, 15, 20, & 25

Valid values are 5, 10, 15, 20, and 25.

Valid values are 5, 10, 15, 20, and 25.

Valid values are: 10, 20, 50, and 100.
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Customize your view by applying filter criteria: 
Filtering Options: Use the available filtering options to set criteria for your 
view. This might involve selecting specific fields, setting conditions, and choosing 
values for those conditions. For more details, see Filtering Records in the Grid View.
Managing View Settings: Apply the view setting to control which columns to 
display in the grid view. For more details, see Managing the View Settings.
Rows per Page and Page Number: Specify the number of records to see per 
page using the Rows per Page option. Enter the page number in the designated 
box to set the default page when applying the view.
Sorting: Apply column sorting for better navigation.

Go to the dropdown menu next to the search bar and click Create New View. 
The Save View popup appears. 
 

 

 
Enter a name and description for your view.
You can save your view as either Private or Public: 

Private: Select this to restrict the search view to yourself only. It remains private 
and accessible only to you.
Public: Select this to permit others to access and use your search view. Your 
search view will be made public, allowing others to view and use the same 
search criteria.

Click Save to save your filtered view.
To access your saved view, click the dropdown menu to the left of the search bar.
Click the More ( ) icon for the view from the list and select Set as default.  
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The grid view updates and displays records based on the saved filter criteria. The system 
retains the applied filter, showing it in the grid view when you return after switching 
screens.

To edit a saved view
Click the More ( ) icon for the relevant view from the list and select Edit.
Make the necessary changes.
Click Update.

To delete a saved view
Click the More ( ) icon for the relevant view from the list and select Delete.
From the confirmation dialog, click Confirm.

Managing the View Settings
View Setting allows you to control which columns are displayed in the grid, freeze/pin a 
column range, rearrange the column order, and change the column width by resizing the 
necessary columns. You can then save your filtered view of a record and set it as the 
default view, so there is no need to reselect the filters and rearrange the column every time 
you open the Grid View (List View). For more information, see Managing the Views.
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To add or remove columns from the grid

Click the View Setting ( ) icon. A View Settings dialog box appears.
 

To remove a column from the grid, highlight it in the right section and click the minus- 

sign ( ) icon. 
To add a column to the grid, highlight it in the left section and click the plus-sign (
) icon. You can use the search box available above the section to search for a specific 
field.
To add or remove more than one column, use Ctrl-Click or Shift-Click to highlight the 
columns, then click Add/Remove Selected Fields (left and right arrows).
To add or remove all columns, click Insert/Remove All. 
At least one column must be displayed in the grid.
Click Apply to close the dialog and apply view settings to the grid. Or click Apply and 
Save to View to apply view settings and save them to the current view (if any).

To rearrange columns in the grid

Click the View Setting ( ) icon to open the View Settings dialog.
In the right section, click and drag a column name to move it before or after another 
column in the list. 
To move a column up or down one place in the order, hover your cursor over the 
column name and click the up or down arrow.
To change the position of more than one column, use Shift-Click to highlight the 
columns and click the up or down arrow to the right of the section to move the 
selected columns.
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Click Apply to close the dialog and apply view settings to the grid. Or click Apply and 
Save to View to apply view settings and save them to the current view (if any).

To freeze/pin columns
When four or more column items are added to the showing panel, you can enable 
the Freeze Column toggle. 

Click the View Setting ( ) icon to open the View Settings dialog. 
Enable the Freeze Column toggle. You can see two sliders (one at the top after the 
first column and the second at the last).
Click and drag the top and bottom sliders to define the range of visible columns to be 
pinned.
Click Apply to close the dialog and apply view settings to the grid.

To resize the column width
Navigate to the column for which you want to resize the width.
Click and drag the edge of the column.

You can resize columns, but not rows. Columns don't retain their sizes, so the next time you 
open the list page you will have to resize the column again.

Filtering Records in Grid View
You can filter the view of records in the grid by performing a keyword search, filtering the 
list by column value, or applying one or more advanced filters and filter logic. You can 
then save your filtered view of a record and set it as the default view, so there is no need to 
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reselect the filters every time you open the Grid View (List View). For more information, 
see Managing Views.

After applying a column filter, if the user tries to apply a keyword or advance search, the 
column filter criteria will not be retained, and the result will be displayed based on the 
keyword or advance search.

To filter records by keyword
Place your cursor in the search bar (at the top of the grid) and enter a keyword search 
term.
Click the Search icon or press Enter to filter the records by keyword.

The grid refreshes to show the filtered list—columns that have the keyword filter applied to 
them. You can use the Clear icon in the search field to remove the entire entered keyword at 
once.

To filter records using advanced search
Click the Advanced Search ( ) icon to open the filter dialog.
To specify the filter criteria, create simple or complex queries by entering values in the 
following fields:

Field Name Description

Field Select a field to be used in the filter criteria.

The application initially pulls the list of fields from the search 
settings, and if no fields are enabled for search for the object, 
it displays queryable fields from the database.

Operator Select an operator from the drop-down. The operator defines 
the relationship between the field and the value. The list of 
available operators varies depending on the data type of the 
chosen field.

Value Enter the value of the field. The type of value field depends on 
the field selected.

To add another filter criteria, click Add Criteria and repeat step 2. 
By default, two or more rows share an AND (Boolean operator) relationship.
To specify the filter logic between multiple rows, enable the Logic toggle.
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Specify your logic in the Filter Logic field. The supported filter logic operators 
are AND and OR. Use parentheses to set the order of operations. 
For example, if you have five rows, you can create a filter logic such as (((1 AND 3) OR 
(2 AND 4)) AND 5).
Click Apply to filter the list of records based on the criteria you defined.

If you have already used a column filter, the application will show a warning message on 
the filter popup. Applying an advanced search will remove the column filter. You can see 
the total number of applied filters next to the Advanced Search icon.

To filter records by column
Click or mouse hover on a column name and click the Filter by ( ) icon to display 
the drop-down controls.
Select an operator from the Select an option drop-down.
Enter or select the value to filter the records by the specified column value.
Click the Apply ( ) button. 
If you have already used an advanced search filter, the application will show a 
warning message on the column filter popup. Applying a column filter will remove any 
applied advanced search filters and the column level filter will be added to the 
advanced search. A red dot will appear next to the filter icon for any applied column 
filter. 
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Exporting Records
The export feature enables you to export multiple selected records at once. This enables 
you to select one or multiple records and export them in a CSV or Excel file format.

Follow these steps to use the mass actions export feature to export selected records:

Navigate to the list of records. 
Click the checkbox beside the "Feature Name" column. You can select one record, 
multiple records, or all the records in the list.

To export selected records, click the export icon ( ).
Choose the desired file format (CSV or Excel) for the export.

The selected records are exported and the file gets downloaded to your local storage.

Product Administration
This section provides information on managing products.

Managing the Products
Managing Catalog
Managing the Product Groups
Managing the Constraint Rules
Managing the Categories
Managing the Option Groups
Managing the Attributes and Attribute Groups
Managing Product Attribute Rules and Attribute Value Matrices
Managing Field Expressions
Managing the Feature Sets
Managing the Rollups

Managing the Products
Products are the primary component of your CPQ system. Using CPQ, you can create 
individual products and product bundles. Once you've created products, you can associate 
attributes and options with them. Options are the additional accessory products to sell 
together with a product. Attributes allow you to associate product specifications such as 
color, size, or model.
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You must associate the products with Categories to classify products into logical groups. 
You can define hierarchies in a category to further divide the products into smaller groups. 
On the Catalog page, CPQ displays the categories and hierarchy containing the products 
you associate with them.

Using feature sets, you can also configure CPQ to allow your users to compare the features 
of multiple products. By implementing feature sets, you allow your users to compare 
products and choose the product that best meets their requirements.

A Product in CPQ terminology is a product or service that can be set up to be sold on its 
own as a standalone product or option of other products. Products or services are set up as 
standalone, bundles, or options of other products. You can associate a product with a 
category or a price list. If you created an option product, you must first associate it with an 
option group.

Standalone - This is an individual product that can be sold on its own.
Bundle - Any product that has other products (options or bundles) associated with it.
Options - This is a product that can be sold with a bundle product only through an 
option group.

Navigating the Product Administation Page
When you launch the CPQ Revenue Admin UI, the Products page is displayed. All the existing 
products are listed on this page along with their details. There are various functionalities 
available for you to manage the products.

Managing Views
You can manage column width, control which columns are displayed in the grid, freeze/pin 
a column range, or rearrange the column order. You can also filter the view of records in the 
grid by performing a keyword search, filtering the list by column value, or applying one or 
more advanced filters and filter logic. For more information, see Managing the View 
Settings and Filtering the Records.

Actions available on this page
Click Add New to create a new product.

Click the ellipsis icon ( ) next to the product name to edit, clone or Bundle Map an 
existing product.
Click the product name link to open the Product Details page.
Use the Activate switch to activate or deactivate a product.
Export the selected products. For more information, see Exporting Records.
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This section provides information on managing products.

Creating a Product
Editing a Product
Cloning a Product
Adding an Image to a Product
Publishing the Product
Associating Price Lists with a Product
Creating Rules for a Product
Associating Categories with a Product
Associating Product Groups with a Product
Associating Attribute Groups with a Product
Associating Option Groups with a Product
Associating Feature Sets with a Product
Deleting a Product

Creating a Product
You can create one or multiple products as required.

To create a product
Go to ADMIN SETUP > Product Administration > Products. A list of products is 
displayed.
Click Create New. The New Product pop-up is displayed.
Select Create New Product and click Next.
Select the type of product you want to create:

Standalone: This is an individual product that can be sold on its own.
Bundle: Any product that has other products (options or bundles) associated 
with it.
Options: This is a product that can be sold with a bundle product only through 
an option group. If you create an option product, you must first associate it with 
an option group.

Click Next. 
Enter the following product information, as required.

  

Product 
Name 

Enter a name for the product. This field is mandatory.
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Product 
Description

Enter a description of the product. This description is displayed when the 
user clicks the product name on the catalog page.

Product 
Code

Enter a product code. The Product Code can be an internal code or a 
product number to identify the product within the org.

Product 
Family

Select a product family to categorize the products.

Product Type Select a type of product. For example, Equipment, Service, and so on.

Uom Select a unit of measurement.

Configuratio 
n Type

Select a configuration type for the product. Supported values are:

Standalone
Bundle
Option

External Key Enter an external key.

Effective 
Date 

Select the date from which the product is in effect. 

Effective date is not required as long as the product is active, but can be 
used for promotional rules, and more.

Expiration 
Date 

Select the date until which the product is in effect.

Configurable Turn this setting on to enable the user to configure a product to add options 
or attributes or both. The Configure button is the only option available on 
the Catalog page. When you turn this setting on, you must also turn on 
either Has Options, Has Attributes, or both.

If this setting is turned off, the user can add the product to the cart directly 
or configure the product with attributes or options, or both.

Has 
Attributes

Turn this setting on to enable indicate that the product has attributes 
associated to it. During the quote creation process, the user can enter 
values for those attributes.
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Has Options Turn this setting on to enable indicate a product as a bundle that has 
options. You can associate options and option groups to the bundle.

This field is available only for bundle products.

Active Turn this setting on to make the product active. If this setting is turned off, 
the product is not displayed on the catalog page.

Click Save.

A product is created and saved.

You will be navigated to the Product Details page. 

You can either activate or clone the product. 

Editing a Product
You can also edit any product as required. This feature enables you to make the necessary 
changes to the product configuration when the requirement changes. 

To edit a product
Go to ADMIN SETUP > Product Administration > Products. 
Search for the product you want to edit.

Click the ellipsis icon   next to the product name and click Edit. The Product Details 
page is displayed.
Edit the required fields.
Click Save.

Cloning a Product
You can clone any product when you want to replicate the same product configurations for 
your new product.

To clone a product
Go to ADMIN SETUP > Product Administration > Products. A list of products is 
displayed.
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Click the ellipsis icon   next to the product name and click Clone. The Product 
Details page is displayed.
Enter the following.

Product to Clone
New Product Name
External ID
Click the Clone Entire Product checkbox to add the following product details 
from the product you are cloning.

Category Details
Pricing, Attributes
Product Groups
Options
Rules (Constraint Rules) or select the individual from the above to be 
added to the cloned product.

Click Save. 

Adding an Image to a Product
You can add a reference image to the product while configuring the product. 

To add an image to a product
Go to ADMIN SETUP > Product Administration > Products. 
Search for the product you want to add a picture.

Click the product name and click Edit on the details page or click the ellipsis icon 
 next to the product name and click Edit. The Product Details page is displayed.
Drag any image from your local storage to the image profile box or click 
the Upload button and double-click the image from your local storage that you want 
to upload.
Click Save.
You can click the preview button on the image to get a full view of the image.
You can delete the picture by hovering over the picture and clicking Delete in Edit 
mode. Click Save.

Publishing the Product

To publish a product
Go to ADMIN SETUP > Product Administration > Products. 
Search for the product you want to edit.
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Click the Product Name and you will be navigated to the Product Details page.

If the product is activated, click the ellipsis icon   next to the Deactivate button and 
click Publish. 
You will get a prompt for successful publishing of the product.

Associating Price Lists with a Product
You can associate more than one price list with a product. When the sales representative 
selects the quote with the price list, CPQ displays all products that are associated with 
that price list are displayed on the catalog page.

Refer to the follwoing topics for more information.

Associate a Price List with a Product
Removing Associated Price Lists with a Product

Associate a Price List with a Product

To associate a price list with a product

Go to Admin Setup > Product Administration > Products > Click on a Product name.
On the Product Details page, click the setup icon ( ) in the Price List Items section to 
open the Associated Price List Items page. you can see all price lists available in the 
org under Available Price Lists. 
In the Search Price Lists field, enter keywords to search the price list you want to 
associate with the product and click the search icon ( ) or press Enter or  
Hover the mouse on the required price list and click + next to the price list name. The 
price list is associated with the product and is displayed in the Price List Items section 
(left-hand side). 
Create a New Price List:

If the desired price list does not exist, click Create New Price List under the 
Available Price Lists page.
The New Price List page will be displayed.
Follow the steps in Creating a Price List to configure the new price list.
After configuring and saving the new price list, return to the Associated Price 
Lists page.
Search for the newly created price list as described in step 3 and associate it 
with the product.

Enter the following details for the price list item:
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From the Charge Type drop-down, select the required charge type for the 
product. Supported values are:

Standard Price
License Fee
Subscription Fee
Implementation Fee
Installation Fee
Adjustment
Service Fee
Rental Price
Sales Price
Usage Fee
Consulting Fee

In the List Price field, enter a list price for the product. 
From the Price Type drop-down, select the price type. Supported values are:

One Time
Recurring
Usage

From the Frequency drop-down, select the frequency for the product. Supported 
values are:

Hourly
Daily
Monthly
Quarterly
Half Yearly 
Yearly 
Weekly

From the Price Method drop-down, select the price method for the product. 
Supported values are:

Per Unit
Flat Price
Percentage
Related Price
Tiered Price

Turn on the Active setting to activate the price list.

Click the ellipsis icon  next to a price list name and click Add Charge Type. A new 
charge type is added for the selected product. Multiple charge types for the same 
price list are together.

Click the ellipsis icon  next to a product name and click Charge Type Criteria. For 
more information, see Adding Charge Type Criteria to a Product.
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Click Save.

The price list is associated with the product.

Removing Associated Price Lists with a Product
You can remove the price lists that are associated with a product when the product is no 
longer a part of that price list or the requirements change.

To remove the association of a price list with a product

Go to ADMIN SETUP > Product Administration > Products. The Products page is 
displayed.
Click the required product name link to open the Products details page.
Click the setup icon  in the Price Lists section. The Price Lists page is displayed.
Click the Price List Items tab.
In the Price List Items section, search for the price list item you want to delete.

Click the ellipsis icon  next to a price list name and click Remove. 
If there are any unsaved changes, the Editing item(s) in Price List Items pop-up is 
displayed. Click Discard Changes. A pop-up is displayed prompting you to 
confirm deletion. Click Confirm.
If there are no unsaved changes, a pop-up is displayed prompting you to 
confirm deletion. Click Confirm.

Creating Rules for a Product
You can use Product Rules to regulate the selection of the products by the Sales rep on the 
Catalog page. When the Catalog exceeds a simple number of products, it can be difficult 
for the Sales rep to find their desired product based on the specific requirements of the 
company. Product Rules can guide the Sales rep to follow what is best and compliant for 
the company.

You can configure the following types of rules:

Constraint Rules: Configuration rules used to conditionally include, exclude, 
recommend, replace, or validate a product or set of products based on other products 
or set of products added to the cart.

Charge Type

If you click the charge symbol on PLI listings, it will display the charge-type criteria.


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Attribute-based Configuration: Helps you modify the product configuration on your cart 
based on the selection of product attributes using Product Attribute Rules and 
Attribute Value Matix.

This section describes the following topics.

Creating Constraint Rules for a Product
Associating Attribute Rules with a Product

Creating Constraint Rules for a Product
You can create more than one constraint rules for a product.

To create a constraint rule for a product

Go to Admin Setup> Product Administration > Products > Click on a Product name.
On the Product Details page, click the setup icon   in the Constraint Rule section. 
The Constraint Rules page is displayed.
Click Create New. The New Constraint Rule pop-up is displayed.
Enter the following details:

Field Description

Rule Name Enter a name for the constraint rule. It is populated based on 
the product name.

Rule Type Select a rule type. Supported values are:

Inclusion: Enforces selection of certain products as 
specified by the product scope specification or 
criteria specification in the inclusion rule.
Exclusion: Enforces exclusion of certain products 
from the shopping cart.
Validation: Displays the error message when the 
criteria conditions are fulfilled.
Recommendation: Product recommendations are 
displayed when the condition is fulfilled.
Replacement: Product replacements are suggested 
when the condition is fulfilled.

Condition Scope The condition scope for the constraint rule is auto-populated 
and you cannot change it as the field is disabled.

Condition Item The condition item for the constraint rule is auto-populated 
and you cannot change it as the field is disabled.
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Field Description

Match In Select an option where the condition match must happen. 
Supported values are:

MatchInOptions: Selecting this means the condition 
is fulfilled only when the condition products are in 
the option line items of the shopping cart.
MatchInPrimaryLines: Selecting this means the 
condition is fulfilled only when the condition 
products are among the primary lines (bundle or 
standalone) of the shopping cart.

Action Intent Select the intent of the action. Supported values are:

Auto Include: Adds selected products 
automatically. When the number of products 
selected by the rule action is more than the number 
mentioned in the Match Rule condition, auto- 
inclusion of products is not triggered. A message is 
displayed from the rule action instead.  
Note: Auto Include will not apply when the match 
rule value is Include All.
Prompt: Displays a message with choices of 
products that you can select or remove.
Show Message: Displays a message.
Check on Finalization: Applies rule action on 
finalization of the shopping cart. This action intent 
does not enable the recommendation rule.
Disable Selection: Disables selection of excluded 
products.
Hide: Hides the selection of excluded products.



Configure Price Quote (CPQ)

207 Copyright ©2024 Conga Corporation. All rights reserved.

•

•

•

•

5.
6.

7.
a.
b.

8.

Field Description

Action Scope Select the action scope. Supported values are:

Product: In the Product field, click to select a 
product to be included or excluded. You search the 
product using product name or code.
Product Family: In the Product Family field, enter a 
product family. One or more of the products from 
the product family will be included or excluded 
based on rule type and match rule specifications.
Product Group: In the Product Group field, enter a 
product group. One or more of the products from 
the product group will be included or excluded 
based on rule type and match rule specifications.
Action Criteria:

Action Item Enter a keyword to search the action item. From the 
displayed search result, select an action item.

Click Save. The constraint rules details page is displayed.
On the Details tab, enter the following details:

Field Description

Rule Name Enter a name for the constraint rule.

Description Description for the constraint rule.

Effective Date Select the date from which the constraint rule is in 
effect.

Expiration Date Select the date until which the constraint rule is valid.

Is Active Turn this setting on to indicate whether the constraint 
rule is active.

Is Bundle Context Turn this setting on to indicate whether the constraint 
is evaluated within a bundle.

On the Conditions & Actions tab:
Create a constraint rule condition.
Create a constraint rule action.

Click Save.
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A constraint rule for the product is created and saved.

Associating Attribute Rules with a Product
You can associate more than one attribute rule with a product.

To associate attribute rule with a product

Go to Admin Setup> Product Administration > Products > Click on a Product name.
On the Product Details page, click the setup icon  in the Attribute Rules section. The 
Attribute Rules page is displayed.
Click the Create New drop-down button:

Click Product Attribute Rule. You can create a PAR. For more information, see 
Creating a Product Attribute Rule.
Click Attribute Value Matrix. You can create an AVM. For more information, see 
Creating an Attribute Value Matrix.

On the Product Attribute Rules tab:
In the Search this list field, enter keywords to search the PAR associated with 
the product.
Use the Active switch to activate or deactivate a PAR.
Click the PAR name link to open the PAR details page.

Click the ellipsis icon   next to the PAR name and click Delete. The Delete 
Attribute Rule pop-up is displayed. Click Confirm.

On the Attribute Value Matrix tab:
In the Search this list field, enter keywords to search the AVM associated with 
the product.
Use the Active switch to activate or deactivate an AVM.
Click the AVM name link to open the AVM details page.

Click the ellipsis icon   next to the AVM name and click Delete. The Delete 
Attribute Matrix pop-up is displayed. Click Confirm.

Associating Categories with a Product
Categories are high-level logical groupings of products, affecting the way the Sales 
representatives sees them for selection on the Product Catalog. A category can be created 
for browsing products in the Catalog page or they can be created for creating options 
groups for a Bundle product. Products are associated to a category through a category 
hierarchy. 

Refer to the following topic for more information.
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Associating a Category with a Product

Associating a Category with a Product
You can associate more than one category with a product.

To associate categories for a product

Go to Admin Setup> Product Administration > Products > Click on a Product name.
On the Product Details page, click the setup icon  in the Categories section. The 
Categories page is displayed. Under Available Categories, you can see all categories 
available in the org.
In the Search Categories field, enter keywords to search the category you want to 
associate with the product.
Hover the mouse on the required category and click + next to the category name. The 
category is associated to the product and is displayed in the Associated Categories 
section (right-hand side).

Create a New Category:
If the desired category does not exist, click Create New Category under the 
Available Categories page.
The New Category page will be displayed.
Follow the steps in Creating a Category to configure the new price list.
After configuring and saving the new price list, return to the Associated Price 
Lists page.
Search for the newly created price list as described in step 3 and associate it 
with the product.

To delete an associated category from the product:
Hover the mouse on the required category under the Associated Categories 
section (right-hand side) and click the delete icon  for the category name. The 
Remove Category pop-up is displayed prompting you to confirm deletion.
Click Confirm.

Under the Associated Categories section (right-hand side):
Click the category name link. The category details pop-up is displayed.
Click Close.

Associating Product Groups with a Product
You can associate more than one product group with a product.

Hover the mouse on a parent category and click the  icon next to the 
category name to display the category hierarchy.


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To associate a product group with a product
Go to Admin Setup> Product Administration > Products > Click on a Product name.
On the Product Details page, click the setup icon  in the Product Groups section. 
The Product Groups page is displayed. Under Available Product Groups, you can see 
all product groups available in the org.
In the Search Product Group field, enter keywords to search the product group you 
want to associate with the product and click the search icon  or press Enter.
Hover the mouse on the required product group and click + next to the product group 
name. The product group is associated with the product and is displayed in the 
Associated Product Groups section (right-hand side).
Create a Product Group:

If the desired product group does not exist, click Create New Product 
Group under the Available Product Groups page.
The New Product Group page will be displayed.
Follow the steps in Creating a Product Group to configure the new product group.
After configuring and saving the new product group, return to the Associated 
Product Groups page.
Search for the newly created product group as described in step 3 and 
associate it with the product.

To delete an associated product group from the product:
Hover the mouse on the required product group under the Associated Product 
Groups section (right-hand side) and click the delete icon  for the product 
group name. A pop-up is displayed prompting you to confirm deletion.
Click Confirm.

Under the Associated Product Groups section (right-hand side):
Click the product group name link. The product group details pop-up is 
displayed.
Click Close.

Associating Attribute Groups with a Product
You can associate more than one attribute group with a product.

To associate an attribute group with a product
Go to Admin Setup> Product Administration > Products > Click on a Product name.
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On the Product Details page, click the setup icon   in the Attribute Groups section. 
The Attribute Groups page is displayed. Under Available Attribute Groups, you can 
see all attribute groups available in the org.
In the Search Attribute Groups field, enter keywords to search the attribute group you 
want to associate with the product.
Hover the mouse on the required attribute group and click + next to the attribute 
group name. The attribute group is associated to the product and is displayed in the 
Associated Attribute Groups section (right-hand side).

Create a New Attribute Group:
If the desired attribute group does not exist, click Create New Attribute 
Group under the Available Attribute Groups page.
The New attribute group page will be displayed.
Follow the steps in Creating an Attribute Group to configure the new attribute 
group.
After configuring and saving the new attribute group, return to the Associated 
Attribute Groups page.
Search for the newly created attribute group as described in step 3 and 
associate it with the product.

To delete an associated attribute group from the product:
Hover the mouse on the required attribute group under the Associated Attribute 
Groups section (right-hand side) and click the delete icon  for the attribute 
group name. The Remove Attribute Group pop-up is displayed prompting you to 
confirm deletion.
Click Confirm.

Under the Associated Attribute Groups section (right-hand side) and click the 
attribute group name link. The attribute group details page is displayed. If the 
attribute group has attributes inside, this page displays those attributes.

Associating Option Groups with a Product
You can associate more than one option groups with a product. You can add a root option 
group to a bundle product.

To associate option group with a product
Go to Admin Setup> Product Administration > Products > Click on a Product name.
On the Product Details page, click the setup icon   in the Option Groups section. The 
Option Groups page is displayed.

You can reorder the Attributes by moving the order  icon up or down.
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Click Add Option Group. The Add Option Group to Product pop-up will be displayed 
where you can see all option groups available in the org.
In the Search Option Groups field, enter keywords to search the option group you 
want to associate with the product and click the search icon  or press Enter.
Select the checkbox beside Option Group name. The option group is associated to the 
product. You can associate one, or more option groups to the product by selecting 
multiple checkbox.
Export the Associated Option Groups
The mass action feature allows you to export the selected coupons in one instance.

Click the checkbox beside Option Group Name column. You can select one 
option group, multiple option groups, or all the option groups.

Click the export ( ) icon to export the selected option groups as CSV or 
Excel file format.

The file gets downloaded to your local storage.
To remove an associated option group from the product:

Click the ellipsis () icon for the required option group and click the Remove. The 
Remove Option Group pop-up is displayed prompting you to confirm deletion.
Click Confirm.

Under the Add Option Group to Product pop-up:
Click the option group name link. The option group details page is displayed.

To Configure Option Groups:
Click the option group name tab. The Configure Option Group detail page 
appears.
Enter the following option group information, as required.

Option Description

Min Options Enter the minimum options that needs to be required for the option 
group in order to associate it to the product.

Max 
Options

Enter the maximum options that needs to be required for the option 
group in order to associate it to the product.

Min Total 
Quantity

Enter the expression for minimum total quantity using the field and 
function feature provided.

Max Total 
Quantity

Enter the expression for maximum total quantity using the field and 
function feature provided.
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Option Description

Modifiable 
Type

Select whether you need a Variable or a Fixed value.

Is Hidden Toggle on of off accordingly.

Is Picklist Toggle on if the options are picklist.

Click Save.

 

Associating Feature Sets with a Product
You can associate more than one feature set with a product.

To associate feature set with a product
Go to Admin Setup> Product Administration > Products > Click on a Product name.
On the Product Details page in the Feature Sets section, click the setup icon ( ) to 
open the Feature Sets page. You can see all Feature Sets available in the org under 
Available Feature Sets.
In the Search Feature Sets field, enter keywords to search the Feature Sets you want 
to associate with the product and click the search icon ( ) or press Enter.
Hover the mouse on the required Feature Sets and click (+) next to the Feature Sets 
name.
Create a Feature Set:

•

•

•

•

Sequencing the option groups

Administrator can define and save the sequence/order of option groups and 
product option groups.
Reordering is possible by moving groups up or down within the same hierarchy 
level.
Adding new groups appends them to the lowest level with sequence numbers 
incrementing accordingly.
Administrator can modify the sequence of an option group, then the sequence 
order on the config page is updated automatically. The Option group 
sequence only affect the sequence for the groups within their respective bundle 
levels. 


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If the desired feature set does not exist, click Create New Feature Set under the 
Available Feature Sets page.
The New Feature Set page will be displayed.
Follow the steps in Creating a Feature Set to configure the new feature set.
After configuring and saving the new feature set, return to the Associated 
Feature Sets page.
Search for the newly created feature set as described in step 3 and associate it 
with the product.

The Feature Set is associated with the product and is displayed in the Associated 
Product Groups section. 

To delete an associated product group from the product:
Click the delete icon ( ) next to the Feature Set name.

Deleting a Product
You can delete produts that are no longer required for your business requirements. 

To delete a product
The delete action cannot be performed on the UI. The delete action can only be triggered 
via API to the product administrator.

Managing Catalog
The Catalog Page allows you to create categories and associate them with the products 
to display when you browse and search for products to add to a quote. It enhances the 
efficiency and accuracy of the quoting process by providing a user-friendly interface for 
product selection and configuration. 

This catalog page allows you to create the following categories.

Main Category
Sub Category

You can reorder the feature sets by moving the order   icon up or down.
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Navigating the Catalog Page
When you launch the Catalogs page on the UI, all the existing catalogs are listed on this 
page along with their details. There are various functionalities available for you to 
manage the catalogs.

Managing Views
You can manage column width, control which columns are displayed in the grid, freeze/pin 
a column range, or rearrange the column order. You can also filter the view of records in the 
grid by performing a keyword search, filtering the list by column value, or applying one or 
more advanced filters and filter logic. For more information, see Managing the View 
Settings and Filtering the Records.

Actions available on this page
Click Create New > Main Category to create a new main category.
Click Create New > Sub Category to create a new sub category.

Click the ellipsis icon (  next to the catelog name to delete an existing rule.
Export the selected catalogs. For more information, see Exporting Records.

The following sections describe various catalog operations for managing catalog.

Creating a Main Category
Creating a Sub Category
Associating Price Lists to the Categories
Associating Products with Categories
Navigating the Catalog Page
Configuring Categories
Deleting a Category

Creating a Main Category
You can create multiple main categories and associate them based on the nature of the 
product. A list of associated products is displayed when you select the category on the 
catalog page.

To create a main category
Go to the Catalog page.

)
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Click Create New to open a new category page. or 
Select the main category type from the dropdown next to the Create New button. 
Enter the following details.  

Field Name Description

Category 
Name

Enter the name of the new category

Label The system automatically fills this field based on the name you entered in 
the category name.

Description Enter the description for the new category.

Search Filter 
Fields

Select the fields you want to use as search filters on the catalog page. 
The selected fields are visible under the 'Refine Your Search 'section while 
adding the products under this category on the catalog page.

Default Search 
Category

To set the category as default on the catalog page.

Expand by 
default

To display the sub-categories expanded by default.

Include in 
Total View

Turn on this setting to include the value of the products in this category in 
total view. 

Hide All Search 
Filters

Turn on this setting to hide all search filters.

Click Save. 

To create a sub-category, see Configuring Sub Categories.

Creating a Sub Category
You can create standalone sub-category or under the main category based on your 
requirement.

To create a sub-category
Go to the Catalog page.
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Click the dropdown next to the Create New button and select the Sub Category to 
open the Choose a Parent Category popup window.
Select the main category by clicking the check box next to the required categories.
Enter the following details.  

Field Name Description

Category Name Enter the name of the new category

Label The system automatically fills this field based on the name you entered 
in the category name.

Description Enter the description for the new category.

Search Filter 
Fields

Select the fields you want to use as search filters on the catalog page.

Default Search 
Category

To set the category as default on the catalog page.

Expand by 
default

To display the sub-categories expanded by default.

Include in Total 
View

Turn on this setting to include the value of the products in this category 
in total view. 

Hide All Search 
Filters

Turn on this setting to hide all search filters.

Click Save.

To include sub-categories from existing
Go to the Catalog page.
Click the desired category name page to open the category details page.

Click the vertical ellipsis ( ) icon and select Add Sub Category from Existing.
In the Add Category window, select the categories by clicking the checkboxes next to 
the required categories to import into the new category.
Click Add.

After creating sub-categries, you can

Use the sequence (  icon to reorder the sub-category up and down in the 
category hierarchy.

)
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To delete an sub-category from the list:

Click the ellipsis icon   of the required sub-category.
Click Delete.

Associating Price Lists to the Categories
You can associate more than one price list with a category.

To associate a price list with categories
Go to the Catalog page.
Click the desired category name page to open the category details page.
Select the category from the list and click the Price Lists in the right panel.
 Click Add Price List to open Add Price List to Category popup window.
Select the required price lists by clicking the check boxes next to the price list. 
Click Add.

Associating Products with Categories

To associate products with the main category
Go to the Catalog page.
Click the desired category name page to open the category details page.
Select the category from the list.
From the right panel, click the Products.
 Click Add Price List to open the Add Products to Category popup window.
Select the required price lists by clicking the check boxes next to the products. 
Click Add.

Navigating the Catalog Page

To navigate the catalog page
Login to the Conga Platform.

You can not create a sub-category once you associate or add products to the main 
category.


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Click the Revenue Apps tile to launch the Revenue Apps page. By default, the 
proposals page is selected. 
Click Revenue Admin in the left pane.
Go to Admin Setup > Product Administration > Catalog to open the catalog page. 

Configuring Categories
The Catalog Page allows you to browse and search for products to add to a quote. It 
enhances the efficiency and accuracy of the quoting process by providing a user-friendly 
interface for product selection and configuration. This catalog page allows you to create 
the following categories.

Main Category
Sub Category

Refer to the fllowing topics for more information.

Deleting a Category
You can remove category that no longer required.

To delete a category
Go to ADMIN SETUP> Product Administration > Catalog. The Catlog page is 
displayed.
Search for the category, and do one of the following:

To delete a single category, click the ellipsis icon (  next to the attribute 
name, and click Delete.
To delete multiple categories, click the checkboxes next to the name column, 

and click the ( ) icon.
To delete all categories, click the checkbox in the header row next to the name 

column, and click the ( ) icon.
Click Confirm.

)
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Managing the Product Groups
You can create a logical grouping of one or more product records using product groups. You 
can create combinations of products with similar characteristics or qualities for use in a 
price rule. A product group can consist of products from different product families.

To configure a product group, you must create a product group and add products as 
members of the group. You can add products as members of a group. You can also add 
products of different product families as a member of a product group.

Navigating the Product Groups Page
All the existing product groups along with their details are displayed on the product groups 
page. The following functionalities are available for you to manage the product groups.

Managing Views
You can manage column width, control which columns are displayed in the grid, freeze/pin 
a column range, or rearrange the column order. You can also filter the view of records in the 
grid by performing a keyword search, filtering the list by column value, or applying one or 
more advanced filters and filter logic. For more information, see Managing the View 
Settings and Filtering the Records.

Actions available on this page
Click Create New to create new product groups.

Click the More ( ) button to delete an existing product group.
Click the product group name link to view the product group details.
Export the selected catalogs. For more information, see Exporting Records.

The following sections describe various product group operations for managing product 
groups.

Creating a Product Group
Editing a Product Group
Associating Products with a Product Group
Creating Constraint Rules for a Product Group
Using the Where used Option for a Product Group
Associating Attribute Rules with a Product Group
Deleting a Product Group
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Configuring Product Groups

Creating a Product Group
You can create multiple product groups as required.

To create a product group
Go to ADMIN SETUP > Product Administration > Product Groups. 
Click Create New. The New Product Group pop-up is displayed.
Enter the following details:

Group Name: Name for the product group.
Description: Description for the product group.

Click Create. The Product Group details page is displayed with all information you 
provided.
On the Details tab, update the details if required and click Save.

A product group is created and saved. You can associate products and constraint rules 
with them.

Editing a Product Group
You can edit a product group as required when the requirement changes. 

To edit a product group
Go to ADMIN SETUP > Product Administration > Product Groups. 
Search for the product group you want to update.

Click the ellipsis icon  next to the product group name and click Edit. The Product 
Group details page is displayed.
On the Details tab, update the required fields.
Click Save.
On the Associated Products tab, associate products with the product group.
On the Constraint Rules tab, create constraint rules for the product group.

Associating Products with a Product Group
Go to ADMIN SETUP > Product Administration > Product Groups. 
Search for the product group you want to update.
Click the product group name link to open the Product Group details page.
Go to the Associated Products tab.
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In the Search Products box, enter keywords to search the product you want to 
associate with the product group.
Hover the mouse on a the required product and click + next to the product name. The 
product is associated to the product group and is displayed under the Associated 
Products section.
To delete an associated product from the product group:

Under the Associated Products section, enter the name of the product that you 
want to search in the Search the list box and press Enter. Products that match 
the search are displayed.
Hover the mouse on the product you want to disassociate and click the x icon. 
The Remove Product pop-up is displayed.
Click Confirm.

Creating Constraint Rules for a Product Group
You can create more than one constraint rules for a product group.

Go to ADMIN SETUP > Product Administration > Product Groups. 
Search for the product group you want to update.
Click the product group name link to open the Product Group details page.
Go to the Constraint Rules tab.
Click Create New. The New Constraint Rule pop-up is displayed.
Enter the following details:

Field Description

Rule Name Enter a name for the constraint rule. It is populated based on 
the product group name.

Rule Type Select a rule type. Supported values are:

Inclusion: Enforces selection of certain products as 
specified by the product scope specification or 
criteria specification in the inclusion rule.
Exclusion: Enforces exclusion of certain products 
from the shopping cart.
Validation: Displays the error message when the 
criteria conditions are fulfilled.
Recommendation: Product recommendations are 
displayed when the condition is fulfilled.
Replacement: Product replacements are suggested 
when the condition is fulfilled.
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Field Description

Condition Scope The condition scope for the constraint rule is auto-populated 
and you cannot change it as the field is disabled.

Condition Item The condition item for the constraint rule is auto-populated 
and you cannot change it as the field is disabled.

Match In Select an option where the condition match must happen. 
Supported values are:

MatchInOptions: Selecting this means the condition 
is fulfilled only when the condition products are in 
the option line items of the shopping cart.
MatchInPrimaryLines: Selecting this means the 
condition is fulfilled only when the condition 
products are among the primary lines (bundle or 
standalone) of the shopping cart.

Action Intent Select the intent of the action. Supported values are:

Auto Include: Adds selected products 
automatically. When the number of products 
selected by the rule action is more than the number 
mentioned in the Match Rule condition, auto- 
inclusion of products is not triggered. A message is 
displayed from the rule action instead.  
Note: Auto Include will not apply when the match 
rule value is Include All.
Prompt: Displays a message with choices of 
products that you can select or remove.
Show Message: Displays a message.
Check on Finalization: Applies rule action on 
finalization of the shopping cart.
Disable Selection: Disables selection of excluded 
products.
Hide: Hides the selection of excluded products.
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Field Description

Action Scope Select the action scope. Supported values are:

Product: In the Product field, click to select a 
product to be included or excluded. You search the 
product using product name or code.
Product Family: In the Product Family field, enter a 
product family. One or more of the products from 
the product family will be included or excluded 
based on rule type and match rule specifications.
Product Group: In the Product Group field, enter a 
product group. One or more of the products from 
the product group will be included or excluded 
based on rule type and match rule specifications.
Action Criteria:

Action Item Enter a keyword to search the action item. From the 
displayed search result, select an action item.

Click Save. The constraint rules details page is displayed.
On the Details tab, enter the following details:

Field Description

Rule Name Enter a name for the constraint rule.

Description Description for the constraint rule.

Effective Date Select the date from which the constraint rule is in 
effect.

Expiration Date Select the date until which the constraint rule is valid.

Is Active Turn this setting on to indicate whether the constraint 
rule is active.

Is Bundle Context Turn this setting on to indicate whether the constraint 
is evaluated within a bundle.

On the Conditions & Actions tab:
Create a constraint rule condition.
Create a constraint rule action.
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Click Save.

A constraint rule for the product group is created and saved.

Using the Where used Option for a Product Group
You can view Field Expressions, Rollups, and Price Rules that are associated with the 
Product Group in the pop-up. The information displayed in this panel is in read-only format.

To use the Where used Option
Go to ADMIN SETUP > Product Administration > Product Groups. The Product Groups 
page is displayed.
Search and click on the product group name to view the details.
Click the Where used button in the top right corner.
In the Used Locations pop-up, do the following:

Review the number of field expressions, rollups, and price rules that are 
associated with the product group.
Click the Field Expressions tab to see the list of field expressions where the 
product group is used as a scope.
Click the Rollups tab to see all the rollups that are associated with the product 
group.
Click the Price Rules tab to see the list of all Price Rules where the product group 
has been referenced.
Click on the name of a Field Expression, Rollup, or price rule to view additional 
details in a new tab.
Search and sort field expressions, rollups, and price rules.

Click Close. 

For more information, see Managing Field Expressions, Managing the Rollups, and Managing 
Price Rulesets.

Associating Attribute Rules with a Product Group
You can associate more than one attribute rules with a product.

On the Product Group list page, select the product group to which you want to 
associate the Attribute rule.
Click the Attribute Rules tab. The Attribute Rules page is displayed.
Click the Create New drop-down button:

Click Product Attribute Rule. You can create a PAR. For more information, 
see Creating a PAR.
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Click Attribute Value Matrix. You can create an AVM. For more information, 
see Creating an AVM.

On the Product Attribute Rules tab:
In the Search this list field, enter keywords to search the PAR associated with 
the product.
Use the Active switch to activate or deactivate a PAR.
Click the PAR name link to open the PAR details page.

Click the ellipsis icon   next to the PAR name and click Delete. The Delete 
Attribute Rule pop-up is displayed. Click Confirm.

On the Attribute Value Matrix tab:
In the Search this list field, enter keywords to search the AVM associated with 
the product.
Use the Active switch to activate or deactivate an AVM.
Click the AVM name link to open the AVM details page.

Click the ellipsis icon   next to the AVM name and click Delete. The Delete 
Attribute Matrix pop-up is displayed. Click Confirm.

Deleting a Product Group
You can delete a product group that is no longer required.

To delete a product group
Go to ADMIN SETUP > Product Administration > Product Groups. 
Search for the product group, and do one of the following:

To delete a single product group, click the ellipsis icon (  next to the attribute 
name, and click Delete.
To delete multiple product groups, click the checkboxes next to the name 

column, and click the ( ) icon.
To delete all product groups, click the checkbox in the header row next to the 

name column, and click the ( ) icon.
Click Confirm.

Configuring Product Groups
This section provides information on configuring product groups.

Refer to the following topics for more information.

)
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Managing the Constraint Rules
Constraint Rules are configuration rules used to conditionally include, exclude, recommend, 
replace, or validate a product or set of products based on other products or set of products 
added to the cart. For example, when Product A is added to the cart, Product B can be 
automatically added based on an auto-inclusion type rule. Similarly, when Product B is 
added to the cart, the sales rep can be prevented from adding Product C.

The constraint rule consists of three associated Objects:

Constraint Rule Object: Header level object that links the condition with the action. 
There are only three significant properties in this object, the active flag, action 
association, and condition association. To configure a constraint rule, you must first 
create a constraint rule header. You can create a constraint rule for a product or 
product group.
Constraint Rule Condition: Captures the condition that triggers the rule.
Constraint Rule Action: Captures the rule action that is applied to the cart when the 
rule condition is satisfied.

Navigating the Constraint Rules Page
When you launch the Constraint Rules page on the UI, all the existing constraint rules are 
listed on this page along with their details. There are various functionalities available for 
you to manage the constraint rules.

Managing Views
You can manage column width, control which columns are displayed in the grid, freeze/pin 
a column range, or rearrange the column order. You can also filter the view of records in the 
grid by performing a keyword search, filtering the list by column value, or applying one or 
more advanced filters and filter logic. For more information, see Managing the View 
Settings and Filtering the Records.

The Constraint Rule Execution mode is mutually exclusive, and only one value may 
be selected via the global system property. Mixing different modes through custom 
code customization is strongly discouraged, as it can result in unpredictable 
behavior. Please ensure adherence to this guidance for consistent and reliable 
system performance.


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Actions available on this page

Click the ellipsis icon  reate a new constraint rule.
Click the constraint rule name link to open the constraint rule details page and edit 
the constraint rule details.

Click the ellipsis icon   next to the constraint rule name to delete a constraint rule.
At the top of the page, you can see different rule types along with a total count of 
constraint rules under that rule type. To view the constraint rule based on rule type, 
click the specific Rule Type on top of the page.
Use the Active switch to activate or deactivate a constraint rule.
Export the selected constraint rules. For more information, see Exporting Records.

Items per page
At the bottom of the page, you can see the total count of constraint rules available. You 
can control the number of constraint rules to be displayed on each page. You can select the 
number of constraint rules from a predefined list. You cannot configure this list. By default, 
you see 20 records on each page.

By default, you can sort 10, 20, 30, 50, and 100 constraint rules per page using the Rows per 
page drop-down. This feature works in association with the search and filter functions to 
display search records per page. You can use the < and > buttons to move to the next or the 
previous pages. You can also jump to a certain page using the page search component.

This section provides information on managing constraint rules.

Creating a Constraint Rule
Configuring a Constraint Rule Using the Advanced Rule Setup
Deleting a Constraint Rule

Creating a Constraint Rule
This section provides information on creating a constraint rule. 

Go to ADMIN SETUP> Product Administration > Constraint Rules. The Constraint Rules 
page is displayed.
Click Create New button. If you want to create a specific type of rule, select the 
required rule type from the dropdown beside Create New button. 
Enter the following details:

below the Edit Page button to c
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Field Description

Rule Name CPQ populates a constraint rule name based on the product 
name. Enter a different name for the constraint rule if 
required.

Rule Type Select a rule type. Supported values are:

Inclusion: Enforces selection of certain products as 
specified by the product scope specification or 
criteria specification in the inclusion rule.
Exclusion: Enforces exclusion of certain products 
from the shopping cart.
Validation: Displays the error message when the 
criteria conditions are fulfilled.
Recommendation: Product recommendations are 
displayed when the condition is fulfilled.
Replacement: Product replacements are suggested 
when the condition is fulfilled.

If you create a specific type of rule directly from the 
drop-down arrow next to the Create New button, 
this field is populated with your selection. However, 
you can change the selection if required.


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Field Description

Condition Scope Select the condition scope. This defines what must be present 
in the shopping cart to fulfil the condition.

Product: This implies that the product must be 
present in the shopping cart to fulfil the condition.
Product Family: This implies that one or more 
products from the specified product family must be 
present in the shopping cart to fulfil the condition. 
The number of products that should be present 
depends on the Match Rule.
Product Group: This implies that one or more 
products from the specified product group must be 
present in the shopping cart to fulfil the condition. 
The number of products that should be present 
depends on the Match Rule.
Product Option Group: This implies that one or 
more products from the specified product option 
group must be present in the shopping cart to fulfil 
the condition. The number of products that must be 
present depends on the Match Rule.

Condition Item Search and select a condition item based on your selection in 
Condition Scope.

Match In Select one or multiple options where the condition match 
must happen. Supported values are:

Match In Options: Selecting this means the 
condition is fulfilled only when the condition 
products are in the option line items of the 
shopping cart.
Match In Primary Lines: Selecting this means the 
condition is fulfilled only when the condition 
products are among the primary lines (bundle or 
standalone) of the shopping cart.

You must enter minimum three characters to perform 
search.


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Field Description

Action Intent Select the intent of the action. Supported values are:

Auto Include: Adds selected products 
automatically. When the number of products 
selected by the rule action is more than the number 
mentioned in the Match Rule condition, auto- 
inclusion of products is not triggered. A message is 
displayed from the rule action instead.  
Note: Auto Include is not applicable when the 
Match Rule value is Include All.
Prompt: Displays a message with choices of 
products that you can select or remove.
Show Message: Displays a message.
Check on Finalization: Applies rule action on 
finalization of the shopping cart.
Disable Selection: Disables selection of excluded 
products.
Hide: Hides the selection of excluded products.

Rule Type Selected Options Available on the 
Action Intent Drop-Down

Inclusion Auto Include
Prompt
Show Message
Check on Finalization

Exclusion Prompt
Show Message
Check on Finalization
Disable Selection
Hide

Validation Show Message
Check on Finalization

Recommendation Prompt
Show Message
Check on Finalization

Replacement Prompt
Show Message
Check on Finalization
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Field Description

Action Scope Select the action scope. Supported values are:

Product: In the Product field, click to select a 
product to be included or excluded. You search the 
product using product name or code.
Product Family: In the Product Family field, enter a 
product family. One or more of the products from 
the product family will be included or excluded 
based on rule type and match rule specifications.
Product Group: In the Product Group field, enter a 
product group. One or more of the products from 
the product group will be included or excluded 
based on rule type and match rule specifications.

Action Item Enter a keyword to search a product, product family, or 
product group on which the action must be applied. From the 
displayed search result, select a product.

You can now:
Create the rule with more conditions, actions, additional scopes, or additional 
criteria. Click Advanced Rule Setup. The rules details page with the Conditions & 
Actions tab is displayed.
Save the rule. Click Save. Only a constraint rule header is created. The rules 
details page with the Details tab is displayed.

On the Details tab, enter the following details:

Field Description

Rule Name Enter a name for the constraint rule.

Description Description for the constraint rule.

Sequence Enter the number in which you want to sequence the 
constraint rule.

Effective Date Select the date from which the constraint rule is in 
effect.

Expiration Date Select the date until which the constraint rule is valid.
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Field Description

Is Active Turn this setting on to indicate whether the constraint 
rule is active.

Bundle Context Turn this setting on to indicate whether the constraint is 
evaluated within a bundle.

On the Conditions & Actions tab, create one or more constraint rule conditions and 
one or more constraint rule actions. For more information, see Configuring a Constraint 
Rule Using the Advanced Rule Setup.
Click Save.

A constraint rule is created and saved.

Configuring a Constraint Rule Using the Advanced Rule Setup
This section provides information on configuring a constraint rule using the Advanced Rule 
Setup. You may have created a constraint rule for a product or a product group. When you 
click Advanced Rule Setup on the rule creation page, the rules details page with the 
Conditions & Actions tab is displayed. You must configure a condition and an action to 
complete constraint rule creation.

Creating a Constraint Rule Condition
On the Conditions & Actions tab, under the CONDITIONS section, click Add Condition.
Select one of the following options from the Scope drop-down. The last column 
changes based on the scope you select. Enter a value name in the last column 
accordingly.

Option Description

Product This implies that the product must be present in the 
shopping cart to fulfil the condition.

From the Scope drop-down, select Product.
From the Operator drop-down, select Equals To.
In the Product field, search and select a product.
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Option Description

Product Family This implies that one or more products from the specified 
product family must be present in the shopping cart to 
fulfil the condition. The number of products that should be 
present depends on the Match Rule.

From the Scope drop-down, select Product 
Family.
From the Operator drop-down, select Equals To.
In the Product Family field, search and select a 
product family.

Product Group This implies that one or more products from the specified 
product group must be present in the shopping cart to fulfil 
the condition. The number of products that should be 
present depends on the Match Rule.

From the Scope drop-down, select Product Group.
From the Operator drop-down, select Equals To.
In the Product Group field, search and select a 
product group.
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Option Description

Product Field Set This implies that when the value of the field specified in the 
product scope matches the value of the field on the cart, 
the constraint rule condition is fulfilled. You must add at 
least one product field. After selecting Product Field Set on 
the Scope drop-down, the + Add Field button is displayed 
to add product fields.

From the Scope drop-down, select Product Field 
Set. 
Click Add Field.
Enter the following details:

Product Field: Select a product field from 
the drop-down.
Operator: Select an operator.
Value: Enter the value of the product field. 
Each product field has one picklist value 
from the product object.

Product Option Group This implies that one or more products from the specified 
product option group must be present in the shopping cart 
to fulfil the condition. The number of products that must be 
present depends on the Match Rule.

From the Scope drop-down, select Product Option 
Group.
From the Operator drop-down, select Equals To.
In the Product Option Group field, search and 
select an option group ID associated with the 
bundle.

Click the Condition Criteria icon  to define a constraint rule condition based on 
criteria. The Add Criteria pop-up is displayed. You can enter more than one criteria.

On the Conditions tab, click Add Criteria and enter the following details:
Field: Select a field on the product.

You must set up the product field to have only one 
choice. If you update the choice later, you must 
also update the constraint rule condition with the 
product field set specification to have the correct 
values. Match Rule is not applied to product field 
set-based constraint rules. CPQ considers Match 
Rule as Match Any In Group by default in such 
cases.


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Operator: Select an operator.
Value: Enter a value.

Click Add Criteria to add more criteria.

Click the Remove icon  to delete a criteria.
Click Remove All to remove all criteria.
Turn the Logic button on if you have more than one criteria and enter a value in 
the Logic field.
On the Actions tab, define the criteria. For more information, see Creating a 
Constraint Rule Action.
Click Save.

Click the Advanced Setup icon  to define advanced conditions. The Advanced 
Setup pop-up is displayed. You can define advanced logic if there is more than one 
conditions.

On the Conditions tab, enter the following details:
Condition Name: The name is populated automatically. You can edit the 
name if required.
Match In: Select an option where the condition match must happen. 
Supported values are:

Primary Lines: Selecting this means the condition is met only when 
the condition products are among the primary lines (bundle or 
standalone) of the shopping cart.
Options: Selecting this means the condition is met only when the 
condition products are in the option line items of the shopping cart.
Cart Options: Selecting this means the condition is met only when 
the condition products are among the cart line items of the shopping 
cart.
Location: CPQ does not support this option currently.

Match Rule: Select one of the following choices.  
There is no default value, which means that the rule condition is met if any 
one of the products in the product scope is selected. It is treated as Min/ 
Max with Match Min Products as 1. Match count is done before applying 
the criteria. 

Match Any In Group means that the rule condition is met if any one 
or more of the products from the group is selected. Match Any In 
Group is the same as Include Min/Max with Match Min Products as 1. 
It is also applicable to the Product Family and Product Field Set.
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Match All In Group means that all of the products from the group 
must be present in the shopping cart to meet the condition. This is 
applicable only to the product group and Product Family.
Min/Max also requires you to specify a min/max range.

Min Products: Enter a value for minimum products.
Max Products: Enter a value for maximum products.

On the Actions tab, define the action. For more information, see Creating a 
Constraint Rule Action.
Click Save.

click Add Condition. to add more conditions.

Click the Remove icon  to delete a condition.
Click Remove All to remove all conditions.
Turn the Logic button on and enter a value in the Logic field when you add multiple 
conditions.
When there is more than one condition for a constraint rule, this field defines when to 
consider one or more of the conditions using AND/OR association. The sequence 
number defined in the Condition column is used as an identifier of the condition.
Few examples, you defined conditions with sequence numbers as 1, 2, 3, 4, 5, and 6. 
The following examples describe various condition associations:

Condition Association  Description

(1 AND (2 OR 3)) Either Conditions 1 and 2  or Conditions 1 and 3 must be 
satisfied on the cart 

1 AND NOT 2 Condition 1 is in the cart while Condition 2 is not

1 AND NOT(2) Condition 1 is in the cart while Condition 2 is not

1 AND 1 Only Condition 1 is evaluated on the cart. If you have 
defined multiple conditions, CPQ does not evaluate the 
remaining conditions

NOT(5 OR 6) Neither Condition 5 nor 6 are in the cart

NOT 5 AND 6 Condition 5 is not in the cart, but Condition 6 is in the 
Cart.

It is recommended that you use the logical operator "AND" to display the resultant 
record if all the conditions separated by AND are TRUE. For instance, (1 OR 2 ) AND (3 
OR 4) AND 5. If you enter an invalid condition association, an error is displayed when 
you save the constraint rule.
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The constraint rule conditions are created. You can now define a constraint rule 
action.
Click Save on the Conditions & Actions tab.

Creating a Constraint Rule Action
On the Conditions & Actions tab, under the ACTIONS section, click Add Action.
From Action Type, select one of the following:

Option Description

Exclusion Enforces exclusion of certain products from the shopping 
cart.

Inclusion Enforces selection of certain products as specified by the 
product scope specification or criteria specification in the 
inclusion rule.

Recommendation Product recommendations are displayed when the 
condition is met.

Replacement Product replacements are suggested when the condition is 
met.

Validation Displays the error message when the criteria conditions 
are met.

  
Action Type selection impacts the options available for Action Intent as shown in the 
following table:

Rule Type Selected Options Available on the Action Intent Drop- 
Down

Inclusion Auto Include
Prompt
Show Message
Check on Finalization

You must set the Sequence for each condition or the Condition Association will 
be unreliable. Also, a constraint rule with only NOT in condition does not work. 
Example, NOT (1 AND 2).


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Rule Type Selected Options Available on the Action Intent Drop- 
Down

Exclusion Prompt
Show Message
Check on Finalization
Disable Selection
Hide

Validation Show Message
Check on Finalization

Recommendation Prompt
Show Message
Check on Finalization

Replacement Prompt
Show Message
Check on Finalization

From Action Intent, select one of the following:

Option Description

Auto Include Adds selected products automatically. When the number 
of products selected by the rule action is more than the 
number mentioned in the Match Rule condition, auto- 
inclusion of products is not triggered. A message is 
displayed from the rule action instead.

Note: Auto Include is not applicable when the Match Rule 
value is Include All.

Prompt Displays a message with choices of products that you can 
select or remove.

Show Message Displays a message.

Check on Finalization Applies rule action on finalization of the shopping cart.

•

•

Constraint rules of Action Types =  Inclusion and Exclusion supports Match 
In Assets.
Constraint rules of Action Types =  Recommendation and Replacement do 
not support Condition Criteria and work only for the Scope.
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Option Description

Disable Selection Disables selection of excluded products.

Hide Hides the selection of excluded products.

Select one of the following options from the Scope drop-down. The last column 
changes based on the scope you select. Enter a value name in the last column 
accordingly.

Option Description

Product From the Scope drop-down, select Product.
In the Product field, search and select a product to 
be included or excluded.

Product Family From the Scope drop-down, select Product Family.
In the Product Family field, search and select a 
product family to be included or excluded. One or 
more of the products from the product family will 
be included or excluded based on rule type and 
match rule specifications.

Product Group From the Scope drop-down, select Product Group.
In the Product Group field, search and select a 
product group to be included or excluded. One or 
more of the products from the product group will 
be included or excluded based on rule type and 
match rule specifications.

Action Criteria Click Edit Action Criteria or the Condition Criteria icon 
to define a constraint rule action.

Click the Condition Criteria icon  to define a constraint rule action based on 
criteria. The Add Criteria pop-up is displayed. You can enter more than one criteria.

On the Actions tab, click Add Criteria and enter the following details:
Field: Select a field on the product.
Operator: Select an operator.

The condition criteria icon  shows up when the 
Action Type is set to Validation.


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Value: Enter a value.
Click Add Criteria to add more criteria.
Turn the Logic button on if you have more than one criteria and enter a value in 
the Logic field.
Click Save.

Click the Advanced Setup icon  to define advanced actions. The Advanced Setup 
pop-up is displayed.

On the Conditions tab, update the conditions if required.
On the Actions tab, enter the following details: 

Action Name: The name is populated automatically. You can edit the 
name if required.
Match In: Select an option where the action match must happen. 
Supported values are:

Primary Lines: Select this option to include or exclude the products 
that are primary line items (offering) based on your Action Type 
selection.
Options: Select this option to include or exclude the products that 
are options based on your Action Type selection.
Cart Options: Select this option to include or exclude the products 
that are cart line items based on your Action Type selection.
Assets: Select this option to include or exclude the products that are  
assets based on your Action Type selection.

Match Rule: Applies to inclusion and exclusion type rule action only, and 
that has product scope as Product Family, Product Group, or Action 
Criteria. Select any one of the following to complete the rule action:

None: No product selection is allowed.
For inclusion type constraint rule:

Include Any: Allows selection of up to one product. Rest of the 
products in the prompt are disabled.
Include All: Allows selection of all products within the Product 
Group or Product Family. Note: Only this match rule works with 
Action Intent Auto Include.
Include Min/Max: Requires a minimum number of products 
specified in the Min Products field.

For exclusion type constraint rule:
Exclude All: All the products are excluded.
Exclude After One: Allows selection of only one product. Any 
other selection will trigger the rule action.
Exclude After Max: Allows selection of a maximum number of 
products specified in the Max Products field. Any other 
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selection over and above the specified number will trigger the 
rule action.

Message Type: Select one of the following values:
Error: If you select Error, you cannot finalize the cart unless you 
satisfy the constraint rule 
Warning: If you select Warning, you can finalize the cart but the 
warning message is displayed on the cart until you satisfy the 
constraint rule.

Message Details: Enter text to be displayed when the rule action is 
effective. These messages can also be translated into multiple languages. 
For inclusion and exclusion type rule actions product name substitution 
parameters {0}, {1} can be used. For example: {0} requires {1}. For validation 
type rule actions only {0} will be substituted by triggering products.
Click Save.

Click Save on the Conditions & Actions tab.

Deleting a Constraint Rule
You can delete a constraint rules that is no longer required for your business requirements.

To delete a constraint rule
Go to ADMIN SETUP> Product Administration > Constraint Rules. The Constraint Rules 
page is displayed.
Click the ellipsis icon   next to the constraint rule name and click Delete.

Managing the Categories
Categories are high-level logical groupings of products, affecting the way the Sales rep 
sees them for selection on the Product Catalog. A category can be created for browsing 
products in the Catalog page or they can be created for creating options groups for a 
Bundle product. Products are associated to a category through a category hierarchy. 
Category hierarchies are maintained using the Hierarchy Manager. They are also used to 
group the total price of the products belonging in a category on the Cart Summary.
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Navigating the Categories Page
When you launch the Categories page on the UI, all the existing categories are listed on this 
page along with their details. There are various functionalities available for you to 
manage the categories.

Categories Search
You can narrow down the categories list using the search feature. You can either define 
search criteria to search for a range of categories or use the categories search option.

Basic Search

In basic search, you can search for a category using keywords. For example, you can search 
using the name of the category. 

In the Search this list field, enter a keyword related to your category details such as 
category name.
Click the search icon   or press Enter. CPQ returns all categories that contain that 
keyword in the category details.

Advanced Search

In advanced search, you can search for a category using a search query.

Click the Advanced Search icon  . The Advanced Search pop-up is displayed.
Enter the following details: 

Field: All category fields are available in the drop-down list such as Category 
Name, Label, Parent Category, Leaf, Modified Date and Created Date.
Operator: Operators that are available for selection helps create the filter 
expression. Operators are displayed based on the field types. For example, a 
picklist value will display equal to and not equal operators and a text field will 
display equal to, not equal to, starts with, contain, does not contain operators. 
If it is a multi-value picklist, the application displays include and does not 
include operators.
Value: Enter a value.

Click Add Criteria if you want add more criteria in the advanced search.
Turn the Logic button on if you have more than one criteria and enter a value in 
the Logic field.
Click Apply to enable the search filter. CPQ returns all categories that match the 
criteria.
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Sorting Categories
You can sort the categories by clicking the column names. The categories are sorted in 
descending order using the last modified date. Every time you click the column name, the 
sorting switches between ascending and descending order. You can adjust the column 
width by dragging the columns. Hover near the column boundaries till two-way arrow 
appears. Click when the arrow appears and drag left or right to adjust the column width.

Actions available on this page
Click Create New to create a main category or sub-category .

Click the ellipsis icon   next to the product name to edit or delete a category.
Click the category name link to open the category details page.

Items per page
At the bottom of the page, you can see the total count of categories available. You can 
control the number of categories to be displayed on each page. You can select the number 
of categories from a predefined list. You cannot configure this list. By default, you see 20 
records on each page.

By default, you can sort 10, 20, 30, 50, and 100 categories per page using the Rows per 
page drop-down. This feature works in association with the search and filter functions to 
display search records per page. You can use the < and > buttons to move to the next or the 
previous pages. You can also jump to a certain page using the page search component.

Creating a Category
Go to ADMIN SETUP> Product Administration > Catalog. The Catalog page is 
displayed.
Click the Create New drop-down button and click one of the following options:

Main Category: Creates a main category on the catalog.
Sub Category: Creates a subcategory under a main category on the catalog.

On the Details tab, enter the following details

Field Description

Category Name Enter a name for the category
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Field Description

Label The label is populated automatically based on the 
category name you enter. Change it if required.

Description Enter a description for the category.

Search Filter Fields Select one or more search filter fields. Selected filter 
fields are displayed in the Refine Your Search section.

Default Search Category Turn this setting on to display the product by default 
under the category or sub-category in the catalog page. 
If not, the user must first select the category from the 
category panel or the browse section to see the product.

Expanded By Default Turn this setting on to indicate that the hierarchy is 
expanded at all times in the catalog page

Include In Total View Turn this setting on to indicate that the mode is 
displayed in the totals view on the shopping cart

Hide All Search Filters Turn this setting on to indicate that all the search filters 
in Narrow Your Search and Refine Your Search on the 
Catalog page are hidden.

Click Save.

Creating a Category Hierarchy
A category hierarchy defines the structure of the product catalog. You can add sub- 
categories (also known as nodes) to a category, reorder categories, and associate 
products, thus build a hierarchy. You can create multi-level categories. For example: Home 
> Laptops > Model.

Prerequisite

You must have an existing non-leaf category as a parent or main category. For more 
information, see Creating a Category. 

To build a category hierarchy
Go to ADMIN SETUP> Product Administration > Catalog. The Catalog page is 
displayed.
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Search for the category in which you want to build a hierarchy.
Click the category name link to open the category details page.
In the Catalog section on the left side, click the expand icon  to view the existing 
category hierarchy of selected category so that I can view sub-categories and 
associated products.

Click the ellipsis icon  on to the category and click:
New Sub Category. A placeholder for the sub-category is added under the 
parent category.

On the Details tab, enter the following details :

Field Description

Category Name Enter a name for the category.

Label The label is populated automatically based on 
the category name you enter. Change it if 
required.

Description Enter a description for the category.

Search Filter Fields Select one or more search filter fields. Selected 
filter fields are displayed in the Refine Your 
Search section.

Default Search Category Turn this setting on to display the product by 
default under the category or sub-category in 
the catalog page. If not, the user must first select 
the category from the category panel or the 
browse section to see the product.

Expanded By Default Turn this setting on to indicate that the hierarchy 
is expanded at all times in the catalog page

•

•

The  icon indicates how many sub-categories are associated with 
the parent category.

The  icon indicates how many price lists are associated with the 
parent category.


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Field Description

Include In Total View Turn this setting on to indicate that the mode is 
displayed in the totals view on the shopping cart

Hide All Search Filters Turn this setting on to indicate that all the 
search filters in Narrow Your Search and Refine 
Your Search on the Catalog page are hidden.

Click Save.
Add Sub Category From Existing. The Add Category pop-up is displayed.

In the Search this list box, enter keywords to search the category you want 
to associate with the parent category.
Select the category and click Add. The category with associated products 
is added to the parent category.

Use the  icon to move the category up and down in the category hierarchy.

To delete a category from the category hierarchy
Go to ADMIN SETUP> Product Administration > Catalog. The Catalog page is 
displayed.
Search for the category from which you want to remove a sub-category.
Click the category name link to open the category details page.
In the Catalog section on the left side, click the expand icon  to view the existing 
category hierarchy of selected category so that I can view sub-categories and 
associated products. 

Click the ellipsis icon  on to the category and click Delete. The Delete Category 
pop-up is displayed.
Click Confirm.

Adding Price Lists to a Category
You can associate more than one price list with a category.

 You can create sub-categories under a non-leaf category or sub- 
category (which does not have products associated with it). 



You can rearrange the order of the categories so that most-used or purchased 
categories appear at the top of the list in the catalog.


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To add a price list to a category
Go to ADMIN SETUP> Product Administration > Catalog. The Catalog page is 
displayed.
Search for the category to which you want to add price lists.
Click the category name link to open the category details page.
On the category hierarchy, select a category to which you want to add price lists.

Go to the Price Lists tab. If any price list is associated with the category, you can see 
it.
Click Add Price List. The Add Price List pop-up is displayed.
In the Search this list box, enter keywords to search the price list you want to 
associate with the category.
Select the price list and click Add. The price list is added and displayed in the price 
lists section on the right side.
To add another price list, click Add Price List again.
Use the  icon to move the price lists up and down in the price lists section.

To delete a price list from a category
Go to ADMIN SETUP> Product Administration > Catalog. The Catalog page is 
displayed.
Search for the category from which you want to remove price lists.

Click the category name link to open the category details page.
On the category hierarchy, select the category from which you want to remove the 
price lists. 
On the Price Lists tab, in the Search this list box, enter keywords to search the price 
list you want to remove from the category.
Click the delete icon  for the price list you want to remove.

You can add a price list to any category in the hierarchy (main or sub- 
category). The same price list reflects in all categories in the hierarchy.



You can sort price lists based on the price list names. You can also use the 
rows per page to find required price lists.


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Adding Products to a Category
You can add products to categories and sub-categories so that the sales representatives 
can easily navigate through the category hierarchy and select the right product during 
runtime. You can add multiple products to categories.

To add a product to a category
Go to ADMIN SETUP> Product Administration > Catalog. The Catalog page is 
displayed.
Search for the category to which you want to add products.
Click the category name link to open the category details page.
On the category hierarchy, select the category to which you want to add the 
products. 

On the Products tab, click Add Products. The Add Product pop-up is displayed.
In the Search this list box, enter keywords to search the product you want to 
associate with the category.

Select the product and click Add. The product is added and displayed in the products 
section on the right side.
To add another product, click Add Product again.
Use the  icon to move the products up and down in the products section.

To delete a product from a category
Go to ADMIN SETUP> Product Administration > Catalog. The Catalog page is 
displayed.
Search for the category from which you want to remove products.

You can associate products only to leaf categories. If a category has a sub- 
category, you cannot associate any products to it. The Add Products button 
the Products tab is disabled. Therefore, ensure that you select the right 
category before you add products.



You can search products from list of product available in the price lists if the 
category is associated with a price list. If not, you can search products from 
all products.



You can rearrange the order of the products so that most-used or purchased 
products appear at the top of the list in the category.


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Click the category name link to open the category details page.
On the category hierarchy, select the category from which you want to remove the 
products. 
On the Products tab, in the Search this list box, enter keywords to search the product 
you want to remove from the category.
Click the delete icon  for the product you want to remove.

Managing the Option Groups
Option Groups in the Conga platform are categories used to organize and group option 
products for association with bundles. They facilitate the process of configuring product 
bundles. Option Groups can also be used as categories, and they are divided into two 
types: Shared Option Groups and Standalone Option Groups.

Types of Option Groups
Shared Option Groups: 
Shared Option Groups can be associated with multiple bundles. These groups are 
ideal for option products that are common across various bundles. Using Shared 
Option Groups ensures that updates to the group structure reflect across all 
associated bundles.
Standalone Option Groups: Standalone Option Groups are specific to a single bundle. 
These groups are suitable for unique option products tailored to a specific bundle. 
While Standalone Option Groups can be associated with other bundles, only the 
initial group structure is retained. Any changes made after the first save are not 
reflected in subsequent associations. Standalone Option Groups allow for tailored 
configurations for individual bundles.

Use Cases
Product Configuration: Structuring and management of option products within 
bundles for various product configurations.
Consistency Across Bundles: Using Shared Option Groups to ensure consistent option 
offerings across multiple bundles.
Tailored Bundles: Employing Standalone Option Groups for unique, bundle-specific 
option configurations.

You can sort products based on the product names. You can also use the rows 
per page to find required products.


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Navigating the Option Groups Page
When you launch the Options Group page on the UI, all the existing option groups are listed 
on this page along with their details. There are various functionalities available for you to 
manage the option groups.

Managing Views
You can manage column width, control which columns are displayed in the grid, freeze/pin 
a column range, or rearrange the column order. You can also filter the view of records in the 
grid by performing a keyword search, filtering the list by column value, or applying one or 
more advanced filters and filter logic. For more information, see Managing the View 
Settings and Filtering the Records.

Actions available on this page
Click Create New to create a new option group.

Click the ellipsis icon ( ) next to the option group name to Clone or Delete an existing 
option group.
Click the option group name link to open the Option Group details page.
Export the selected option groups. For more information, see Exporting Records.
On the Products tab, associate products with the option group.

 

This section provides information on configuring option groups.

Refer to the following topics for more information.

Creating an Option Group
Associating Products with an Option Group
Removing an Associate Product From the Option Group
Editing an Option Group
Deleting an Option Group
Using the Where used Option for an Option Group

Creating an Option Group
Option groups are a type of category that is used to group option products together to be 
associated with bundles. Option groups are further categorized into two types Shared and 
Standalone. You can create these option groups in the parent option group's details page.



Configure Price Quote (CPQ)

252 Copyright ©2024 Conga Corporation. All rights reserved.

1.

2.
3.

•

•
•

•
•
•

•
•

4.

1.

2.

3.

4.

To create an option group
Go to ADMIN SETUP > Product Administration > Option Groups. The Option Groups 
page is displayed.
Click Create New. The Option Group details page is displayed.
On the Details tab, enter the following details:

Click Browse file or Drag and drop the file to upload and attach an image to 
the option group. This step is not mandatory. 
Option Group Name: Enter a name for the option group.
Label: The label is populated automatically based on the option group name 
you enter.
Type: Select the type of option group:

Shared: This type of option group can be associated with multiple bundles.
Standalone: This type of option group is bundle-specific.

Description: Enter a description of the option group.
Expanded By Default: Turn this setting on to expand the option groups in the 
config page based on your requirement.

Click Save.

To create a sub-option group. see Creating Sub Option Group.

Associating Products with an Option Group

Editing an Option Group

Creating a Sub Option Group
You can create option group hierarchies based on your business requirement. You can also 
create sub-option groups in the existing option group. The option group for which you are 
creating a sub-option group is considered a parent option group. 

To create a sub-option group

Go to ADMIN SETUP > Product Administration > Option Groups. The Option Groups 
page is displayed.
Click the parent option group to create a new option group. The option group details 
page is displayed.

Click the vertical ellipsis ( ) icon next to the option group name and click New Sub 
Option Group. 
In the right panel, in the Details tab, enter the option group name. The Label field is 
filled automatically.
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From the Type drop-down, select the option group type. The supported values are 
Standalone and Shared.
Enter the description of the new sub-option group. 
Click Save. A new sub-option group is tagged to the existing option group as a 
hierarchy. 

Repeat from step 3 to step 7 to add more sub-option groups. You can create multiple levels 
of sub-option groups. 

Creating the Option Groups

Associating Products with an Option Group
This section provide information on association of products with an option group.

To associate a product with an option group
Go to ADMIN SETUP > Product Administration > Option Groups. The Option Groups 
page is displayed.
Search for the required option group and click the option group name link. The Option 
Group details page is displayed.
Click the Products tab. 
Click Add Product. The Add Product pop-up is displayed. 
Advanced Search
In advanced search, you can search for a product using a search query. The search 
query uses options provided in Field, Operator, and Value and displays a search 
result that matches the criteria.

Click the Advanced Search icon  . The Advanced Search pop-up is displayed.
Click Add Criteria.
Enter the following details: 

Field: All product field options are available in the drop-down list such as 
product Name, Product Code, and Configuration Type.
Operator: Operators that are available for selection helps create the 
filter expression. Operators are displayed based on the field types. 
Value: Enter a value.

Click Add Criteria if you want add more criteria in the advanced search.
Review the filter expression.
Click Apply to enable the search filter. CPQ returns all products that match the 
criteria.

Click the checkbox beside Product Name column. You can select one product, multiple 
products, or all the products.
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Click the ( ) icon to export the selected products in CSV or Excel file format.
Click Add button.
Use the  icon to move the products up and down in the products section.

To delete an associated product from an option group, see Deleting an Associate Product 
From the Option Group.

Creating the Option Groups

Removing an Associate Product From the Option Group
You can remove an associated product from the option group.

To delete an associated product from an option group
Go to ADMIN SETUP > Product Administration > Option Groups. The Option Groups 
page is displayed.
Search for the required option group from which you want to remove products.
You can sort products based on the product names. You can also use the rows per 
page to find required products.
Click the option group name link. The Option Group details page is displayed.
Click the Products tab. You can see a list of products associated with the option 
group.
In the Search this list field, enter keywords to search the product you want to remove 
from the option group and search.

Click the remove icon   for the product you want to remove.

Associating Products with an Option Group

Editing an Option Group
You can edit any option group as required. This feature enables you to make the necessary 
changes to the option group configuration when the requirement changes. 

To edit an option group
Go to ADMIN SETUP > Product Administration > Option Groups. The Option Groups 
page is displayed.

You can rearrange the order of the products so that most-used or purchased 
products appear at the top of the list in the option group.


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Search for the option group you want to edit.
Click the option group name. The Option Group Details page is displayed.
Edit the required fields.
Click Save.

Deleting an Option Group
You can delete Option groups that are no longer required. 

Deleting an Option Group
When deleting an root or child option group, if one or more products are associated with the 
option group, it cannot be deleted, and a validation error is triggered. However, if no 
products are associated, the behavior depends on the deleteHierarchy  query parameter. 
If deleteHierarchy  is set to true , the option group along with all its children should be 
deleted. If the parameter is set to false  or not passed at all, the option group are deleted, 
and separate hierarchies should be created for all immediate children.

Deleting a Product Option Group 
For the deletion of a product option group (Root or Child, Standalone or Shared), the entire 
product option group and its children should be removed, along with all corresponding 
product option components. The parent product option group of the deleted group should 
then derive its IsLeaf  value solely from the corresponding option group. This deletion 
process does not affect the corresponding option group or other product option groups.

To delete an option group
Go to ADMIN SETUP > Product Administration > Option Groups. The Option Groups 
page is displayed.
Search for the option group and do one of the following: 

To delete a single option group, click the ellipsis icon (  next to the option 
group name, and click Delete.
To delete multiple option groups, click the checkboxes next to the name column, 

and click the ( ) icon.
To delete all the option groups, click the checkbox in the header row next to the 

name column, and click the ( ) icon.
Click Confirm.

)
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Using the Where used Option for an Option Group
You can view Constraint rules and Associated Bundles that are associated with the Option 
Group in the pop-up. The information displayed in this panel is in read-only format.

To use the Where used Option
Go to ADMIN SETUP > Product Administration > Option Groups. The Option Groups 
page is displayed.
Search and click on the option group name to view the details.
Click the Where used button in the top right corner.
In the Used Locations pop-up, do the following:

Review the number of constraint rules and associated bundles that are 
associated with the option group.
Click the Associated Bundles tab. You can see the products where the option 
group is referenced by a product option group.
Click the Constraint Rules tab. You can see the list of all constraint rules where 
option group is used as scope. 
Click on the name of a Constraint Rule or an Associated Bundle to view 
additional details in a new tab.
Search and sort constraint rules and associated bundles

Click Close. 

Managing the Attributes and Attribute Groups

Attributes 
An Attribute represents a specific characteristic or feature of a product. Attributes can 
range from physical properties like color and size to technical specifications such as weight 
and material.

Examples of Attributes
Color: Red, Blue, Green
Size: Small, Medium, Large
Weight: 1kg, 2kg, 5kg
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Functionality
Pricing Determination: Attributes can influence the pricing of products based on 
specific configurations. For example, a larger size may cost more than a smaller size.
Informational Details: Attributes provide additional information for each line item, 
helping customers understand product specifications.
Product Configuration: Attributes allow for the customization and filtering of 
products to meet specific customer requirements.

Attribute Groups
An Attribute Group is a collection of attributes that can be associated with products. 
Attribute Groups help in organizing attributes into manageable sets, making it easier to 
assign and maintain them across different products.

Examples of Attribute Groups
Physical Characteristics: Color, Size, Weight
Technical Specifications: Processor Type, RAM, Storage
Material Properties: Fabric Type, Durability, Waterproofing

Functionality:
Organization: Attribute Groups simplify the management of multiple attributes by 
grouping related attributes together.
Association: Groups can be associated with products to streamline the attribute 
assignment process.
Management: The Attributes administration page enables users to create, delete, 
and manage Attribute Groups. Users can also control the sequence in which these 
groups are associated with products.

Use Cases of Attributes and Attribute Groups
Product Customization: Attributes allow for detailed customization of products to 
match customer preferences.
Efficient Product Management: Attribute Groups facilitate the streamlined 
assignment and management of attributes across a product catalog.
Pricing Strategy: Attributes can be used to implement dynamic pricing models based 
on product specifications.
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Navigating the Attributes Page
When you launch the Attributes page on the UI, all the existing attributes are listed on this 
page along with their details. There are various functionalities available for you to 
manage the attributes.

Managing Views
You can manage column width, control which columns are displayed in the grid, freeze/pin 
a column range, or rearrange the column order. You can also filter the view of records in the 
grid by performing a keyword search, filtering the list by column value, or applying one or 
more advanced filters and filter logic. For more information, see Managing the View 
Settings and Filtering the Records.

Actions available on this page
Click Create New to create a new attribute or attribute group.

Click the ellipsis icon ( ) next to the product name to delete the attribute.
Click the attribute name link to open the Attribute Details page.
Export the selected attributes. For more information, see Exporting Records.

 

The following section provides information on configuring attributes and attribute groups.

Creating an Attribute
Creating an Attribute Group
Associating an Attribute to an Attribute Group
Associating Products under Attribute Groups
Removing an Associated Attribute from the Attribute Group
Removing an Associated Product from the Attribute Group
Editing an Attribute
Editing an Attribute Group
Deleting an Attribute
Deleting an Attribute Group

Creating an Attribute
You can create an attribute as per your business requirements.
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To create an attribute
Go to ADMIN SETUP > Product Administration > Attributes. The Attributes page is 
displayed.
Click the Create New drop-down button and click Attribute. The New Attribute page 
is displayed.
On the Data Type drop-down, select a data type.

Data Type Description

String Allows users to enter any text. Default length is 2000.

Int Allows users to enter any number. Leading zeros are 
removed.

Double Allows users to enter any number. Leading zeros are 
removed.

Currency Allows users to enter any number. Leading zeros are 
removed.

Boolean Allows users to enable or disable a checkbox.

Date Time Date Time description here...

Lookup Lookup description here...

Picklist Allows users to select a value from a list you define.

Multi Picklist Allows users to select a value from a list you define.

In the Attribute Name field, enter a name for the attribute.
The Display Name field is populated automatically based on the attribute name you 
enter. Change it if required.
In the Description field, enter a description for the attribute. 
In the Default Value field, enter a default value for the attribute. If you select Data 
Type as Picklist or Multi Picklist, you must select the default value from the Default 
Value drop-down. 
The Default Value will be defined by adding the List Values.
Turn the Is Required setting on to make this attribute as a required attribute.
Click Save. to save this attribute or Save & Create New to save this attribute and 
create another attribute.
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To discard your changes:
Click Discard Changes. The Alert pop-up is displayed prompting you to confirm 
discard.
Click Don't Save.

To edit an attribute, see Editing an Attribute.

To delete an attribute. see Deleting Attribute.

Creating an Attribute Group
You can create an attribute group as per your business requirements.

To create an attribute group
Go to ADMIN SETUP > Product Administration > Attributes. The Attributes page is 
displayed.
Click the Create New drop-down button and click Attribute Group. The New Attribute 
Group page is displayed.
In Attribute Group Name field, enter a name for the attribute group name.
From the Display Attributes In drop-down, select an option. The supported values 
are:

Two column
Three column

In the Description field, enter a description for the attribute group.
Click Save.
Go to the Attributes tab to associate attributes to the attribute group you created. 
For more information, see Associate an Attribute to an Attribute Group.
Go to the Associated Products tab to associate products to the attribute group you 
created. For more information, see Associated Products under Attribute Groups.

To edit an attribute group, see Editing an Attribute Group.

To delete an attribute group, see Deleting an Attribute Group.

Associating an Attribute to an Attribute Group
Associating attributes to attribute groups is a crucial step in organizing product 
characteristics within the Conga platform. This association allows for a structured and 
systematic approach to managing product features, ensuring that each product is 
configured with the relevant attributes. By grouping attributes, you can simplify product 



Configure Price Quote (CPQ)

261 Copyright ©2024 Conga Corporation. All rights reserved.

1.

2.
3.
4.
5.
6.

7.

8.

9.
•

•
•
•

•

10.

management, improve filtering capabilities, and ensure that pricing and product 
information are aligned with customer requirements.

To associate an attribute to an attribute group
Go to ADMIN SETUP > Product Administration > Attributes. The Attributes page is 
displayed.
Click the Attribute Groups tab.
Search for the attribute group to update.
Click the attribute group name link to open the Attribute Group details page.
Click the Attributes tab.
Under Available Attribute Groups, you can see all attribute groups available in the 
org.
In the Search Attribute box, enter keywords to search the attribute you want to 
associate with the attribute group.
Hover the mouse on the required attribute and click + next to the attribute name. The 
product is associated with the product group and is displayed under the associated 
attributes section.

Create an attribute:
If the desired attribute does not exist, click Create New Attribute under the 
Available Attributes page.
The New Attribute page will be displayed.
Follow the steps in Creating an Attribute to configure the new attribute.
After configuring and saving the new attribute, return to the Associated 
Attributes page.
Search for the newly created attribute as described in step 7 and associate it 
with the attribute group.

Turn the following settings on if required:

Setting Description

Is Read Only Indicates that the value of the attribute is not editable. The 
user cannot edit the value.

Is Hidden Indicates that the attribute is not displayed on the 
configuration page. However, the attribute is associated 
with the attribute group.

Hover the mouse on the required attribute and click the info  icon next to 
the attribute name to display the description of the attribute.


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Setting Description

Is Primary Indicates that the attribute is critical and the attribute is 
displayed on the Installed Products page as a critical 
attribute.

Click Save.

To discard changes:
Click Discard Changes. The Alert pop-up is displayed.
Click Don't Save.

Creating Attribute

Creating Attribute Group

Associating Products under Attribute Groups
Associating products with attribute groups is an essential process within the Conga 
platform that ensures products are configured with the appropriate characteristics. This 
involves linking specific products to the attribute groups that have been created, allowing 
for detailed management of product features such as color, size, weight, and more.

To associate products to the Attribute groups
Go to ADMIN SETUP > Product Administration > Attributes. The Attributes page is 
displayed.
Click the Attribute Groups tab.
Search for the attribute group to update.
Click the attribute group name link to open the Attribute Group details page.
Click the Associated Products tab.
Click Available products, the right pane will open.
In the Search Products box, enter keywords to search the products you want to 
associate with the attribute group.

The Save button is enabled only when you make any changes to the 
associated attributes.



You can reorder the Attributes by moving the order  icon up or down.
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Hover the mouse on the required product and click + next to the product name. The 
product is associated with the attribute group and is displayed under the associated 
products section.

To delete an associated product from the attribute group:
Under the associated products section, enter the name of the product you want 
to search in the Search the list box and press Enter. Products that match the 
search are displayed.
Click the ellipsis icon and select the Remove button.
Click Confirm.

Click Save.

To discard changes:
Click Discard Changes. The Alert pop-up is displayed.
Click Don't Save.

Creating Attribute

Creating Attribute Group

Creating a Product

Removing an Associated Attribute from the Attribute Group
You can remove an associated attribute from the attribute group.

To remove an associated attribute from an attribute group
Go to ADMIN SETUP > Product Administration > Attribute. Click the Attribute Group 
tab.
The Attribute Groups page is displayed. Search for the attribute group from where 
you want to remove the associated attribute.
Click the attribute group name. The Attribute group Details page is displayed.
Click the Attributes tab. Search for the attribute you want to remove.

Click the delete ( ) icon.
The Delete Attribute pop-up is displayed.
Click Confirm.

Hover the mouse on the required product and click the info (  icon next to 
the associated product name to display the description of the product.

 )

• The Save button is enabled only when you make any changes to the 
associated products.





Configure Price Quote (CPQ)

264 Copyright ©2024 Conga Corporation. All rights reserved.

1.

2.

3.
4.

5.
6.
7.

1.
2.
3.
4.
5.

1.

2.

Removing an Associated Product from the Attribute Group

To remove an associated product from an attribute group
Go to ADMIN SETUP > Product Administration > Attribute. Click the Attribute Group 
tab.
The Attribute Groups page is displayed. Search for the attribute group from where 
you want to remove the associated product.
Click the attribute group name. The Attribute group Details page is displayed.
Click the Associated Product tab. Search for the product you want to remove.

Click the ellipsis ( ) icon. Click Remove.
The Remove Product pop-up is displayed.
Click Confirm.

Editing an Attribute
You can edit any attribute as required. This feature enables you to make the necessary 
changes to the attribute configuration when the requirement changes. 

To edit an attribute
Go to ADMIN SETUP > Product Administration > Attributes. 
Search for the attribute you want to edit.
Click the attribute name. The Attribute Details page is displayed.
Edit the required fields.
Click Save.

Creating Attribute

Editing an Attribute Group
You can edit any attribute as required. This feature enables you to make the necessary 
changes to the attribute configuration when the requirement changes. 

To edit an attribute group
Go to ADMIN SETUP > Product Administration > Attribute. Click the Attribute Group 
tab.
The Attribute Groups page is displayed. Search for the attribute group to edit.
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Click the attribute group name and the Attribute group Details page is displayed.
Edit the required fields.
Click Save.

Creating Attribute Group

Deleting an Attribute
You can delete attributes that are no longer required for your business requirements. 

To delete an attribute
Go to ADMIN SETUP> Product Administration > Attributes. The Attribute page is 
displayed.
Search for the attribute, and do one of the following:

To delete a single attribute, click the ellipsis icon (  next to the attribute 
name, and click Delete.
To delete multiple attributes, click the checkboxes next to the name column, 

and click the ( ) icon.
To delete all the attributes, click the checkbox in the header row next to the 

name column, and click the ( ) icon.
Click Confirm.

Deleting an Attribute Group
You can delete attribute groups that are no longer required for your business requirements. 

To delete an attribute group
Go to ADMIN SETUP > Product Administration > Attributes. The Attributes page is 
displayed.
Click the Attribute Group tab.
The Attribute Groups page is displayed. Search for the attribute group and do one of 
the following: 

To delete a single attribute group, click the ellipsis icon (  next to the attribute 
group name, and click Delete.
To delete multiple attribute groups, click the checkboxes next to the name 

column, and click the ( ) icon.

)

)
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To delete all the attribute groups, click the checkbox in the header row next to 

the name column, and click the ( ) icon.
Click Confirm.

Managing Product Attribute Rules and Attribute Value 
Matrices

Product Attribute Rules (PAR)
PAR are a set of rules that govern the behavior and constraints of product attributes within 
the Conga Platform. These rules ensure that product configurations follows predefined 
standards and business logic.

Key Components
Attribute Definition: Specifies the characteristics and constraints of an attribute.
Product Scope: Define the product, product family, and product group.
Rule Actions: Outline the actions to be taken when the conditions are met, such as 
updating values or triggering notifications.

Use Cases
Ensuring Data Integrity: Enforcing constraints on attribute values to maintain data 
accuracy.
Automating Processes: Triggering automated actions based on attribute values.
Enhancing Product Configurability: Enabling complex product configurations through 
dynamic attribute rules.

Attribute Value Matrices (AVM)
AVMs provide a structured way to manage and map out the relationships between 
different attribute values. This matrix format allows the management of complex attribute 
dependencies and combinations.

Key Components
Matrix Definition: Specifies the structure and dimensions of the matrix, defining which 
attributes are included.
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Attribute Scope: Define the product, product family, product group, and account 
location.
Value Mapping: Details the possible values for each attribute and how they 
interrelate within the matrix.
Dependency Rules: Outline the dependencies and constraints between different 
attribute values.

 Use Cases
Managing Complex Configurations: Simplifying the management of products with 
multiple interdependent attributes.
Ensuring Consistency: Maintaining consistent and valid attribute value combinations 
across products.
Streamlining Product Setup: Facilitating the efficient setup and modification of 
product configurations through structured attribute management.

Navigating the Attributes Page
When you launch the Attributes Rules page on the UI, all the existing PAR and AVM are 
listed on this page on their respective tiles along with their details. There are various 
functionalities available for you to manage the attributes.

Managing Views
You can manage column width, control which columns are displayed in the grid, freeze/pin 
a column range, or rearrange the column order. You can also filter the view of records in the 
grid by performing a keyword search, filtering the list by column value, or applying one or 
more advanced filters and filter logic. For more information, see Managing the View 
Settings and Filtering the Records.

Actions available on this tab
Click Create New > Attribute Value Matrix to create a new AVM.
Click Create New > Product Attribute Rule to create a new PAR.

Click the ellipsis icon (  next to the PAR or AVM name to delete an existing rule.
Use the Active switch to activate or deactivate a PAR or AVM.
At the top of the page, you can see Product Attribute Rules and Attribute Value 
Matrices tiles along with a total count of rules under that rule type. Click the required 
tile to view a list of rules or matrices. 
Export the selected PAR or AVM. For more information, see Exporting Records.

)
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The following section provides information on configuring PAR and AVM.

Creating a Product Attribute Rule
Creating an Attribute Value Matrix
Editing a Product Attribute Rule
Editing an Attribute Value Matrix
Deleting a Product Attribute Rule
Deleting an Attribute Value Matrix

Creating a Product Attribute Rule
You can create an Product Attribute Rules (PAR) as per your business requirements.

To create a PAR
Go to ADMIN SETUP > Product Administration > Attributes Rules. The Attributes Rules 
page is displayed.
Click the Create New drop-down button and click Product Attribute Rule. The New 
Product Attribute Rule page is displayed.
Enter the following details:

Field Description

Rule Name Enter a name for the Product Attribute Rule.

Is Active The active toggle should be enabled only when both the 
scope and action are defined. Until then, the toggle 
remains disabled.

Description Enter a description for the Product Attribute Rule.

Effective Date Select the date when the product attribute rule is in effect. 
Leave this field blank if you want this product attribute 
rule to be always effective.

Expiration Date Select the date when the product attribute rule will 
become invalid. Leave this field blank if you want this 
product attribute rule to be always effective.

Click Save. A PAR is created.



Configure Price Quote (CPQ)

269 Copyright ©2024 Conga Corporation. All rights reserved.

5.
6.
7.

•
•
•
•
•
•

On the Details tab, make changes if required.
Click the Scope & Action tab.
Under PRODUCT SCOPE section, enter the following details:

Field Description

PRODUCT SCOPE

Prod 
uct

It is a multi-select field. Click in the text box to view the available products and 
select the appropriate ones. You can also enter a keyword and search for a product. 
The products are filtered on the basis of product families and product groups that 
you select.

Prod 
uct 
Fami 
ly

It is a multi-select field. Click in the text box to view the available product families 
and select the appropriate ones. You can also enter a keyword and search for a 
product family.

Prod 
uct 
Grou 
p

It is a multi-select field. Click in the text box to view the available product groups 
and select the appropriate ones. You can also enter a keyword and search for a 
product group. The product groups are filtered on the basis of product families that 
you select.

Crite 
ria

Enter the formula to be evaluated. When this formula evaluates to true, the rule is 
executed.

ACTIONS

Targ 
et 
Field

Search and select the target attribute. Use type ahead to display a list of 
applicable fields or attributes.

Actio 
n 
Type

Select the action that you want to perform on the product attribute. Supported 
values are:

Allow - To restrict the visibility of values on the target field.
Default - To add a default value on the target attribute.
Hidden - To hide the target attribute.
Disabled - To make the target attribute as a read-only field.
Required - To make the target attribute as a required field.
Reset - To auto-populate a default value on the target attribute if the 
field is left blank.
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Field Description

Valu 
e 
Expr 
essio 
n

Enter the Value Expression.

Click Save.

Editing a Product Attribute Rule

Deleting a Product Attribute Rule

Creating an Attribute Value Matrix
You can create an Attribute Value Matrices (AVM) as per your business requirements.

To create AVM
Go to ADMIN SETUP > Product Administration > Attributes Rules. The Attributes Rules 
page is displayed.
Click the Create New drop-down button and click Attribute Value Matrix(AVM). The 
New Product Attribute Matrix page is displayed.
Enter the following details:

Field Description

Rule Name Enter a name of the Attribute Value Matrix.

Is Active Turn this setting on to make the matrix active.

Description Enter a description of the Attribute Value Matrix.

Effective Date Select the date from which the Attribute Value Matrix is in 
effect.

Expiration Date Select the date until which the attribute value matrix is 
valid.
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Field Description

Application Type Select the application type. Supported values are

Default: Selecting this lets you choose the picklist 
values which you have configured as default 
values in the Matrix View. The rest of the values 
are visible in the drop-down list, but you cannot 
select any of them on the Cart.
Constraint: Selecting this value lets you choose 
only those picklist values which you have 
configured in the Matrix View. All the other values 
are disabled in the drop-down list on the cart. This 
also works with the Multi-select picklist.
Force Set: Selecting this value lets you 
automatically set the picklist values which you 
have configured in the Matrix View (considering 
the last user selection). As soon as you change the 
attribute value for one attribute, the system sets 
the attribute values for other attributes 
immediately. If there is a Matrix entry with null 
values and Treat Null As Wildcard is set to false, 
the system resets the attribute values to null.

Treat Null as Wildcard This field works in conjunction with Application Type. If you 
select this check box, all the picklist values (default or 
constrained) configured in the Matrix View are available for 
selection on the Cart. Deselecting this check box disables 
all the picklist values on the Cart.

Click Save. An AVM is created.
On the Details tab, make changes if required.
Click the Scope & Matrix tab.
Enter the following details:

Field Description

SCOPE
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Field Description

Produ 
ct

It is a multi-select field. Click in the text box to view the available products and 
select the appropriate ones. You can also enter a keyword and search for a 
product. The products are filtered on the basis of product families and product 
groups that you select.

Produ 
ct 
Famil 
y

It is a multi-select field. Click in the text box to view the available product families 
and select the appropriate ones. You can also enter a keyword and search for a 
Product Family.

Produ 
ct 
Group

It is a multi-select field. Click in the text box to view the available product groups 
and select the appropriate ones. You can also enter a keyword and search for a 
product group. The product groups are filtered on the basis of product families 
that you select.

Accou 
nt 
Locati 
on

It is a multi-select field. Click in the text box to view the available account 
locations and select the appropriate ones. You can also enter a keyword and 
search for a location. The locations are filtered on the basis of product families, 
product groups, and products that you select.

CHOOSE ATTRIBUTE TO CREATE MATRIX

Attrib 
ute

This field is used to define the attributes to be used with the matrices. 

If you need to define different matrices for different attributes, make sure the 
attribute column is added. If you would like to add another attribute, Click the (+) 
icon and select the value from the picklist and click the Update Matrix button.

MATRICES

Colum 
n 
Name

As per the passed Attribute values, the Matrix Table should be created. One or 
more than one matrices can be provided in the Matrix by clicking on Add button 
and you can delete a particular row by clicking the delete icon (  icon.

In the Matrix, enter the relevant values.

Click Save.

If you create an AVM from a product, the product is populated on this field 
based on the parent product.



)
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Editing an Attribute Value Matrix

Deleting an Attribute Value Matrices

Editing a Product Attribute Rule
You can edit any Product Attribute Rule (PAR) as required. This feature enables you to make 
the necessary changes to the PAR configuration when the requirement changes. 

To edit a PAR
Go to ADMIN SETUP > Product Administration > Attributes Rules. The Attributes Rules 
page is displayed.
In the PAR section, search for the PAR you want to edit.
Click the PAR name. The PAR Details page is displayed.
Edit the required fields.
Click Save.

Creating a PAR

Editing an Attribute Value Matrix
You can edit any Attribute Value Matrix (AVM) as required. This feature enables you to 
make the necessary changes to the AVM configuration when the requirement changes. 

To edit a AVM
Go to ADMIN SETUP > Product Administration > Attributes Rules. The Attributes Rules 
page is displayed.
In the AVM section, search for the AVM you want to edit.
Click the AVM name. The AVM Details page is displayed.
Edit the required fields.
Click Save.

Creating an Attribute Value Matrix

Deleting a Product Attribute Rule
You can delete Product Attribute Rules (PAR) that are no longer required for your business 
requirements. 
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To delete PAR
Go to ADMIN SETUP > Product Administration > Attribute Rules. The Attribute rules 
page is displayed
On the Product Attribute Rules tab, search for the PAR you want to delete and do one 
of the following:

To delete a single PAR, click the ellipsis icon (  next to the PAR name, and 
click Delete.
To delete multiple PAR, click the checkboxes next to the name column, and click 

the ( ) icon.
To delete all the PAR, click the checkbox in the header row next to the name 

column, and click the ( ) icon.
Click Confirm.

Deleting an Attribute Value Matrix
You can delete Attribute Value Matrices (AVM) that are no longer required for your business 
requirements. 

To delete AVM
Go to ADMIN SETUP > Product Administration > Attribute Rules. The Attribute rules 
page is displayed
On the Attribute Value Matrices tab, search for the AVM you want to delete and do 
one of the following:

To delete a single AVM, click the ellipsis icon (  next to the AVM name, and 
click Delete.
To delete multiple AVM, click the checkboxes next to the name column, and click 

the ( ) icon.
To delete all the AVM, click the checkbox in the header row next to the name 

column, and click the ( ) icon.
Click Confirm.

)

)
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Managing Field Expressions
A field expression is a predefined expression used to update record fields based on certain 
criteria, particularly on the line items. These expressions are managed through the CPQ 
Admin interface and are essential for automating and customizing the behavior of CPQ 
according to specific business logic. You can apply field expressions when configuring 
products and adding a line item to the cart. You can view a line item or attribute field 
update based on the criteria of a field expression on the cart page. This feature enables 
you to have the correct configuration while adding the products to the cart. Field 
expressions can be used to set standard line item fields, such as Selling Term or End Date, 
based on the criteria of the Line Item or product attributes. For example, if a product 
attribute named Term has values like 1 Year and 3 Years, a field expression can be written 
to set the selling term of the line item based on the selected term.

 
Field expressions are different from formula fields, which are used for calculating values at 
runtime and can impact performance, especially when used in large numbers on objects 
like line items. Field expressions are used to update records based on criteria, while formula 
fields calculate values dynamically based on other field values. While field expressions can 
update many fields, there are best practices to consider. For instance, using too many 
formula fields on line items is not advised, as they are calculated at runtime and can 
impact performance. Instead, using numeric expressions is suggested. The benefits of using 
field expressions include the ability to automate record updates based on specific criteria, 
which can streamline processes and reduce the need for manual updates.

Navigating the Field Expressions Page
When you launch the Field Expressions page on the UI, all the existing field expressions are 
listed on this page along with their details. There are various functionalities available for 
you to manage the field expressions.

Managing Views
You can manage column width, control which columns are displayed in the grid, freeze/pin 
a column range, or rearrange the column order. You can also filter the view of records in the 
grid by performing a keyword search, filtering the list by column value, or applying one or 
more advanced filters and filter logic. For more information, see Managing the View 
Settings and Filtering the Records.
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Actions available on this page
Click New Field Expression to create new field expressions.

Click the ellipsis icon   next to the field expression name to delete an existing field 
expression.
Click the field expression name link to open the field expression details page.
Export the selected field expressions. For more information, see Exporting Records.

 

The following sections describe various operations for managing field expressions:

Creating a Field Expression
Editing a Field Expression
Deleting a Field Expression

Creating a Field Expression
Create a field expression to update record fields based on certain predefined criteria and 
reduce the need for manual updates.

To create a field expression
Go to ADMIN SETUP > Product Administration > Field Expressions.
Click Create New to open a New Field Expression pop-up.
Enter the following details:

Field Description

Name Enter the name of the field expression

Is Active Turn this button on to activate the field expression.

Is Modifiable Turn this button on to enable editing of the field 
expression.

Expression Type This field is populated by default with the value Field 
Update.

Expression Context This field is populated by default with the value 
Record Update. 
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Field Description

Source Object This field is populated by default with the value Line 
Item.

Scope Select one of the following values that are displayed 
in the dropdown:

Product: to apply field expression on the 
product line items.
Product Group: to apply field expression on 
the product group level.
Header Level: to apply field expression on 
fields at header level.

Based on your selection, you must select a product or 
product group.

Click Create. A field expression is created and you are redirected to the details page.
Click Expression under Filter Expression, and use the formula builder to create a 
formula. 

 
Go to the Field tab and search for your desired field from the list.
Click the arrow next to the field name to view and select its related child fields. 
The formula expression, determined by the selected object-field and/or subfield, 
appears on the right panel of the application.
Click Insert to add it to the expression.
Go to the Functions tab, select a function from the list, and click Insert to add it 
to the expression.
Click any operator available below the expression window to add it to the 
expression.
Continue building your expression.
Click Save.

In Update Object, select one of the following from the drop-down.
Product Attribute
Line Item

In Update Field, select the field on which you want to apply the field expression. 
Click Expression under Value Expression, and refer Step 5a to Step 5g to use the 
formula builder to create a formula.

For adding an expression, you can choose from three fields: Line Item, Product, 
and Attribute. Select any of these fields to create an expression.


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Click Save or click Save & Create New.

Editing a Field Expression
You can edit a field expression as required. 

To edit a field expression
Go to ADMIN SETUP > Product Administration > Feature Set.
Click on the name of the field expression and modify it as required.
Click Save.

Deleting a Field Expression
You can delete a field expression if required.

To delete a field expression
Go to ADMIN SETUP> Product Administration >Field Expressions.
Search for the field expression and do one of the following:

To delete a field expression, click the ellipsis icon (  next to the field expression 
name, and click Delete.
To delete multiple field expressions, click the checkboxes next to the name 

column, and click the ( ) icon.
To delete all the field expressions, click the checkbox in the header row next to 

the name column, and click the ( ) icon.
Click Confirm.

Creating a Field Expression

Managing Field Expressions

Managing the Feature Sets
Feature sets are collections of features that can be associated with a product to define its 
capabilities or specifications. They are used to organize and manage product features in a 
structured way, which can be particularly useful for product comparison on the catalog 
pages. You can define the sequence of features within a feature set. When you create a 
feature set in the CPQ Admin console, you can add multiple features to it. Each feature you 
add is assigned a sequence number that is auto-populated. If you need to rearrange the 

)
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sequence of these features, you can do so by clicking and dragging the rows to the desired 
order. Once you have arranged the features in the sequence you prefer, you can save the 
feature set, and this sequence is retained.

When a feature set is created, it must be associated with a product. The association allows 
for the comparison on the catalog pages. 

Feature sets enable the comparison of products by allowing you to see different features 
side by side. This is particularly useful when products have minor differences that need to 
be highlighted.

Navigating the Feature Sets Page
When you launch the feature sets page on the UI, all the existing feature sets are listed on 
this page along with their details. There are various functionalities available for you to 
manage the feature sets.

Managing Views
You can manage column width, control which columns are displayed in the grid, freeze/pin 
a column range, or rearrange the column order. You can also filter the view of records in the 
grid by performing a keyword search, filtering the list by column value, or applying one or 
more advanced filters and filter logic. For more information, see Managing the View 
Settings and Filtering the Records.

Actions available on this page
Click Create New to create a new feature set.

Click the ellipsis icon   next to the feature set name to edit an existing feature set.
Click the feature set name link to open the feature set Details page.
Export the selected feature sets. For more information, see Exporting Records.

 

The following sections describe various operations for managing feature sets:

Creating a Feature Set
Editing a Feature Set
Deleting a Feature Set
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Creating a Feature Set
You can organize product features in a structured way in feature sets. To create a feature 
set, you must first define the feature set name and description, then define individual 
features within that set, including their names and descriptions. Once created, you can add 
multiple features to a feature set and rearrange their sequence.

To create a feature set
Go to ADMIN SETUP> Product Administration > Feature Sets.
Click Create New to open a New Feature Set pop-up.
Enter the following details:

Field Description

Feature Set Name Enter a name for the feature set.

Sequence Give a sequence number to the new feature set. It should 
have a unique value from existing feature sets.

Description Enter a description.

Click Create. A Feature Set is created and you are redirected to the Details tab.
On the Details tab, review the information and make changes if required.
Click the Features tab, and click Add New.
Enter a name and description of the feature.
Click Add New to add another feature.
Click Save.

Managing the Feature Sets

Editing a Feature Set
You can edit a feature set as required. 

To edit a feature set
Go to ADMIN SETUP > Product Administration > Feature Set.
Click on the name of the feature set and modify as required.
Click Save.

Managing the Feature Sets
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Deleting a Feature Set
You can delete a feature set if required. 

To delete a Feature Set
Go to ADMIN SETUP> Product Administration >Feature Sets.
Search for the feature  set and do one of the following:

To delete a feature set, click the ellipsis icon (  next to the feature set name, 
and click Delete.
To delete multiple feature sets, click the checkboxes next to the name column, 

and click the ( ) icon.
To delete all the feature sets, click the checkbox in the header row next to the 

name column, and click the ( ) icon.
Click Confirm.

Creating a Feature Set

Managing the Feature Sets

Managing the Rollups

Roll-Up Summary Fields
A roll-up summary field is a calculated field on a master record that aggregates data 
from its related detail records. The types of calculations typically supported include sums, 
averages, minimums, and maximums, among others. These fields automatically update as 
the detail records change, ensuring that the summary data is always current.

Key Components
Master Record: The main record that displays the roll-up summary field.
Detail Records: The related records whose values are aggregated to populate the 
roll-up summary field.
Calculation Type: The specific type of aggregation performed, such as sum, average, 
min, or max.
Field Criteria: Conditions that detail records must meet to be included in the roll-up 
calculation.

)
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Functionality
Automatic Updates: Roll-up summary fields are dynamically updated whenever the 
related detail records change, ensuring accurate and up-to-date summary data.
Aggregation Types:

Sum: Adds up the values of a specified field from the detail records.
Average: Calculates the average value of a specified field from the detail 
records.
Min/Max: Finds the minimum or maximum value of a specified field from the 
detail records.
AND/OR: Includes either one condition or multiple conditions.

Conditional Criteria: Roll-up summary fields can be configured to only include detail 
records that meet certain conditions, allowing for more tailored and relevant 
summaries.

Use Cases
Sales Performance: Summarize total sales amounts from individual sales 
transactions to provide an overall sales figure on the master sales record.
Inventory Management: Calculate the total quantity of items in stock by 
aggregating quantities from individual inventory records.
Customer Accounts: Display the total balance due by summing up outstanding 
invoices related to a customer account.
Project Management: Aggregate total hours worked from individual time logs to 
display on a master project record.

Benefits
Roll-up summary fields provide improved data visibility by offering a clear and concise view 
of aggregated data directly on the master record, enhancing comprehensive reporting and 
analysis of key metrics. They boost operational efficiency by automating calculations and 
updates, thus saving time and reducing errors. These fields also ensure real-time insights, 
enabling timely and informed decision-making.

Navigating the Rollups Page
When you launch the rollups page on the UI, all the existing rollups are listed on this page 
along with their details. There are various functionalities available for you to manage the 
rollups.



Configure Price Quote (CPQ)

283 Copyright ©2024 Conga Corporation. All rights reserved.

•

•
•
•

•
•
•

1.
2.
3.

Managing Views
You can manage column width, control which columns are displayed in the grid, freeze/pin 
a column range, or rearrange the column order. You can also filter the view of records in the 
grid by performing a keyword search, filtering the list by column value, or applying one or 
more advanced filters and filter logic. For more information, see Managing the View 
Settings and Filtering the Records.

Actions available on this page
Click Create New to create a new rollup.

Click the ellipsis icon   next to the rollup name to delete an existing rollup.
Click the rollup name link to open the rollup Details page.
Export the selected rollups. For more information, see Exporting Records.

 

This section provides information on configuring option groups.

Refer to the following topics for more information.

Creating the Rollups
Editing the Rollups
Deleting the Rollup

Creating the Rollups

To create a Rollup
Go to ADMIN SETUP> Product Administration > Rollups. The Rollups page is displayed.
Click the Create New button. The New Rollup page is displayed.
Enter the following details:

Field Description

Rollup Name Enter a name for the Rollup.

Is Active Switch the toggle to on if the rollup is active.

Is Modifiable Switch the toggle to on if the rollup can be modified.
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Field Description

Scope This is a picklist value, where you have to choose whether 
the rollup belons to the product or the product group.

Once the rollup is created, you can configure the rollup. 

Field Description

DETAILS

Name Enter a name for the Feature

Is Active Switch the toggle to on if the rollup is active.

Is Modifiable Switch the toggle to on if the rollup can be modified.

Scope This is a picklist value, where you have to choose 
whether the rollup belons to the product or the product 
group.

Product Select the product that you want to associate the rollup 
with.

Filter Expression Add the formula field.

ACTION

Update Object Update the object type.

Update Field Update the field associated with the rollup.

Operator Choose the operator value.

Value Expression Enter the formula that needs to be calculated.

Click Save to save the updates.
Click Save & Create New to save the updates and create new Rollup.
Click Discard Changes to delete the updates
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Editing the Rollups
You can edit any rollup as required. This feature enables you to make the necessary 
changes to the rollup configuration when the requirement changes. 

To edit an rollup
Go to ADMIN SETUP > Product Administration > Rollups. The rollups page is 
displayed.
Search for the rollup you want to edit.
Click the rollup name. The rollup Details page is displayed.
Edit the required fields.
Click Save.

Deleting the Rollup
You can delete rollups that are no longer required for your business requirements. 

To delete a rollup
Go to ADMIN SETUP > Product Administration > Rollups. The Rollups page is 
displayed.
Search for the rollup and do one of the following: 

To delete a single rollup, click the ellipsis icon (  next to the rollup name, and 
click Delete.
To delete multiple rollups, click the checkboxes next to the name column, and 

click the ( ) icon.
To delete all the rollups, click the checkbox in the header row next to the name 

column, and click the ( ) icon.
Click Confirm.

Pricing Administration
This section provides information on pricing products.

Managing Price Lists
Managing Price Dimensions
Managing Price Rulesets
Managing Deal Guidance

)
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Managing Promotions
Managing the Price Waterfall

Managing Price Lists
Price lists are containers of price list items. Price lists can also have a currency set if your 
environment is multi-currency enabled.

Price lists are associated with categories so that an end user can view and select products 
from the shopping cart. For example, Price list A is associated with Category B, when you 
select price list A on the Quote/Proposal Edit page, only category B and associated 
products are displayed in the shopping cart.

You can create a price list at any time; however, it is most efficient to create a price list 
before creating products to easily associate the products with the price list.

Navigating the Price Lists Page
When you launch the Price Lists page on the UI, all the existing price lists are listed on this 
page along with their details. There are various functionalities available for you to 
manage the price lists.

Managing Views
You can manage column width, control which columns are displayed in the grid, freeze/pin 
a column range, or rearrange the column order. You can also filter the view of records in the 
grid by performing a keyword search, filtering the list by column value, or applying one or 
more advanced filters and filter logic. For more information, see Managing the View 
Settings and Filtering the Records.

Actions available on this page
Click Add New to create a new price lists.

Click the ellipsis icon  next to a price list name to delete or clone an existing price 
list.
Click the price list name link to open the Price Lists details page.
Use the Active switch to activate or deactivate a price list.
Export the selected price lists. For more information, see Exporting Records.
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This section provides information on managing price lists.

Creating a Price List
Editing a Price List
Cloning a Price List
Deleting a Price List
Managing Price List Items
Associating Categories with a Price List

Creating a Price List
You can create a price list at any time; however, it is most efficient to create a price list 
before creating products to easily associate the products with the price list.

To create a price list
Go to ADMIN SETUP > Pricing Administration > Price Lists. The Price Lists page is 
displayed.
Click Add New. The New Price List pop-up is displayed.
Enter the following details:

Field Description

Price List Name Enter the name for the price list. This is a mandatory 
field.

Active Turn this field on to make the price list active.

Currency Enter the currency for the price list. By default, the 
currency of the org is selected. This is a mandatory field.

Account Search and select an account to be associated with the 
price list.

Description Enter a description for the price list.

Effective Date Select a date from when the price list must be effective.

Expiration Date Select a date on which the price list must be expired or 
made inactive.
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Field Description

Price List Type Select the type of price list from the drop-down. 
Supported values are:

Standard: Select standard price list if the 
quote derives its pricing from price list and its 
related price list items configured in CPQ.
Contract: Select contract price list if the quote 
derives its pricing from an agreement. You 
must also associate a contract number when 
you select this price list.

Contract Number Enter a contract number to which you want to 
associate this price list. This enables contract pricing in 
CPQ.

Disable based on currency 
Adjustment

Turn this setting on to disable currency conversion on 
the price list. By default, this setting is turned off.

When this setting is enabled, CPQ ignores the currency 
conversion. For example, the currency of the master 
price list is USD [100 USD] and the child price list is based 
on master PL and the currency is GBP.  When this setting 
is enabled, CPQ displays 100 GBP on the cart.

 

Based on Price List
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Field Description

Based on Price List Name Search and select the name of an existing price list 
depending on which the new price list is created.

 

Price List Level Adjustment

•
•
•

This field is useful in scenarios such as your 
organization wants to sell the same products in 
different currencies or in the same currency with 
some discount.
For example, your organization sells products in 
the United States in the USD currency. You have 
created a price list called USD Price List. For all 
products, you have created the required price 
list items, which are associated with USD Price 
List. Now you want to sell the same products in 
Great Britain in the GBP currency. You can 
create another price list with the following 
details:

PriceList Name: GBP Price List
Currency: GBP - British Pound
Based On Price List: USD Price List

If you sell a product that costs 1 USD in the 
Unites States, the price of it will be converted to 
GBP based on the currency conversion rate 
defined. In this way, you can create a price list 
based on another price list, without creating 
corresponding price list items.


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Field Description

Adjustment Type Select the type of adjustment. Supported values are:

% Discount: If the user applies a % discount 
type of adjustment, the list price is discounted 
by a percentage specified in the Adjustment 
Amount field. The new amount is stored on the 
cart line item.
Discount Amount: If the user applies a discount 
amount of adjustment, the list price is 
discounted by a percentage specified in the 
Adjustment Amount field. The new amount is 
stored on the cart line item.
Markup Amount: If the user applies a markup 
amount of adjustment, the list price is 
increased by the amount specified in the 
Amount adjustment field. The new amount is 
stored on the cart line item.
Price Factor: This is a multiplier. Select this 
and enter an amount in the Adjustment 
Amount field. Using this price factor, CPQ 
multiplies the list price on the cart.
% Markup: If the user applies a percentage 
markup of adjustment, the list price is 
increased by the percentage specified in the 
Amount adjustment field. The new amount is 
stored on the cart line item. For example, if 
you want to increase the price of laptops 
during the month of September, you can apply 
a markup amount or a percentage markup 
that adds to the List price.

Adjustment Amount Enter a value based on the adjustment type that you 
have selected.

Click Save. The Price List Details page is displayed with all information you provided.
On the Details tab, update the details if required and click Save.

A price list is created and saved. You can associate products with the price list.
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Editing a Price List
You can edit a price list as required when the requirement changes. 

To edit a price list
Go to ADMIN SETUP > Pricing Administration > Price Lists. The Price Lists page with all 
price lists is displayed.
Search for the price list you want to update.
Click the price list name link. The Price List Details page is displayed.
On the Details tab, update the required fields.
Click Save.

Cloning a Price List
You can create a new price list from the existing price list using a clone option. 

To clone a price list
Go to ADMIN SETUP > Pricing Administration > Price Lists. The Price Lists page with all 
price lists is displayed.
Search for the price list you want to clone.

Click the ellipsis icon  next to the product name and click Clone. The Clone Price List 
pop-up is displayed.
By default, the Price List Name will be Clone-The price list name from which you have 
cloned and all the field values will be similar to the cloned price list.
Click Clone.

Deleting a Price List
You can delete price lists that are no longer required for your business requirements. 

To delete a price list
Go to ADMIN SETUP> Pricing Administration > Price List. The Price list page is 
displayed.
Search for the price list, and do one of the following:

To delete a single price list, click the ellipsis icon (  next to the price list name, 
and click Delete.

)



Configure Price Quote (CPQ)

292 Copyright ©2024 Conga Corporation. All rights reserved.

•

•

3.

To delete multiple price lists, click the checkboxes next to the name column, and 

click the ( ) icon.
To delete all the price lists, click the checkbox in the header row next to the 

name column, and click the ( ) icon.
Click Confirm.

Managing Price List Items
Price List Items (PLIs) contain detailed pricing information about a product.

A product can be set up with one or more price list items. Each price list item includes the 
list price for the product including details of charges such as per unit, flat price, one time, 
recurring, and more. All the fields on a price list item are price related and impact the final 
price on the shopping cart. Each price list item represents different ways, a customer is 
charged for a product. For example: License fee, Implementation fee, and more. Price list 
items are categorized into price lists.

Navigating the Price List Items Tab on a Price List
When you launch the Price List Items tab on a price list on the UI, all the existing price list 
items in the price list are listed on this tab along with their details. There are various 
functionalities available for you to manage the price list items.

Price list item search

You can narrow down the price list items using the search feature. In basic search, you can 
search for a price list item using keywords. For example, you can search using the name of 
the price list item. 

The order of PLIs is based on the "Sequence" field, administrators must define the 
sequences accordingly to ensure the correct PLIs are resolved on Catalog and 
Pricing.
If a product has multiple price list items (PLIs) with the same charge type, the 
catalog page shows those products in the order of their sequences in the PLIs. The 
PLI with the lowest sequence number appears first on the catalog screen. When you 
add a product from the catalog screen, the system prioritizes the sequence defined 
in the PLI charge type picklist metadata to display the products in the cart grid.


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In the Search this list field, enter a keyword related to your price list item name.
Click the search icon   or press Enter. CPQ returns all price list items that contain 
that keyword in the price list item names.

Actions available on this tab

Click the available products icon  on the right side panel to add Products to 
configure price list items.

Click the ellipsis icon  next to a price list item name to add a charge type to a 
product, add a charge type criteria, or remove an existing price list item.
Click the advanced setup icon  next to a price list item name to add configure 
advanced settings for an existing price list item.
Click the product name link to open the product details page.
Update the following details in a price list item:

Charge Type
List Price
Price Type
Frequency
Price Method

Use the Active switch to activate or deactivate a price list item.
Discard any changes you performed to the price list items.
Save any changes you performed to the price list items.

Adding Charge Types to a Product

To add a charge type to a product

Go to ADMIN SETUP > Pricing Administration > Price Lists. The Price Lists page is 
displayed.
Click the required price list name link to open the Price Lists details page.
Click the Price List Items tab.
Search for the product to which you want to add a charge type.

Click the ellipsis icon   next to a product name and click Add Charge Type. A new 
charge type is added for the selected product. Multiple charge types for the same 
price list are together.

To remove a charge type from a product

You must remove the price list item to remove a charge type.

Go to ADMIN SETUP > Pricing Administration > Price Lists. The Price Lists page is 
displayed.
Click the required price list name link to open the Price Lists details page.



Configure Price Quote (CPQ)

294 Copyright ©2024 Conga Corporation. All rights reserved.

3.
4.

5.

•

•

1.

2.
3.
4.

5.

6.
a.
b.
c.
d.

e.
f.
g.

h.
7.

a.
b.
c.
d.

e.
f.

Click the Price List Items tab.
Search for the product from which you want to delete a charge type.

Click the ellipsis icon   next to a product name and click Remove to delete an 
existing price list item.

If there are any unsaved changes, the Editing item(s) in Price List Items pop-up is 
displayed. Click Discard Changes. The Delete Price List Item pop-up is 
displayed. Click Delete.
If there are no unsaved changes, the Delete Price List Item pop-up is displayed. 
Click Delete.

Adding Charge Type Criteria to a Product

To add a charge type criteria to a product

Go to ADMIN SETUP > Pricing Administration > Price Lists. The Price Lists page is 
displayed.
Click the required price list name link to open the Price Lists details page.
Click the Price List Items tab.
Search for the product to which you want to add a charge type criteria.

Click the ellipsis icon  next to a product name and click Charge Type Criteria. The 
Charge Type Criteria pop-up is displayed.
On the Line Items tab, enter the following details:

Field: Select a field on the product. You can select custom fields also.
Operator: Select an operator.
Value: Enter a value.
Click Add Criteria to add one more criteria.

Click the remove icon  to remove a criteria.
Click Remove All to remove all criteria.
Turn the Logic button on and enter a value in the Logic field when you add 
multiple criteria.
Click Save.

On the Product Attributes tab, enter the following details: 
Field: Select a field on the product. You can select custom fields also.
Operator: Select an operator.
Value: Enter a value.
Click Add Criteria to add one more criteria.

Click the remove icon  to remove a criteria.
Click Remove All to remove all criteria.
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Turn the Logic button on and enter a value in the Logic field when you add 
multiple criteria.
Click Save.

Click Save on the Price List Items tab.

To remove a charge type criteria from a product

You must remove the price list item to remove a charge type.

Go to ADMIN SETUP > Pricing Administration > Price Lists. The Price Lists page is 
displayed.
Click the required price list name link to open the Price Lists details page.
Click the Price List Items tab.
Search for the product from which you want to remove a charge type criteria.

Click the ellipsis icon  next to a product name and click Charge Type Criteria. The 
Charge Type Criteria pop-up is displayed.

On the Line Items tab, click the remove icon  to remove a criteria and click Save.

On the Product Attributes tab, click the remove icon    to remove a criteria and click 
Save.
Click Save on the Price List Items tab.

Creating a Price List Item
This section provides information on creating a price list item for a product from a price list. 
You can associate more than one product to the price list and create price list items for 
those products.

To create a price list item

Go to ADMIN SETUP > Pricing Administration > Price Lists. The Price Lists page is 
displayed.
Click the required price list name link to open the Price Lists details page.
Click the Price List Items tab. Under Available Products, you can see all products 
available in the org.
In the Search Products field, enter keywords to search the product you want to 
associate with the price list and click the search icon   or press Enter.
Hover the mouse on the required product and click + next to the product name. A price 
list item is created for the product with default values and is displayed in the Price 
List Items section (right-hand side).

Hover the mouse on the required product and click the   icon next to the 
product name to display more information about the product.


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Enter the following details:
From the Charge Type drop-down, select the required charge type for the 
product. The default value is the default charge type of the org. Supported 
values are:

Standard Price
License Fee
Subscription Fee
Implementation Fee
Installation Fee
Adjustment
Service Fee
Rental Price
Sales Price
Usage Fee
Consulting Fee

In the List Price field, enter a list price for the product. The default value is 0 
(zero).
From the Price Type drop-down, select the price type. Supported values are:

One Time (default value)
Recurring
Usage

From the Frequency drop-down, select the frequency for the product. Supported 
values are:

Hourly
Daily
Monthly
Quarterly
Half Yearly 
Yearly 
Weekly

From the Price Method drop-down, select the price method for the product. 
Supported values are:

•

•

If the Price Type is Usage on a price line item(PLI), the Matrix 
Type should also be Usage while creating a price matrix. 
CPQ supports only this combination.
You will be forced to provide the frequency if it's Price Type is 
Recurring or Usage so that you can have the frequency 
defined.


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Per Unit (default value)
Flat Price
Percentage
Related Price
Tiered Price

The Active switch for the price list item is turned on by default.
Click Save.

To delete a price list item

Go to ADMIN SETUP > Pricing Administration > Price Lists. The Price Lists page is 
displayed.
Click the required price list name link to open the Price Lists details page.
Click the Price List Items tab.
In the Price List Items section, search for the price list item you want to delete.

Click the ellipsis icon   next to a product name and click Remove to delete an 
existing price list item.

If there are any unsaved changes, the Editing item(s) in Price List Items pop-up is 
displayed. Click Discard Changes. The Delete Price List Item pop-up is 
displayed. Click Delete.
If there are no unsaved changes, the Delete Price List Item pop-up is displayed. 
Click Delete.

Adding Default Pricing to a Product

You can apply default pricing to a product from the Defaults tab. This tab enables you to 
apply default quantity and pricing to a product.

To apply default pricing to a product

You must have an existing price list item.

Go to ADMIN SETUP > Pricing Administration > Price Lists. The Price Lists page is 
displayed.
Click the required price list name link to open the Price Lists details page.
Click the Price List Items tab. 
Click the advanced setup icon  next to a price list item name. The price list item 
details page is displayed.
On the Defaults tab, enter the following details:

Clicking the product name link under the Price List Items section redirects you to the 
product details page.


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Field Description

QUANTITY

Default Quantity 
From

Select an option from where default quantity is to be considered. If the 
price list item derives its default quantity from a specific attribute, 
when the user navigates to the catalog page and selects a product 
and its attribute, the default quantity of the product is derived based 
on a number selected from an attribute of type picklist or number. 
Supported values are:

Product Configuration
Product Attribute
Advanced Formula

Default Quantity 
Field

This field is dependent on the Default Quantity From field. Select a 
default quantity field.

Default Quantity Enter the default quantity.

Is Quantity Read 
Only

Select this to make the Quantity field non-editable on the cart.

PRICE

Default Price 
From

Select an option from where default price can be considered. Supported 
values are:

Advanced Formula 

Product Attribute

Default Price 
Field

This field is dependent on the Default Price From field. Search and 
select a default price field.

SELLING TERM

Advanced Formula is not supported in July '23.

Advanced Formula is not supported in July '23.
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Field Description

Default Selling 
Term

Enter the default selling term.

Is Selling Term 
Read Only

Select this to make the Selling Term field non-editable on the cart.

CASCADE

Auto Cascade 
Quantity

Select to automatically cascade quantity.

Auto Cascade 
Selling Term

Select to automatically cascade selling term.

AUTO RENEW

•

•

•

If a product has two PLIs of Recurring type and PLI 1 has 
Default Selling Term mentioned on it while PLI 2 does not have 
Default Selling Term, then on product configuration, the selling 
term of PLI 2 gets auto-updated in line with the selling term of 
PLI 1.
When Price Type = Recurring, CPQ calculates the selling term 
on the cart as follows:

If you provide the Default Selling Term (but the cart 
line item does not have start date and end date), 
CPQ calculates the selling term based on the default 
selling term.
If the cart line item has start date and end date (but 
you do not provide the Default Selling Term), CPQ 
calculates the selling term based on the start date 
and end date.
If you provide the default selling term and the cart 
line item also has start date and end date, CPQ gives 
precedence to the start and end dates, and 
calculates the selling term accordingly.



Suppose you have one bundle with two options.
Option 1 has Auto Cascade Selling Term set to False. 
Option 2 has Auto Cascade Selling Term set to True.
If you change the bundle selling term, it will only cascade to 
Option 2, but not Option 1.


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6.

1.
2.
3.
4.

5.

Field Description

Auto Renew

Auto Renewal 
Type

Auto Renewal 
Term

Click Save before you navigate away from this tab. Otherwise, CPQ displays an error 
message.

Adding Details to a Price List Item

Go to the Price Lists page (ADMIN SETUP > Pricing Administration > Price Lists).
Click a price list name link to open the Price List Details page.
Click the Price List Items tab. 
Click the advanced setup icon ( ) next to a price list item name. The price list item 
details page is displayed.
Select the Details tab and enter the following details:

Field Description

DETAILS

Charge Type Select a charge type. These are a separate, identifiable 
element of charges that can be used for pricing. For 
example: Standard Price, Maintenance Fee, Installation 
Fee, and more.

Active Turn the setting on to make the price list item active.

Do not use this field in June '23.

Do not use this field in June '23.

Do not use this field in June '23.
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Field Description

Charge Type Criteria Configure charge type criteria.

This is used for conditional charge types that are 
included only if a certain criterion is met and as part of 
adding the main product to the cart. Define this criterion 
against a Line Item or Attribute field value to apply the 
price list item when the criterion is satisfied. For example, 
this may be a charge type based on workstations, while 
the product may have a charge type based on users.

List Price Enter a list price for a product in the price list item. If the 
price list item has matrices or may be overridden, enter 0 
or null as the list price.

Cost Enter the product's cost.

Effective Date Enter an effective date for the price list item.

Expiration Date Enter an expiry date for the price list item.

Price Type Select One Time, Recurring, or Usage. Selecting Recurring 
or Usage enables the Frequency field. For instance, to 
add a subscription product, choose Recurring as the 
type and then specify the frequency as monthly, yearly, 
and so on.

A product must have at least one price list item 
without any charge type criteria to be priced in 
the cart.
If you are using the Charge Type Criteria setting, 
you must define a criterion for all PLIs (Price List 
Item)s. Do not define that same criterion for more 
than one PLI. Criteria must be mutually exclusive 
so that CPQ does not apply two PLIs while 
pricing a product.


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•
•
•

•

•

Field Description

Price Method Select one of:

Per Unit: Multiplies the price by the quantity.
Flat Price: Applies a flat price.
Percentage: Enables the Percent, Percent 
Applies To, and Related Price List Item fields.
Related Price: Used when the price is 
calculated as a function of the price of other 
lines in the same shopping cart.
Tiered Rate: Default price method for the 
Usage price type.

Frequency If your Price Type field selection is Recurring or Usage, 
select an option to indicate how often the product shall 
be charged. 

If you selected Usage in the Price 
Type field, select Tiered Rate here. CPQ 
does not prevent you from creating 
other combinations, but you might not 
get appropriate results.


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a.

b.

c.
d.

e.

f.
g.

h.

i.

Field Description

Filter Expression This field appears when you select Price Method as 
Related Pricing. Filter expression allows you to define the 
related adjustment amount source as a dynamic value 
using expressions within the line item context.

Click Expression define the adjustment amount 
on related pricing as an expression to have a 
dynamic adjustment value.
Go to the Field tab and search for your desired 
field from the list. Click the arrow next to the 
field name to view and select its related child 
fields. The formula expression, determined by 
the selected object-field and/or subfield, 
appears on the right panel of the formula 
builder.
Click Insert to add it to the expression.
Go to the Functions tab, select a function from 
the list, and click Insert to add it to the 
expression.
Click any operator available below the 
expression window to add it to the expression.
Continue building your expression.
Click Clear to remove the entire expression, 
or manually remove it by pressing the 
Backspace key.
Click Validate to check your formula. The 
application verifies the formula and displays a 
confirmation message if it is valid. If the 
formula is invalid, an error message is 
displayed.
Click Save.
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•

•

•

•

•

Field Description

Related Adjustment Applies To Enable this field to add the Related Price List Item value.

Enter the number of rows add, and click Add button.

If you selected Related Price in the Price Method field, 
select one of Base Extended Price, Base Price, Extended 
Price, List Price, Net Price, or Net Unit Price to indicate 
which prices shall be adjusted by the related price.

Field Description

Relation To Define the entity the related 
adjustment applies to. Select one 
of: 

Price List Item: Show all 
PLIs for returned price 
lists with both Product 
Name and Charge Type 
values.
Product: Show all 
products in the Related 
Item.
Product Family: Show 
all product families in 
the Related Item.
Product Group: Show all 
product groups in the 
Related Item.
Line Item Fields: Show 
all line item fields in the 
Related Item.

Related Item Select the related item to 
associate it to the related price.

Charge Type Select the charge type for the 
related price. (If the Relation To 
value is Price List Item, this field is 
predefined and non-editable.) 
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6.

1.

2.
3.
4.

5.

Field Description

Field Description

Adjustment 
Amount

Enter the adjustment amount.

Adjustment Type Select the adjustment type.

Related Item 
Value

You can add a value to this field 
only if you selected Relation To as 
Line item field. (For example: If the 
Related Item field's value is 
Quantity, then you can specify 
that quantity here.)

To delete a row, click the more icon and select Remove.

Click Save before you leave this tab.

Adding Miscellaneous Settings to a Price List Item

Go to ADMIN SETUP > Pricing Administration > Price Lists. The Price Lists page is 
displayed.
Click the required price list name link to open the Price Lists details page.
Click the Price List Items tab. 
Click the advanced setup icon  next to a price list item name. The price list item 
details page is displayed.
On the Miscellaneous tab, enter the following details:

Setting Description

Price Included In Bundle Select to include the price with the bundle product. 
Selecting Price Included in Bundle sets the Adjustment 
Amount to zero and Adjustment Type to Price 
Override. This means the option price is included in the 
bundle price and therefore is free.

Enable Price Ramps Select this check box to make a product price 
rampable.
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6.

Setting Description

Allow Manual Adjustments Select this to enable the end user to make manual 
adjustments. Manual adjustments are done through 
the adjustment type and amount fields on the pricing 
cart page.

Allocate Group Adjustment Select this to include the product in a manual group 
discount, if applied, on the pricing cart page.

Enable Commitment Select this to enable commitment.

Allow Proration Select to allow proration. On the Cart page, to make 
Selling Frequency editable by the user, this check box 
must be selected.

Is Usage Tier Modifiable Select this check box to enable an end user to modify 
the usage tier.

Disable Sync With Opportunity Select to prevent the creation of asset corresponding 
to this product during the quote process. For now, you 
can disable asset creation only for standalone 
products. 
It is recommended not to block asset creation because 
it hinders the preferable system flow of asset creation 
on quote acceptance.

Disable Asset Integration Select to prevent the creation of asset corresponding 
to this product during the quote process. For now, you 
can disable asset creation only for standalone 
products.

Enable Price Overlap Select this to enable price overlap.

Click Save before you navigate away from this tab. Otherwise, CPQ displays an error 
message.

Configuring Price Escalators

Price Escalator is a new mechanism to define a markup on the different prices for a product. 
The markup can be defined on a previous or first ramp line on the cart.

On which prices is it applicable?



Configure Price Quote (CPQ)

307 Copyright ©2024 Conga Corporation. All rights reserved.

1.
2.

The markup is applied on the List Price, Base Price or Extended Price.

Applicable for which products?

The Price Escalator can be applied on Bundle and Option products. Please note that the 
bundle level escalator does not cascade to the option products.

Where is this applied?

The markup is applied on the first or previous ramp line (defined by the Period field) of 
bundle or option products on the cart.

When is this applied?

For bundle products, the price escalator is applied after the Price Matrices.

For option products, the price of the ramps is calculated depending on the value in 
the Product Option Price Order field.

How is price escalator applied on ramp lines during ABO operations?

CPQ applies Price Escalator on new ramp lines created during ABO operations regardless 
of the Default Asset Pricing Indicator? setting (true or false). A new ramp line always gets 
its value from the price list item (PLI) pricing. For more information, see Use Case: Applying 
Price Escalator on New Ramp Lines During ABO Operations.

To configure a Price Escalator

Navigate to your Price List Item record and search for Price Escalator related list.
Click New Price Escalator and enter the following details:

Field Description

Period Number Defines the ramp line number.

Adjustment Source Defines the ramp on which the adjustment is applied. 
For example, Previous Ramp (if the ramp value depends 
on its previous value) or, the First Ramp (if the ramp 
value depends first ramp).

Usecase

If the matrix gives a base price is 60 and if the YOY ramp markup has been defined 
as 10%  over base price on period 2 and period 3, then the first ramp line will be $60, 
second will be $66 and the third will be $72.60.


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3.

4.

5.
•

•

6.

1.

2.

Field Description

Adjustment Applies To Values for the different prices to which the adjustment 
is applied. Valid values are List Price, Base Price and 
Extended Price.

Adjustment Type Values for manual adjustments whether you want to 
apply discount or markup on the price.

Adjustment Amount Field to enter in the amount or percentage of manual 
adjustment.

Price List Item This is a lookup to the Price List Item, containing the PLI 
Id by default.

Turn the setting Copy the current data in new row on to copy the details of a price 
matrix entry to the next entry.
In the Number of rows field, enter a value of how many rows you want to add.

Click the ellipsis icon   for the entry and click Delete.
If there are no unsaved changes, the Delete Price Matrix Entry pop-up is 
displayed. Click Confirm.
If there are unsaved changes, the a pop-up is displayed prompting your 
confirmation. Click Discard Changes. The Delete Price Matrix Entry pop-up is 
displayed. Click Confirm.

Click Add.

Configuring Price Matrices

Matrices Search

You can narrow down the matrices list using the search feature. You can either define 
search criteria to search for a range of matrices or use the matrices search option.

You can search for a matrices using keywords. For example, you can search using the name 
of the matrix. 

In the Search this list field, enter a keyword related to your matrix details such as 
matrix name.
Click the search icon   or press Enter. CPQ returns all matrices that contain that 
keyword in the matrices names.

The price escalators will be sorted according to the Period Number.
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1.

2.
3.
4.

5.
•

i.

ii.

iii.

iv.
•

•

•

Sorting Matrices

You can sort the matrices list by clicking the column names. The matrices are sorted 
alphabetically in ascending order using the matrice name. Every time you click the column 
name, the sorting switches between ascending and descending order. You can adjust the 
column width by dragging the columns. Hover near the column boundaries till two-way 
arrow appears. Click when the arrow appears and drag left or right to adjust the column 
width.

Items per page

At the bottom of the page, you can see the total count of matrices available. You can 
control the number of matrices to be displayed on each page. You can select the number of 
matrices from a predefined list. You cannot configure this list. By default, you see 20 records 
on each page.

By default, you can sort 10, 20, 30, 50, and 100 matrices per page using the Rows per 
page drop-down. This feature works in association with the search and filter functions to 
display search records per page. You can use the < and > buttons to move to the next or the 
previous pages. You can also jump to a certain page using the page search component.

Go to ADMIN SETUP > Pricing Administration > Price Lists. The Price Lists page is 
displayed.
Click the required price list name link to open the Price Lists details page.
Click the Price List Items tab. 
Click the advanced setup icon  next to a price list item name. The price list item 
details page is displayed.
Click the Metrices tab.

If there are existing metrices, you can perform the following actions on the list of 
metrices:

Click Create New. The Create New Matrix pop-up is displayed. Go to Step 
6.
Click the required price matrix name link to open the price matrix details 
page. You can create price matrix entries. For more information, see 
Configuring Price Matrix Entries.
Rearrange the sequence of matrices using the  icon.

Click the ellipsis icon  for the matrix and click Delete.
If there are no unsaved changes, the Delete Price Matrix pop-up is 
displayed. Click Confirm.
If there are unsaved changes, the a pop-up is displayed prompting 
your confirmation. Click Discard Changes. The Delete Price Matrix 
pop-up is displayed. Click Confirm.

If there are no metrices created, click Create New on the required matrix type.
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i.

ii.

iii.

6.

•
•
•

7.

a.

Dimension: You can enter a maximum of six dimensions, which bring in 
attributes from the line items or headers of any data type within the 
Conga Platform to be used in pricing.
Condition: You can create conditions using multiple fields of a line item or 
product attribute with Boolean logic such as AND/OR.
Usage: If the Price Type is "Usage" on a price line item, the Matrix Type 
should also be "Usage" while creating a price matrix. CPQ supports only 
this combination. 
The Create New Matrix pop-up is displayed.

Enter the following details:

Setting Description

Matrix Name Enter a name for the matrix.

Sequence Enter a sequence number for the matrix.

Description Enter a description for the matrix.

Enable Date Range Turn this setting on to enable the start and end 
date for price matrix to execute.

If you enable this, you must enter Start Date and 
End Date while creating price matrix entries.

Stop Processing More Matrices Turn this setting on to stop CPQ from evaluating 
further matrices if a match is found within this 
matrix.

Select Matrix Type Select a matrix type. Supported values are:

Dimension
Condition
Usage

Enter the following details under the Dimensions section if you select Dimension under 
Select Matrix Type.

Dimension: Select a dimension. 

When you hover over the info icon beside Dimension Name, it will show 
the basic information in a pop-up. If you click more info, it will navigate 
you to the respective dimension.


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b.
•
•
•
•
•

c.

d.

8.

1.

2.
3.
4.

5.
6.

7.
8.

Dimension Value: Select a value for the dimension. Supported values are:
Discrete
Range
Cumulative Range
Weighted Range
Cumulative Range - Line Item

Click Add Dimension to add a dimension. You can select a maximum of six 
dimensions.

Click the delete icon  to delete a dimension. If there is only one dimension, you 
cannot delete it.

Click Save.

Configuring Price Matrix Entries

Dimension

Go to ADMIN SETUP > Pricing Administration > Price Lists. The Price Lists page is 
displayed.
Click the required price list name link to open the Price Lists details page.
Click the Price List Items tab. 
Click the advanced setup icon  next to a price list item name. The price list item 
details page is displayed.
Click the Metrices tab. The list of existing metrices is displayed.
Click the required price matrix name link (Dimension type matrix) to open the price 
matrix details page.
On the Entries tab, click Add. A price matrix entry is added.
Enter the following details:

Setting Description

Start Date This field is visible only if you turn the Enable Date 
Range setting on while creating the price matrix.

Select a start date for the matrix entry. It is a 
mandatory field.

End Date This field is visible only if you turn the Enable Date 
Range setting on while creating the price matrix.

Select an end date for the matrix entry. It is a 
mandatory field.

Adjustment Amount Enter a percentage or a number to adjust the price.
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9.

a.

b.
c.

d.

e.
f.

g.

h.
10.

11.

12.
•

•

13.

Setting Description

Adjustment Type Select the kind of adjustment required if the criteria is 
met. For example, an override to a list price, markup, 
or discount. 

Adjustment Amount Source Search and select a field from where the adjustment 
must be sourced.

Click Formula Builder icon  to define the adjustment amount on Matrices rule entry 
as an expression to have a dynamic adjustment value.

Go to the Field tab and search for your desired field from the list. Click the 
arrow next to the field name to view and select its related child fields. The 
formula expression, determined by the selected object-field and/or subfield, 
appears on the right panel of the formula builder.
Click Insert to add it to the expression.
Go to the Functions tab, select a function from the list, and click Insert to add it 
to the expression.
Click any operator available below the expression window to add it to the 
expression.
Continue building your expression.
Click Clear to remove the entire expression, or manually remove it by pressing 
the Backspace key.
Click Validate to check your formula. The application verifies the formula and 
displays a confirmation message if it is valid. If the formula is invalid, an error 
message is displayed.
Click Save.

Turn the setting Copy the current data in new row on to copy the details of a price 
matrix entry to the next entry.
In the Number of rows field, enter a value of how many rows you want to add.

Click the ellipsis icon  for the entry and click Delete.
If there are no unsaved changes, the Delete Price Matrix Entry pop-up is 
displayed. Click Confirm.
If there are unsaved changes, the a pop-up is displayed prompting your 
confirmation. Click Discard Changes. The Delete Price Matrix Entry pop-up is 
displayed. Click Confirm.

Click Save.

Condition 
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1.

2.
3.
4.

5.
6.

7.
8.

a.
i.
ii.
iii.
iv.
v.
vi.
vii.

viii.
b.

i.
ii.
iii.
iv.
v.
vi.
vii.

viii.
9.

Go to ADMIN SETUP > Pricing Administration > Price Lists. The Price Lists page is 
displayed.
Click the required price list name link to open the Price Lists details page.
Click the Price List Items tab. 
Click the advanced setup icon  next to a price list item name. The price list item 
details page is displayed.
Click the Metrices tab. The list of existing metrices is displayed.
Click the required price matrix name link (condition type matrix) to open the price 
matrix details page.
On the Entries tab, click Add. A price matrix entry is added.
Click Add Condition. The Charge Type Criteria pop-up is displayed. 

On the Line Items tab, enter the following details:
Field: Select a field on the product. You can select custom fields also.
Operator: Select an operator.
Value: Enter a value.
Click Add Criteria to add one more criteria.
Click the remove icon  to remove a criteria.
Click Remove All to remove all criteria
Turn the Logic button on and enter a value in the Logic field when you add 
multiple criteria.
Click Save.

On the Product Attributes tab, enter the following details: 
Field: Select a field on the product. You can select custom fields also.
Operator: Select an operator.
Value: Enter a value.
Click Add Criteria to add one more criteria.
Click the remove icon  to remove a criteria.
Click Remove All to remove all criteria.
Turn the Logic button on and enter a value in the Logic field when you add 
multiple criteria.
Click Save.

Enter the following details:

Setting Description

Start Date This field is visible only if you turn the Enable Date 
Range setting on while creating the price matrix.

Select a start date for the matrix entry. It is a 
mandatory field.
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10.

a.

b.
c.

d.

e.
f.

g.

h.
11.

12.

13.

Setting Description

End Date This field is visible only if you turn the Enable Date 
Range setting on while creating the price matrix.

Select an end date for the matrix entry. It is a 
mandatory field.

Adjustment Amount Enter a percentage or a number to adjust the price.

Adjustment Type Select the kind of adjustment required if the criteria is 
met. For example, an override to a list price, markup, 
or discount. 

Adjustment Amount Source Search and select a field from where the adjustment 
must be sourced.

Click Formula Builder icon  to define the adjustment amount on Matrices rule entry 
as an expression to have a dynamic adjustment value.

Go to the Field tab and search for your desired field from the list. Click the 
arrow next to the field name to view and select its related child fields. The 
formula expression, determined by the selected object-field and/or subfield, 
appears on the right panel of the formula builder.
Click Insert to add it to the expression.
Go to the Functions tab, select a function from the list, and click Insert to add it 
to the expression.
Click any operator available below the expression window to add it to the 
expression.
Continue building your expression.
Click Clear to remove the entire expression, or manually remove it by pressing 
the Backspace key.
Click Validate to check your formula. The application verifies the formula and 
displays a confirmation message if it is valid. If the formula is invalid, an error 
message is displayed.
Click Save.

Turn the setting Copy the current data in new row on to copy the details of a price 
matrix entry to the next entry.
In the Number of rows field, enter a value of how many rows you want to add.

Click the ellipsis icon  for the entry and click Delete.
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•

14.

1.

2.
3.
4.

5.
6.

7.
8.

If there are no unsaved changes, the Delete Price Matrix Entry pop-up is 
displayed. Click Confirm.
If there are unsaved changes, the a pop-up is displayed prompting your 
confirmation. Click Discard Changes. The Delete Price Matrix Entry pop-up is 
displayed. Click Confirm.

Click Save.

Usage

Go to ADMIN SETUP > Pricing Administration > Price Lists. The Price Lists page is 
displayed.
Click the required price list name link to open the Price Lists details page.
Click the Price List Items tab. 
Click the advanced setup icon  next to a price list item name. The price list item 
details page is displayed.
Click the Metrices tab. The list of existing metrices is displayed.
Click the required price matrix name link (usage type matrix) to open the price matrix 
details page.
On the Entries tab, click Add. A price matrix entry is added.
Enter the following details:

Setting Description

From Enter a value.

To Enter a value.

Start Date This field is visible only if you turn the Enable Date Range 
setting on while creating the price matrix.

Select a start date for the matrix entry. It is a mandatory 
field.

EndDate This field is visible only if you turn the Enable Date Range 
setting on while creating the price matrix.

Select an end date for the matrix entry. It is a mandatory 
field.

For Usage type price matrix entries, either Unit Price or Flat Price is required, not 
both.


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•

12.

1.

2.
3.

4.

5.

Setting Description

Unit Price Enter a unit price.

Flat Price  Enter a flat price.

Is Included Turn this setting on to indicate if the entry is included.

Turn the setting Copy the current data in new row on to copy the details of a price 
matrix entry to the next entry.
In the Number of rows field, enter a value of how many rows you want to add.

Click the ellipsis icon  for the entry and click Delete.
If there are no unsaved changes, the Delete Price Matrix Entry pop-up is 
displayed. Click Confirm.
If there are unsaved changes, the a pop-up is displayed prompting your 
confirmation. Click Discard Changes. The Delete Price Matrix Entry pop-up is 
displayed. Click Confirm.

Click Save.

Associating Categories with a Price List
You can associate more than one categories with a price List.

Go to Admin Setup > Pricing Administration > Price Lists. The Price Lists page is 
displayed.
Search for the price list you want to associate a category with. Click the Price List.
On the Price List details page, click the Associated Categories tab. Under Available 
Categories, you can see all categories available in the org.
In the Search Categories field, enter keywords to search the category you want to 
associate with the price list.
Hover the mouse on the required category and click + next to the category name. The 
category is associated to the price list and is displayed in the categories list section 
(right-hand side). 

If you enter Unit Price, do not enter Flat Price.

If you enter Flat Price, do not enter Unit Price.
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6.

7.

a.

b.
8.

a.

b.

Use the sequence (  icon to reorder the associated category up and down in the 
category hierarchy.
To delete an associated category from the product:

Click the ellipsis icon   next to the required category under Category Name in 
the categories list (right-hand side).
Click Remove.

Under Category Name in the categories list (right-hand side):
Click the category name link. The category details pop-up is displayed. You can 
see the category details, associated products, and associated price lists.
Click Close.

Managing Price Dimensions
Price dimensions are an important concept to link any field into the pricing tables. Any field 
that will determine a pricing adjustment such as Quantity, Term, and more, needs a 
dimension created for it.

Navigating the Price Dimensions Page
When you launch the Price Dimensions page on the UI, all the existing price dimensions are 
listed on this page along with their details. There are various functionalities available for 
you to manage the price dimensions.

Managing Views
You can manage column width, control which columns are displayed in the grid, freeze/pin 
a column range, or rearrange the column order. You can also filter the view of records in the 
grid by performing a keyword search, filtering the list by column value, or applying one or 
more advanced filters and filter logic. For more information, see Managing the View 
Settings and Filtering the Records.

•

•

Hover the mouse on a parent category and click the   icon next to the 
category name to view category hierarchy before associating to the 
price list.
Reorder the Associated Categories under Pricelists on the Admin UI, and 
the changes will reflect in the same sequence on the Catalog page in 
Runtime UI. The sequence updates automatically when categories are 
reordered or deleted.



)
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Actions available on this page
Click Create New to create a new price dimensions.

Click the ellipsis icon  next to a price dimension name to edit or delete an existing 
price dimension.
Click the price dimension name link to open the Price Dimension details page.
Export the selected price dimensions. For more information, see Exporting Records.

This section provides information on managing price dimensions.

Creating a Price Dimension
Cloning a Price Dimension
Deleting a Price Dimension

Creating a Price Dimension
Price Dimensions are an important concept to link any field into the pricing tables. Any field 
that will determine a pricing adjustment such as Quantity, Term, and more, needs a 
dimension created for it.

To create a price dimension
Go to ADMIN SETUP > Pricing Administration > Price Dimensions. The Price Dimensions 
page is displayed.
Click Create New. The New Dimension page is displayed.
Select the Context Type drop-down, select a context type: 

Field Name Description

Context Type

(Mandatory)

 

 

 

Select the context type for the dimension from the 
following:

Line Item
Product Attribute
Custom
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Field Name Description

If Context Type is Line Item, it allows you to choose any 
field on the line item shopping cart. When you select this 
context type, the following fields are enabled:

a. Field (Mandatory): Search and select a line item field.

b. Cumulative Dimension: If you want to use a value 
from another dimension with the current dimension and 
use the resultant value as the final value, select a 
dimension name from the Cumulative Dimension drop- 
down. CPQ adds the value from another dimension to 
the value of the current dimension during evaluation. 
The cumulative dimension works only if line item field 
type is a number or currency.

c. Relation Type : Select a relation type between the 
context type and the line item field. The supported 
value is Related Quantity.

If Context Type is Attribute, it allows you to select any 
product attribute that is associated to a product 
through an attribute group. When you select this 
context type, the following fields are enabled:

a. Attribute Group (Mandatory) : Search and select an 
attribute group

b. Attribute (Mandatory) : Select an attribute in the 
attribute group selected above.

c. Type: Select one of the types of price dimensions.

If Context Type is Custom, it allows you to provide a 
dimension field manually for defining lookup fields using 
dot notation. When selecting this context type, the 
following fields are enabled:

a. Field (Mandatory): Search and select a line item field.

b. Type: Select one of the types of price dimensions.

In the Price Dimension Name field, enter a name for the dimension.
In the Description field, enter a description for the price dimension.
From the Type drop-down, select one of the following types of price dimensions:
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Type Description

Standard Select this for a standard price dimension.

Quantity Select this if the price dimension is based on quantity.

Term Select this if the price dimension is based on term.

Amount Select this if the price dimension is based on purchase amount.

Equipment Select this if the price dimension is based on equipment.

Click Save to save the price dimension or click Save & Create New to save and create 
a new price dimension.

Cloning a Price Dimension
Cloning price dimensions allows pricing administrators to copy existing price settings, 
making it easier to create and manage similar pricing structures quickly.

To clone a price dimension
Go to ADMIN SETUP > Pricing Administration > Price Dimensions. The Price Dimensions 
page is displayed.
Search for the price dimension you want to clone.

Click the ellipsis icon next to the product name and click Clone. The Clone Price 
Dimension page is displayed.
Enter the details:
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Field Name Description

Context Type

(Mandatory)

Select the context type for the dimension from the 
following:

Product Attribute
Line Item
Custom

Price Dimension Name

(Mandatory)

Give the name to your cloned dimension. The default 
name will be CLONE - Name.

Description Enter a description for the dimension.

Field Select the field for the cloned dimension.

Cumulative Dimension List of existing dimensions.

•
•
•

•

•
•

•

•
•

If Context Type is Line Item
Field (Mandatory)
Cumulative Dimension - 
dropdown with the list of 
existing dimensions
Relation Type : Select a 
relation type between the 
context type and the line 
item field.

If Context Type is Attribute
Attribute Group 
(Mandatory) : Search and 
select an attribute group
Attribute (Mandatory) : 
Select an attribute in the 
attribute group selected 
above.

If Context Type is Custom
Field (Mandatory)


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Field Name Description

Type Select the type of the dimension from the following:

Amount
Quantity
Standard (Default selected)
Term
Equipment

Click Save.

Deleting a Price Dimension
You can delete price dimension that are no longer required for your business requirements.

To delete a price dimension
Go to ADMIN SETUP> Pricing Administration > Price Dimension. The Price Dimension 
page is displayed.
Search for the price dimension, and do one of the following:

To delete a single price dimension, click the ellipsis icon (  next to the price 
dimension name, and click Delete.
To delete multiple price dimensions, click the checkboxes next to the name 

column, and click the ( ) icon.
To delete all the price dimensions, click the checkbox in the header row next to 

the name column, and click the ( ) icon.
Click Confirm.

.

Creating a Price Dimension

Managing Price Dimensions

Managing Price Rulesets
Price Rulesets allow you to apply either line item pricing adjustments or summary pricing 
adjustments to particular families, categories, or groupings of products. This section 
provides information on managing price rulesets.

)
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Navigating the Price Rulesets Page
When you launch the Price Rulesets page on the UI, all the existing price rulesets are listed 
on this page along with their details. There are various functionalities available for you to 
manage the price rulesets.

Managing Views
You can manage column width, control which columns are displayed in the grid, freeze/pin 
a column range, or rearrange the column order. You can also filter the view of records in the 
grid by performing a keyword search, filtering the list by column value, or applying one or 
more advanced filters and filter logic. For more information, see Managing the View 
Settings and Filtering the Records.

Actions available on this page
Click Create New to create a new price rulesets.

Click the ellipsis icon  next to a price ruleset name to delete an existing price 
ruleset.
Click the price ruleset name link to open the Price Rulesets details page.
Use the Active switch to activate or deactivate a price ruleset.
Export the selected deal guidance. For more information, see Exporting Records.

Refer to the following topics for more information.

Creating a Price Ruleset
Creating a Price Rule
Creating Price Rule Entries
Deleting a Price Ruleset
Deleting Price Rules
Deleting a Price Rule Entry

Creating a Price Ruleset
Price Ruleset enables you to adjust prices for various products through rules, manage 
special offers, promotions, and discounts based on specific attributes. It can contain 
multiple rule entries and be dimensional like Price Matrices. You can apply line item and 
summary pricing adjustments, supporting strategies like discounting rules, promotional 
pricing, and aggregate adjustments based on Product Family.
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For example, if you want to apply a 20% promotional discount on all products within a 
specific category during a holiday sale, you can achieve this using a Price Ruleset.

To create a price ruleset
Go to ADMIN SETUP > Pricing Administration > Price Rulesets to create a price ruleset.
Click Create New to view New Price Ruleset pop-up window.
Enter the following details:

Field Description

Ruleset Name Enter a mandatory name for the ruleset.

Sequence Enter a mandatory Sequence in which the system will 
evaluate multiple rulesets. Typically, you will perform 
line item adjustments first and then any summary 
adjustments.

Description Enter a description for the ruleset.

Effective Date This field is visible only if you turn the Enable Date 
Range setting on.

Select an effective date for the rule. It is a mandatory 
field.

Expiration Date This field is visible only if you turn the Enable Date 
Range setting on.

Select an expiration date for the rule. It is a 
mandatory field.

Active Turn this setting on to set the ruleset as active.

Stop Processing More Rules Turn this setting on to indicate that if the ruleset is 
satisfied, CPQ does not process any more rules.

Click Save to save the new price rule. A price rule is created and you are redirected to 
the price ruleset details page.
On the Details tab, you can update the details if required.
Click the Condition & Charge Type Criteria tab and enter the following details:
Under the Conditions section:

In the Price List field, search and select a price list.



Configure Price Quote (CPQ)

325 Copyright ©2024 Conga Corporation. All rights reserved.

b.
c.
d.
e.
f.

8.
a.

•

•

•
b.

•
•

9.

a.
b.

i.

ii.
iii.
iv.

v.
vi.
vii.

viii.
c.

Click the Product Family drop-down to select a product family.
On the Product Category field, search and select a product category.
On the Product Group field, search and select a product group.
Click the Category drop-down to select a category.
Click the Charge Type drop-down to select a charge type.

Under the Application section:
Application Level: Select a level to which this ruleset will be applied. The 
supported values are:

Line Item: Selecting this will apply the line item adjustment within the line 
item net price in the shopping cart.
Bundle: Selecting this will apply the adjustment to a bundle and its 
options and the adjustment is displayed in the Totals tab in the shopping 
cart.
Aggregate: Selecting this enables the Application Method field.

Application Method: This field is enabled if you selected Aggregate from the 
Application Level drop-down list. This indicates that you want the adjustment 
to select products in aggregate but apply an adjustment as a summary line in 
the Totals tab or spread the adjustment over numerous products. The supported 
values are:

Apply to Line Items: Applies the adjustment to line items on the cart.
Create Summary Lines: Applies the adjustment as a summary line in the 
Totals tab on the cart.

Under Charge Type Criteria, add a criteria. This allows you to set criteria for a line 
item rule or a bundle, depending on the Application Level you have selected, such 
that the ruleset only applies when it satisfies a line level field value or a product 
attribute value.

Click Rule Set Criteria. The Charge Type Criteria pop-up is displayed.
On the Line Items tab, enter the following details:

Field: Search and select a field on the product. You can select custom 
fields also.
Operator: Click and select an operator from the dropdown list.
Value: Enter a value.
Click Add Criteria to add one more criteria.

Click the remove icon  to remove a criteria.
Click Remove All to remove all criteria
Turn the Logic button on and enter a value in the Logic field when you add 
multiple criteria.
Click Save.

On the Product Attributes tab, enter the following details: 
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Field: Search and select a field on the product. You can select custom 
fields also.
Operator: Click and select an operator from the dropdown list.
Value: Enter a value.
Click Add Criteria to add one more criteria.

Click the remove icon  to remove a criteria.
Click Remove All to remove all criteria
Turn the Logic button on and enter a value in the Logic field when you add 
multiple criteria.
Click Save.

Click Save on the price ruleset details page.

To delete a price ruleset
Go to ADMIN SETUP > Pricing Administration > Price Rulesets. The Price Rulesets page 
is displayed.
Search for the price ruleset you want to delete.

Click the ellipsis icon  next to the price ruleset name and click Delete. The Delete 
Price Ruleset pop-up is displayed.
Click Confirm.

Creating a Price Rule
You can associate multiple rules to a rule set or through to a product. Price matrices can be 
defined in price rules as well as conditional price rules (rules that use boolean logic such as 
AND/OR). Price rules can be dimensional, which use a similar concept as Price Matrices or 
Conditional, that relate to fields for pricing adjustments.

One ruleset can have multiple rules and are evaluated in order of the rule sequence. A rule 
can be dimensional or conditional. A price rule determines the actual price adjustment 
made

Price Rule Search
You can narrow down the price rules using the search feature. You can either define search 
criteria to search for a range of price rules or use the price rule search option.

Basic Search

In basic search, you can search for a price rule using keywords. For example, you can search 
using the name of the price rule. 
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In the Search this list field, enter a keyword related to your price rule name.
Click the search icon   or press Enter. CPQ returns all price dimensions that contain 
that keyword in the price dimension names.

Sorting Price Rule
You can sort the price rules by clicking the column names. The price rules are sorted 
alphabetically. Every time you click the column name, the sorting switches between 
ascending and descending order. You can adjust the column width by dragging the 
columns. Hover near the column boundaries till two-way arrow appears. Click when the 
arrow appears and drag left or right to adjust the column width.

To create a price rule
Go to ADMIN SETUP > Pricing Administration > Price Rulesets. The Price Rulesets page 
is displayed.
Click the required price ruleset name link to open the Price Rulesets details page.
Click the Price Rules tab. 

If there are existing price rules, you can perform the following actions on the list 
of rules:

Click Create New to create new price rule. Go to step 4.
Click the required price rule name link to open the price rule details page.
Rearrange the sequence of rules using the  icon. 
Turn the Is Active? setting on to make the rule active.
Click the ellipsis icon for the rule and click Delete.

If there are no unsaved changes, the Delete Price Rule pop-up is 
displayed. Click Confirm.
If there are unsaved changes, the a pop-up is displayed prompting 
your confirmation. Click Discard Changes. The Delete Price Rule pop- 
up is displayed. Click Confirm.

If there are no rules created, click Create New on the required rule type.
Dimension
Condition

Enter the following details:

Field Setting

Rule Name Enter a mandatory rule name.

Sequence Enter a mandatory sequence for the rule.
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Field Setting

Description Enter a description for the rule.

Active Turn this setting on to make the rule active.

Stop Processing More Rules Turn this setting to indicate that if the ruleset is 
satisfied, CPQ does not process any more rules.

Adjustment Applies To Select an option to which the adjustment is applied. 
This is for line item adjustments only. Supported 
values are:

Base Extended Price
Base Price (this is the default value)
Extended Price 
List Price

Adjustment Charge Type Select an option to set summary level adjustments 
as a charge type. Supported value is Adjustment 
(this is the default value also).

Allow Renewal of Adjustment Turn this setting on to allow complete removal of a 
price adjustment.

Rule Type Select a rule type. Supported values are:

Dimension
Condition

Under Dimensions:

Click Add Dimensions.
In the Dimension field, search and select a dimension.
In the Dimension Value field, select an option. Supported values are:

Discrete
Range
Weighted Range
Cumulative Range - Line Item
Cumulative Range

Click Save.

The Dimensions section is applicable for Dimension rule type.
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Creating Price Rule Entries
You can create Dimension or Condition type price rule entries as per the requirement.

Dimension
Go to ADMIN SETUP > Pricing Administration > Price Rulesets. The Price Rulesets page 
is displayed.
Click the required price ruleset name link to open the Price Rulesets details page.
Click the Price Rules tab.

If there are existing metrices, click the required price rule name link to open the 
price rule details page.
If there are no metrices created, create a price rule. For more information, see 
Creating a Price Rule.

On the Entries tab, click Add. A price rule entry is added.
Enter the following details:

Field Description

<dimension> Enter a value for the dimension.

The number of dimensions depends on how many 
dimensions you have configured for the price rule.

Adjustment Amount Enter a percentage or a number to adjust the price.

Adjustment Type Select the kind of adjustment required if the criteria is 
met. For example, an override to a list price, markup, 
or discount. 

Adjustment Amount Source Search and select a field from where the adjustment 
must be sourced.

Click Formula Builder icon   to define the adjustment amount on price rule entry as 
an expression to have a dynamic adjustment value.

Go to the Field tab and search for your desired field from the list. Click the 
arrow next to the field name to view and select its related child fields. The 
formula expression, determined by the selected object-field and/or subfield, 
appears on the right panel of the formula builder.
Click Insert to add it to the expression.
Go to the Functions tab, select a function from the list, and click Insert to add it 
to the expression.
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Click any operator available below the expression window to add it to the 
expression.
Continue building your expression.
Click Clear to remove the entire expression, or manually remove it by pressing 
the Backspace key.
Click Validate to check your formula. The application verifies the formula and 
displays a confirmation message if it is valid. If the formula is invalid, an error 
message is displayed.
Click Save.

Turn the setting Copy the current data in new row on to copy the details of a price 
rule entry to the next entry.
In the Number of rows field, enter a value of how many rows you want to add.

Click the ellipsis icon (  for the entry and click Delete.
If there are no unsaved changes, the Delete Price Rule Entry pop-up is displayed. 
Click Confirm.
If there are unsaved changes, the a pop-up is displayed prompting your 
confirmation. Click Discard Changes. The Delete Price Rule Entry pop-up is 
displayed. Click Confirm.

Click Save.

Condition
Go to ADMIN SETUP > Pricing Administration > Price Rulesets. The Price Rulesets page 
is displayed.
Click the required price ruleset name link to open the Price Rulesets details page.
Click the Price Rules tab.

If there are existing metrices, click the required price rule name link to open the 
price rule details page.
If there are no metrices created, create a price rule. For more information, see 
Creating a Price Rule.

On the Entries tab, click Add. A price rule entry is added.
Click Add Condition. The Charge Type Criteria pop-up is displayed. 

On the Line Items tab, enter the following details:
Field: Select a field on the product. You can select custom fields also.
Operator: Select an operator.
Value: Enter a value.
Click Add Criteria to add one more criteria.
Click the remove icon (  to remove a criteria.
Click Remove All to remove all criteria.

)

)
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Turn the Logic button on and enter a value in the Logic field when you add 
multiple criteria.
Click Save. A criteria is added under the Condition column.

On the Product Attributes tab, enter the following details: 
Field: Select a field on the product. You can select custom fields also.
Operator: Select an operator.
Value: Enter a value.
Click Add Criteria to add one more criteria.
Click the remove icon (  to remove a criteria.
Click Remove All to remove all criteria.
Turn the Logic button on and enter a value in the Logic field when you add 
multiple criteria.
Click Save. A criteria is added under the Condition column.

Enter the following details:

Field Description

Adjustment Amount Enter a percentage or a number to adjust the price.

Adjustment Type Select the kind of adjustment required if the criteria is 
met. For example, an override to a list price, markup, 
or discount. 

Adjustment Amount Source Search and select a field from where the adjustment 
must be sourced.

Click Formula Builder icon   to define the adjustment amount on price rule entry as 
an expression to have a dynamic adjustment value.

Go to the Field tab and search for your desired field from the list. Click the 
arrow next to the field name to view and select its related child fields. The 
formula expression, determined by the selected object-field and/or subfield, 
appears on the right panel of the formula builder.
Click Insert to add it to the expression.
Go to the Functions tab, select a function from the list, and click Insert to add it 
to the expression.
Click any operator available below the expression window to add it to the 
expression.
Continue building your expression.

)

You can add dynamic adjustment amounts to price rule entries, using the 
formula builder to define expressions for both static values and formula fields.


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Click Clear to remove the entire expression, or manually remove it by pressing 
the Backspace key.
Click Validate to check your formula. The application verifies the formula and 
displays a confirmation message if it is valid. If the formula is invalid, an error 
message is displayed.
Click Save.

Turn the setting Copy the current data in new row on to copy the details of a price 
rule entry to the next entry.
In the Number of rows field, enter a value of how many rows you want to add.

Click the ellipsis icon (  for the entry and click Delete.
Click Save.

Deleting a Price Ruleset
You can delete price ruleset that are no longer required for your business requirements. 

To delete a price ruleset
Go to ADMIN UP > Pricing Administration > Price Ruleset. The price rulesets page is 
displayed.
Search for the price ruleset and do one of the following: 

To delete a single price ruleset, click the ellipsis icon (  next to the rollup 
name, and click Delete.
To delete multiple price rulesets, click the checkboxes next to the name column, 

and click the ( ) icon.
To delete all the price rulesets, click the checkbox in the header row next to the 

name column, and click the ( ) icon.
Click Confirm.

Deleting Price Rules
You can delete price rule that are no longer required for your business requirements. 

To delete a price rule
Go to ADMIN UP > Pricing Administration > Price Ruleset. The price ruleset page is 
displayed. Search for the ruleset you want to edit.
Click the Ruleset. The Price Ruleset detail page is displayed. Click the Price Rules tab.

)

)
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Search for the price rule and do one of the following: 

To delete a single price rule, click the ellipsis icon (  next to the rollup name, 
and click Delete.
To delete multiple price rules, click the checkboxes next to the name column, 

and click the ( ) icon.
To delete all the price rules, click the checkbox in the header row next to the 

name column, and click the ( ) icon.
Click Confirm.

Deleting a Price Rule Entry
You can delete price rule entry that are no longer required for your business requirements. 

To delete a price rule entry
Go to ADMIN UP > Pricing Administration > Price Ruleset. The price ruleset page is 
displayed. Search for the ruleset you want to edit.
Click the Ruleset. The Price Ruleset detail page is displayed. Click the Price Rules tab.
The Price Rule detail page is displayed. Click the Price Rule Entry tab.
Search for the price rule entry and do one of the following: 

To delete a single price rule entry, click the ellipsis icon (  next to the rollup 
name, and click Delete.
To delete multiple price rule entries, click the checkboxes next to the name 

column, and click the ( ) icon.
To delete all the price rule entries, click the checkbox in the header row next to 

the name column, and click the ( ) icon.
Click Confirm.

Managing Deal Guidance
Deal Guidance provides you means to determine if a deal is appropriate based on a set of 
predefined rules. These rules drive the color bands and shapes that are displayed on the 
cart to help you determine if a deal is good or not. The feature guides you to present a deal 
that aligns with your organization's objectives which in turn helps to fast-track the deals.

There are three types of deal guidance:

Color Bands
Dimension & Sets

)

)
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Guidance Rules

Navigating the Deal Guidance Page
When you launch the deal guidance page on the UI, all the existing deal guidance are listed 
on this page along with their details. There are various functionalities available for you to 
manage the deal guidance.

Managing Views
You can manage column width, control which columns are displayed in the grid, freeze/pin 
a column range, or rearrange the column order. You can also filter the view of records in the 
grid by performing a keyword search, filtering the list by column value, or applying one or 
more advanced filters and filter logic. For more information, see Managing the View 
Settings and Filtering the Records.

Actions available on this tab
Click New Dimension Set to create a new dimension.

Click the ellipsis icon   next to the dimension set name to edit or delete an existing 
dimension set.
Click the dimension set name link to open the dimension set details page.
Export the selected deal guidance. For more information, see Exporting Records.

Refer to the following topics for more information.

Associating Dimension to the Dimension Set
Creating a Color Band
Creating a Dimension Set
Creating Guidance Rules
Creating a Dimension
Deleting Color Bands
Deleting a Dimension
Deleting Dimensions Sets
Deleting Guidance Rule

Associating Dimension to the Dimension Set
You can associate more than one dimension set with a dimension.
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To associate a dimension with a dimension set
Go to ADMIN SETUP > Pricing Administration > Deal Guidance > Dimension & Sets. 
The Dimension page is displayed.
Click the Dimension Sets tab.
Search for the dimension set to update.
Click the dimension set name link to open the Dimension Set details page.
Click the Associated Dimensions tab.
Under Available Dimensions, you can see all dimensions available in the org.
In the Search Dimension field, enter keywords to search the dimension you want to 
associate with the dimension set and click the search icon   or press Enter.
Hover the mouse on the required dimension and click + next to the dimension name. 
The dimension is associated with the dimension set and is displayed in the Associated 
Dimensions section (right-hand side).
Create a Dimension:

If the desired dimension does not exist, click Create New Dimension under the 
Available Dimension page.
The New Dimension page will be displayed.
Follow the steps in Creating a Dimension to configure the new dimension.
After configuring and saving the new dimension, return to the Associated 
Dimensions page.
Search for the newly created dimension as described in step 7 and associate it 
with the dimension set.

Click Save. 

To discard changes:
Click Discard Changes. The Alert pop-up is displayed.
Click Don't Save.

Creating a Color Band

To create a Color Band
Go to ADMIN SETUP> Pricing Administration > Deal Guidance > Color Bands. The Color 
Bands page is displayed.
Click the Add Color Band button. The Color Bands list page is displayed.
Enter the following details:

The Save button is enabled only when you make any changes to the 
associated dimensions.


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Field Description

Band Name Enter a name for the Band name. This is a mandatory 
field.

Color Code Give a color code to the new Band Name. This is a 
mandatory field.

Deal Shape Choose a Deal Shape from the given picklist. This is a 
mandatory field.

Description Enter a description for the Band Color.

Click +. A new Band Color will be created.
Enter the details that is required.
Click the delete icon {  to remove the color band.
Click Save.

To delete a Color Band
Go to ADMIN SETUP > Pricing Administration > Deal Guidance > Color Bands. The 
Color Bands page is displayed.
Search for the color band that you want to delete.
Click the delete icon {  to remove the color band.
Click Confirm

To update a Color Band
Go to ADMIN SETUP > Pricing Administration > Deal Guidance > Color Bands. The 
Color Bands page is displayed.
Search for the color band that you want to update.

Select the field that you want to update and click { } icon.
Enter the desired changes and click Save.

Creating a Dimension Set

To create a dimension set
Go to ADMIN SETUP> Pricing Administration > Deal Guidance. The Dimension and Sets 
page is displayed.

}

}
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On the Dimension Sets tab, click New Dimension Set. 
Enter the following details:

Field Description

Set Name Enter a name for the dimension set

Guidance Type Select a type of guidance that controls which values are 
available on the Business Object drop-down. Supported 
value is Line Level, which means the guidance is based on 
a field at the line-item level.

Business Object Select a business object for the dimension set. The options 
on the Business Object drop-down depend on the 
Guidance Type selection. This must match the object you 
plan to use the deal guidance for. Supported value is 
LineItem.

Description Enter a brief description of the dimension set.

Click Save.

To delete a dimension set
Go to ADMIN SETUP> Pricing Administration > Deal Guidance. The Dimension and Sets 
page is displayed.
Click the Dimension Sets tab.

Click the ellipsis icon   next to the dimension set name and click Delete. The Delete 
Dimension Set pop-up is displayed.
Click Confirm.

Creating Guidance Rules

To create a guidance rule
Go to ADMIN SETUP> Pricing Administration > Deal Guidance > Guidance Rules. The 
Guidance Rules page is displayed.
Click Create New.
Enter the following details:

Rule Name Enter a name for the guidance rule.



Configure Price Quote (CPQ)

338 Copyright ©2024 Conga Corporation. All rights reserved.

4.

1.

2.

3.

1.

Sequence Enter the sequence for the rule.

Guidance Type Select a type of guidance that controls which values are 
available on the Business Object drop-down. Supported 
value is Line Level, which means the guidance is based on 
a field at the line-item level.

Is Active Toggle-on to make the rule active.

Business Object Select a business object for the guidance rule. The options 
on the Business Object drop-down depend on 
the Guidance Type selection. This must match the object 
you plan to use the deal guidance for. Supported value is 
LineItem.

Dimension Set Select the Dimension set.

Measure Select the measure.

Currency Scope Select the currency for the rule.

Description Enter a brief description of the guidance rule.

Click Save.

To delete a guidance rule
Go to ADMIN SETUP> Pricing Administration > Deal Guidance> Guidance Rules. The 
Guidance Rules page is displayed.

Click the ellipsis icon   next to the guidance rule name and click Delete. The Delete 
Deal Guidance Rule pop-up is displayed.
Click Confirm.

Creating a Dimension

To create a dimension
Go to ADMIN SETUP> Pricing Administration > Deal Guidance > Dimension and Sets. 
The Dimension and Sets page is displayed.
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Click the Dimension tab.
On the Dimension tab, click Create New. 
Enter the following details:

Field Description

Dimension Name Enter a name for the dimension.

Field Select the field.

Business Object Select a business object for the dimension set. The 
options on the Business Object drop-down depend on 
the Guidance Type selection. This must match the object 
you plan to use the deal guidance for. Supported value is 
LineItem.

Description Enter a brief description of the dimension.

Click Save.

To delete a dimension
Go to ADMIN SETUP> Pricing Administration > Deal Guidance. The Dimension and Sets 
page is displayed.
Click the Dimension tab.

Click the ellipsis icon   next to the dimension name and click Delete. The Delete 
Dimension pop-up is displayed.
Click Confirm.

Deleting Color Bands
You can delete color bands that are no longer required for your business requirements. 

To delete a color band
Go to ADMIN SETUP > Pricing Administration > Color Band. The Color Bands page is 
displayed.
Search for the color band and do one of the following: 

To delete a single color band, click the ellipsis icon (  next to the rollup name, 
and click Delete.

)
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To delete multiple color band, click the checkboxes next to the name column, 

and click the ( ) icon.
To delete all the color band, click the checkbox in the header row next to the 

name column, and click the ( ) icon.
Click Confirm.

Deleting a Dimension
You can delete dimension that are no longer required for your business requirements. 

To delete a Dimension 
Go to ADMIN UP > Pricing Administration > Dimension . Click the Dimension tab. The 
dimensions page is displayed.
Search for the dimension and do one of the following: 

To delete a single dimension, click the ellipsis icon (  next to the rollup name, 
and click Delete.
To delete multiple dimensions, click the checkboxes next to the name column, 

and click the ( ) icon.
To delete all the dimensions, click the checkbox in the header row next to the 

name column, and click the ( ) icon.
Click Confirm.

Deleting Dimensions Sets
You can delete dimension sets that are no longer required for your business requirements. 

To delete a Dimension Set
Go to ADMIN SETUP > Pricing Administration > Dimension Set. Click the Dimension Set 
tab. The dimension sets page is displayed.
Search for the dimension set and do one of the following: 

To delete a single dimension set, click the ellipsis icon (  next to the rollup 
name, and click Delete.
To delete multiple dimension set, click the checkboxes next to the name column, 

and click the ( ) icon.

)

)
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To delete all the dimension set, click the checkbox in the header row next to the 

name column, and click the ( ) icon.
Click Confirm.

Deleting Guidance Rule
You can delete guidance rules that are no longer required for your business requirements. 

To delete a guidance rule
Go to ADMIN SETUP > Pricing Administration > Deal Guidance > Guidance Rule. The 
guidance rules page is displayed.
Search for the guidance rule and do one of the following: 

To delete a single guidance rule, click the ellipsis icon (  next to the rollup 
name, and click Delete.
To delete multiple guidance rules, click the checkboxes next to the name 

column, and click the ( ) icon.
To delete all the guidance rules, click the checkbox in the header row next to the 

name column, and click the ( ) icon.
Click Confirm.

Managing Promotions

Navigating the Promotions Page
When you launch the promotions page on the UI, all the existing promotions are listed on 
this page along with their details. There are various functionalities available for you to 
manage the promotions.

Managing Views
You can manage column width, control which columns are displayed in the grid, freeze/pin 
a column range, or rearrange the column order. You can also filter the view of records in the 
grid by performing a keyword search, filtering the list by column value, or applying one or 
more advanced filters and filter logic. For more information, see Managing the View 
Settings and Filtering the Records.

)
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Actions available on this page
Click Create New to create a new promotion.

Click the ellipsis icon   next to the promotion name to delete an existing promotion.
Click the promotion name link to open the promotion Details page.
Export the selected promotions. For more information, see Exporting Records.

This section provides information on managing promotions.

About Promotions
Viewing Promotions
Creating a Promotion
Editing a Promotion
Deleting Promotion
Exporting Promotions

About Promotions
Promotions add value to a product through discount pricing and add reward for purchase. 
Promotions provide value for money for your customers and contribute to better sales for 
your organization. With the Conga Promotions package, you can incentivize the sales of 
products in your inventory. 

A promotion is a marketing technique that you apply to reduce the list price of a product or 
a service. A promotion consists of all non-tech activities that marketers use to try to 
increase sales over a specific period of time. You can create such promotions and restrict 
their scope, limit, and benefits so that your sales representatives can apply promotions to 
specific products, for specific customers, and for a limited period.

The following types of promotions are available.

Pro 
moti 
on 
Typ 
e

Description Example

Buy 
X 
Get 
X

When the customer 
purchases a product, you 
offer some benefit on the 
same product. 

As a marketing manager of a mobile phone company, you 
need to promote a new smart phone. You create a promotion 
where you offer your customers 20% discount on the price of 
the phone that they buy. 
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Pro 
moti 
on 
Typ 
e

Description Example

Buy 
X 
Get 
Y

When the customer 
purchases a product, you 
offer some benefit on a 
different product. 

As a marketing manager of an e-commerce company, you 
need to increase the sales of a refrigerator. You create a 
promotion where you offer your customers a free voltage 
stabilizer when they buy the refrigerator.

For 
ever 
y X 
Get 
X

When the customer 
purchases a certain 
quantity of a 
product, you offer some 
benefit on the same 
product.

As a marketing manager of a telecommunications company, 
you need to retain existing enterprise customers. You create a 
promotion where you offer your customers 10% discount on the 
price of each subscription for every 10 subscriptions that they 
buy.

For 
ever 
y X 
Get 
Y

When the customer 
purchases a certain 
quantity of a 
product, you offer some 
benefit on a different 
product.

As a marketing manager of a software company, you need to 
provide competitive pricing to a software as a service product 
during heavy competition. You create a promotion where you 
offer your customers free training for every 10 licenses that 
they buy.

 

Creating a Promotion

Viewing Promotions
The Promotion section is primarily designed for use by the Sales and Marketing department 
admin. The Promotions page provides a comprehensive listing of existing promotions and 
lets you filter, sort, and delete a promotion as required. You can also create new 
promotions from this page.

Promotions Search
You can narrow down the promotions list using the search feature. You can either define a 
search criteria to search for a range of promotions or use the promotion search option.

Basic Search
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In basic search, you can search for a promotion using keywords. For example, you can 
search using the name of the promotion. 

In the Search this list field, enter a keyword related to your promotion details such as 
promotion name.
Click the search icon   or press Enter. CPQ returns all promotions that contain that 
keyword in the promotion names.

Advanced Search

In advanced search, you can search for a promotion using a search query. The search query 
uses options provided in Field, Operator, and Value and displays a search result that 
matches the criteria.

Click the Advanced Search icon  . The Advanced Search pop-up is displayed.
Click Add Criteria.
Enter the following details: 

Field: All promotion field options are available in the drop-down list such as 
Promotion Code, Promotion Name, Type, Effective Date, Expiration Date, Last 
Modified Date, and Auto Apply?
Operator: Operators that are available for selection helps create the filter 
expression. Operators are displayed based on the field types. 
Value: Enter a value.

Click Add Criteria if you want add more criteria in the advanced search.
Review the filter expression.
Click Apply to enable the search filter. CPQ returns all promotions that match the 
criteria.

Sorting promotions
You can sort the promotions list by clicking the column names. The promotions are sorted 
alphabetically in ascending order using the promotion name. Every time you click the 
column name, the sorting switches between ascending and descending order. You can 
adjust the column width by dragging the columns. Hover near the column boundaries till 
two-way arrow appears. Click when the arrow appears and drag left or right to adjust the 
column width.

Actions available on this page
Click Create New to create a new promotion.
Click the promotion name to view or edit the details of the promotion.

Click the ellipsis icon   next to the promotion code to delete an existing promotion.
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Items per page
At the bottom of the page, you can see the total count of promotions available. You can 
control the number of promotions to be displayed on each page. You can select the number 
of promotions from a predefined list. You cannot configure this list. By default, you see 20 
records on each page.

By default, you can sort 10, 20, 30, 50, and 100 promotions per page using the Rows per 
page drop-down. This feature works in association with the search and filter functions to 
display search records per page. You can use the < and > buttons to move to the next or the 
previous pages. You can also jump to a certain page using the page search component.

Promotion Summary

Click on a promotion name from the list of promotions to view details for for all 
sections that is Information, Scope, Criteria, Benefits, Limits and Coupons.
All the sections have ‘Expand’ and ‘Collapse’ effects to view the details. The data is 
displayed in read-only mode.
You can edit a section of the promotion from the Summary page. For example, open a 
promotion and expand Benefits. Click Edit to modify the benefits that are applied to 
the selected promotion.

Creating a Promotion
Every promotion you create has the following aspects that you must define:

Information
Scope
Criteria
Benefits
Limits
Coupons

Each aspect of a promotion is dependent on certain objects and fields that you must 
configure or define before you can create your first promotion. 

Defining Information of a Promotion

To create a promotion

Go to ADMIN SETUP> Pricing Administration > Promotions. A list of promotions is 
displayed.
Click Create New.
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Select a promotion type.
Buy X Get X
Buy X Get Y
For Every X Get X
For Every X Get Y 

Click Continue. The Information page is displayed. 

Enter the following details:

Field Description

Promotion 
Name

Enter a name for the promotion. This name is displayed along with the 
promotion information. For example, whenever you look-up the promotion 
information that is applicable to a specific product, the promotion name 
that you provided here is displayed.

Promotion 
Code

Enter the code that is used for applying promotion. This code is captured 
on the order or proposal line items when the promotion is applied to the 
line item. Marketing teams can use this code for marketing campaigns. 
When a promotion is not auto-applied, that is when the Auto Apply? is 
deactivated or off, you can use the promotion code to avail a 
promotional offer.

Applied To You can apply promotions on line item and on order levels. Select from the 
following options:

Line Item: To apply a promotion on line item level. This line item 
is the primary object to which your promotion is applied.
Summary Group: To apply promotion on the order level.

If you select 'Buy X Get X' promotion, only then can you choose between 
Line Item and Summary Group. For all other types of promotions, Line Item 
is the default selection. 
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Field Description

Priority Enter a number for the priority.

Effective Date Date from which the promotion is applicable. Cannot be blank. By 
default, it is set to current date (date when you create the promotion 
record) +1.

Expiration 
Date

Date on which the promotion expires. Cannot be blank. Should be greater 
than the effective or the start date. By default, it is set to 1 year from the 
effective date.

Is Active Can be set to On or Off. Set it to On when you want a promotion to be 
applied and should be active for the criteria which you specify. Active flag 
on the promotions is set using a workflow linked to approvals similar to 
what you would do for any other custom object approval. For example, 
you can write a workflow rule to set the active status to true once the 
promotion is Approved (if approval is set up). Approvals set up would be 
similar to custom object approvals for any object.

Auto Apply? Can be set to On or Off. Set it to On when you want a promotion to be 
automatically applied when a promotion criterion is met. Set it to Off 
when you want to manually enter an Incentive Code to apply a 
promotion. If you want to create coupons along with the promotion, then 
set Auto Apply? to Off. 

Combine with 
Other 
Promotion?

Enables you to combine the new promotion with an existing promotion.

Cannot 
combine with 
these 
promotions

Enabled only if Combine With Other Promotions? is set to On.

You can select a list of promotions which should not be combined with the 
new promotion.

This is a generic grouping of the promotions for analyzing and tracking 
the promotions. You can select one or more promotion groups. The list of 
Promotion Groups needs to be defined separately in the Incentive Group 
object and should be active. Marketing managers can create reports and 
track the groups that are more successful than others and drive the 
business strategy accordingly.

Description Enter a description for the promotion.
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Review the summary box which displays the details of the promotion which you have 
created.
Click Save to save the changes or click Save & Next to move to the next tab.

After you have described the promotion, you must now define the scope of this new 
promotion.

Defining Scope of a Promotion
You must define the scope of a promotion to determine the types of accounts, the regions, 
and the products that this promotion will be available to. 

To define the scope of your new promotion

Define values for the fields described in the following table.

Field Description

Price List Select the price list that you want to use for your 
promotion.

Note

The default value for each field is All. If you do not select a value, CPQ 
evaluates all items for each field and that can impact the performance.
By default, the fields you define are set to be included in the scope of your 
promotion. Select the Exclude radio button for any parameter if you want to 
exclude that specific object from the scope of your promotion.


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Field Description

Product Family Select the Product Family that you want to apply the 
promotion to.

Exclude: The promotion will not be applied to 
the product families specified.
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Field Description

Product Select the specific products that you want to apply the 
promotion to. You can search a product by its name or 
code.

If you selected Promotion Type as Buy X Get X on the 
Information page, you will see the following options:

IN (Include (OR)): CPQ applies promotion on all 
products (in scope), which are available in the 
cart.
ALL (Include (AND)): CPQ applies promotion on 
all products (in scope) only if the products are 
added to the cart.
ALL IN BUNDLE (Include Bundle Options (AND)): 
CPQ applies promotion to a bundle and options 
only if the bundle is configured with specified 
options.
Exclude: The promotion will not be applied to 
the products specified.

Functionalities

To use Include (OR) scope, update the Product 
Criteria Oper field as “in”.
To use Include (AND) scope, update the Product 
Criteria Oper field as “all”.
To use Include Bundle Option (AND) scope, 
update the Product Criteria Oper field as “all in 
bundle”.

If you selected Promotion Type as Buy X Get Y on the 
Information page, you will see the following options:

IN (Include (OR)): If one of the specified products 
is included in the cart, CPQ applies the 
promotion to the benefit product.
ALL (Include (AND)): If all specified products are 
included in the cart, CPQ applies the promotion 
to the benefit product.
ALL IN BUNDLE (Include Bundle Options 
(AND)): If the bundle and all specified option 
products are included in the cart, CPQ applies 
the promotion to the benefit product.
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Field Description

Exclude: CPQ does not apply the promotion to 
the products specified.

Product Group Select the Product Group that you want to apply the 
promotion to.

Exclude: The promotion will not be applied to 
the product groups specified.

Account Type Select the types of accounts for which you want to make 
this promotion available.

Accounts Select the accounts for which you want to make this 
promotion available.

Click Save to save the changes or click Save & Next to move to the next tab.

After the scope, you must now define the criteria for this promotion.

Defining Criteria of a Promotion
You must define the criteria for a promotion before making it available to customers.  If a 
sales representative wants to apply this promotion to a customer's purchase, the criteria 
you define here will determine if that purchase qualifies for the promotion.

You can define two types of criteria based on:

The past purchases of customers or rolled-up metrics of past purchases. 
The data from the line item, header, lookup objects, and child objects of the lookup 
objects for a quote or an order.

You can also define additional filter criteria to determine which products this 
promotion applies to. 

To define the scope of your new promotion

Define values for the fields described in the following table.
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Field Description

Field Select an option from this list of fields to which the promotion 
must be applied. The fields available depend on 
what Reference Data Source you selected while defining the 
information.

Operator If the field you defined is a picklist or a lookup field, you can 
select one of the following operators.

equal to 
not equal to
in
not in

For any other field you defined, select one of the following 
operators.

equal to 
not equal to
less than
less than or equal to
greater than
greater than or equal to
contains (displayed only if you selected a field of 
type text or area such as Description)

Value Type If you select Constant (default), only Value is displayed.

If you select Field Value, Field Value is displayed. 

If the field you selected is a date, you can select from one of 
the following options:

Offset (+) Days
Offset (-) Days
Offset (+) Months
Offset (-) Months
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Field Description

Value This field is visible only if you select Constant from the Value 
Type drop-down.

Enter a simple constant value or select single or multiple 
values using the search widget depending on the field type and 
operator you defined for the primary data source.

If you select Product from the Field drop-down, you can search 
for a product by its name or code in the Value field. The search 
results display the product name and code wherever 
applicable. If a product has a code defined, the search result 
displays the name and code; otherwise, the search result 
displays only the name.

Field Value This field is visible only if you select Field Value from the Value 
Type drop-down.

Select one from the list of fields from the child filter object.

To add a new row click the Add Criteria button.
By default all the criteria will be in the AND condition. If you want to modify the logic 
then toggle on for the logic and enter the condition manually. For example, If the user 
wants the ‘Criteria Expression’ to be generated automatically as per the created 
rows with AND operation, you can keep the ‘Logic’ as Turned Off. By doing this, all the 
criteria will have by default AND operators in between and the string will be 
generated as 1 AND 2 AND 3 automatically. Whereas, if the user wants to create the 
expression string manually, then the ‘Logic’ should be turned on and you can create 
expressions manually such as 1 AND (2 OR 3), (1 OR 2) AND 3 etc.
Click Save to save the changes or click Save & Next to move to the next tab.

After the scope, you must now define the limits for this promotion.

Defining Benefits of a Promotion

To define the benefits of a promotion:

In the Benefits section, the Rule Name, Product Family, and Product fields are 
available only if you selected the Buy X Get Y promotion.
In the Benefits section, the For Every X Criteria, Benefit Product, and Benefit Type sub- 
sections are available only if you select the For Every X Get X and For Every X Get 
Y promotions.
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In the Rule Name field, enter a name for the benefit rule.
From the Product Family lookup, search and select the required product 
families.
From the Products lookup, search and select the required products. You can 
search for a product by its name or code. The search results also display 
product name and code wherever applicable. If a product has code defined, the 
search result displays name and code; else the search result displays only the 
name.
For Buy X Get Y promotions, if the charge types of scope and benefit products 
are different in price list items, you must select a charge type for the benefit 
product in the Charge Type multi-select box. Otherwise, CPQ does not apply 
the promotion on the benefit product. CPQ applies the Buy X Get Y promotion to 
the benefit product regardless of the charge type present on the product you 
have selected in the Scope and Benefit sections.
Use the following operators to define the benefit for multiple products:

Or: CPQ applies promotion only to the first product that matches the 
criteria (selected by default).
And: CPQ applies promotion to all products on the benefit criteria. All 
benefit products must exist on the cart to apply the promotion.

In the Charge Type multiselect box, select the required charge type for the 
benefit products if the charge types of scope and benefit products are different 
in price list items.
The Charge Type multiselect box is applicable only for Buy X Get Y type of 
promotions. The charge type of the product you selected from the Product drop- 
down in the Scope section does not have any impact on the charge type you 
select for benefit product in the Charge Type multiselect box in the Benefit 
section.

If you select multiple benefit products from the Products lookup, you must 
select multiple charge types in the Charge Type multiselect box 
depending on their charge types in the price list item.
If you select only one benefit product from the Products lookup and its 
charge type is same as of the charge type of the scope product, CPQ 
applies promotion on the benefit product even if you do not select a 
charge type in the Charge Type multiselect box.
If you select only one benefit product from the Products lookup and its 
charge type is different from the charge type of the scope product, you 
must select a charge type in the Charge Type multiselect box. Otherwise, 
CPQ does not apply promotion on the benefit product. For example, if the 
charge type of the scope product is Standard Price and the charge type of 
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iii.

the benefit product is License Fee, you must select License Fee for the 
benefit product in the Charge Type multiselect box.
If the benefit product has two charge types in price list item, you must 
select only one of the charge types in the Charge Type multiselect box 
depending on which charge type you want CPQ to apply the promotion on 
the benefit product.

Enter the details in the following subsections:
In the Benefits section, the For Every X Criteria, Benefit Product, and Benefit 
Type sub-sections are available only if you selected the For Every X Get 
X and For Every X Get Y promotions.
You can create a promotion of type For Every X Get X where X can be multiple 
products or any product from a group. For example, Mobile Phones are a group 
of products consisting of ABC 13, ABC 13 Pro, and ABC 13 Max phones. You create 
a For Every X Get X promotion for Mobile Phones as "for every 5 mobile phones 
get 20% discount on the 6th mobile phone". When the users add any product 
from Mobile Phones (that are defined in the criteria of the promotion) to the 
Cart; CPQ applies the defined For Every X Get X promotions to those products. 
For example, if the user adds 6 ABC 13 and 6 ABC 13 Max phones to the Cart, 
CPQ provides 20% on the 6th 6 ABC 13 and 6th ABC 13 Max phones. However, 
the users must fulfil the quantity criteria for each product to get the benefit for 
that product. For example, the users must add 5 ABC 13 mobile phones to get 
20% discount on the 6th ABC 13. The users will not get any benefit if they add 4 
ABC 13 and 2 ABC Pro phones to the Cart.
From Conga CPQ May '22 release, CPQ does not add the criteria product on the 
Price Rule entry object. All products in scope are eligible for promotions. After 
upgrading Conga CPQ to May ’22, the existing or previously defined Every X Get 
X promotions do not work with multiple products. You must create a new 
promotion to support multiple products. However, the existing Every X Get 
X promotions will work for a single product according to their current 
implementation.

Criteria Value: Enter the criteria value on the scope product for the 
promotion to be applied on the benefit product. The criteria value 
determines how many quantities of the scope product the user must buy 
for the promotion to be applicable on the benefit product.

Type: Select Quantity.
Metric: Select Quantity. 
Value: Enter a numerical value.

Benefit Product: Select the benefit product on which promotion must be 
applied.
Benefit Type: Select Price and Quantity.
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Benefit Quantity: Enter a numerical value. The benefit quantity 
determines on how many benefit products the promotion is applicable.

From the Rate Type drop-down, select a value.
On the Rate Type drop-down, CPQ supports only Single Rate, Rate Table - No Tiers, 
and Rate Table - With Tiers rate types.

"Rate Table - With Tiers" and "Rate Table - No Tiers" are only supported with 
Buy X Get X (Line Item) promotions. For all other promotion types, only "Single 
Rate" is supported.


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Rate Type Description

Single Rate Selecting this option allows you to define lump sum benefits that do not 
depend on transaction volume or amount. This is an ideal option when your 
promotion is not dependent on the amount or quantity of the line items. Select 
this value if your promotion calculation has no dependency on the amount or 
quantity ordered.

For example, a seasonal promotion that offers 15% off for smartphones.

If you select this Rate Type, enter the following values:
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Rate Type Description

Field Description

Adjustment Type Select a value to define how you want to apply 
the benefit. The supported values are:

% Discount: A percentage discount 
specified in the Adjustment 
Amount field is applied on the option 
selected in Adjustment Applies To. 
Discount Amount: A discount 
amount specified in the Adjustment 
Amount field is applied on the option 
selected in Adjustment Applies To.
% Markup: A percentage 
markup specified in the Adjustment 
Amount field is applied on the option 
selected in Adjustment Applies To. For 
example, if you want to increase the 
price of laptops during the month of 
September, you can apply a 
percentage markup that adds to the 
List price.
Markup Amount: A markup amount 
specified in the Adjustment 
Amount field is applied on the option 
selected in Adjustment Applies To. For 
example, if you want to increase the 
price of laptops during the month of 
September, you can apply a markup 
amount that adds to the List price.
Price Override: The amount specified in 
the Adjustment Amount field overrides 
the option selected in Adjustment 
Applies To.

Adjustment Applies To The value of this field controls to which price 
point the adjustments are applied. For example, 
whether the price discounts are applied to the 
total net price or the starting price.
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Rate Type Description

Field Description

Adjustment Amount Enter the adjustment amount.

Benefit Uom Select the benefit unit of measure for the 
product. This is not a mandatory field. The 
default value will be NULL and the user can 
select anyone from below. If the user has not 
selected any value here, then the system will 
consider the Cart line item’s selling UOM as the 
Benefit UOM.

Each
Hour
Day
Month
Year
Quarter
Case
Gallon
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Rate Type Description

Rate Table 
- No Tiers

Allows you to conditionally define promotional amount. Examples of 
conditions are products, regions, and account types.

If you select this Rate Type, enter the following values:

Field Description

Benefit Uom Select the benefit unit of measure for the 
product. This is not a mandatory field. The 
default value will be NULL and the user can 
select anyone from below. If the user has not 
selected any value here, then the system will 
consider the Cart line item’s selling UOM as the 
Benefit UOM.

Each
Hour
Day
Month
Year
Quarter
Case
Gallon

Adjustment Applies To The value of this field controls to which price 
point the adjustments are applied. The values 
for tis field are

Base Price
List Price
Base Extended Price
Extended Price
Net Unit Price

Effective Date Enter the start date for the product  from when 
the Benefits will be applied.

Expiration Date Enter the expiration date for the product.
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Rate Type Description

Field Description

Rate Table Columns This field is used to define the conditions to be 
used with the rate table. 

If you need to define different promotions for 
different products, make sure the product 
column is added. If you would like to add 
another condition, make sure to select the value 
from the picklist and click the Update button.

Rate Table As per the passed Rate Table Column values, 
the Rate Tables should be created. One or more 
than one entries can be provided in the Rate 
Tables by clicking on '+' icon and you can delete 
a particular row by clicking the 'Delete' icon.

In the Create Structure, enter the following 
details:

Field Description

Rate Value Type From the below values, 
anyone value can be 
selected:

% Discount
Discount 
Amount
% Markup
Markup Amount
Price Override

Adjustment 
Amount

Enter the adjustment 
amount.

Once the Rate Table is created, you can view 
the structure by clicking on 'View Structure'.  One 
or more than one entries can be provided in the 
Rate Table Structure by clicking on '+' icon and 
you can delete a particular row by clicking the 
'Delete' icon against the row.
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Rate Type Description

Rate Table 
- With Tiers

Selecting this option allows you to define promotional adjustment that 
depends on transaction volume or revenue. If you select this Rate Type, enter 
the following values:

Field Description

Rate Table - Tier Type The value of this field controls how 
the promotion is calculated.

Rate Per Each Tier - Promotion is calculated at 
different pricing levels. The promotion 
amount for each unit depends on which tier the 
unit falls under. This is the most common 
scenario for customer promotion calculation.

Highest Tier Rate - Promotion is calculated 
based on the total volume or revenue. Each unit 
receives the same promotional amount.

Tier Metric Type The value of this field controls which metric will 
be used to qualify for tiers.

Volume - Volume or quantities are used 
to qualify for tiers. Select this value if your 
promotion varies based on the purchase 
quantities but has no dependencies on the 
dates. 

Revenue - Total quote amount is used to 
qualify for tiers. Select this value if your 
promotion varies based on the revenue amount 
but not on the dates.
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Rate Type Description

Field Description

Benefit Uom Select the benefit unit of measure for the 
product. This is not a mandatory field. The 
default value will be NULL and the user can 
select anyone from below. If the user has not 
selected any value here, then the system will 
consider the Cart line item’s selling UOM as the 
Benefit UOM.

Each
Hour
Day
Month
Year
Quarter
Case
Gallon

Metric Calculation Period Select a period over which the tier metric is 
aggregated. The supported value is No Rollup, 
which means the tier metric is based on the 
value from individual transaction only.

Metric Value Source The value from this field determines the source 
based on which the volume or revenue is 
calculated. The calculated volume or revenue 
amount is used to determine the tier.

Select this value if the Tier Metric Type is 
Volume. Once Quantity is selected, you will see 
that in the Rate Table Structure, the “from” and 
“to” columns become “From Quantity” and “To 
Quantity”.
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Rate Type Description

Field Description

Adjustment Applies To The value of this field controls to which price 
point the adjustments are applied. The values 
for this field are 

Base Price
List Price
Base Extended Price
Extended Price
Net Unit Price

Rate Table Columns This field is used to define the conditions to be 
used with the rate table. 

If you need to define different promotions for 
different products, make sure the product 
column is added. If you would like to add 
another condition, make sure to select the 
value from the picklist and click the Update 
button.
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Rate Type Description

Field Description

Rate Table As per the passed Rate Table Column values, 
the Rate Tables should be created. One or more 
than one entries can be provided in the Rate 
Tables by clicking on '+' icon and you can delete 
a particular row by clicking the 'Delete' icon.

In the Create Structure, enter the following 
details:

Field Description

Rate Value Type From the below values, 
anyone value can be 
selected:

% Discount
Discount 
Amount
% Markup
Markup 
Amount
Price Override

Adjustment 
Amount

Enter the adjustment 
amount.

Once the Rate Table is created, you can view 
the structure by clicking on 'View Structure'.  
One or more than one entries can be provided in 
the Rate Table Structure by clicking on '+' icon 
and you can delete a particular row by clicking 
the 'Delete' icon against the row.

Click Save to save the changes or click Save & Continue to move to the next tab.

Defining Limits of a Promotion
You must define promotion limits to determine the number of times your customer can 
apply a promotion for different types of the transactions.
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2.

To define the limit of a promotion,

Enter values for the fields described in the following table:

Field Name Description

To Whom Does the Limit Apply? Enables you specify the object on which the limit is 
applied. The objects on which limit is applicable on 
are Account, User, and Contact.

Benefit Quantity Specifies what will be the parameter on which the 
limit is applicable.

Benefit Quantity: Specifies that the discount would 
be applied on a fixed quantity.

Benefit Quantity Limit Specifies the value of the Benefit Quantity.

Recurring Type Specifies whether the limit applied is one time or on a 
recurring basis.

Frequency Specifies the frequency at which the applied 
incentives are limited. Available frequencies are 
 Monthly, Quarterly, Half Yearly, Yearly, Order.

Click Save to save the changes or click Save & Next to move to the next tab.

Expected Behavior
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Options Selected Expected behavior

Auto Apply deselected, Combine with 
Other incentives selected

You can build a User Interface to display the “Show 
Available Promotions” list using the Promotions API, 
which displays non-auto applied promotions. 

The user can then select one or multiple promotions to 
be applied.

Auto Apply deselected, combine with 
other incentives deselected

If a user provides multiple promo codes as a comma- 
separated list, the highest priority promotion is 
selected and applied from the list of promotions 
provided in the comma-separated list.

 

Auto-Apply selected, combine with other 
incentives deselected

If two or more promotions are applicable, the system 
picks the promotion with the highest priority and 
applies it.

Auto-apply selected, combine with other 
incentives selected

All promo codes fulfilling the criteria will be applied. If 
one or more promo codes have priority 1 which is 
applicable in a scenario all the promotions are 
applied. Suppose for a given scenario there are 4 
promo codes which are applicable having priority 
1,1,2,2 all four are applied.

Pricing is not stacked, so if all the four qualify and 
allow others to be applied then all four are applied.

If some of the promotions do not allow others to be 
applied then those promotions are filtered out.

Defining Coupons of a Promotion
Coupons are generally alphanumeric codes that correspond to a promotion. With Conga 
Promotions, you can now create multiple coupon codes for potential customers to promote 
your business and specific products in your inventory.

After you identify potential end customers in a target market, you can use coupons to track 
how customers use incentives, how you can optimize your promotions, and how you can re- 
target your customers. You can generate multiple coupon codes to share the range with 
your marketing team. 
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Viewing Coupons

You can view all coupons in Card and List view.

View Type Description

Card View Card view displays Coupon details in individual card format. It is a default view on 
UI. A card shows all the details of the existing coupon.

Click Card view icon ( ) to view coupon in card format.

Click the ellipsis ( ) icon to edit or delete the coupon.
Use Active toggle button to enable/disable the coupon.

List View List view displays coupon in a list. It is a default view on UI. Click List view icon (
) to view coupon in a list.

For this view, refer the following sections:

Click the ellipsis ( ) icon to edit or delete the coupon.
Edit any field for the coupon.
Mass Action is enabled.

To create a new coupon

On the coupons page, click Create Coupon to raise a Coupon Quantity pop-up.
Enter the number of coupons you want to create and click Create. The system 
generates coupons based on the number you entered.
Enter values for the fields described in the following table:
These fields act as filter criteria as well. For example, the coupon-assigned account 
or Incentive user needs to match the account field value specified on the quote or the 
logged-in user respectively. If the Account field value on the quote is missing, the 
coupon assigned to the account needs to match the account linked to the 
opportunity.

Field Description

Start Date The start date for the coupon.

End Date The last date this coupon is valid.

To create coupons for this promotion, set Auto Apply? to Off on the Information 
page. 


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Field Description

Limit The number of times you can use this coupon.

Price Dimension Select any type of price dimension associated with user or an 
account.

Assigned To Select the object to which the coupon is assigned to. The values 
will be shown according to the value selected for price 
dimension. 

Active Select the checkbox to activate the coupon.

Click Save to save the changes or click Save & Continue to move to the next tab.

 

Mass Actions: Delete, Edit, and Export

The mass action feature allows you to export, edit, or delete the selected coupons in one 
instance.

Click the checkbox beside Coupon Code column. You can select one coupon, multiple 
coupons, or all the coupons.

Click the ( ) icon to export the selected coupon as CSV or Excel file format.
Click the edit () icon to edit the Start Date, End Date, Price Dimension, or Limit of the 
selected coupons. You can also make them active or inactive.

An Edit (number of coupons selected) Coupons pop-up will appear.
Make necessary changes and click Save. 
A Delete Coupons pop-up will appear. Click the delete () icon to delete the 
selected coupons.
Click Confirm. 

Editing a Promotion
After you have created a promotion, you can edit the same whenever required.

To edit a promotion
Go to ADMIN SETUP> Pricing Administration > Promotions. The Promotions page is 
displayed.
Search for the promotion you want to edit.
Click the promotion name. The Summary screen is displayed.
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You can expand each section to see the details.
Click Edit to modify the expanded section. For example, expand Benefits section for a 
promotion and click Edit to modify the benefits that are applied to the selected 
promotion.
Click Save & Next to move to the next section.
Click Save to save the changes to the promotion.

Deleting Promotion
You can delete promotions that are no longer required for your business requirements. 

To delete a promotion
Go to ADMIN SETUP > Pricing Administration > Promotion. The Promotions page is 
displayed.
Search for the promotion and do one of the following: 

To delete a single promotion, click the ellipsis icon (  next to the rollup name, 
and click Delete.
To delete multiple promotions, click the checkboxes next to the name column, 

and click the ( ) icon.
To delete all the promotions, click the checkbox in the header row next to the 

name column, and click the ( ) icon.
Click Confirm.

 

Managing promotions

Exporting Promotions

Mass Actions: Export
The mass action feature allows you to export the selected coupons in one instance.

Click the checkbox beside Promotion Code column. You can select one promotion, 
multiple promotions, or all the promotions.

Click the export ( ) icon to export the selected promotions as CSV or Excel file 
format.

The file gets downloaded to your local storage.

)
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Managing the Price Waterfall
Price Waterfall is the industry standard for Price and Margin calculation. Price waterfall 
defines a sequence to handle different prices with the target of reaching the net price.

A well-defined Price Waterfall provides transparency and high visibility of pricing 
calculation and helps protect margins and avoid incorrect pricing.

Price Waterfall comes with features for transparency and high visibility in pricing 
calculation and protecting margins, avoiding incorrect pricing. In addition, Price Waterfall 
defines a sequence to treat different prices with the end goal of arriving at the net price 
charged to the customer. 

Price Waterfall enables administrators to configure the price execution flow and set the 
groundwork for Conga's Price Waterfall feature to display detailed pricing steps for end- 
users to visualize. Price waterfall is a tool that provides users with detailed information on 
how much revenue the company is generating from a transaction and the pocket margin of 
that transaction. The waterfall is typically represented in a column chart consisting of 
critical price or margin points and any adjustments that were applied to the list price to 
arrive at the final price or margin.

The advantages of the price waterfall functionalities are as follows:

Provides Sales Representatives with the ability to drill down on any price point visible 
to them so that they can make better decisions and better communicate the deal to 
customers giving them more leverage during a negotiation.
Provides approvers and the deal desk with a complete picture of the different price 
points, preapproved and non-standard adjustments, and costs to better analyze the 
health of the deal.
Enables cost accountants and controllers ability to drill down on the cost (if cost is 
included as part of the price waterfall) to ensure that the deal's profitability is 
accurately calculated.

Navigating the Price Waterfall Page
When you launch the Price Waterfall page on the UI, all the existing price waterfalls are 
listed on this page along with their details. There are various functionalities available for 
you to manage the field sets.

Viewing Price Waterfall
You can view all price waterfall in Card and List view.
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View 
Type

Description

Card View Card view displays price waterfall details in individual card format. It is a default 
view on UI. A card shows the details such as Title, Description, Effective & Expiration 
Date, Sequence, and Is Active?.

Click Card view icon ( ) to view price waterfall in card format.
Click the card title to open the card.
Use Is Active? toggle button to enable/disable the price waterfall.

List View List view displays price waterfall in a list. Click List view icon ( ) to view price 
waterfall in a list.

For this view, refer the following sections:

Price Waterfall Search in List View
Sorting Price Waterfall List
Items Per Page in List View

Price Waterfall Search in List View
You can narrow the price waterfall list using the search feature in list view. You can either 
define search criteria to search for a range of price waterfalls or use the price waterfall 
search option.

Basic Search

In basic search, you can search for a price waterfall using keywords. For example, you can 
search using the name of the price waterfall. 

In the Search this list field, enter a keyword related to your price waterfall details 
such as price waterfall name.
Click the search icon (  or press Enter. CPQ returns all price waterfalls that 
contain that keyword in the price waterfall names.

Managing Views
You can manage column width, control which columns are displayed in the grid, freeze/pin 
a column range, or rearrange the column order. You can also filter the view of records in the 
grid by performing a keyword search, filtering the list by column value, or applying one or 
more advanced filters and filter logic. For more information, see Managing the View 
Settings and Filtering the Records.

)
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Actions Available on this Page
Click Create New to create a new price waterfall.

Click the More icon (  next to the price waterfall name to edit an existing price 
waterfall.
Click the price waterfall name link to open the price waterfall Details page.
Export the selected price waterfall. For more information, see Exporting Records.

Navigating the Price Waterfalls Details page
Go to ADMIN SETUP > Pricing Administration > Price Waterfall > Price Waterfall.
Search for the price waterfall you want to update.
Click the price waterfalls name link to open the Price Waterfalls details page.

This section provides information on managing price waterfall.

Creating the Price Waterfall
Creating New Price Point
Managing Price Waterfall Rulesets
Deleting the Price Waterfall

Creating the Price Waterfall
You can create one or multiple price waterfall as required.

To create a price waterfall
Go to ADMIN SETUP> Pricing Administration > Price Waterfalls > Price Waterfall. 
The Price Waterfall page is displayed.
Click the Create New button. The New Price Waterfall page is displayed.
Enter the following details:

Field Description

Waterfall Name Enter a name for the Price waterfall.

Sequence Give a number sequence to the new Price 
waterfall. (Avoid duplicate sequence numbers. While the 
system doesn't enforce this restriction, if duplicates occur, 
random priority will be assigned within the identical 
sequences)

)
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Field Description

Description Enter a description for the Price waterfall.

Effective Date Select the date from which the Price waterfall will be 
active.

Expiration Date Select the expiration date for the Price waterfall. The date 
must be greater than the effective date if both are defined.

Active Toggle button to show whether the Price waterfall is 
active.

Click Continue.  
The application navigates you to the Price Points screen to define the points.

Defining Price Points

Creating New Price Point

Managing the Price Waterfall

Defining Price Points
You can define the price points to new price waterfall as per the requirements.

To define price points to new price waterfall

When you click Continue from New Price Waterfall screen, the application navigates you to 
define price points. You can add and define price points to be used in waterfall. The List 
Price and Base Price are set by default, you can add other custom price points and set one 
of them as Net Price.

Click the text box in the Price Point Name column and select the Custom Price 
Point from the list.
Net Price: Define one of the Custom Price Point as Net Price, which will be used for 
downstream net price calculation. Move the slider to enable the Is net price option.
Click the '+' icon to add more Custom Price Points. To create new price points, see 
Creating New Price Point.

Click the delete   icon to delete the Custom Price Point.
Click Create.

you can define a criteria once the Waterfall is created.
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The application creates a new price waterfall. Once the new price waterfall created, you 
can access the price point for the desired price waterfall.

Click the desired price waterfall to open it.
Click Price Points tab to view the price points.
Click icon to define new price points.
Enter the following details:

Field Description

Price Point Name Select a price points from the list of price points created in the 
Waterfall Charts list page. The List Price and Base Price are 
added by default and cannot not be modified or deleted.

You can create custom price points on the Waterfall chart 
list page by clicking Price Points button. You can see the list of 
price points on the Price points screen. For more information, 
see Creating New Price Point.

Net Price Enable and set one of the price points as the Net Price which 
is used for downstream integration (Billing, ABO, etc.). You 
cannot set the List price and Base Price as the Net Price. By 
default, Net Price will be enabled for the first price point. You 
can change it to any other custom price point. 

Turning ON the net price to any other price point should turn 
OFF the previously enabled because we can have only one 
net price enabled price point.

•

•
•

•

•

You can set one of the price points as the net price that is used for 
downstream integration (Billing, ABO, etc.) except list price and base 
price
Setting up one price point as net price is mandatory.
By default, Net Price is enabled for the first price point and will allow 
you to change to any other custom price point,
Turning on net price to any other price point will turn off the previously 
enabled net price.

You can adjust the sequence of price points by moving the   icon. 
However, the net price and base price would be in it's default position.


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Field Description

Display Name Use the "Display Name" feature to create a custom label for 
the price point, which will appear on the waterfall chart to 
represent the price point. By default, the display name 
matches the name of the price point.

You can edit the display name by clicking on it. To edit the 
display name, follow the steps below:

a. Select the display name and enter the desired new display 
name.

b. Click Save.

Click the delete icon to remove a price point.
Click Save.

Creating the Price Waterfall

Creating New Price Point

Creating Price Waterfall Charts

To create a price waterfall chart

Go to ADMIN SETUP > Pricing Administration > Price Waterfall. The Price Waterfall 
page is displayed.
Click the required price waterfall name link to open the Price Waterfalls details page.
Click the Waterfalls Charts tab. 

If there are existing price rules, you can perform the following actions on the list 
of rules:

Click Create New Chart. The Create New Waterfall Chart pop-up is 
displayed. Go to step 4.
Click the required waterfall chart name link to open the waterfall chart 
details page.
Rearrange the sequence of rules using the   icon. 
Click the ellipsis icon for the waterfall chart and click Delete.

If there are no unsaved changes, the Delete Price Rule pop-up is 
displayed. Click Confirm.

You can adjust the sequences of price points by moving the   icon. However, the 
net price and base price would be in it's default position.


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If there are unsaved changes, the a pop-up is displayed prompting 
your confirmation. Click Discard Changes. The Delete Price Rule pop- 
up is displayed. Click Confirm.

Click the ellipsis icon for the waterfall chart and click Clone.
By default, the Chart Name will be Clone-The chart name from 
which you have cloned and the sequence will be 1+ The chart 
sequence from which you have cloned.
Click Clone.

If there are no charts created, click Create New.
Enter the following details: 

Field Description

Chart Name Enter the name of the waterfall chart.

Sequence Give a number sequence to the new waterfall 
chart. (Avoid duplicate sequence numbers. While the system 
doesn't enforce this restriction, if duplicates occur, random 
priority is assigned within the identical sequences)

Description Enter a description for the waterfall chart.

Is Active? Toggle on if the waterfall chart is to be set active.

 Click Create.
You can add the criteria using standard criteria model.

Click Add Criteria. The Chart Criteria pop-up is displayed.
On the Line Items tab, enter the following details:

Field: Select a field on the product. You can select custom fields also.
Operator: Select an operator.
Value: Enter a value.
Click Add Criteria to add one more criteria.

Click the remove icon   to remove a criteria.
Click Remove All to remove all criteria.
Click Save.

On the Product Attributes tab, enter the following details: 
Field: Select a field on the product. You can select custom fields also.

If you enter a description to a price waterfall chart, 
then the info icon associates to the Waterfall Chart's 
left panel. 


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Operator: Select an operator.
Value: Enter a value.
Click Add Criteria to add one more criteria.

Click the remove icon   to remove a criteria.
Click Remove All to remove all criteria.
Click Save.

On the User Role tab, enter the following details:
Field: Select a field on the product. You can select custom fields also.
Operator: Select an operator.
Value: Enter a value.
Click Add Criteria to add one more criteria.

Click the remove icon   to remove a criteria.
Click Remove All to remove all criteria.
Click Save.

Turn the Logic button on and enter a value in the Logic field when you add 
multiple conditions. When there is more than one condition for a constraint rule, 
this field defines when to consider one or more of the conditions using AND/OR 
association. The sequence number defined in the Condition column is used as an 
identifier of the condition.

Under Manage Price Points section: 
The manage price point enables you to set the visibility restriction on price points. It is 
advised to refrain from eliminating intermediate price points.

Price point restriction will have all the price point listed down as defined in the 
waterfall.
By default, all the price points will be selected and user can deselect the price 
points which are not required for the respective chart.
The Net Price tag will be defined with the associated price point. 

Under Additional Details: 
This section will allow you to select the line item fields which you want to display 
below waterfall chart as additional detail for the line item and make it editable if 
you want user to modify on the same page.

Creating New Price Point
You can create new price points as per the requirements.
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To create a new price point
Go to ADMIN SETUP> Pricing Administration > Price Waterfalls > Price Waterfall. 
The Price Waterfall page is displayed.
Click Price Points option.
Enter a Enter the name of the new price point in the New Price Point Name field.
Click Create. 

Managing Price Waterfall Rulesets
The Price Waterfall Ruleset enables the specification of adjustments tailored to particular 
price points. By leveraging criteria and scope parameters, one can refine the adjustment's 
relevance to meet specific business requirements.

Navigating the Price Waterfall Rulesets Page
When you launch the price waterfall page on the UI, click the price waterfall ruleset tab. 
There are various functionalities available for you to manage the waterfall rulesets.

Waterfall Rulesets Search

You can narrow down the waterfall rulesets list using the search feature. You can either 
define search criteria to search for a range of waterfall rulesets or use the waterfall 
ruleset search option.

Basic Search

In basic search, you can search for a waterfall ruleset using keywords. For example, you 
can search using the name of the waterfall ruleset. 

In the Search this list field, enter a keyword related to your waterfall ruleset details 
such as waterfall ruleset name.
Click the search icon   or press Enter. CPQ returns all waterfall rulesets that 
contain that keyword in the waterfall ruleset names.

Advanced Search

In advanced search, you can search for a waterfall ruleset using a search query. The 
search query uses options provided in the Field, Operator, and Value and displays a search 
result that matches the criteria.

Click the Advanced Search icon  . The Advanced Search pop-up is displayed.
Enter the following details: 
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Field: All waterfall ruleset fields are available in the drop-down list such as 
Text, Checkbox, Date, Date/Time, Number, Percent, Picklist, Multi-Select Picklist, 
Currency.
Operator: Operators that are available for selection helps create the filter 
expression. Operators are displayed based on the field types. For example, a 
picklist value will display equal to and not equal operators and a text field will 
display equal to, not equal to, starts with, contain, does not contain operators. 
If it is a multi-value picklist, the application displays include and does not 
include operators.
Value: Enter a value.

Click Add Criteria if you want add more criteria in the advanced search.
Turn the Logic button on if you have more than one criteria and enter a value in 
the Logic field.
Click Apply to enable the search filter. CPQ returns all waterfall rulesets that match 
the criteria.

View Setting

In view setting, you can select the fields to be displayed in the list of waterfall rulesets. You 
can freeze the columns as well. You can move the fields in the available and showing 
sections to configure the view setting.

Sorting Waterfall Rulesets

You can sort the waterfall rulesets list by clicking the column names. The waterfall rulesets 
are sorted alphabetically in ascending order using the waterfall ruleset name. Every time 
you click the column name, the sorting switches between ascending and descending order. 
You can adjust the column width by dragging the columns. Hover near the column 
boundaries till two-way arrow appears. Click when the arrow appears and drag left or 
right to adjust the column width.

Items per page

At the bottom of the page, you can see the total count of waterfall rulesets available. You 
can control the number of waterfall rulesets to be displayed on each page. You can select 
the number of waterfall rulesets from a predefined list. You cannot configure this list. By 
default, you see 20 records on each page.

By default, you can sort 10, 20, 30, 50, and 100 waterfall rulesets per page using the Rows 
per page drop-down. This feature works in association with the search and filter functions 
to display search records per page. You can use the < and > buttons to move to the next or 
the previous pages. You can also jump to a certain page using the page search component.
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Navigating the waterfall rulesets Details page
Go to ADMIN SETUP > Pricing Administration > Price Waterfall > Waterfall Rulesets
Search for the waterfall ruleset you want to update.
Click the waterfall rulesets name link to open the waterfall rulesets details page.

Actions available on this page

Create new price waterfall rulesets.
On the Details tab, edit the waterfall ruleset details.
On the Features tab, add or remove features in the waterfall ruleset.

To add a new Feature, click the Add New button, and enter the field details. 

To remove an existing feature, click   button.
Click Save.
Export the selected waterfall rules. For more information, see Exporting Records.

Creating a Price Waterfall Ruleset

To create a price waterfall ruleset

Go to ADMIN SETUP > Pricing Administration > Price Waterfall > Price Waterfall 
Rulesets. The Price Waterfall Rulesets page is displayed.
Click Create New. The New Price Ruleset pop-up is displayed.
Enter the following details:

Field Description

Ruleset Name Enter a mandatory name for the ruleset.

Sequence Enter a mandatory Sequence in which the system 
will evaluate multiple rulesets. Typically, you will 
perform line item adjustments first and then any 
summary adjustments

Description Enter a description for the ruleset.

Active Turn this setting on to set the ruleset as active.

Stop Processing More Rules Turn this setting on to indicate that if the ruleset is 
satisfied, CPQ does not process any more rules.
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Field Description

Enable Data Range in Rule Entry Turn this setting on to set the effective date and 
expiration date on the rule entry.

Click Save. A new waterfall price ruleset is created and you are redirected to the price 
waterfall ruleset details page.
On the Details tab, you can update the details if required.
Click the Condition & Criteria tab and enter the following details:
Under the Conditions section:

In the Price List field, search and select a price list.
On the Product Family drop-down, select a product family.
On the Product Category drop-down, select a product category.
On the Product Group drop-down, select a product group.
On the Category drop-down, select a category.
On the Charge Type drop-down, select a charge type.

Under the Criteria section, do the following steps to add a ruleset criteria. 
Click Add Criteria. The Charge Type Criteria pop-up is displayed.
On the Line Items tab, enter the following details:

Field: Select a field on the product. You can select custom fields also.
Operator: Select an operator.
Value: Enter a value.
Click Add Criteria to add one more criteria.

Click the remove icon (  to remove a criteria.
Click Remove All to remove all criteria.
Turn the Logic button on and enter a value in the Logic field when you add 
multiple criteria.
Click Save.

On the Product Attributes tab, enter the following details: 
Field: Select a field on the product. You can select custom fields also.
Operator: Select an operator.
Value: Enter a value.
Click Add Criteria to add one more criteria.

Click the remove icon (  to remove a criteria.
Click Remove All to remove all criteria
Turn the Logic button on and enter a value in the Logic field when you add 
multiple criteria.
Click Save.

Click Save on the price ruleset details page.

)

)
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To delete a price ruleset

Go to ADMIN SETUP > Pricing Administration > Price Rulesets. The Price Rulesets page 
is displayed.
Search for the price ruleset you want to delete.

Click the ellipsis icon (  next to the price ruleset name and click Delete. The Delete 
Price Ruleset pop-up is displayed.
Click Confirm.

Creating a Price Waterfall Rule
The Waterfall Rule enables you to provide target adjustments to specific rulesets in the 
price waterfall chart. Although the standard price rules are applied to the Base Price, you 
can now target any custom waterfall ruleset that you want by using the price waterfall 
rule. When defining any price waterfall rule, you must associate at least one price point to 
a price waterfall rule. These rules are executed (subject to fulfilling other criteria) and 
shown as adjustments specific to only those price points in the price waterfall chart.

You can associate multiple waterfall rules to a price waterfall ruleset or through to a 
product. Price matrices can be defined in price rules as well as conditional price pipeline 
rules (rules that use Boolean logic such as AND/OR). The price waterfall rule can be 
dimensional, which uses a similar concept to Price Matrices, or Conditional, which relates to 
fields for pricing adjustments.

One ruleset can have multiple rules and is evaluated in order of the rule sequence. A rule 
can be dimensional or conditional. A price pipeline rule determines the actual price 
adjustment made.

Price Rule Search

You can narrow down the price rules using the search feature. You can either define search 
criteria to search for a range of price rules or use the price rule search option.

Basic Search

In basic search, you can search for a price rule using keywords. For example, you can search 
using the name of the price rule. 

In the Search this list field, enter a keyword related to your price rule name.
Click the search icon   or press Enter. CPQ returns all price dimensions that contain 
that keyword in the price dimension names.

Sorting Price Rule

You can sort the price rules by clicking the column names. The price rules are sorted 
alphabetically. Every time you click the column name, the sorting switches between 

)
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ascending and descending order. You can adjust the column width by dragging the 
columns. Hover near the column boundaries till two-way arrow appears. Click when the 
arrow appears and drag left or right to adjust the column width.

To create a price rule

Go to ADMIN SETUP > Pricing Administration > Price Waterfall Rulesets. The Price 
Waterfall Rulesets page is displayed.
Click the required price waterfall ruleset name link to open the Price Waterfall 
Rulesets details page.
Click the Price Waterfall Rules tab. 

If there are existing price waterfall rules, you can perform the following actions 
on the list of rules:

Click Create New. The Create New Price Waterfall Rule pop-up is 
displayed. Go to step 4.
Click the required price waterfall rule name link to open the price 
waterfall rule details page.
Rearrange the sequence of waterfall rules using the   icon. 
Turn the Is Active? setting on to make the waterfall rule active.
Click the ellipsis icon for the waterfall rule and click Delete.

If there are no unsaved changes, the Delete Price Waterfall Rule 
pop-up is displayed. Click Confirm.
If there are unsaved changes, the a pop-up is displayed prompting 
your confirmation. Click Discard Changes. The Delete Price Waterfall 
Rule pop-up is displayed. Click Confirm.

If there are no waterfall rules created, click Create New on the required 
waterfall rule type.

Dimension
Condition

Enter the following details:

Field Setting

Rule Name Enter a mandatory rule name.

Sequence Enter a mandatory sequence for the rule.

Description Enter a description for the rule.

Active Turn this setting on to make the rule active.
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Field Setting

Stop Processing More Rules Turn this setting to indicate that if the ruleset is satisfied, 
CPQ does not process any more rules.

Target Price Point Select the price point from the list to associate with the 
rule.

Target Price Point(s) - The Target Price Point 
specifies the position on the waterfall sequence 
prior to which the adjustment is applied. If 
multiple price points within the same waterfall 
are included, the adjustment is applied before the 
first price point in the sequence, disregarding 
others designated as Target Price Points. However, 
if the price points belong to different waterfalls, 
the same rule applies to multiple price points 
within each respective waterfall.


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Field Setting

Adjustment Applies To select an option to which the adjustment is applied. If the 
adjustment is a percentage, the Adjustment applies 
To value specifies the reference value against which the 
percentage is calculated. The supported values are List 
Price, Previous, and Prior Price Point. 

Value Description

Price Point Name The adjustment is a percentage of 
a designated price point, such as 
List Price, Base Price, or any other 
Custom Price Point preceding the 
adjustment in the waterfall 
sequence.

Previous The adjustment is a percentage of 
the running total up to the previous 
adjustment or price point, relative 
to the current adjustment.

Prior Price Point The adjustment represents a 
percentage of the price point just 
before the target in the waterfall 
sequence.
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Field Setting

Allowable Actions Adjust the value. In the example provided, Green signifies 
allowance and Red indicates restriction:

Value Description

Adjustment Upwards Users are permitted to increase 
the value but are restricted 
from reducing it.

Adjustment 
Downwards

Users can decrease the value 
but are prohibited from 
increasing it.

No Adjustments Users are not permitted to 
modify the adjustment.

Unrestricted Users can increase and 
decrease the value freely.

Rule Type Select a rule type. Supported values are:

Dimension
Condition

Under Dimensions:
The Dimensions section is applicable for Dimension rule type. 

Click Add Dimensions.
In the Dimension field, search and select a dimension.
In the Dimension Value field, select an option. Supported values are:

Discrete
Range
Weighted Range
Cumulative Range - Line Item
Cumulative Range

Click Save.

You can enter up to six dimensions, which bring in attributes from the line items 
or headers of any data type. For example, you can select a dimension on 
quantity.


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Creating Price Waterfall Ruleset Entry

Condition

Go to ADMIN SETUP > Pricing Administration > Price Waterfall Rulesets. The Price 
Waterfall Rulesets page is displayed.
Click the required price waterfall ruleset name link to open the Price Waterfall 
Rulesets details page.
Click the Waterfall Rules tab.

If there are existing metrices, click the required price waterfall rule name link to 
open the price waterfall rule details page.
If there are no metrices created, create a price waterfall rule. For more 
information, see Creating a Price Waterfall Rule.

On the Entries tab, click Add. A price waterfall rule entry is added.
Click Add Condition. The Charge Type Criteria pop-up is displayed. 

On the Line Items tab, enter the following details:
Field: Select a field on the product. You can select custom fields also.
Operator: Select an operator.
Value: Enter a value.
Click Add Criteria to add one more criteria.
Click the remove icon   to remove a criteria.
Click Remove All to remove all criteria.
Turn the Logic button on and enter a value in the Logic field when you add 
multiple criteria.
Click Save. A criteria is added under the Condition column.

On the Product Attributes tab, enter the following details: 
Field: Select a field on the product. You can select custom fields also.
Operator: Select an operator.
Value: Enter a value.
Click Add Criteria to add one more criteria.
Click the remove icon   to remove a criteria.
Click Remove All to remove all criteria.
Turn the Logic button on and enter a value in the Logic field when you add 
multiple criteria.
Click Save. A criteria is added under the Condition column.

Enter the following details:
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Field Description

Adjustment Amount Enter a percentage or a number to adjust the price 
waterfall.

Adjustment Type Select the kind of adjustment required if the criteria is met. 
For example, an override to a list price, markup, or 
discount. 

Adjustment Source You can add dynamic adjustment amounts to waterfall 
rule entries, using the formula builder to define 
expressions for both static values and formula fields. 

Turn the setting Copy the current data in new row on to copy the details of a price 
waterfall rule entry to the next entry.
In the Number of rows field, enter a value of how many rows you want to add.

Click the ellipsis icon   for the entry and click Delete.
Click Save.

Dimension

Go to ADMIN SETUP > Pricing Administration > Price Waterfall Rulesets. The Price 
Waterfall Rulesets page is displayed.
Click the required price waterfall ruleset name link to open the Price Waterfall 
Rulesets details page.
Click the Price Waterfall Rules tab.

If there are existing metrices, click the required price waterfall rule name link to 
open the price waterfall rule details page.
If there are no metrices created, create a price waterfall rule. For more 
information, see Creating a Price Waterfall Rule.

On the Entries tab, click Add. A price waterfall rule entry is added.
Enter the following details:

Field Description

<dimension> Enter a value for the dimension.

The number of dimensions depends on how many 
dimensions you have configured for the price waterfall 
rule.

Adjustment Amount Enter a percentage or a number to adjust the price 
waterfall.



Configure Price Quote (CPQ)

390 Copyright ©2024 Conga Corporation. All rights reserved.

6.

7.

8.
a.

b.

9.

1.

2.

•

•

•

3.

Field Description

Adjustment Type Select the kind of adjustment required if the criteria is 
met. For example, an override to a list price, markup, or 
discount. 

Adjustment Amount Source You can add dynamic adjustment amounts to 
waterfall rule entries, using the formula builder to 
define expressions for both static values and formula 
fields. 

Turn the setting Copy the current data in new row on to copy the details of a price 
waterfall rule entry to the next entry.
In the Number of rows field, enter a value of how many rows you want to add.

Click the ellipsis icon (  for the entry and click Delete.
If there are no unsaved changes, the Delete Price Waterfall Rule Entry pop-up is 
displayed. Click Confirm.
If there are unsaved changes, the a pop-up is displayed prompting your 
confirmation. Click Discard Changes. The Delete Price Waterfall Rule Entry pop- 
up is displayed. Click Confirm.

Click Save.

Deleting a Price Waterfall Ruleset
You can delete price waterfall ruleset that are no longer required for your business 
requirements. 

To delete a rollup

Go to ADMIN SETUP > Pricing Administration > Price Waterfall Ruleset. The Price 
Waterfall Ruleset page is displayed.
Search for the waterfall ruleset and do one of the following: 

To delete a single ruleset, click the ellipsis icon (  next to the rollup name, and 
click Delete.
To delete multiple rulesets, click the checkboxes next to the name column, and 

click the ( ) icon.
To delete all the rulesets, click the checkbox in the header row next to the name 

column, and click the ( ) icon.
Click Confirm.

)

)
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Deleting the Price Waterfall
You can delete price waterfall that are no longer required for your business requirements. 

To delete a rollup
Go to ADMIN SETUP > Product Administration > Price Waterfall. The Price Waterfall 
page is displayed.
Search for the price waterfall and do one of the following: 

To delete a single price waterfall, click the ellipsis icon (  next to the rollup 
name, and click Delete.
To delete multiple price waterfalls, click the checkboxes next to the name 

column, and click the ( ) icon.
To delete all the price waterfalls, click the checkbox in the header row next to 

the name column, and click the ( ) icon.
Click Confirm.

Diagnostics
The diagnostics page provides a comprehensive view of the application regarding system 
health and status, access alerts or notifications to provide extensive support to the Conga 
Platform users. 

This section provides information on system diagnostic settings. 

Scheduled Jobs
Publisher

Scheduled Jobs
This section provides information on config scheduled jobs and publisher settings. 

Publisher

Publisher
The publisher page provides a comprehensive listing of Pending, Completed, Failed, and 
ongoing Config Publishing Jobs and lets you search for required jobs. 

)
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Scheduled Jobs Search
You can narrow down the scheduled jobs list using the search feature. You can use a search 
option to search for a range of scheduled jobs.

Basic Search

In basic search, you can search for scheduled jobs using keywords. For example, you can 
search using the product name of the scheduled job. 

In the Search this list field, enter a keyword related to your product details such as 
the scheduled job name.
Click the search icon (  or press Enter. CPQ returns all scheduled jobs that contain 
that keyword in the names of the scheduled jobs.

Sorting Scheduled Jobs
You can sort the Config Publishing Jobs list by clicking the column names. The scheduled 
jobs are sorted alphabetically in ascending order using the scheduled job name. Every time 
you click the column name, the sorting switches between ascending and descending order. 
You can adjust the column width by dragging the columns. Hover near the column 
boundaries till a two-way arrow appears. Click when the arrow appears and drag left or 
right to adjust the column width.

Actions available on this page
Enable Publisher: Enables publishing for multiple products at once.

Items per page
At the bottom of the page, you can see the total count of scheduled jobs available. You 
can control the number of scheduled jobs to be displayed on each page. You can select the 
number of scheduled jobs from a predefined list. You cannot configure this list. By default, 
you see 20 records on each page.

By default, you can sort 10, 20, 30, 50, and 100 scheduled jobs per page using the Rows per 
page drop-down. This feature works in association with the search and filter functions to 
display search records per page. You can use the < and > buttons to move to the next or the 
previous pages. You can also jump to a certain page using the page search component.

Scheduled Job Summary

)
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Click the required scheduled job name from the list of scheduled jobs to view details 
of a product. For more information, see Configuring the Products.

Customizing CPQ on Conga Platform using 
Callback Classes
Callbacks offer a mechanism to incorporate custom logic into different components of 
CPQ, such as line items, cart pages, and catalog pages, during runtime. For instance, you 
can apply custom pricing or validation to line items within the cart using Pricing Callback 
Classes and Validation Callback Classes respectively. Implementing callbacks involves 
utilizing interfaces tailored to each specific callback. It's essential to implement these 
interfaces in C# and configure your custom logic within the corresponding class using the 
interface's methods. Subsequently, after implementing the interface, you need to register 
the C# class on the platform to enable invocation of the callback class during runtime.

Setting Up Callbacks using Custom Code on 
Platform Extensibility and Platform UI
To create a new custom code on Conga Platform, you must complete bit bucket setup for 
custom code. For more information, see Getting Started with Custom Code.

Authoring and registering callbacks is now supported through the Platform admin 
interface. You can access and manage custom code through the Platform UI. For step-by- 
step instructions on creating and using custom code and callbacks, see Managing Custom 
Code.

 

In this section, the following Callbacks are described:

Validation Callback Class
Config Callback Class
Product Filter Callback Class
Pricing Callback Class
Revalidation Callback Class
Display Action Callback Class
Cart Lifecycle Callback Class
Asset Filter Callback Class
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Validation Callback Class
Validation Callback provides a mechanism to implement custom validations on the line 
items in the cart. Validations are any constraints you define on the line item to restrict the 
selection of that line item based on any condition or criteria. When you define validations, 
CPQ checks if the condition or the criteria is satisfied and displays an error message 
accordingly. For example, you can validate if the Quantity field for any product is negative 
and prevent the sales rep from finalizing the cart.

Validation Callback applies validation on the following aspects in the configuration: 

Entire cart
Line items in the cart
Price Ramps

To use the Validation Callback you must create a custom C# that implements the 
IValidationCallback interface and register the custom C# with Validation Callback Class. 
You must write your custom logic in the custom C# language.

The following methods are available in the IValidationCallback interface:

Method Signature Description

BeforePricin 
gValidation 
Async

BeforePricingValidatio 
nAsync(IActionRequest 
request)

This extension point is utilized for creating pre-price 
validation callbacks.

FinalizeVali 
dationAsyn 
c

FinalizeValidationAsy 
nc(IActionRequest 
request)

This hook point is used to write validation callback code 
for finalize event.

OnCartVali 
dationAsyn 
c

OnCartValidationAsy 
nc(IActionRequest 
actionRequest)

This is generic method for validation callback.

The following is an example of the custom logic you can implement using Validation 
example.

Example

The given code example implements the method of IValidationCallback interface. 

using Conga.Revenue.Common.Callback.Messages;



Configure Price Quote (CPQ)

395 Copyright ©2024 Conga Corporation. All rights reserved.

using System;

using System.Collections.Generic;

using System.Linq;

using System.Text;

using System.Threading.Tasks;

 
namespace Conga.Revenue.Common.Callback

{

    public interface IValidationCallback

    {

        /// <summary>

        /// This extension point is used to write prepricing validation callback

        /// </summary>

        /// <param name="actionRequest">This will have cart context where lines are 

there.</param>

        public Task BeforePricingValidationAsync(IActionRequest actionRequest);

 
        /// <summary>

        /// This hookpoint is used to write validation callback code for finalize 

event

        /// </summary>

        /// <param name="actionRequest"></param>

        /// <returns></returns>

        public Task FinalizeValidationAsync(IActionRequest actionRequest);

 
        /// <summary>

        /// This is generic method for validation callback

        /// </summary>

        /// <param name="actionRequest"></param>

        /// <returns></returns>

        public Task OnCartValidationAsync(IActionRequest actionRequest);

 
    }

}

Config Callback Class
Config Callback Class boosts product recommendations beyond the constraints defined by 
recommendation type rules. When config callback class is executed based on the custom 
code, you can see a refined list of recommended products in the Recommendation Thumbs 
up icon. Recommended products will be displayed if the Show Recommended Products Cart 
View setting is enabled in Config Select Products Settings.
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This feature is part of ConfigCallback which implements the IConfigCallback interface. 
This interface facilitates customization and extension of the configuration rules execution 
process.

The following method is available in the IConfigCallback interface and custom logic should 
be written inside this method:

Method Signature Description

BeforeConfigRulesExec 
utionAsync

BeforeConfigRulesExecution 
Async(IConfigCartRequest 
configCartRequest)

This extension point is called before config 
rules execution.

AfterConfigRulesExecu 
tionAsync

AfterConfigRulesExecutionA 
sync(IConfigCartRequest 
configCartRequest)

This extension point is called after config 
rules execution.

Example

The given code example implements the method of IConfigCallback interface. 

using Conga.Revenue.Common.Callback.Messages;1
using System.Threading.Tasks;2
 3
 4
namespace Conga.Revenue.Common.Callback5
{6
    /// <summary>7
    /// IConfigCallback8
    /// </summary>9
    public interface IConfigCallback10
    {11
        /// <summary>12
        /// This extension point is called before config rules execution13
        /// </summary>14
        /// <param name="configCartRequest">Cart and all line item of 

cart</param>

15

        public Task BeforeConfigRulesExecutionAsync(IConfigCartRequest 

configCartRequest);

16

 17
        /// <summary>18
        /// This extension point is called after config rules execution19
        /// </summary>20
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Action Callback
 

Action Callback provides you a mechanism to apply custom actions on different actions 
available on the cart. For example, you can apply custom action before deleting or copying 
a bundle, finalizing a cart, submitting a cart for approval. You can directly use methods of 
the callback to apply the custom action or use Web Services to implement the callback.

Example:

Base product Name: “Cisco UCS”

When the base product is cloned 3 times, the name of the cloned product can be “Cisco 
UCS-1”, “Cisco UCS-2”, “Cisco UCS-3” etc…

Expose two interface methods, "before clone" and "after clone," for implementing as 
callbacks.

 

To use the Action Callback you must create a custom C# class that implements one of the 
following interfaces and you must register the custom class with Action Callback Class. 
You must write your custom logic in the custom C# class.

The following method is available in the IConfigCallback interface:

Method Signature Description

BeforeConfigRul 
esExecutionAsy 
nc

BeforeConfigRule 
sExecutionAsync( 
IConfigCartRequ 
est 
configCartReque 
st)

This extension point is called before config rules execution.

        /// <param name="configCartRequest">Cart and all line item of 

cart</param>

21

        public Task AfterConfigRulesExecutionAsync(IConfigCartRequest 

configCartRequest);

22

    }23
}24

Action Callback can be achieved with Config Callback using its method.
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Product Filter Callback Class

Product Filter Callback
Product Filter Callback provides you a mechanism to control the visibility of products on 
the catalog page based on custom criteria that you define.

To use the Product Attribute Callback you must create a custom code that implements the 
IProductFilterCallback interface and register the custom code. You must write your custom 
logic in the C# custom code.

Feature Flag: is-productfiltercallback-enabled  is the feature flag that enables the 
Product Filter callback.

The following methods are available in IProductFilterCallback interface:

Method Signature Description

GetProductFilterExpr() GetProductFilterExpr(string 
cartId);

Callback to return Products Search 
Filter Expression & search the 
products which matches the criteria 
from catalog page.

(Parameter name cartId).

 

GetOptionFilterExpr() GetOptionFilterExpr(string 
cartId)

Callback to return Option Search 
Filter Expression & search the 
products which matches the criteria 
from catalog page.

 

getExcludedOptionIds( 
)

List 
getExcludedOptionIds(Apttus_C 
onfig2.CustomClass.ActionPara 
ms)

Callback to return option IDs which 
are to be excluded from the bundle.

 

Sample Code
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Example

This is just a sample callback custom class to control the visibility of products on the 
Catalog page.

using Conga.Revenue.Common.Callback.Models;1
using Conga.Revenue.Common.Callback.Models.SearchFilter;2
using System.Collections.Generic;3
using System.Threading.Tasks;4
 5
namespace Conga.Revenue.Common.Callback6
{7
    /// <summary>8
    /// This interface defines extension points for Product Filter 

Callback

9

    /// </summary>10
    public interface IProductFilterCallback11
    {12
        /// <summary>13
        /// Callback to return Product Search Filter Expression14
        /// </summary>15
        /// <param name="cartId"></param>16
        /// <returns></returns>17
        Task<ICriteria> GetProductFilterExpr(string cartId);18
 19
        /// <summary>20
        /// Callback to return Option Search Filter Expression21
        /// </summary>22
        /// <param name="cartId"></param>23
        /// <returns></returns>24
        Task<ICriteria> GetOptionFilterExpr(string cartId);25
 26
        /// <summary>27
        /// Callback to return option IDs which are to be excluded from 

the bundle

28

        /// This filter is used when we configure a bundle.29
        /// </summary>30
        /// <param name="config"></param>31
        /// <returns></returns>32
        Task<List<string>> GetExcludedOptionIds(IConfigModel config);33
    }34
}35
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The following only filter the Catalog products having ExpirationDate greater than 
"2092-01-01", second method is used to exclude the list of productid mentioned within the 
list. You may change the custom class to fit your business requirements.

public class ProductFilterCallbackTest : CodeExtensibility, 

IProductFilterCallback

1

 2
    {3
 4
        public async Task<ICriteria> GetProductFilterExpr(string cartId)5
 6
        {7
 8
            ICriteria criteria = new TestCriteria()9
 10
            {11
 12
                ObjectName = "Product",13
 14
                Filter = new TestFilter()15
 16
                {17
 18
                    Predicates = new List<IPredicate>()19
 20
                    {21
 22
                        new TestPredicate()23
 24
                        {25
 26
                            RowNum = 1,27
 28
                            FieldName = "ExpirationDate",29
 30
                            FieldLabel = "ExpirationDate",31
 32
                            FieldValue = "2092-01-01",33
 34
                            FieldType = "DATETIME",35
 36
                            CompOper = "greater than",37
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 38
                            BoolOper = "AND"39
 40
                        }41
 42
                        43
 44
                    },45
 46
                    HasRHSFields = false,47
 48
                    CondExpr = "1"49
 50
                },51
 52
                Fields = new List<string>() { "Id" },53
 54
                ExprStr = "ExpirationDate > 2092-01-01"55
 56
            };57
 58
            return criteria;59
 60
        }61
 62
        public async Task<List<string>> GetExcludedProductIds(string 

cartId)

63

 64
        {65
 66
            return new List<string>{67
 68
            "{productId01}",69
 70
"{productId02}"        }71
 72
//We are excluding {productId01} and {productId02}73
 74
    }75
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Option Filter Callback

Option Filter Callback provides you with a mechanism to control the visibility of the option 
products on the Configuration page based on the custom logic that you define. The 
callback is executed in the following scenarios:

when you click Configure on the Catalog page

when the configuration of the product is pending and you click the wrench icon (  ) 
on the Cart page. 

When callback is invoked, CPQ excludes the option products on the Configuration page.

 

Example

This is just a sample callback custom class to control the exclusion of option products on 
the catalog page. The following custom code only removes a few option products. You may 
change the custom class to list out the ID of option products to fit your business 
requirements.

Option filter callback in now clubbed with product filter callback.

Default options and options included based on constraint rules are also hidden 
when the Option Filter Callback is used to hide options. In the scenario, where all the 
case all the options in an option group are hidden, the option group is also hidden on 
the Configuration page.



global with sharing class SampleOptionFilterCallback implements 

 Apttus_Config2.CustomClass.IOptionFilterCallback {

1

 2
    /**3
     * Callback to return option IDs which are to be excluded from the 

bundle

4

     * This filter is used when we configure a bundle.5
     * @param params is the CustomClass.ActionParams that contains 

bundleId and productIds

6

     * @return List of option product IDs which will be excluded7
     */8
    global List<ID> 

getExcludedOptionIds(Apttus_Config2.CustomClass.ActionParams params) {

9
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Pricing Callback Class
The Pricing Callback class enables you to add pricing logic to your cart that cannot be 
achieved by out-of-the-box pricing mechanisms, such as Price Rulesets and Price Matrices. 
The Pricing Callback is executed for each bundled product or standalone in the cart. A 
separate transaction call is initiated for each product in the cart. The Pricing Callback is 
invoked when you are on the cart page. The pricing callback is invoked during pricing stages 
and executes the various methods in the BASEPRICE and ADJUSTMENT modes. This feature 
enables dynamic pricing adjustments based on specific conditions.

IBasePricing Callback
IBasePricing callback is invoked during different pricing stages and executes the various 
methods in the BASEPRICE and ADJUSTMENT modes.

To use the Pricing Callback you must create a custom C# class that implements the 
following interfaces:

Interface Description

IBasePricing Provides a mechanism to define custom logic to be executed 
during different pricing stages.

 

Feature Flag 
is-pricing-callback-enabled is the feature flag that enables the Product Filter callback.

The following methods are available in the  IBasePricing callback interface:

        //return new List<ID>{ <18 CHARACTER PRODUCT ID> };10
        //Example for returning THREE products to be excluded:11
            return new List<ID>{ '01t3C000000DVwh', '01t3C000000DVwm','01t 

3C000000DVww'};

12

        //Example for returning ONE product to be excluded:13
        //  return new List<ID>{ 01t50000004nmL1YYX'};14
    }    15
}16

Adjustment Line Item Callback can be achieved with IBasePricing callback using its 
method.


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Method Signature Description

BeforePricingBatchAsy 
nc ()

Task 
BeforePricingBatchAsync(IBatchPri 
ceRequest batchPriceRequest)

You can use this method to define 
custom logic that must be executed 
before Base Price is calculated.

OnPricingBatchAsync() Task 
OnPricingBatchAsync(IBatchPriceR 
equest batchPriceRequest)

You can use this method to define 
custom logic that must be executed 
during the Base Price calculation. 
You can use the price list items to 
write the custom logic.

AfterPricingBatchAsyn 
c()

Task 
AfterPricingBatchAsync(IBatchPric 
eRequest batchPriceRequest)

You can use this method to define 
custom logic that must be executed 
after the Base Price is calculated.

OnProductOptionPrice 
Async()

Task 
OnProductOptionPriceAsync(IBatc 
hPriceRequest batchPriceRequest, 
IDictionary<string, 
IProductOptionPrice> 
productOptionPrice)

You can use this extension point to 
modify product option prices for the 
given line item.

OnPriceMatrixAsync() Task 
OnPriceMatrixAsync(IBatchPriceRe 
quest batchPriceRequest, 
IDictionary<string, 
IEnumerable<IPriceMatrixEntry>> 
priceMatrixEntries)

You can use this extension point to 
modify resolved price matrix for the 
given line item if required.

OnPriceRuleAsync() Task 
OnPriceRuleAsync(IBatchPriceRequ 
est batchPriceRequest, 
IDictionary<string, 
IEnumerable<IPriceRuleEntry>> 
priceRuleEntries)

You can use this extension point to 
modify the resolved price rule 
entries for the given line item if 
required.
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OnPipelinePriceRuleAs 
ync()

Task 
OnPipelinePriceRuleAsync(IBatchPr 
iceRequest batchPriceRequest, 
IDictionary<string, 
IEnumerable<IPriceRuleEntry>> 
pipelinePriceRuleEntries)

You can use this extension point to 
modify the resolved price pipeline 
rule entries for the given line item if 
required

 

OnPriceEscalatorAsyn 
c()

 

Task 
OnPriceEscalatorAsync(IBatchPric 
eRequest batchPriceRequest, 
List<IPriceEscalator> 
priceEscalators)

 

You can use this extension point to 
modify the resolved price 
escalators if required.

Sample Code

This is just a sample Callback custom class to update the Quantity and Custom Dimension 
field of product based on the Price Type of Line Item.

using System;

using System.Linq;

using Conga.Revenue.Common.Callback.Models;

using Conga.Platform.Extensibility.CustomCode.Library;

using System.Collections.Generic;

using System.Threading.Tasks;

using Conga.Revenue.Common.Callback;

using Conga.Revenue.Common.Callback.Entities;

using Conga.Revenue.Common.Callback.Messages;

 
namespace APTestan

{

    /// <summary>

    /// Pricing Callback

    /// </summary>

    public class PricingBasePriceCallback : CodeExtensibility, 

IPricingBasePriceCallback

    {

        public async Task AfterPricingBatchAsync(IBatchPriceRequest 

batchPriceRequest)

        {

            await Task.CompletedTask;

        }
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        public async Task BeforePricingBatchAsync(IBatchPriceRequest 

batchPriceRequest)

        {

            var batchLineItems = batchPriceRequest.GetLineItems().SelectMany(x => 

x.GetChargeLines()).ToList();

            

            foreach(var item in batchLineItems)

            {

            

                IPriceListItemModel priceListItemModel = item.GetPriceListItem();

                IPriceListItem priceListItemEntity = priceListItemModel.GetEntity();

                var entity = item.GetEntity();

                

                if(priceListItemEntity.PriceType == "One Time"){

                    entity.Quantity = 15;

                    entity.SetValue("Auto_Integer_Dimension2_c", 50);

                }else{

                    entity.Quantity = 10;

                    entity.SetValue("Auto_Integer_Dimension2_c", 25);

                }

            }

            

            await Task.CompletedTask;

        }

 
        public async Task OnPricingBatchAsync(IBatchPriceRequest batchPriceRequest)

        {

        

            var batchLineItems = batchPriceRequest.GetLineItems().SelectMany(x => 

x.GetChargeLines()).ToList();

            

                

            await Task.CompletedTask;

        }

 
        public async Task OnProductOptionPriceAsync(IBatchPriceRequest 

batchPriceRequest, IDictionary<string, IProductOptionPrice> productOptionPrice)

        {

            var batchLineItems = batchPriceRequest.GetLineItems().SelectMany(x => 

x.GetChargeLines()).ToList();
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            await Task.CompletedTask;

        }

 
        public async Task OnPriceMatrixAsync(IBatchPriceRequest batchPriceRequest, 

IDictionary<string, IEnumerable<IPriceMatrixEntry>> priceMatrixEntries)

        {

            await Task.CompletedTask;

        }

 
        public async Task OnPriceRuleAsync(IBatchPriceRequest batchPriceRequest, 

IDictionary<string, IEnumerable<IPriceRuleEntry>> priceRuleEntries)

        {

            await Task.CompletedTask;

        }

 
        public async Task OnPipelinePriceRuleAsync(IBatchPriceRequest 

batchPriceRequest, IDictionary<string, IEnumerable<IPriceRuleEntry>> 

pipelinePriceRuleEntries)

        {

            await Task.CompletedTask;

        }

 
        public async Task OnPriceEscalatorAsync(IBatchPriceRequest batchPriceRequest, 

List<IPriceEscalator> priceEscalators)

        {

            await Task.CompletedTask;

        }

    }

}

ITotallingPricing Callback
ITotalingPricing Callback class enables you to add pricing totaling logic to your cart that 
cannot be achieved by out-of-the-box pricing mechanisms. The Pricing Totaling Callback is 
invoked when you are on the cart page. The pricing totaling callback is invoked during 
different pricing totaling stages and executes the various methods in the BASEPRICE and 
ADJUSTMENT modes. This feature enables dynamic pricing adjustments based on specific 
conditions.

Adjustment Spread Callback can be achieved with ITotallingPricing Callback using 
its method. 


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Example:

Customer has a use case where they want to capture Total QTY (sum of QTY of all Similar 
Products in cart) against the Line Item. Also, they wanted to Capture Total Product Group 
QTY (Sum of QTY belonging to Similar Product Group). This intern was used to drive Pricing 
using Price Rules. In this case ITotalingPricing triggers to calculate Total QTY and Total 
Product Group QTY.

Interface Description

ITotalingPricing Provides a mechanism to define custom logic to be executed 
before, during, and after adjustment Calculation

Method Signature Description

BeforePricingCart 
AdjustmentAsync

Task 
BeforePricingBatchAsync(IBatchPriceReques 
t batchPriceRequest)

You can use this method to 
define custom logic that must 
be executed before Base Price 
is calculated.

AfterPricingCartA 
djustmentAsync

Task 
AfterPricingBatchAsync(IBatchPriceRequest 
batchPriceRequest)

You can use this method to 
define custom logic that must 
be executed after the Base 
Price is calculated.

OnCartPricingCo 
mpleteAsync

Task 
OnProductOptionPriceAsync(IBatchPriceReq 
uest batchPriceRequest, IDictionary<string, 
IProductOptionPrice> productOptionPrice)

You can use this extension 
point to modify product option 
prices for the given line item.

 

Sample Code

using System;

using System.Linq;

using Conga.Revenue.Common.Callback.Models;

using Conga.Platform.Extensibility.CustomCode.Library;

using System.Collections.Generic;

using System.Threading.Tasks;

using Conga.Revenue.Common.Callback;

using Conga.Revenue.Common.Callback.Entities;

using Conga.Revenue.Common.Callback.Messages;
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namespace APTestan

{

    public class PricingTotallingCallback : CodeExtensibility, 

IPricingTotallingCallback 

    {     

    public async Task BeforePricingCartAdjustmentAsync(IAggregateCartRequest 

aggregateCartRequest)

        {

            var batchLineItems = 

aggregateCartRequest.GetCartContext().GetLineItems().SelectMany(x => 

x.GetChargeLines()).ToList();

            

            foreach(var item in batchLineItems){

                var entity = item.GetEntity();

                var cartName = entity.GetLookupValue<string>("Configuration.Name");

                if(cartName == "Auto_Pricing_TotalingCallbackAdjustment"){

                    entity.AdjustmentType = "Discount Amount";

                    entity.AdjustmentAmount = 10;

                }

            }

            

            await Task.CompletedTask;

        }

        public async Task AfterPricingCartAdjustmentAsync(IAggregateCartRequest 

aggregateCartRequest)

        {

            var batchLineItems = 

aggregateCartRequest.GetCartContext().GetLineItems().SelectMany(x => 

x.GetChargeLines()).ToList();

            

            foreach(var item in batchLineItems){

                var entity = item.GetEntity();

                var cartName = entity.GetLookupValue<string>("Configuration.Name");

                if(cartName == "Auto_Pricing_TotalingCallbackAdjustment"){

                

                    if(entity.AdjustmentAmount > 0){

                        var unitAdjustment = entity.AdjustmentAmount / 

entity.Quantity;

                        entity.SetValue("Auto_Integer_Dimension1_c", unitAdjustment);

                    }else{

                        var unitAdjustment = (entity.AdjustedPrice / entity.Quantity) 

- entity.BasePrice;

                        entity.SetValue("Auto_Integer_Dimension1_c", unitAdjustment);
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                    }

                }

            }

            

            await Task.CompletedTask;

        }

 
        public async Task OnCartPricingCompleteAsync(IAggregateCartRequest 

aggregateCartRequest)

        {

            var cartLineItems = 

aggregateCartRequest.GetCartContext().GetLineItems().SelectMany(x => 

x.GetChargeLines()).ToList();

            foreach(var cartLineItem in cartLineItems) {

            var entity = cartLineItem.GetEntity();

            var cartName = entity.GetLookupValue<string>("Configuration.Name");

                if(cartName == "Auto_Pricing_TotalingCallbackAdjustment"){

                

                    if(entity.NetPrice < 1000) {

                        entity.SetValue("Auto_String_Dimension3_c", "Red" );

                    } else {

                        entity.SetValue("Auto_String_Dimension3_c", "Green" );

                    }

                }   

                

            }

            await Task.CompletedTask;

        }

    }

}

IRelatedPricing Callback
IRelatedPricing Callback allows you to apply custom logic to calculate the related pricing. 
This callback is invoked while CPQ is calculating related pricing after the main pricing is 
calculated.

To use the Related Pricing Callback you must create a custom C# class that implements 
the IRelatedPricing callback interface and register the custom C# class with Related 
Pricing Callback Class. You must write your custom logic in the custom C# class.
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If you have defined Pricing Callback class, Related Pricing Callback is always invoked after 
the Pricing Callback is executed.

Interface Description

IRelatedPricing Provides a mechanism to define custom logic for calculating 
the pricing for related product line items

 

The following methods are available in the 
 Apttus_Config2.CustomClass.IRelatedPricingCallback interface:

Method Signature Description

computeBas 
ePrice()

Apttus_Config2.CustomClass.RelatedPriceRes 
ult 
computeBasePrice(Apttus_Config2.ProductCo 
nfiguration, Apttus_Config2.LineItem, List)

You can use this method to apply 
custom logic for related pricing 
calculation and override the 
default CPQ related pricing logic. 

 

Example

In the following sample code, Related Pricing Callback to calculates the price on related 
line items. 

using System;

using System.Linq;

using Conga.Revenue.Common.Callback.Models;

using Conga.Platform.Extensibility.CustomCode.Library;

using System.Collections.Generic;

using System.Threading.Tasks;

using Conga.Revenue.Common.Callback;

using Conga.Revenue.Common.Callback.Entities;

using Conga.Revenue.Common.Callback.Messages;

 
 
namespace DemoRelatedPricingCallback

{

    public class RelatedPricingCallback : CodeExtensibility, IRelatedPricingCallback

    {

        public async Task<List<IRelatedPricingBatchResponse>> 

ComputeBasePriceBatchAsync(IRelatedPricingBatchRequest relatedPricingBatchRequest)

        {
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            List<IRelatedPricingBatchResponse> relatedPricingBatchResponseResult = 

new List<IRelatedPricingBatchResponse>();

            List<ILineItemModel> relatedLineItems = 

relatedPricingBatchRequest.GetRelatedLineItems();

 
            

            foreach(var relatedLineItem in relatedLineItems) {

                var cartName = 

relatedLineItem.GetLookupValue<string>("Configuration.Name");

                if(cartName.Contains("RelatedPriceCallback01")){

                    var priceBreakupRecords = 

relatedLineItem.GetPriceBreakupRecords();

 
                    IRelatedPricingBatchResponse relatedPricingResponse = 

relatedPricingBatchRequest.CreateRelatedPricingBatchResponse(relatedLineItem);

                    relatedPricingResponse.BasePrice = 500;

                    relatedPricingBatchResponseResult.Add(relatedPricingResponse);

                }

            }

            return await Task.FromResult(relatedPricingBatchResponseResult);

        }

    }

}

Revalidation Callback Class
Revalidation Callback provides you a mechanism to implement custom revalidations for 
products based on custom criteria. You can define custom criteria based on which the 
products are identified by CPQ for revalidation. The callback allows you to define a custom 
logic to be applied on the line item along with revalidation. You can also define a custom 
product version when the line item is created.

Example

You can use this callback to a scenario like:

You can have multiple versions for a single product record. This enables you to 
revalidate a specific version of the product as necessary. 
For example, for product record, you can set the version as X, Y, and any such value 
for the newly created line item of that product. You can determine which line item 
qualifies for revalidation and apply custom logic on the line items accordingly.
You can apply validation based custom fields other than the Product Version.
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• You can validate changes in pricing fields like List price of a given price list item. 
 

To use the Revalidation Callback you must create a custom C# that implements the 
IRevalidationCallback interface and register the custom C# with Revalidation Callback 
Class. You must write your custom logic in the custom C#.

The following methods are available in the IRevalidationCallback interface:

Method Signatur 
e

Description

GetRevalid 
ationDetail 
Async()

GetRevali 
dationDe 
tailAsync 
(IActionRe 
quest 
revalidati 
onReques 
t)

You can use this method to determine whether the line item requires 
revalidation based on a custom logic that you can define. This method 
is invoked when you reconfigure a save or finalized cart.

GetApplyR 
evalidation 
DetailAsyn 
c()

GetApply 
Revalidat 
ionDetail 
Async(IAc 
tionReque 
st 
revalidati 
onReques 
t)

You can use this method write custom logic to apply on line items. This 
method is invoked when you click Apply Revalidation on the 
Revalidation pop-up.

Example

The below-given code example checks if the quantity of line items is greater then 10 then 
triggers the revalidation on the cart, revalidates the line item and resets the quantity of the 
line items.

You can control Revalidation feature by using config system properties with setting 
name EnableRevalidationOnPricing to True.



using Conga.Revenue.Common.Callback.Messages;1
using System.Threading.Tasks;2
 3
namespace Conga.Revenue.Common.Callback4
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Display Action Callback Class
Display Action Callback provides you a mechanism to disable any of the action buttons on 
the cart. Following are few examples of custom buttons that you can disable:

Abandon 
Approvals
Generate
Quick Save

To use the Display Action Callback you must create a custom C# class that implements 
the IDisplayActionCallback interface and register the custom C# class with Display Action 
Callback Class. You must write your custom logic in the custom C# class.

The following method is available in the IDisplayActionCallback interface:

{5
    /// <summary>6
    /// IRevalidationCallback: Revalidation callback hookpoint7
    /// </summary>8
    public interface IRevalidationCallback9
    {10
        /// <summary>11
        /// This hookpoint is used to write get revalidation callback 

code.

12

        /// </summary>13
        /// <param name="revalidationRequest">revalidationRequest</param>14
        public Task GetRevalidationDetailAsync(IActionRequest 

revalidationRequest);

15

 16
        /// <summary>17
        /// This hookpoint is used to write get apply revalidation 

callback code.

18

        /// </summary>19
        /// <param name="revalidationRequest">revalidationRequest</param>20
        /// <returns></returns>21
        public Task GetApplyRevalidationDetailAsync(IActionRequest 

revalidationRequest);

22

    }23
}24
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Method Signature Description

ExecuteDisplayAction ExecuteDisplayAction(IActionRequ 
est actionRequest)

You can use this method to 
execute display action.

Example

This is just a sample callback custom class to hide the visibility of the Abandon and 
Generate action buttons on the cart page. You may change the custom class to fit your 
business requirements

Cart Lifecycle Callback Class
The Cart Lifecycle Callback in CPQ on Platform is utilized during cart creation to populate 
fields that cannot be written as formula fields. It enables the execution of more complex 
logic, similar to actions performed in triggers before before the cart is finalized.

To use the Cart Lifecycle Callback you must create a custom C# that implements the 
ICartLifecycleCallback interface and register the custom C# with Cart Lifecycle Callback 
Class. You must write your custom logic in the custom C#.

The following method is available in the ICartLifecycleCallback interface:

using Conga.Revenue.Common.Callback.Messages;1
using Conga.Revenue.Common.Callback.Models;2
using System.Collections.Generic;3
using System.Threading.Tasks;4
 5
namespace Conga.Revenue.Common.Callback6
{7
    /// <summary>8
    /// Interface for display action callback9
    /// </summary>10
    public interface IDisplayActionCallback11
    {12
        /// <summary>13
        /// Executes the display action.14
        /// </summary>15
        /// <param name="actionRequest">The action request.</param>        16
        /// <returns></returns>17
        Task ExecuteDisplayAction(IActionRequest actionRequest);18
    }19
}20
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Method Signature Description

BeforeC 
artCrea 
tionAsy 
nc

BeforeCartCreati 
onAsync(IProduct 
Configuration 
cart)

You can use this method to enable or disable an action button. User 
has to mention the desired action button.

 

Example

Asset Filter Callback Class
Asset filter callback provides you a mechanism to define the criteria based on which you 
want to filter assets on the Installed Product page. The asset line items on the Installed 
product page are shown according to the business logic defined in the asset filter callback 

using Conga.Revenue.Common.Callback.Entities;1
using Conga.Revenue.Common.Callback.Models;2
using System;3
using System.Collections.Generic;4
using System.Linq;5
using System.Text;6
using System.Threading.Tasks;7
 8
namespace Conga.Revenue.Common.Callback9
{10
    /// <summary>11
    /// This interface will be used to update product configuration via 

callback.

12

    /// </summary>13
    public interface ICartLifecycleCallback14
    {15
        /// <summary>16
        /// Used to update product configuration17
        /// </summary>18
        /// <param name="cart"></param>19
        /// <returns></returns>20
        public Task BeforeCartCreationAsync(IProductConfiguration cart);21
    }22
}23
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class. You can further filter the asset on the Installed Products page using the filters on the 
page.

To use the Asset filter callback you must create a custom C# class that implements the 
IAssetFilterCallback interface and register the custom C# class with Asset Filter Callback 
Class. You must write your custom logic in the custom C# class.

The following methods are available in the IAssetFilterCallback interface:

Method Signature Description

GetFilterExp 
ression

GetFilterExpression(IA 
ssetFilterCallbackReq 
uest 
assetFilterCallbackRe 
quest)

Callback to return filter expression which will be used to 
filter asset line items.

ValidateAss 
etTerminati 
on

ValidateAssetTermina 
tion(IAssetTerminateC 
allbackRequest 
assetTerminateCallb 
ackRequest)

Callback to validate asset termination.

The following is an example of the custom logic you can implement using asset filter 
example.

Example

using Conga.Revenue.Common.Callback.Messages;1
using System.Threading.Tasks;2
 3
namespace Conga.Revenue.Common.Callback4
{5
    /// <summary>6
    /// This interface defines extension points for Asset Filter Callback7
    /// </summary>8
    public interface IAssetFilterCallback9
    {10
        /// <summary>11
        ///  Callback to return filter expression which will be used to 

filter asset line items

12

        /// </summary>13
        /// <param name="assetFilterCallbackRequest">List of account Ids 

passed as search parameter</param>

14

        /// <returns> filter expression </returns>15
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        Task<string> GetFilterExpression(IAssetFilterCallbackRequest 

assetFilterCallbackRequest);

16

 17
        /// <summary>18
        ///  Callback to validate asset termination19
        /// </summary>20
        /// <param name="assetTerminateCallbackRequest"> List of asset 

ids, account ids and termination date</param>

21

        /// <returns>22
        ///  Validation message to be shown to the user, If termination 

date is invalid and termination can't be proceeded

23

        ///  Empty string, if termination date is valid and termination 

can be proceeded.

24

        /// </returns>25
        Task<string> 

ValidateAssetTermination(IAssetTerminateCallbackRequest 

assetTerminateCallbackRequest);

26

    }27
}28
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CPQ for REST API Developers
This section explains the REST APIs provided by Conga Configuration, Pricing, and Quoting 
(CPQ).

Topic Description

What's Covered This section walks API developers through the list of REST 
APIs provided by Conga.

Primary Audience API developers

Updates For a comprehensive list of updates to this section for each 
release, see the What's New in CPQ Documentation topic.

Other Resources Refer to Conga CPQ Release Notes for information on new 
features and enhancements, resolved issues, and known 
issues for a specific release.

 

CPQ REST APIs
Navigate to the Conga Developer Portal to review interactive API documentation for CPQ.

Conga CPQ on Conga Platform Use Cases
This section describes Conga CPQ use cases:

Use Case: User Authentication to Conga Platform
Getting the Application Context
Use Case: Browsing the Catalog
Retrieving Product Details
Interacting with the Cart
Creating and Editing Quotes
Working with Order APIs



Configure Price Quote (CPQ)

420 Copyright ©2024 Conga Corporation. All rights reserved.

1.

2.
3.
4.

Use Case: User Authentication to Conga Platform
All users and orgs require authorization to access the CPQ services on the Conga Platform. 
Before starting the authentication process, the org or user must be onboarded to the Conga 
Platform with the help of Dev Ops or Cloud Ops.

Conga Platform users can use an external identity provider to log in to the application 
which is implemented through the OAuth 2.0 to enable communication between the 
application and external identity provider. So, users can log in to the application using their 
existing credentials from a trusted third-party identity provider, instead of creating new 
credentials specifically for the application. The application relies on the identity provider 
for authentication and authorization. This enables a secure and convenient way of 
accessing the application.

Log in to the Conga Platform:
Launch the application using the Conga Platform URL on a supported web browser. 
This redirects you to the OAuth screen where you can select the Identity Providers as 
required.  

Click Identity Provider and select the required Idp from the list.
Click Sign In.
Log in with your credentials on the external identity provider. A Conga Platform home 
page is displayed. 
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Getting the Application Context
Understanding the settings and configurations helps you to configure products, calculate 
pricing, and generate quotes quickly.

Getting Storefront
You can retrieve the storefront details.

Method: GET 
Endpoint: /storefronts

For example, the following sample code enables you to get the storefront details.

Request

'GET' \ 'https://<URL_of_the_Instance>/api/revenue-admin/v1/storefronts

Getting Active Pricelist
You can retrieve the price lists.

Method: GET 
Endpoint: /price-lists/active

For example, the following sample code enables you to get the active price lists.

Request

'GET' \ 'https://<URL_of_the_Instance>/api/catalog/v1/price-lists/active

Get Application Settings
You can retrieve the custom settings defined for a flow name provided in the parameter. 
When custom settings are defined at both flow-level and global-level, flow-level take 
precedence over global settings in response the API retrieves.

The API retrieves the following custom settings:

Config System Properties
Config Select Config Products Settings
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Config Select Bundle Options Settings
Incentive System Properties
Installed Products Settings

The above-mentioned custom settings are categorized into the following:

Config Page Settings
Catalog Page Settings
Cart Page Settings
Pricing Engine
Configuration Engine
Promotions Settings
Asset Settings
Incentives Settings
Favorite Settings

Method: GET 
Endpoint: /flows/{flowName}/settings

For example, the following sample code enables you to get custom settings defined for a 
flow.

Request

'GET' \ 'https://<URL_of_the_Instance>/flows/{flowName}/settings

Get User Details
You can retrieve the user details.

Method: GET 
Endpoint: /api/user-management/v1/users

For example, the following sample code enables you to get the user details.

Request

'GET' \ 'https://<URL_of_the_Instance>/api/user-management/v1/users
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Get Account Details
You can retrieve the account details.

Method: GET 
Endpoint: /api/data/v1/objects/{objectName}

For example, the following sample code enables you to get the account details.

Request

'GET' \ 'https://<URL_of_the_Instance>/api/data/v1/objects/account

Getting the Active Cart
You can retrieve the latest active cart for a given quote/proposal. Pass the Quote ID in the 
parameters. If the cart does not exist for the provided quote, this API will create a new cart. 
In the case of an existing cart, the saved cart ID is returned.

For a newly created cart, the cart status is New and a new Cart ID is generated. The 
following fields will be passed from the quote header to the newly created cart - Account, 
Price List, Status, Business Object, Business Object Type, cart Effective Date, Expected Start 
Date, Expected End Date, Location, Quote/Proposal, Pricing Date, Payment Term, and Cart 
Name.

Method: GET 
Endpoint: /quotes/{quoteId}/carts/active

For example, the following sample code enables you to get the active cart.

Request

'GET' \ 'https://<URL_of_the_Instance>/api/cart/v1/quotes/{quoteId}/carts/active

Use Case: Browsing the Catalog
A Catalog is a view that allows hierarchical categorization of products for you to search 
through products. This use case describes how to browse through a catalog. It helps you 
explore the products before you add them to the cart. There are multiple ways you can 
search and find the product you are looking for. Implementation teams can use these APIs 
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to filter products by their characteristics, sort products by fields associated with them, 
apply pagination to the results, and use other such functionalities to navigate the catalog.

Getting the Category Tree for a Price List
You can retrieve all or a filtered list of categories based on provided parameters. For 
example, pass the price list ID to retrieve all categories associated with that price list ID.

Prerequisite
You must have price list ID to retrieve the categories associated with it.

Example
The following table lists the API method, endpoint, and path as well as a sample request 
and response to get the category tree for a price list.

Metho 
d

GET

Endpo 
int

/categories

Reque 
st 
Para 
meter

The following URL parameters are used to narrow down the search result to specifically 
retrieve categories associated with a price list ID.

Parameters Values

page 1

limit 100

include product

price list ID ffc5c4ad-7329-472e-aca6-b733c2ae47dd

 

Reque 
st URL

https://<URL_of_the_Instance>/api/catalog/v1/categories? 

includes=products&page=1&limit=100
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Reque 
st 
Body

The following sample code enables you to get the category tree for the given price list 
and based on the other above-mentioned parameters.

curl --request GET \1
     --url 'https://<URL_of_the_Instance>/api/catalog/v1/ 

categories?includes=products&page=1&limit=100' \

2

     --header 'PriceListId: ffc5c4ad-7329-472e-aca6- 

b733c2ae47dd' \

3

     --header 'accept: application/json' \4
     --header 'authorization: Bearer <token>5



Configure Price Quote (CPQ)

426 Copyright ©2024 Conga Corporation. All rights reserved.

Respo 
nse

The API returns the list of categories with details such as Category ID, Category Name, 
Description, Hierarchy ID, and the category's parent and child categories.

Response Body

[1
  {2
    "AncestorId": null,3
    "AncestorPath": "391a047e-0a21-4f4a-be76-835ca61515d8",4
    "HierarchyId": "fab05569-02aa-43fc-b44c-d88b0d30d6ac",5
    "DefaultSearchCategory": false,6
    "Description": "Parent_RLPAutoCat_SmokeProd_Category",7
    "ExpandedByDefault": false,8
    "GuidePage": null,9
    "HideAllSearchFilters": false,10
    "ImageURL": null,11
    "IncludeInTotalsView": true,12
    "IsHidden": false,13
    "IsLeaf": false,14
    "IsPicklist": false,15
    "Label": "Parent_RLPAutoCat_SmokeProd_Category",16
    "LargeImageURL": null,17
    "LongDescription": null,18
    "SearchFilterFields": null,19
    "Type": null,20
    "CreatedBy": null,21
    "CreatedDate": "2023-01-19T10:01:45.0678137Z",22
    "Id": "391a047e-0a21-4f4a-be76-835ca61515d8",23
    "ModifiedBy": null,24
    "ModifiedDate": "2023-01-19T10:01:45.0678137Z",25
    "Name": "Parent_RLPAutoCat_SmokeProd_Category",26
    "Currency": "USD",27
    "ExternalId": null,28
    "Digest": null,29
    "CatAuto_Boolean_CstField_c": null,30
    "CatAuto_Currency_CstField_c": null,31
    "CatAuto_CustomFieldPickList_c": null,32
    "CatAuto_DateTime_CstField_c": null,33
    "CatAuto_Double_CstField_c": null,34
    "CatAuto_Int_CstField_c": null,35
    "CatAuto_Multipicklist_CstField_c": null,36
    "CatAuto_String_CstField_c": null,37
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    "CreatedById": "d717a075-9cbf-480c-b230-837e0e6dee75",38
    "ModifiedById": "d717a075-9cbf-480c-b230-837e0e6dee75"39
  },40
  {41
    "AncestorId": "ed316c6a-0bbb-4477-bb88-baad008e3478",42
    "AncestorPath": "391a047e-0a21-4f4a- 

be76-835ca61515d8,ed316c6a-0bbb-4477-bb88- 

baad008e3478,7f0d36db-2484-4920-b099-f08adc7111fa",

43

    "HierarchyId": "fab05569-02aa-43fc-b44c-d88b0d30d6ac",44
    "DefaultSearchCategory": false,45
    "Description": "Level3_Ch1_RLPAutoCat_SmokeProd_Category",46
    "ExpandedByDefault": false,47
    "GuidePage": null,48
    "HideAllSearchFilters": false,49
    "ImageURL": null,50
    "IncludeInTotalsView": true,51
    "IsHidden": false,52
    "IsLeaf": true,53
    "IsPicklist": false,54
    "Label": "Level3_Ch1_RLPAutoCat_SmokeProd_Category",55
    "LargeImageURL": null,56
    "LongDescription": null,57
    "SearchFilterFields": null,58
    "Type": null,59
    "CreatedBy": null,60
    "CreatedDate": "2023-01-19T10:02:44.7413515Z",61
    "Id": "7f0d36db-2484-4920-b099-f08adc7111fa",62
    "ModifiedBy": null,63
    "ModifiedDate": "2023-01-19T10:02:44.7413515Z",64
    "Name": "Level3_Ch1_RLPAutoCat_SmokeProd_Category",65
    "Currency": "USD",66
    "ExternalId": null,67
    "Digest": null,68
    "CatAuto_Boolean_CstField_c": null,69
    "CatAuto_Currency_CstField_c": null,70
    "CatAuto_CustomFieldPickList_c": null,71
    "CatAuto_DateTime_CstField_c": null,72
    "CatAuto_Double_CstField_c": null,73
    "CatAuto_Int_CstField_c": null,74
    "CatAuto_Multipicklist_CstField_c": null,75
    "CatAuto_String_CstField_c": null,76
    "CreatedById": "d717a075-9cbf-480c-b230-837e0e6dee75",77
    "ModifiedById": "d717a075-9cbf-480c-b230-837e0e6dee75"78
  }79
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Getting the Products in a Category
You can retrieve all active products associated with the provided category ID and price list 
ID. This can be the ID of the leaf category, sub-category, or root category.

Prerequisite
You must have a price list ID and the category ID.

Example 1
The following table lists the API method, endpoint, and path as well as a sample request 
and response to get all products associated with a category and the corresponding price 
list.

Method GET

Endpoint /categories/{categoryId}/products

Request URL The following URL parameters are used to narrow down the search result to 
specifically retrieve products associated with a category ID and a price list 
ID.

Parameters Values

page 10

limit 5

category ID 391a047e-0a21-4f4a-be76-835ca61515d8

price list ID ffc5c4ad-7329-472e-aca6-b733c2ae47dd

]80
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Request The following sample code enables you to get the products associated with 
the given price list and category, adhering to the other above-mentioned 
parameters.

curl --request GET \1
     --url 'https://rlp-dev.congacloud.io/api/ 

catalog/v1/categories/cf3e1894-7732-4de2- 

bc2d-171d3bafa563/products?page=10&limit=5' \

2

     --header 'PriceListId: 51432cec-268a-4d2f- 

a543-8b91f70cdb7c' \

3

     --header 'accept: application/json' \4
     --header 'authorization: Bearer <Token>5
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Response For a leaf category, the API returns all products associated with it. If the ID 
of the root or sub-category (not a leaf category ID) is provided, the API 
returns all the products associated with all child categories.

Response Body

[1
  {2
    "ConfigurationType": "Standalone",3
    "Customizable": null,4
    "Description": "ACS_Pagination_St_46",5
    "DisplayUrl": null,6
    "EffectiveDate": "1900-01-01T00:00:00Z",7
    "ExcludeFromSitemap": false,8
    "ExpirationDate": "2100-12-31T00:00:00Z",9
    "Family": null,10
    "HasAttributes": false,11
    "HasDefaults": false,12
    "HasOptions": false,13
    "HasSearchAttributes": false,14
    "ImageURL": "https://i1.wp.com/ 

techforceservices.com.au/wp-content/uploads/2019/04/ 

Conga.png?fit=584%2C190,ssl=1",

15

    "IsActive": true,16
    "IsCustomizable": false,17
    "IsTabViewEnabled": false,18
    "ProductCode": "ACS_Pagination_St_46",19
    "ProductType": null,20
    "QuantityUnitOfMeasure": null,21
    "RenewalLeadTime": 0,22
    "StockKeepingUnit": null,23
    "Uom": "Each",24
    "Version": 1,25
    "TriggeringPrimaryLineNumbers": null,26
    "RuleActionId": null,27
    "CreatedBy": null,28
    "CreatedDate": "2022-08-11T10:18:59.1461591Z",29
    "Id": "ddc05e30-9406-4713-991e-ea9fb7d199db",30
    "ModifiedBy": null,31
    "ModifiedDate": "2022-09-06T14:22:43Z",32
    "Name": "ACS_Pagination_St_46",33
    "Currency": null,34
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    "ExternalId": null,35
    "Digest": null,36
    "CatAuto_Boolean_CstField_c": true,37
    "CatAuto_Currency_CstField_c": null,38
    "CatAuto_CustomFieldPickList_c": "USD",39
    "CatAuto_DateTime_CstField_c": 

"2022-03-01T00:00:00Z",

40

    "CatAuto_Double_CstField_c": 169,41
    "CatAuto_Int_CstField_c": 369,42
    "CatAuto_Multipicklist_CstField_c": [43
      "Red",44
      "Blue"45
    ],46
    "CatAuto_String_CstField_c": "AutoString_169",47
    "CreatedById": "27634e3f-904a-4321-9ce5- 

c2edbe181d90",

48

    "ModifiedById": "27634e3f-904a-4321-9ce5- 

c2edbe181d90"

49

  },50
  {51
    "ConfigurationType": "Standalone",52
    "Customizable": null,53
    "Description": "ACS_Pagination_St_47",54
    "DisplayUrl": null,55
    "EffectiveDate": "1900-01-01T00:00:00Z",56
    "ExcludeFromSitemap": false,57
    "ExpirationDate": "2100-12-31T00:00:00Z",58
    "Family": null,59
    "HasAttributes": false,60
    "HasDefaults": false,61
    "HasOptions": false,62
    "HasSearchAttributes": false,63
    "ImageURL": "https://i1.wp.com/ 

techforceservices.com.au/wp-content/uploads/2019/04/ 

Conga.png?fit=584%2C190,ssl=1",

64

    "IsActive": true,65
    "IsCustomizable": false,66
    "IsTabViewEnabled": false,67
    "ProductCode": "ACS_Pagination_St_47",68
    "ProductType": null,69
    "QuantityUnitOfMeasure": null,70
    "RenewalLeadTime": 0,71
    "StockKeepingUnit": null,72
    "Uom": "Each",73
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    "Version": 1,74
    "TriggeringPrimaryLineNumbers": null,75
    "RuleActionId": null,76
    "CreatedBy": null,77
    "CreatedDate": "2022-08-11T10:18:59.1461591Z",78
    "Id": "b5f22f5c-8a88-4fc7-add6-b3f11bf0114e",79
    "ModifiedBy": null,80
    "ModifiedDate": "2022-09-06T14:22:43Z",81
    "Name": "ACS_Pagination_St_47",82
    "Currency": null,83
    "ExternalId": null,84
    "Digest": null,85
    "CatAuto_Boolean_CstField_c": false,86
    "CatAuto_Currency_CstField_c": null,87
    "CatAuto_CustomFieldPickList_c": "INR",88
    "CatAuto_DateTime_CstField_c": 

"2022-03-01T00:00:00Z",

89

    "CatAuto_Double_CstField_c": 170,90
    "CatAuto_Int_CstField_c": 370,91
    "CatAuto_Multipicklist_CstField_c": [92
      "Yellow",93
      "Green"94
    ],95
    "CatAuto_String_CstField_c": "AutoString_170",96
    "CreatedById": "27634e3f-904a-4321-9ce5- 

c2edbe181d90",

97

    "ModifiedById": "27634e3f-904a-4321-9ce5- 

c2edbe181d90"

98

  },99
  {100
    "ConfigurationType": "Standalone",101
    "Customizable": null,102
    "Description": "ACS_Pagination_St_48",103
    "DisplayUrl": null,104
    "EffectiveDate": "1900-01-01T00:00:00Z",105
    "ExcludeFromSitemap": false,106
    "ExpirationDate": "2100-12-31T00:00:00Z",107
    "Family": null,108
    "HasAttributes": false,109
    "HasDefaults": false,110
    "HasOptions": false,111
    "HasSearchAttributes": false,112
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    "ImageURL": "https://i1.wp.com/ 

techforceservices.com.au/wp-content/uploads/2019/04/ 

Conga.png?fit=584%2C190,ssl=1",

113

    "IsActive": true,114
    "IsCustomizable": false,115
    "IsTabViewEnabled": false,116
    "ProductCode": "ACS_Pagination_St_48",117
    "ProductType": null,118
    "QuantityUnitOfMeasure": null,119
    "RenewalLeadTime": 0,120
    "StockKeepingUnit": null,121
    "Uom": "Each",122
    "Version": 1,123
    "TriggeringPrimaryLineNumbers": null,124
    "RuleActionId": null,125
    "CreatedBy": null,126
    "CreatedDate": "2022-08-11T10:18:59.1461591Z",127
    "Id": "1387c727-82a9-4a24-bdd6-57b2a379cef2",128
    "ModifiedBy": null,129
    "ModifiedDate": "2022-09-06T14:22:43Z",130
    "Name": "ACS_Pagination_St_48",131
    "Currency": null,132
    "ExternalId": null,133
    "Digest": null,134
    "CatAuto_Boolean_CstField_c": true,135
    "CatAuto_Currency_CstField_c": null,136
    "CatAuto_CustomFieldPickList_c": "GBP",137
    "CatAuto_DateTime_CstField_c": 

"2022-03-01T00:00:00Z",

138

    "CatAuto_Double_CstField_c": 171,139
    "CatAuto_Int_CstField_c": 371,140
    "CatAuto_Multipicklist_CstField_c": [141
      "Pink",142
      "White"143
    ],144
    "CatAuto_String_CstField_c": "AutoString_171",145
    "CreatedById": "27634e3f-904a-4321-9ce5- 

c2edbe181d90",

146

    "ModifiedById": "27634e3f-904a-4321-9ce5- 

c2edbe181d90"

147

  },148
  {149
    "ConfigurationType": "Standalone",150
    "Customizable": null,151
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    "Description": "ACS_Pagination_St_49",152
    "DisplayUrl": null,153
    "EffectiveDate": "1900-01-01T00:00:00Z",154
    "ExcludeFromSitemap": false,155
    "ExpirationDate": "2100-12-31T00:00:00Z",156
    "Family": null,157
    "HasAttributes": false,158
    "HasDefaults": false,159
    "HasOptions": false,160
    "HasSearchAttributes": false,161
    "ImageURL": "https://i1.wp.com/ 

techforceservices.com.au/wp-content/uploads/2019/04/ 

Conga.png?fit=584%2C190,ssl=1",

162

    "IsActive": true,163
    "IsCustomizable": false,164
    "IsTabViewEnabled": false,165
    "ProductCode": "ACS_Pagination_St_49",166
    "ProductType": null,167
    "QuantityUnitOfMeasure": null,168
    "RenewalLeadTime": 0,169
    "StockKeepingUnit": null,170
    "Uom": "Each",171
    "Version": 1,172
    "TriggeringPrimaryLineNumbers": null,173
    "RuleActionId": null,174
    "CreatedBy": null,175
    "CreatedDate": "2022-08-11T10:18:59.1461591Z",176
    "Id": "dda4cb81-d8c9-4b15-9d59-0bf8c60db23d",177
    "ModifiedBy": null,178
    "ModifiedDate": "2022-09-06T14:22:43Z",179
    "Name": "ACS_Pagination_St_49",180
    "Currency": null,181
    "ExternalId": null,182
    "Digest": null,183
    "CatAuto_Boolean_CstField_c": false,184
    "CatAuto_Currency_CstField_c": null,185
    "CatAuto_CustomFieldPickList_c": "EUR",186
    "CatAuto_DateTime_CstField_c": 

"2018-03-01T00:00:00Z",

187

    "CatAuto_Double_CstField_c": 172,188
    "CatAuto_Int_CstField_c": 372,189
    "CatAuto_Multipicklist_CstField_c": [190
      "Purple",191
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      "Black"192
    ],193
    "CatAuto_String_CstField_c": "AutoString_172",194
    "CreatedById": "27634e3f-904a-4321-9ce5- 

c2edbe181d90",

195

    "ModifiedById": "27634e3f-904a-4321-9ce5- 

c2edbe181d90"

196

  },197
  {198
    "ConfigurationType": "Standalone",199
    "Customizable": null,200
    "Description": "ACS_Pagination_St_50",201
    "DisplayUrl": null,202
    "EffectiveDate": "1900-01-01T00:00:00Z",203
    "ExcludeFromSitemap": false,204
    "ExpirationDate": "2100-12-31T00:00:00Z",205
    "Family": null,206
    "HasAttributes": false,207
    "HasDefaults": false,208
    "HasOptions": false,209
    "HasSearchAttributes": false,210
    "ImageURL": "https://i1.wp.com/ 

techforceservices.com.au/wp-content/uploads/2019/04/ 

Conga.png?fit=584%2C190,ssl=1",

211

    "IsActive": true,212
    "IsCustomizable": false,213
    "IsTabViewEnabled": false,214
    "ProductCode": "ACS_Pagination_St_50",215
    "ProductType": null,216
    "QuantityUnitOfMeasure": null,217
    "RenewalLeadTime": 0,218
    "StockKeepingUnit": null,219
    "Uom": "Each",220
    "Version": 1,221
    "TriggeringPrimaryLineNumbers": null,222
    "RuleActionId": null,223
    "CreatedBy": null,224
    "CreatedDate": "2022-08-11T10:18:59.1461591Z",225
    "Id": "81c9ef97-5b6d-4f17-9f92-d960f7e935b6",226
    "ModifiedBy": null,227
    "ModifiedDate": "2022-09-06T14:22:43Z",228
    "Name": "ACS_Pagination_St_50",229
    "Currency": null,230
    "ExternalId": null,231
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Example 2
The following table lists the API method, endpoint, and path as well as a sample request 
and response to get a product having a specific name and are associated with a category 
and a corresponding price list. 

Method GET

Endpoint /categories/{categoryId}/products

    "Digest": null,232
    "CatAuto_Boolean_CstField_c": true,233
    "CatAuto_Currency_CstField_c": null,234
    "CatAuto_CustomFieldPickList_c": "USD",235
    "CatAuto_DateTime_CstField_c": 

"2025-03-01T00:00:00Z",

236

    "CatAuto_Double_CstField_c": 173,237
    "CatAuto_Int_CstField_c": 373,238
    "CatAuto_Multipicklist_CstField_c": [239
      "Red",240
      "Blue"241
    ],242
    "CatAuto_String_CstField_c": "AutoString_173",243
    "CreatedById": "27634e3f-904a-4321-9ce5- 

c2edbe181d90",

244

    "ModifiedById": "27634e3f-904a-4321-9ce5- 

c2edbe181d90"

245

  }246
]247
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Request URL The following URL parameters are used to narrow down the search result 
to specifically retrieve products with the name "ACS_System_Installer" 
associated with a category ID and a price list ID.

Parameters Values

filter eq(Name:ACS_System_Installer)

category ID 391a047e-0a21-4f4a-be76-835ca61515d8

price list ID ffc5c4ad-7329-472e-aca6- 
b733c2ae47dd

Request The following sample code enables you to get the products associated 
with the given price list and category, adhering to the other above- 
mentioned parameters.

curl --request GET \1
     --url 'https://rlp-dev.congacloud.io/api/ 

catalog/v1/categories/cf3e1894-7732-4de2- 

bc2d-171d3bafa563/products? 

filter=eq%28Name%3AACS_System_Installer%29' \

2

     --header 'PriceListId: 51432cec-268a-4d2f- 

a543-8b91f70cdb7c' \

3

     --header 'accept: application/json' \4
     --header 'authorization: Bearer <Token>5
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Response For a leaf category, the API returns all products associated with it. If the 
ID of the root or sub-category (not a leaf category ID) is provided, the API 
returns all the products associated with all child categories.

Response Body

[1
  {2
    "ConfigurationType": "Standalone",3
    "Customizable": null,4
    "Description": "ACS System Installer",5
    "DisplayUrl": null,6
    "EffectiveDate": "1900-01-01T00:00:00Z",7
    "ExcludeFromSitemap": false,8
    "ExpirationDate": "2100-12-31T00:00:00Z",9
    "Family": null,10
    "HasAttributes": false,11
    "HasDefaults": false,12
    "HasOptions": false,13
    "HasSearchAttributes": false,14
    "ImageURL": "https://i1.wp.com/ 

techforceservices.com.au/wp-content/uploads/ 

2019/04/Conga.png?fit=584%2C190,ssl=1",

15

    "IsActive": true,16
    "IsCustomizable": false,17
    "IsTabViewEnabled": false,18
    "ProductCode": "ACS System Installer",19
    "ProductType": null,20
    "QuantityUnitOfMeasure": null,21
    "RenewalLeadTime": 0,22
    "StockKeepingUnit": null,23
    "Uom": "Each",24
    "Version": 1,25
    "TriggeringPrimaryLineNumbers": null,26
    "RuleActionId": null,27
    "CreatedBy": null,28
    "CreatedDate": "2022-08-11T10:18:59.1461591Z",29
    "Id": "ddc05e30-9406-4713-991e-ea9fb7d199db",30
    "ModifiedBy": null,31
    "ModifiedDate": "2022-09-06T14:22:43Z",32
    "Name": "ACS System Installer",33
    "Currency": null,34
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Example 3
The following table lists the API method, endpoint, and path as well as a sample request 
and response to get only standalone products associated with a category and a 
corresponding price list. 

Method GET

Endpoint /categories/{categoryId}/products

    "ExternalId": null,35
    "Digest": null,36
    "CatAuto_Boolean_CstField_c": true,37
    "CatAuto_Currency_CstField_c": null,38
    "CatAuto_CustomFieldPickList_c": "USD",39
    "CatAuto_DateTime_CstField_c": 

"2022-03-01T00:00:00Z",

40

    "CatAuto_Double_CstField_c": 169,41
    "CatAuto_Int_CstField_c": 369,42
    "CatAuto_Multipicklist_CstField_c": [43
      "Red",44
      "Blue"45
    ],46
    "CatAuto_String_CstField_c": "AutoString_169",47
    "CreatedById": "27634e3f-904a-4321-9ce5- 

c2edbe181d90",

48

    "ModifiedById": "27634e3f-904a-4321-9ce5- 

c2edbe181d90"

49

  }50
]51
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Request URL The following URL parameters are used to narrow down the search result 
to specifically retrieve the 1st standalone product on the third page that 
is associated with a category ID and a price list ID.

Parameters Values

page 10

limit 5

filter eq(ConfigurationType:Standalone)

category ID 391a047e-0a21-4f4a-be76-835ca61515d8

price list ID ffc5c4ad-7329-472e-aca6- 
b733c2ae47dd

Request The following sample code enables you to get the products associated 
with the given price list and category, adhering to the other above- 
mentioned parameters.

curl --request GET \1
     --url 'https://rlp-dev.congacloud.io/api/ 

catalog/v1/categories/cf3e1894-7732-4de2- 

bc2d-171d3bafa563/products? 

page=3&limit=1&filter=eq%28ConfigurationType%3ASta 

ndalone%29' \

2

     --header 'PriceListId: 51432cec-268a-4d2f- 

a543-8b91f70cdb7c' \

3

     --header 'accept: application/json' \4
     --header 'authorization: Bearer <Token>5
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Response For a leaf category, the API returns all products associated with it. If the 
ID of the root or sub-category (not a leaf category ID) is provided, the API 
returns all the products associated with all child categories.

Response Body

[1
  {2
    "ConfigurationType": "Standalone",3
    "Customizable": null,4
    "Description": "ACS_Pagination_St_3",5
    "DisplayUrl": null,6
    "EffectiveDate": "1900-01-01T00:00:00Z",7
    "ExcludeFromSitemap": false,8
    "ExpirationDate": "2100-12-31T00:00:00Z",9
    "Family": null,10
    "HasAttributes": false,11
    "HasDefaults": false,12
    "HasOptions": false,13
    "HasSearchAttributes": false,14
    "ImageURL": "https://i1.wp.com/ 

techforceservices.com.au/wp-content/uploads/ 

2019/04/Conga.png?fit=584%2C190,ssl=1",

15

    "IsActive": true,16
    "IsCustomizable": false,17
    "IsTabViewEnabled": false,18
    "ProductCode": "ACS_Pagination_St_3",19
    "ProductType": null,20
    "QuantityUnitOfMeasure": null,21
    "RenewalLeadTime": 0,22
    "StockKeepingUnit": null,23
    "Uom": "Each",24
    "Version": 1,25
    "TriggeringPrimaryLineNumbers": null,26
    "RuleActionId": null,27
    "CreatedBy": null,28
    "CreatedDate": "2022-08-11T10:18:59.1461591Z",29
    "Id": "229a416f-1b52-4e60-95c5-a8aa78973209",30
    "ModifiedBy": null,31
    "ModifiedDate": "2022-09-06T14:22:41Z",32
    "Name": "ACS_Pagination_St_3",33
    "Currency": null,34
    "ExternalId": null,35
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•

•
•
•

Retrieving Product Details
Retrieving products to view the details helps you explore the products before you add them 
to the cart. You can retrieve the product details using the GET/products  endpoint. The API 
retrieves the following basic product details:

Product header details, which includes Product Name, Description, Configuration 
Type, images associated, and if the product has options or attribute.
Product pricing details
Attributes and options associated with the product
Recommended similar products

You can use the parameters available in the API to retrieve product details based on a 
specific requirement. 

Method: GET 
Endpoint: /products

    "Digest": null,36
    "CatAuto_Boolean_CstField_c": false,37
    "CatAuto_Currency_CstField_c": null,38
    "CatAuto_CustomFieldPickList_c": "INR",39
    "CatAuto_DateTime_CstField_c": 

"2015-03-01T00:00:00Z",

40

    "CatAuto_Double_CstField_c": 126,41
    "CatAuto_Int_CstField_c": 326,42
    "CatAuto_Multipicklist_CstField_c": [43
      "Yellow",44
      "Green"45
    ],46
    "CatAuto_String_CstField_c": "AutoString_126",47
    "CreatedById": "27634e3f-904a-4321-9ce5- 

c2edbe181d90",

48

    "ModifiedById": "27634e3f-904a-4321-9ce5- 

c2edbe181d90"

49

  }50
]51
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API Purpose

GET/products?  

page=1&limit=12&sort=asc(Name)

Retrieves the details of the first 12 products in the 
given pricelist and sorts them alphabetically 
based on the Product Names

GET/products?  

filers=eq(ConfigurationType='Standalon 

e')

&page=1&limit=12&sort=asc(Name)

Retrieves details of standalone products with the 
pricing details associated with them.

GET/products?  

filers=eq(ConfigurationType='Bundle')

&includes=options&includes=price&page=  

1&limit=12&sort=asc(Name)

Retrieve details of bundle products with their 
options and associated pricing details associated 
with them

Example API with Parameter Details and Responses
The following example is when we have to retrieve details of bundle products with their 
options and associated pricing details associated with them. 

Pass the parameters in the GET/products  API, as described in the following table.

Request

'GET' \'https://<URL_of_the_Instance>/api/catalog/v1/products? 

filter=eq%28ConfigurationType%3A%27Bundle%27%29&includes=options&includes=price&sort= 

asc%28Name%29&page=1&limit=2'

Parameters Value

page 1

limit 2

sort asc(Name)

filter  ConfigurationType:'bundle'
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Parameters Value

includes prices, options

pricelist ID cbc75112-60e9-47b2-a632-f70d5912b70f

Response

[

  {

    "ConfigurationType": "Bundle",

    "Customizable": null,

    "Description": null,

    "DisplayUrl": null,

    "EffectiveDate": "1900-01-01T00:00:00Z",

    "ExcludeFromSitemap": false,

    "ExpirationDate": "2100-12-31T00:00:00Z",

    "Family": "Hardware",

    "HasAttributes": false,

    "HasDefaults": false,

    "HasOptions": true,

    "HasSearchAttributes": false,

    "ImageURL": null,

    "IsActive": true,

    "IsCustomizable": false,

    "IsTabViewEnabled": false,

    "ProductCode": null,

    "ProductType": "Equipment",

    "QuantityUnitOfMeasure": null,

    "RenewalLeadTime": 0,

    "StockKeepingUnit": null,

    "Uom": "Each",

    "Version": 1,

    "TriggeringPrimaryLineNumbers": null,

    "RuleActionId": null,

    "CreatedBy": null,

    "CreatedDate": null,

    "Id": "beb90aeb-5b10-439c-b177-adf11a6ec63a",

    "ModifiedBy": null,

    "ModifiedDate": null,

    "Name": "3000 Series Memory",
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    "Currency": null,

    "ExternalId": null,

    "Digest": null,

    "CatAuto_Boolean_CstField_c": null,

    "CatAuto_Currency_CstField_c": null,

    "CatAuto_CustomFieldPickList_c": null,

    "CatAuto_DateTime_CstField_c": null,

    "CatAuto_Double_CstField_c": null,

    "CatAuto_Int_CstField_c": null,

    "CatAuto_Multipicklist_CstField_c": null,

    "CatAuto_String_CstField_c": null

  },

  {

    "ConfigurationType": "Bundle",

    "Customizable": null,

    "Description": null,

    "DisplayUrl": null,

    "EffectiveDate": "1900-01-01T00:00:00Z",

    "ExcludeFromSitemap": false,

    "ExpirationDate": "2100-12-31T00:00:00Z",

    "Family": "Hardware",

    "HasAttributes": false,

    "HasDefaults": false,

    "HasOptions": true,

    "HasSearchAttributes": false,

    "ImageURL": null,

    "IsActive": true,

    "IsCustomizable": false,

    "IsTabViewEnabled": false,

    "ProductCode": null,

    "ProductType": "Equipment",

    "QuantityUnitOfMeasure": null,

    "RenewalLeadTime": 0,

    "StockKeepingUnit": null,

    "Uom": "Each",

    "Version": 1,

    "TriggeringPrimaryLineNumbers": null,

    "RuleActionId": null,

    "CreatedBy": null,

    "CreatedDate": null,

    "Id": "9dcb978a-6109-4465-a9fa-4363686e8cdb",

    "ModifiedBy": null,

    "ModifiedDate": null,

    "Name": "3200 Series Memory",
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•
•

    "Currency": null,

    "ExternalId": null,

    "Digest": null,

    "CatAuto_Boolean_CstField_c": null,

    "CatAuto_Currency_CstField_c": null,

    "CatAuto_CustomFieldPickList_c": null,

    "CatAuto_DateTime_CstField_c": null,

    "CatAuto_Double_CstField_c": null,

    "CatAuto_Int_CstField_c": null,

    "CatAuto_Multipicklist_CstField_c": null,

    "CatAuto_String_CstField_c": null

  }

]

Interacting with the Cart
This use case describes how to interact with the cart, which stores details about the 
product you configure from the catalog, including options, attributes, and pricing 
configuration. Implementation teams can use these APIs to build a cart as necessary to 
prepare a product configuration by providing relevant details. These APIs also enable 
actions on the cart to activate and price the product configuration.

Retrieving a List of Carts
You can retrieve all carts with their details where the requester is the creator, owner of, or 
has access to the cart. Retrieving carts helps you explore the carts before you check them 
out. This API retrieves the following details:

Cart name
Effective date of the cart

Method: GET 
Endpoint: /carts

You can use the query parameters available in the API to sort or filter carts based on 
specific requirements. For example, you have access to 1000 carts and retrieve them as 
follows.
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API Purpose

GET/carts?  

Page=1&limit=20&sort=asc(Name)

Retrieves only the first 2 carts sorted 
alphabetically based on cart names.

GET/carts?  

Page=1&limit=30&sort=desc(EffectiveDat 

e)

Retrieves only the first 2 carts sorted based on the 
effective dates of carts in descending order.

For the following values:

Parameters Value

page 1

limit 2

sort desc(EffectiveDate)

The below is the request URL and after executing that:

Request

'GET' \'https://<URL_of_the_Instance>/api/cart/v1/carts? 

sort=asc%28Name%29&page=1&limit=2' \

You get the following response:

Response

[

  {

    "Account": {

      "Id": "d80484e9-6a11-4019-8bab-7733726f068a",

      "Name": "Auto_IncStartAndEndDateCR_Account001"

    },

    "Ancestor": null,

    "ApprovalStatus": null,

    "BaseRelationCount": null,

    "BillingPreference": null,

    "BillToAccount": null,
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    "BusinessObjectId": null,

    "BusinessObjectProfile": "Regular",

    "BusinessObjectRefId": null,

    "BusinessObjectType": "Agreement",

    "Comments": null,

    "ContractNumbers": null,

    "CostRollupInfo": null,

    "CouponCodes": null,

    "CurrentUser": null,

    "Description": "Cart1 Created with automation script",

    "EffectiveDate": "2023-06-30T00:00:00",

    "EffectivePriceList": {

      "Id": "ca40ab42-1756-4047-851e-29ca7568ed80",

      "Name": "Auto_IncStartAndEndDateCR_PL001"

    },

    "ExpectedEndDate": null,

    "ExpectedStartDate": null,

    "FinalizedDate": null,

    "Intent": null,

    "IsPricePending": false,

    "IsTaskPending": false,

    "IsTransient": false,

    "IsValidationPending": false,

    "LineItemsAwaitingPrice": null,

    "LegalEntity": null,

    "Location": null,

    "NumberOfItems": 0,

    "Order": null,

    "ParentConfiguration": null,

    "PaymentTerm": null,

    "PriceList": {

      "Id": "ca40ab42-1756-4047-851e-29ca7568ed80",

      "Name": "Auto_IncStartAndEndDateCR_PL001"

    },

    "PricingDate": "2023-06-30T00:00:00",

    "Primordial": null,

    "PurchaseId": null,

    "RenewalAdjustmentAmount": null,

    "RenewalAdjustmentType": null,

    "ShipToAccount": null,

    "SplitCriteriaKey": null,

    "Status": "New",

    "SummaryGroupType": "Category",
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    "TaskCompletedDate": null,

    "UseType": "Main",

    "VersionNumber": null,

    "ActivationDate": null,

    "Id": "e42d09d9-6498-4b5b-8529-54a8826ab341",

    "Name": "Auto_IncStartAndEndDateCR_Cart001",

    "CreatedBy": {

      "Id": "27634e3f-904a-4321-9ce5-c2edbe181d90",

      "Name": "Test User"

    },

    "CreatedDate": "2022-11-16T01:09:06",

    "ModifiedBy": {

      "Id": "27634e3f-904a-4321-9ce5-c2edbe181d90",

      "Name": "Test User"

    },

    "ModifiedDate": "2022-11-16T01:09:06",

    "ExternalId": null,

    "PDTest_CustomField_c": "Custom Field Default Value",

    "ActivationDate_c": null

  },

  {

    "Account": {

      "Id": "c8a3e8e3-ceba-46a9-9dae-84058e8dd4a2",

      "Name": "Auto_IncStartAndEndDateCR_Account001"

    },

    "Ancestor": null,

    "ApprovalStatus": null,

    "BaseRelationCount": null,

    "BillingPreference": null,

    "BillToAccount": null,

    "BusinessObjectId": null,

    "BusinessObjectProfile": "Regular",

    "BusinessObjectRefId": null,

    "BusinessObjectType": "Agreement",

    "Comments": null,

    "ContractNumbers": null,

    "CostRollupInfo": null,

    "CouponCodes": null,

    "CurrentUser": null,

    "Description": "Cart1 Created with automation script",

    "EffectiveDate": "2023-06-30T00:00:00",

    "EffectivePriceList": {

      "Id": "8f58849c-ae90-4040-865d-8c67432e0ae1",

      "Name": "Auto_IncStartAndEndDateCR_PL001"
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    },

    "ExpectedEndDate": null,

    "ExpectedStartDate": null,

    "FinalizedDate": null,

    "Intent": null,

    "IsPricePending": false,

    "IsTaskPending": false,

    "IsTransient": false,

    "IsValidationPending": false,

    "LineItemsAwaitingPrice": null,

    "LegalEntity": null,

    "Location": null,

    "NumberOfItems": 0,

    "Order": null,

    "ParentConfiguration": null,

    "PaymentTerm": null,

    "PriceList": {

      "Id": "8f58849c-ae90-4040-865d-8c67432e0ae1",

      "Name": "Auto_IncStartAndEndDateCR_PL001"

    },

    "PricingDate": "2023-06-30T00:00:00",

    "Primordial": null,

    "PurchaseId": null,

    "RenewalAdjustmentAmount": null,

    "RenewalAdjustmentType": null,

    "ShipToAccount": null,

    "SplitCriteriaKey": null,

    "Status": "New",

    "SummaryGroupType": "Category",

    "TaskCompletedDate": null,

    "UseType": "Main",

    "VersionNumber": null,

    "ActivationDate": null,

    "Id": "72da7e2d-0fb5-49c3-9124-effc819ee424",

    "Name": "Auto_IncStartAndEndDateCR_Cart001",

    "CreatedBy": {

      "Id": "27634e3f-904a-4321-9ce5-c2edbe181d90",

      "Name": "Test User"

    },

    "CreatedDate": "2022-11-15T14:48:59",

    "ModifiedBy": {

      "Id": "27634e3f-904a-4321-9ce5-c2edbe181d90",

      "Name": "Test User"
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    },

    "ModifiedDate": "2022-11-15T14:48:59",

    "ExternalId": null,

    "PDTest_CustomField_c": "Custom Field Default Value",

    "ActivationDate_c": null

  }

]

 

Activating a Cart
Of all carts, only one cart can be active. You can activate a cart that is in the "New" status 
only. You cannot activate a cart in other statuses such as Finalized, Superseded, 
Suspended, Abandoned, or Deleted. Activating a cart does not change anything on the cart, 
except marking the cart as "Active". This API allows you to work on any existing cart that is 
not checked out yet.

Method: POST 
Endpoint: /carts/{CartId}/activate

For example, you want to activate a cart with the cart ID b6c8762a-2c14-49b0-9a46- 
bebe4044c919. Execute the following API:

POST/carts/b6c8762a-2c14-49b0-9a46-bebe4044c919/activate

Retrieving Cart Details (Header Information)
You can retrieve the header details of a cart. This API retrieves the following details among 
others:

Cart name
Price list
Account
Effective date
Link to the business object if the cart is finalized

Method: GET  
Endpoint: /carts/{cartId}

For example, the following sample code enables you to get the header details of a cart 
with the cart ID e42d09d9-6498-4b5b-8529-54a8826ab34. 
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Request

'GET' \ 'https://<URL_of_the_Instance>/api/cart/v1/carts/ 

e42d09d9-6498-4b5b-8529-54a8826ab341' \

You get the following response:

Response

{

  "Account": {

    "Id": "d80484e9-6a11-4019-8bab-7733726f068a",

    "Name": "Auto_IncStartAndEndDateCR_Account001"

  },

  "Ancestor": null,

  "ApprovalStatus": null,

  "BaseRelationCount": null,

  "BillingPreference": null,

  "BillToAccount": null,

  "BusinessObjectId": null,

  "BusinessObjectProfile": "Regular",

  "BusinessObjectRefId": null,

  "BusinessObjectType": "Agreement",

  "Comments": null,

  "ContractNumbers": null,

  "CostRollupInfo": null,

  "CouponCodes": null,

  "CurrentUser": null,

  "Description": "Cart1 Created with automation script",

  "EffectiveDate": "2023-06-30T00:00:00",

  "EffectivePriceList": {

    "Id": "ca40ab42-1756-4047-851e-29ca7568ed80",

    "Name": "Auto_IncStartAndEndDateCR_PL001"

  },

  "ExpectedEndDate": null,

  "ExpectedStartDate": null,

  "FinalizedDate": null,

  "Intent": null,

  "IsPricePending": false,

  "IsTaskPending": false,

  "IsTransient": false,
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  "IsValidationPending": false,

  "LineItemsAwaitingPrice": null,

  "LegalEntity": null,

  "Location": null,

  "NumberOfItems": 0,

  "Order": null,

  "ParentConfiguration": null,

  "PaymentTerm": null,

  "PriceList": {

    "Id": "ca40ab42-1756-4047-851e-29ca7568ed80",

    "Name": "Auto_IncStartAndEndDateCR_PL001"

  },

  "PricingDate": "2023-06-30T00:00:00",

  "Primordial": null,

  "PurchaseId": null,

  "RenewalAdjustmentAmount": null,

  "RenewalAdjustmentType": null,

  "ShipToAccount": null,

  "SplitCriteriaKey": null,

  "Status": "New",

  "SummaryGroupType": "Category",

  "TaskCompletedDate": null,

  "UseType": "Main",

  "VersionNumber": null,

  "ActivationDate": null,

  "Id": "e42d09d9-6498-4b5b-8529-54a8826ab341",

  "Name": "Auto_IncStartAndEndDateCR_Cart001",

  "CreatedBy": {

    "Id": "27634e3f-904a-4321-9ce5-c2edbe181d90",

    "Name": "Test User"

  },

  "CreatedDate": "2022-11-16T01:09:06",

  "ModifiedBy": {

    "Id": "27634e3f-904a-4321-9ce5-c2edbe181d90",

    "Name": "Test User"

  },

  "ModifiedDate": "2022-11-16T01:09:06",

  "ExternalId": null,

  "PDTest_CustomField_c": "Custom Field Default Value",

  "ActivationDate_c": null

}
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Retrieving Line Items of the Cart
You can retrieve all line items in a cart, with their details. The API retrieves the following 
details:

Cart header fields
Primary line items
Secondary line items associated with the primary line items such as options and 
charge types

Method: GET 
Endpoint: /carts/{cartId}/items

For example, you want to get the details of all line items in a cart with the cart ID 
e42d09d9-6498-4b5b-8529-54a8826ab341. Execute the following API:

Request

'GET' \'https://<URL_of_the_Instance>/api/cart/v1/carts/ 

e42d09d9-6498-4b5b-8529-54a8826ab341/items'

You can use the query parameters available in the API to sort or filter cart line items based 
on specific requirements. For example, a cart with the cart ID b6c8762a-2c14-49b0-9a46- 
bebe4044c919 has 1000 cart line items and you retrieve them as follows.

API Purpose

GET/carts/{b6c8762a-2c14-49b0-9a46-  

bebe4044c919}/ 

items&page=1&limit=20&sort=asc(Name)

Retrieves only the first 20 cart line items sorted 
alphabetically based on their names.

Adding Line Items to the Cart
You can add one or more standalone, bundle, and option products to the cart. You can add 
bundle line items with the default or modified configuration. You cannot add products to a 
cart in the Finalized, Superseded, or Deleted status.

Method: POST 
Endpoint: /carts/{cartId}/items
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For example, you want to add line items to a cart with the cart ID 
b6c8762a-2c14-49b0-9a46-bebe4044c919. Execute the following API:

POST/carts/b6c8762a-2c14-49b0-9a46-bebe4044c919/items

You must pass the product ID in the request body to add the product to the cart. You can 
add products with different field values.

Scenarios
In the following example, you add multiple standalone products with different field 
values. You pass the following parameters in the request body: 

Request Body

[

    {

        "PrimaryTxnLineNumber": 100001,

        "Product": {

            "Id": "44a35bef-6d8d-420a-9d7a-3c443c304f05",

            "Name": "Product_1"

        },

        "ExternalId": "45c8a8c8-7b94-419f-94b0-9e8f14d35696",

        "LineType": "Product/Service",

        "PricingStatus": "Pending",

        "Quantity": 1

    },

    {

        "PrimaryTxnLineNumber": 100002,

        "Product": {

            "Id": "ad590285-ac23-4182-9137-9a1b294842f2",

            "Name": "Product_2"

        },

        "ExternalId": "beed1ffe-1317-4bbb-a3b9-6a57c303a43a",

        "LineType": "Product/Service",

        "PricingStatus": "Pending",

        "Quantity": 1

    },

    {

        "PrimaryTxnLineNumber": 100003,

        "Product": {

            "Id": "71dda149-7dcc-4f37-8c67-a5c4b927afe5",
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            "Name": "Product_3"

        },

        "ExternalId": "f49c3693-d1ee-4590-83f3-f30102fef080",

        "LineType": "Product/Service",

        "PricingStatus": "Pending",

        "Quantity": 1

    }

]

In the following example, you add option to the Bundle products. You pass the 
following parameters in the request body:

[

    {

        "IsPrimaryLine": true,

        "LineType": "Product/Service",

        "PricingStatus": "Pending",

        "Product": {

            "Id": "9872ad8d-87c7-4a7c-ab49-c9332ce2fb0e",

            "Name": "n1"

        },

        "ExternalId": "Auto_BundleOnly_LineItem001",

        "PrimaryTxnLineNumber": 1,

        "StartDate": "2024-01-01",

        "EndDate": "2024-01-31",

        "AdjustmentAmount": 10.123456789,

        "AdjustmentType": "% Discount"

    },

    {

        "IsPrimaryLine": true,

        "LineType": "Option",

        "TxnParentBundleNumber": "1",

        "Option": {

            "Id": "9872ad8d-87c7-4a7c-ab19-c9332ce2fb0e",

            "Name": "n2"

        },

        "PricingStatus": "Pending",

        "Product": {

            "Id": "9872ad8d-87c7-4a7c-ab49-c9332ce2fb0e",

            "Name": "n1"

        },

        "ExternalId": "Auto_BundleOption_LineItem002",
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        "PrimaryTxnLineNumber": 2

    }

]

Updating an Existing Cart Item
You can update one or more existing cart line items by providing details of the following 
fields in the request body:

Quantity
Selling Term
Start Date
End Date
Adjustment Amount
Adjustment Type

You cannot update custom fields. You cannot update line items in a cart in the Finalized, 
Superseded, or Deleted status.

Method: PATCH 
Endpoint: /carts/{cartId}/items

For example, you want to update line items in a cart with the cart ID 
b6c8762a-2c14-49b0-9a46-bebe4044c919. Execute the following API:

PATCH/carts/b6c8762a-2c14-49b0-9a46-bebe4044c919/items

In the request body, you must pass the product ID and the required fields with values to 
update the cart line items.

Scenarios
In the following example, you update the quantity of an existing cart line item.

[

    {

        "PrimaryTxnLineNumber": "1",

        "ProductId": "6e6619b8-8d2e-4686-af69-b16e683b98f9",

        "LineType": "Product/Service",

        "LineNumber" : 1,

        "PrimaryLineNumber" :1,

        "PricingStatus": "Pending",
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        "Id": "494f0297-d63a-46b1-a71a-689ad5409a3f",

        "Quantity": 10,

        "ExternalId": "Standalone"

    }

]

In the following example, you update the selling term of an existing cart line item:

[

    {

        "PrimaryTxnLineNumber": "1",

        "ProductId": "6e6619b8-8d2e-4686-af69-b16e683b98f9",

        "LineType": "Product/Service",

        "LineNumber": 1,

        "PrimaryLineNumber": 1,

        "PricingStatus": "Pending",

        "Id": "494f0297-d63a-46b1-a71a-689ad5409a3f",

        "Quantity": 10,

        "ExternalId": "Standalone",

        "SellingTerm" : 5

    }

]

Removing Line Items from the Cart
You can remove one or more line items from the cart. You cannot remove line items from a 
cart in the Finalized, Superseded, or Deleted status.

Method: DELETE 
Endpoint: /carts/{cartId}/items

For example, you want to remove line items from a cart with the cart ID 
b6c8762a-2c14-49b0-9a46-bebe4044c919. Execute the following API:

DELETE/carts/b6c8762a-2c14-49b0-9a46-bebe4044c919/items

In the request body, you provide IDs of cart line items to remove the associated records from 
the cart.
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Scenario
In the following example, you remove one cart line item.

[

  {

    "LineNumber": 0

  },

  {

    "CartItemId": "3fa85f64-5717-4562-b3fc-2c963f66afa6"

  }

]

Run Pricing on the Cart
You must calculate pricing on the cart whenever you add any product(s) to the cart and/or 
configure products from the catalog. CPQ does not run pricing on the cart by default, so 
you must do it explicitly. Following are some of the scenarios to call this API:

Adding a standalone product to the cart
Adding a bundle product and configuring its options
Selecting different charge types
Configuring product attributes or modifying them
Changing the default quantity (that is 1) on the Catalog page while adding/ 
configuring the products
Deselecting an added product from the catalog

You must also perform repricing of the cart whenever you update the cart. Following are 
some of the scenarios to reprice the cart:

Changing any cart line item fields such as Quantity, Selling Term, Start Date, End 
Date, Base Price
Applying any kind of adjustments on any cart line item
Performing actions such Mass Update
Adding or removing any line item
Configuring any line item for options, attributes, or other parameters

Method: POST 
Endpoint: /carts/{cartId}/price

For example, you want to price or reprice a cart with the cart ID 
b6c8762a-2c14-49b0-9a46-bebe4044c919. Execute the following API:
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POST/carts/b6c8762a-2c14-49b0-9a46-bebe4044c919/price

Deleting a Cart
You can delete a cart when it is no longer required. A deleted cart record is not stored so 
you cannot access it after deletion.

Method: DELETE 
Endpoint: /carts/{cartId}

For example, you want to delete a cart with the cart ID b6c8762a-2c14-49b0-9a46- 
bebe4044c919. Execute the following API:

DELETE/carts/b6c8762a-2c14-49b0-9a46-bebe4044c919

Creating and Editing Quotes
This use case describes how to create and edit quotes, which is a formal statement of 
promise that lists the products and services to be sold to a customer at a defined price. 
Quote creation involves configuring products and services, pricing them, and generating 
quotes based on predefined rules. Implementation teams can use these APIs to build 
quoting functionalities necessary to prepare a quote by providing relevant details.

Creating a Quote
You can create one or more quotes by providing the quote name, price list ID, and price list 
name in the request. Provide other relevant quote details as it is a good practice to pass as 
many fields in the request body as are needed to pre-populate the quote. For example, it is 
recommended to populate the Account related fields.

Prerequisite
You must gather the following details to create a quote. 

Price List ID
Price List Name

You can use the GET/price-lists  API to retrieve all price lists in the system. For more 
information, see Pricing Setup APIs.
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Example 1
The following table lists the API method, endpoint, and path as well as a sample request 
and response for creating a quote.

Method POST

Endpoint /quotes

Request URL https://<URL_of_the_Instance>/api/quote/v1/quotes

Request The following sample request creates a quote named Tier_1, with 
AutoQuoteRLP_QuotePL pricelist.

[1
  {2
    "Account": {3
      "Id": "e60f1de6-6b54-4304-a600-31c226b842db",4
      "Name": "AutoQuoteRLPAccount_"5
    },6
    "Currency": "USD",7
    "Description": 

"AutoQuoteService_Description1667823791262_57",

8

    "Location": {9
      "Id": "7b363b21-2d8b-4277-b14e-0698ccd6bbd8",10
      "Name": "Ahmedabad"11
    },12
     "Opportunity": {13
      "Id": "9129aa7e-2ad5-430f-b456-49d62eeaed87",14
      "Name": "AutoQuoteRLPOpportunity"15
    },16
    "PriceList": {17
      "Id": "8bea2478-428c-4421-afcd-97e327dad477",18
      "Name": "AutoQuoteRLP_QuotePL"19
    },20
    "ProposalCategory": "Quote",21
    "Name": "Tier_1"22
    }23
]24
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Response The API returns the structure of the newly created quote, which includes all 
associated field values that are populated by default or overridden based 
on the request body. 

Response Body

[1
  {2
    "ABOType": "New",3
    "Account": {4
      "Id": "e60f1de6-6b54-4304-a600-31c226b842db",5
      "Name": "AutoQuoteRLPAccount_"6
    },7
    "Amount": null,8
    "ApprovalStage": "Draft",9
    "AutoActivateOrder": false,10
    "AutoCreateBill": false,11
    "AutoCreateRevenue": false,12
    "BillingPreference": null,13
    "BillToAccount": null,14
    "ConfigurationEffectiveDate": null,15
    "ConfigurationFinalizedDate": null,16
    "ConfigurationSyncDate": null,17
    "Currency": "USD",18
    "Description": 

"AutoQuoteService_Description1667823791262_57",

19

    "DisableCartVersioning": false,20
    "DiscountPercent": null,21
    "ExpectedEndDate": null,22
    "ExpectedStartDate": null,23
    "GrandTotal": null,24
    "Intent": null,25
    "InternalDeadline": null,26
    "IsAutoAccepted": false,27
    "IsPrimary": true,28
    "IsSystemGenerated": false,29
    "IsTaskPending": false,30
    "LegalEntity": null,31
    "Location": {32
      "Id": "7b363b21-2d8b-4277-b14e-0698ccd6bbd8",33
      "Name": "Ahmedabad"34
    },35
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    "NetAmount": null,36
    "Opportunity": {37
      "Id": "9129aa7e-2ad5-430f-b456-49d62eeaed87",38
      "Name": "AutoQuoteRLPOpportunity"39
    },40
    "ParentProposal": null,41
    "PartnerAccount": null,42
    "ProposalPaymentTerm": "Net 30 Days",43
    "PaymentTerm": null,44
    "PODate": null,45
    "PONumber": null,46
    "PresentedDate": null,47
    "PriceList": {48
      "Id": "8bea2478-428c-4421-afcd-97e327dad477",49
      "Name": "AutoQuoteRLP_QuotePL"50
    },51
    "PricingDate": null,52
    "PrimaryContact": null,53
    "ProposalApprovalDate": null,54
    "ProposalCategory": "Quote",55
    "ProposalExpirationDate": null,56
    "ProposalName": null,57
    "PurchaseId": null,58
    "QTCProfile": null,59
    "ReadyForActivationDate": null,60
    "ReadyForBillingDate": null,61
    "ReadyForFulfillmentDate": null,62
    "ReadyForRevRecDate": null,63
    "ReadyToGenerate": true,64
    "ReadyToPresent": true,65
    "RelatedProposal": null,66
    "RFPIntakeDate": null,67
    "RFPResponseDueDate": null,68
    "RFPStage": null,69
    "RFPValue": null,70
    "RiskFactors": null,71
    "SalesTaxAmount": null,72
    "SalesTaxPercent": null,73
    "ShippingHandling": null,74
    "ShipToAccount": null,75
    "SingleTransactionAdjustment": false,76
    "SourceChannel": "Direct",77
    "SpecialTerms": null,78
    "StrategicImportance": null,79
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Example 2
The following table list the API method, endpoints, and sample codes for request and 
responses to create more than one quote:

Method POST

Endpoint /quotes

Request URL https://<URL_of_the_Instance>/api/quote/v1/quotes

    "SyncAssetChangesToQuote": true,80
    "UseType": "Main",81
    "ValidUntilDate": null,82
    "Id": "75723d17-937e-4213-89f8-41a8f2c81594",83
    "Name": "Tier_1",84
    "CreatedBy": {85
      "Id": "d717a075-9cbf-480c-b230-837e0e6dee75",86
      "Name": "<Test_Username>"87
    },88
    "CreatedDate": "2022-12-27T18:54:56.3326618",89
    "ModifiedBy": {90
      "Id": "d717a075-9cbf-480c-b230-837e0e6dee75",91
      "Name": "<Test_Username> "92
    },93
    "ModifiedDate": "2022-12-27T18:54:56.3326618",94
    "ExternalId": null,95
    "QuoteAuto_PickList_CstField_c": null,96
    "QuoteAuto_String_CstField_c": null,97
    "QuoteAuto_Double_CstField_c": null,98
    "QuoteAuto_Int_CstField_c": null,99
    "QuoteAuto_Boolean_CstField_c": null,100
    "QuoteAuto_Currency_CstField_c": null,101
    "QuoteAuto_DateTime_CstField_c": null,102
    "QuoteAuto_Multipicklist_CstField_c": null103
  }104
]105
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Request The following sample code creates quotes with the following names with 
AutoQuoteRLP_QuotePL pricelist. 

Tier_2
Tier_3

 

[1
    {2
        "Name": "Tier_2",3
        "ProposalCategory": "Quote",4
        "PriceList": {5
          "Id": "8bea2478-428c-4421- 

afcd-97e327dad477",

6

          "Name": "AutoQuoteRLP_QuotePL"7
        },8
        "Account": {9
          "Id": "e60f1de6-6b54-4304- 

a600-31c226b842db",

10

          "Name": "AutoQuoteRLPAccount_"11
        },12
        "Description": "Tier 2 Quote",13
        "Location": {14
          "Id": "7b363b21-2d8b-4277- 

b14e-0698ccd6bbd8",

15

          "Name": "Ahmedabad"16
        },17
         "Opportunity": {18
          "Id": "9129aa7e-2ad5-430f- 

b456-49d62eeaed87",

19

          "Name": "AutoQuoteRLPOpportunity"20
        }21
    },22
    {23
        "Name": "Tier_3",24
        "ProposalCategory": "Quote",25
        "PriceList": {26
          "Id": "8bea2478-428c-4421- 

afcd-97e327dad477",

27

          "Name": "AutoQuoteRLP_QuotePL"28
        },29
        "Account": {30
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          "Id": "e60f1de6-6b54-4304- 

a600-31c226b842db",

31

          "Name": "AutoQuoteRLPAccount_"32
        },33
        "Currency": "USD",34
        "Description": "Tier 3 Quote",35
        "Location": {36
          "Id": "7b363b21-2d8b-4277- 

b14e-0698ccd6bbd8",

37

          "Name": "Ahmedabad"38
        },39
         "Opportunity": {40
          "Id": "9129aa7e-2ad5-430f- 

b456-49d62eeaed87",

41

          "Name": "AutoQuoteRLPOpportunity"42
        }43
    }44
]45



Configure Price Quote (CPQ)

467 Copyright ©2024 Conga Corporation. All rights reserved.

Response The API returns the structure of the newly created quotes.

Response Body

[1
  {2
    "ABOType": "New",3
    "Account": {4
      "Id": "e60f1de6-6b54-4304-a600-31c226b842db",5
      "Name": "AutoQuoteRLPAccount_"6
    },7
    "Amount": null,8
    "ApprovalStage": "Draft",9
    "AutoActivateOrder": false,10
    "AutoCreateBill": false,11
    "AutoCreateRevenue": false,12
    "BillingPreference": null,13
    "BillToAccount": null,14
    "ConfigurationEffectiveDate": null,15
    "ConfigurationFinalizedDate": null,16
    "ConfigurationSyncDate": null,17
    "Currency": "USD",18
    "Description": "Tier 2 Quote",19
    "DisableCartVersioning": false,20
    "DiscountPercent": null,21
    "ExpectedEndDate": null,22
    "ExpectedStartDate": null,23
    "GrandTotal": null,24
    "Intent": null,25
    "InternalDeadline": null,26
    "IsAutoAccepted": false,27
    "IsPrimary": true,28
    "IsSystemGenerated": false,29
    "IsTaskPending": false,30
    "LegalEntity": null,31
    "Location": {32
      "Id": "7b363b21-2d8b-4277-b14e-0698ccd6bbd8",33
      "Name": "Ahmedabad"34
    },35
    "NetAmount": null,36
    "Opportunity": {37
      "Id": "9129aa7e-2ad5-430f-b456-49d62eeaed87",38
      "Name": "AutoQuoteRLPOpportunity"39
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    },40
    "ParentProposal": null,41
    "PartnerAccount": null,42
    "ProposalPaymentTerm": "Net 30 Days",43
    "PaymentTerm": null,44
    "PODate": null,45
    "PONumber": null,46
    "PresentedDate": null,47
    "PriceList": {48
      "Id": "8bea2478-428c-4421-afcd-97e327dad477",49
      "Name": "AutoQuoteRLP_QuotePL"50
    },51
    "PricingDate": null,52
    "PrimaryContact": null,53
    "ProposalApprovalDate": null,54
    "ProposalCategory": "Quote",55
    "ProposalExpirationDate": null,56
    "ProposalName": null,57
    "PurchaseId": null,58
    "QTCProfile": null,59
    "ReadyForActivationDate": null,60
    "ReadyForBillingDate": null,61
    "ReadyForFulfillmentDate": null,62
    "ReadyForRevRecDate": null,63
    "ReadyToGenerate": true,64
    "ReadyToPresent": true,65
    "RelatedProposal": null,66
    "RFPIntakeDate": null,67
    "RFPResponseDueDate": null,68
    "RFPStage": null,69
    "RFPValue": null,70
    "RiskFactors": null,71
    "SalesTaxAmount": null,72
    "SalesTaxPercent": null,73
    "ShippingHandling": null,74
    "ShipToAccount": null,75
    "SingleTransactionAdjustment": false,76
    "SourceChannel": "Direct",77
    "SpecialTerms": null,78
    "StrategicImportance": null,79
    "SyncAssetChangesToQuote": true,80
    "UseType": "Main",81
    "ValidUntilDate": null,82
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    "Id": "8cae6d8a-2a3b-4c1c-bf64-8ddef14dc863",83
    "Name": "Tier_2",84
    "CreatedBy": {85
      "Id": "d717a075-9cbf-480c-b230-837e0e6dee75",86
      "Name": "Test Manish User"87
    },88
    "CreatedDate": "2022-12-27T20:04:29.9468282",89
    "ModifiedBy": {90
      "Id": "d717a075-9cbf-480c-b230-837e0e6dee75",91
      "Name": "Test Manish User"92
    },93
    "ModifiedDate": "2022-12-27T20:04:29.9468282",94
    "ExternalId": null,95
    "QuoteAuto_PickList_CstField_c": null,96
    "QuoteAuto_String_CstField_c": null,97
    "QuoteAuto_Double_CstField_c": null,98
    "QuoteAuto_Int_CstField_c": null,99
    "QuoteAuto_Boolean_CstField_c": null,100
    "QuoteAuto_Currency_CstField_c": null,101
    "QuoteAuto_DateTime_CstField_c": null,102
    "QuoteAuto_Multipicklist_CstField_c": null103
  },104
  {105
    "ABOType": "New",106
    "Account": {107
      "Id": "e60f1de6-6b54-4304-a600-31c226b842db",108
      "Name": "AutoQuoteRLPAccount_"109
    },110
    "Amount": null,111
    "ApprovalStage": "Draft",112
    "AutoActivateOrder": false,113
    "AutoCreateBill": false,114
    "AutoCreateRevenue": false,115
    "BillingPreference": null,116
    "BillToAccount": null,117
    "ConfigurationEffectiveDate": null,118
    "ConfigurationFinalizedDate": null,119
    "ConfigurationSyncDate": null,120
    "Currency": "USD",121
    "Description": "Tier 3 Quote",122
    "DisableCartVersioning": false,123
    "DiscountPercent": null,124
    "ExpectedEndDate": null,125
    "ExpectedStartDate": null,126
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    "GrandTotal": null,127
    "Intent": null,128
    "InternalDeadline": null,129
    "IsAutoAccepted": false,130
    "IsPrimary": true,131
    "IsSystemGenerated": false,132
    "IsTaskPending": false,133
    "LegalEntity": null,134
    "Location": {135
      "Id": "7b363b21-2d8b-4277-b14e-0698ccd6bbd8",136
      "Name": "Ahmedabad"137
    },138
    "NetAmount": null,139
    "Opportunity": {140
      "Id": "9129aa7e-2ad5-430f-b456-49d62eeaed87",141
      "Name": "AutoQuoteRLPOpportunity"142
    },143
    "ParentProposal": null,144
    "PartnerAccount": null,145
    "ProposalPaymentTerm": "Net 30 Days",146
    "PaymentTerm": null,147
    "PODate": null,148
    "PONumber": null,149
    "PresentedDate": null,150
    "PriceList": {151
      "Id": "8bea2478-428c-4421-afcd-97e327dad477",152
      "Name": "AutoQuoteRLP_QuotePL"153
    },154
    "PricingDate": null,155
    "PrimaryContact": null,156
    "ProposalApprovalDate": null,157
    "ProposalCategory": "Quote",158
    "ProposalExpirationDate": null,159
    "ProposalName": null,160
    "PurchaseId": null,161
    "QTCProfile": null,162
    "ReadyForActivationDate": null,163
    "ReadyForBillingDate": null,164
    "ReadyForFulfillmentDate": null,165
    "ReadyForRevRecDate": null,166
    "ReadyToGenerate": true,167
    "ReadyToPresent": true,168
    "RelatedProposal": null,169
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    "RFPIntakeDate": null,170
    "RFPResponseDueDate": null,171
    "RFPStage": null,172
    "RFPValue": null,173
    "RiskFactors": null,174
    "SalesTaxAmount": null,175
    "SalesTaxPercent": null,176
    "ShippingHandling": null,177
    "ShipToAccount": null,178
    "SingleTransactionAdjustment": false,179
    "SourceChannel": "Direct",180
    "SpecialTerms": null,181
    "StrategicImportance": null,182
    "SyncAssetChangesToQuote": true,183
    "UseType": "Main",184
    "ValidUntilDate": null,185
    "Id": "4d444f87-ff0c-4955-b742-74576f86ba58",186
    "Name": "Tier_3",187
    "CreatedBy": {188
      "Id": "d717a075-9cbf-480c-b230-837e0e6dee75",189
      "Name": "Test Manish User"190
    },191
    "CreatedDate": "2022-12-27T20:04:29.9477331",192
    "ModifiedBy": {193
      "Id": "d717a075-9cbf-480c-b230-837e0e6dee75",194
      "Name": "Test Manish User"195
    },196
    "ModifiedDate": "2022-12-27T20:04:29.9477331",197
    "ExternalId": null,198
    "QuoteAuto_PickList_CstField_c": null,199
    "QuoteAuto_String_CstField_c": null,200
    "QuoteAuto_Double_CstField_c": null,201
    "QuoteAuto_Int_CstField_c": null,202
    "QuoteAuto_Boolean_CstField_c": null,203
    "QuoteAuto_Currency_CstField_c": null,204
    "QuoteAuto_DateTime_CstField_c": null,205
    "QuoteAuto_Multipicklist_CstField_c": null206
  }207
]208
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Retrieving List of Quotes
You can retrieve all quotes with their details where the requester is the creator, owner of, or 
has access to the quote. Retrieving quotes helps you explore the quote as it moves through 
the quote life cycle. 

Prerequisite
You must have existing quotes in the system which you have created or that you own or 
have access to.

Example
The following table lists the API method, endpoints, and sample codes for request and 
response, to retrieve a quote:

Method GET

Endpoint /quotes

Request Parameters The following URL parameters are used to narrow down the search result 
to specifically retrieve quote names containing the string "Tier".

Parameters Values

page 1

limit 2

sort asc(Name)

filter  like(Name: 'Tier' )

Request URL https://<URL_of_the_Instance>/api/quote/v1/quotes? 

filter=like%28Name%3A%20%27Tier%27%20%29&sort=asc%28Name%29&page 

=1&limit=2
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Response The API returns all details associated with the retrieved quotes.

Response Body

[1
  {2
    "ABOType": "New",3
    "Account": {4
      "Id": "e60f1de6-6b54-4304- 

a600-31c226b842db",

5

      "Name": "AutoQuoteRLPAccount_"6
    },7
    "Amount": null,8
    "ApprovalStage": "Draft",9
    "AutoActivateOrder": false,10
    "AutoCreateBill": false,11
    "AutoCreateRevenue": false,12
    "BillingPreference": null,13
    "BillToAccount": null,14
    "ConfigurationEffectiveDate": null,15
    "ConfigurationFinalizedDate": null,16
    "ConfigurationSyncDate": null,17
    "Currency": "USD",18
    "Description": 

"AutoQuoteService_Description1667823791262_57",

19

    "DisableCartVersioning": false,20
    "DiscountPercent": null,21
    "ExpectedEndDate": null,22
    "ExpectedStartDate": null,23
    "GrandTotal": null,24
    "Intent": null,25
    "InternalDeadline": null,26
    "IsAutoAccepted": false,27
    "IsPrimary": true,28
    "IsSystemGenerated": false,29
    "IsTaskPending": false,30
    "LegalEntity": null,31
    "Location": {32
      "Id": "7b363b21-2d8b-4277- 

b14e-0698ccd6bbd8",

33

      "Name": "Ahmedabad"34
    },35
    "NetAmount": null,36
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    "Opportunity": {37
      "Id": "9129aa7e-2ad5-430f- 

b456-49d62eeaed87",

38

      "Name": "AutoQuoteRLPOpportunity"39
    },40
    "ParentProposal": null,41
    "PartnerAccount": null,42
    "ProposalPaymentTerm": "Net 30 Days",43
    "PaymentTerm": null,44
    "PODate": null,45
    "PONumber": null,46
    "PresentedDate": null,47
    "PriceList": {48
      "Id": "8bea2478-428c-4421- 

afcd-97e327dad477",

49

      "Name": "AutoQuoteRLP_QuotePL"50
    },51
    "PricingDate": null,52
    "PrimaryContact": null,53
    "ProposalApprovalDate": null,54
    "ProposalCategory": "Quote",55
    "ProposalExpirationDate": null,56
    "ProposalName": null,57
    "PurchaseId": null,58
    "QTCProfile": null,59
    "ReadyForActivationDate": null,60
    "ReadyForBillingDate": null,61
    "ReadyForFulfillmentDate": null,62
    "ReadyForRevRecDate": null,63
    "ReadyToGenerate": true,64
    "ReadyToPresent": true,65
    "RelatedProposal": null,66
    "RFPIntakeDate": null,67
    "RFPResponseDueDate": null,68
    "RFPStage": null,69
    "RFPValue": null,70
    "RiskFactors": null,71
    "SalesTaxAmount": null,72
    "SalesTaxPercent": null,73
    "ShippingHandling": null,74
    "ShipToAccount": null,75
    "SingleTransactionAdjustment": false,76
    "SourceChannel": "Direct",77
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    "SpecialTerms": null,78
    "StrategicImportance": null,79
    "SyncAssetChangesToQuote": true,80
    "UseType": "Main",81
    "ValidUntilDate": null,82
    "Id": "75723d17-937e-4213-89f8-41a8f2c81594",83
    "Name": "Tier_1",84
    "CreatedBy": {85
      "Id": "d717a075-9cbf-480c- 

b230-837e0e6dee75",

86

      "Name": "Test Manish User"87
    },88
    "CreatedDate": "2022-12-27T18:54:56",89
    "ModifiedBy": {90
      "Id": "d717a075-9cbf-480c- 

b230-837e0e6dee75",

91

      "Name": "Test Manish User"92
    },93
    "ModifiedDate": "2022-12-27T18:54:56",94
    "ExternalId": null,95
    "QuoteAuto_PickList_CstField_c": null,96
    "QuoteAuto_String_CstField_c": null,97
    "QuoteAuto_Double_CstField_c": null,98
    "QuoteAuto_Int_CstField_c": null,99
    "QuoteAuto_Boolean_CstField_c": null,100
    "QuoteAuto_Currency_CstField_c": null,101
    "QuoteAuto_DateTime_CstField_c": null,102
    "QuoteAuto_Multipicklist_CstField_c": null103
  },104
  {105
    "ABOType": "New",106
    "Account": {107
      "Id": "e60f1de6-6b54-4304- 

a600-31c226b842db",

108

      "Name": "AutoQuoteRLPAccount_"109
    },110
    "Amount": null,111
    "ApprovalStage": "Draft",112
    "AutoActivateOrder": false,113
    "AutoCreateBill": false,114
    "AutoCreateRevenue": false,115
    "BillingPreference": null,116
    "BillToAccount": null,117
    "ConfigurationEffectiveDate": null,118
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    "ConfigurationFinalizedDate": null,119
    "ConfigurationSyncDate": null,120
    "Currency": "USD",121
    "Description": "Tier 2 Quote",122
    "DisableCartVersioning": false,123
    "DiscountPercent": null,124
    "ExpectedEndDate": null,125
    "ExpectedStartDate": null,126
    "GrandTotal": null,127
    "Intent": null,128
    "InternalDeadline": null,129
    "IsAutoAccepted": false,130
    "IsPrimary": true,131
    "IsSystemGenerated": false,132
    "IsTaskPending": false,133
    "LegalEntity": null,134
    "Location": {135
      "Id": "7b363b21-2d8b-4277- 

b14e-0698ccd6bbd8",

136

      "Name": "Ahmedabad"137
    },138
    "NetAmount": null,139
    "Opportunity": {140
      "Id": "9129aa7e-2ad5-430f- 

b456-49d62eeaed87",

141

      "Name": "AutoQuoteRLPOpportunity"142
    },143
    "ParentProposal": null,144
    "PartnerAccount": null,145
    "ProposalPaymentTerm": "Net 30 Days",146
    "PaymentTerm": null,147
    "PODate": null,148
    "PONumber": null,149
    "PresentedDate": null,150
    "PriceList": {151
      "Id": "8bea2478-428c-4421- 

afcd-97e327dad477",

152

      "Name": "AutoQuoteRLP_QuotePL"153
    },154
    "PricingDate": null,155
    "PrimaryContact": null,156
    "ProposalApprovalDate": null,157
    "ProposalCategory": "Quote",158
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    "ProposalExpirationDate": null,159
    "ProposalName": null,160
    "PurchaseId": null,161
    "QTCProfile": null,162
    "ReadyForActivationDate": null,163
    "ReadyForBillingDate": null,164
    "ReadyForFulfillmentDate": null,165
    "ReadyForRevRecDate": null,166
    "ReadyToGenerate": true,167
    "ReadyToPresent": true,168
    "RelatedProposal": null,169
    "RFPIntakeDate": null,170
    "RFPResponseDueDate": null,171
    "RFPStage": null,172
    "RFPValue": null,173
    "RiskFactors": null,174
    "SalesTaxAmount": null,175
    "SalesTaxPercent": null,176
    "ShippingHandling": null,177
    "ShipToAccount": null,178
    "SingleTransactionAdjustment": false,179
    "SourceChannel": "Direct",180
    "SpecialTerms": null,181
    "StrategicImportance": null,182
    "SyncAssetChangesToQuote": true,183
    "UseType": "Main",184
    "ValidUntilDate": null,185
    "Id": "8cae6d8a-2a3b-4c1c-bf64-8ddef14dc863",186
    "Name": "Tier_2",187
    "CreatedBy": {188
      "Id": "d717a075-9cbf-480c- 

b230-837e0e6dee75",

189

      "Name": "Test Manish User"190
    },191
    "CreatedDate": "2022-12-27T20:04:29",192
    "ModifiedBy": {193
      "Id": "d717a075-9cbf-480c- 

b230-837e0e6dee75",

194

      "Name": "Test Manish User"195
    },196
    "ModifiedDate": "2022-12-27T20:04:29",197
    "ExternalId": null,198
    "QuoteAuto_PickList_CstField_c": null,199
    "QuoteAuto_String_CstField_c": null,200
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•

 

Retrieving Quote Details (header information)
You can retrieve the details of a specific quote by passing the quote ID. The API returns the 
quote header fields, pricing, and quote line items among other details.

Prerequisite
You must gather the following details to create a quote. 

Quote ID

You can create a new quote and extract the quote ID from the response, create a quote 
using POST/quotes , or retrieve existing quotes using GET/quotes . For more information, see 
the "Creating a Quote" and "Retrieving List of Quotes" sections or see Quoting APIs.

Example
The following table lists the API method, endpoints, and sample codes for request and 
response, to retrieve the details of a quote:

Method GET

Endpoint /quotes/{quoteId}

    "QuoteAuto_Double_CstField_c": null,201
    "QuoteAuto_Int_CstField_c": null,202
    "QuoteAuto_Boolean_CstField_c": null,203
    "QuoteAuto_Currency_CstField_c": null,204
    "QuoteAuto_DateTime_CstField_c": null,205
    "QuoteAuto_Multipicklist_CstField_c": null206
  }207
]208
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Request Parameters The following URL parameter is used to pass the quote ID. You can use 
the value 'items' in the includes parameter to proposal line items 
associated with the given quote. For this example, only the ID of the 
quote is passed. 

Parameters Values

quoteID 8cae6d8a-2a3b-4c1c- 
bf64-8ddef14dc863

This quote was generated in the "Create a quote" section,  using the 
POST/quotes  API and its ID was retrieved using the GET/quotes  API.

Request URL https://<URL_of_the_Instance>/api/quote/v1/quotes/ 

8cae6d8a-2a3b-4c1c-bf64-8ddef14dc863
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Response The API retrieves the structure of the quote.

Response Body

{1
  "ABOType": "New",2
  "Account": {3
    "Id": "e60f1de6-6b54-4304-a600-31c226b842db",4
    "Name": "AutoQuoteRLPAccount_"5
  },6
  "Amount": null,7
  "ApprovalStage": "Draft",8
  "AutoActivateOrder": false,9
  "AutoCreateBill": false,10
  "AutoCreateRevenue": false,11
  "BillingPreference": null,12
  "BillToAccount": null,13
  "ConfigurationEffectiveDate": null,14
  "ConfigurationFinalizedDate": null,15
  "ConfigurationSyncDate": null,16
  "Currency": "USD",17
  "Description": "Tier 2 Quote",18
  "DisableCartVersioning": false,19
  "DiscountPercent": null,20
  "ExpectedEndDate": null,21
  "ExpectedStartDate": null,22
  "GrandTotal": null,23
  "Intent": null,24
  "InternalDeadline": null,25
  "IsAutoAccepted": false,26
  "IsPrimary": true,27
  "IsSystemGenerated": false,28
  "IsTaskPending": false,29
  "LegalEntity": null,30
  "Location": {31
    "Id": "7b363b21-2d8b-4277-b14e-0698ccd6bbd8",32
    "Name": "Ahmedabad"33
  },34
  "NetAmount": null,35
  "Opportunity": {36
    "Id": "9129aa7e-2ad5-430f-b456-49d62eeaed87",37
    "Name": "AutoQuoteRLPOpportunity"38
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  },39
  "ParentProposal": null,40
  "PartnerAccount": null,41
  "ProposalPaymentTerm": "Net 30 Days",42
  "PaymentTerm": null,43
  "PODate": null,44
  "PONumber": null,45
  "PresentedDate": null,46
  "PriceList": {47
    "Id": "8bea2478-428c-4421-afcd-97e327dad477",48
    "Name": "AutoQuoteRLP_QuotePL"49
  },50
  "PricingDate": null,51
  "PrimaryContact": null,52
  "ProposalApprovalDate": null,53
  "ProposalCategory": "Quote",54
  "ProposalExpirationDate": null,55
  "ProposalName": null,56
  "PurchaseId": null,57
  "QTCProfile": null,58
  "ReadyForActivationDate": null,59
  "ReadyForBillingDate": null,60
  "ReadyForFulfillmentDate": null,61
  "ReadyForRevRecDate": null,62
  "ReadyToGenerate": true,63
  "ReadyToPresent": true,64
  "RelatedProposal": null,65
  "RFPIntakeDate": null,66
  "RFPResponseDueDate": null,67
  "RFPStage": null,68
  "RFPValue": null,69
  "RiskFactors": null,70
  "SalesTaxAmount": null,71
  "SalesTaxPercent": null,72
  "ShippingHandling": null,73
  "ShipToAccount": null,74
  "SingleTransactionAdjustment": false,75
  "SourceChannel": "Direct",76
  "SpecialTerms": null,77
  "StrategicImportance": null,78
  "SyncAssetChangesToQuote": true,79
  "UseType": "Main",80
  "ValidUntilDate": null,81
  "Id": "8cae6d8a-2a3b-4c1c-bf64-8ddef14dc863",82
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•
•

Editing Quote
You can update one or more quotes by passing the updates in the request body. You can 
update the quote header field details of any quote that is not in the accepted state.

Prerequisite
You must gather the following details to create a quote. 

Quote ID
Quote object details

You can retrieve existing quotes using the GET/quotes  API and extract quote ID from the 
response. In case you have Quote ID, you can also extract the quote object details using the 
GET/quotes/{quoteId}  API For more information, see the "Retrieving List of Quotes" or 

"Retrieving Quote Details (header information)" sections or see Quoting APIs.

  "Name": "Tier_2",83
  "CreatedBy": {84
    "Id": "d717a075-9cbf-480c-b230-837e0e6dee75",85
    "Name": "Test Manish User"86
  },87
  "CreatedDate": "2022-12-27T20:04:29",88
  "ModifiedBy": {89
    "Id": "d717a075-9cbf-480c-b230-837e0e6dee75",90
    "Name": "Test Manish User"91
  },92
  "ModifiedDate": "2022-12-27T20:04:29",93
  "ExternalId": null,94
  "QuoteAuto_PickList_CstField_c": null,95
  "QuoteAuto_String_CstField_c": null,96
  "QuoteAuto_Double_CstField_c": null,97
  "QuoteAuto_Int_CstField_c": null,98
  "QuoteAuto_Boolean_CstField_c": null,99
  "QuoteAuto_Currency_CstField_c": null,100
  "QuoteAuto_DateTime_CstField_c": null,101
  "QuoteAuto_Multipicklist_CstField_c": null102
}103
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•
•

Example 1
The following table lists the API method, endpoints, and sample codes for requests and 
responses, to update quotes:

Method PATCH

Endpoint /quotes

Request URL https://<URL_of_the_Instance>/api/quote/v1/quotes

Request Body The below sample code updates the pricelist associated with the quotes 
with the following IDs, which were generated in the section Creating 
quotes.

75723d17-937e-4213-89f8-41a8f2c81594
8cae6d8a-2a3b-4c1c-bf64-8ddef14dc863

[1
    {2
        "Id": 

"75723d17-937e-4213-89f8-41a8f2c81594",

3

        "PriceList": {4
          "Id": 

"b01c1010-9381-4335-88a5-8323378b86a0",

5

          "Name": "Auto_IncOtoOPromptELevel2_PL001"6
        }7
    },8
    {9
        "Id": "8cae6d8a-2a3b-4c1c- 

bf64-8ddef14dc863",

10

        "PriceList": {11
          "Id": 

"b01c1010-9381-4335-88a5-8323378b86a0",

12

          "Name": "Auto_IncOtoOPromptELevel2_PL001"13
        }14
    }15
]16
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Response The API returns the structure of the updated quotes.

Response Body

[1
  {2
    "ABOType": "New",3
    "Account": {4
      "Id": "e60f1de6-6b54-4304-a600-31c226b842db",5
      "Name": "AutoQuoteRLPAccount_"6
    },7
    "Amount": null,8
    "ApprovalStage": "Draft",9
    "AutoActivateOrder": false,10
    "AutoCreateBill": false,11
    "AutoCreateRevenue": false,12
    "BillingPreference": null,13
    "BillToAccount": null,14
    "ConfigurationEffectiveDate": null,15
    "ConfigurationFinalizedDate": null,16
    "ConfigurationSyncDate": null,17
    "Currency": "USD",18
    "Description": 

"AutoQuoteService_Description1667823791262_57",

19

    "DisableCartVersioning": false,20
    "DiscountPercent": null,21
    "ExpectedEndDate": null,22
    "ExpectedStartDate": null,23
    "GrandTotal": null,24
    "Intent": null,25
    "InternalDeadline": null,26
    "IsAutoAccepted": false,27
    "IsPrimary": true,28
    "IsSystemGenerated": false,29
    "IsTaskPending": false,30
    "LegalEntity": null,31
    "Location": {32
      "Id": "7b363b21-2d8b-4277-b14e-0698ccd6bbd8",33
      "Name": "Ahmedabad"34
    },35
    "NetAmount": null,36
    "Opportunity": {37
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      "Id": "9129aa7e-2ad5-430f-b456-49d62eeaed87",38
      "Name": "AutoQuoteRLPOpportunity"39
    },40
    "ParentProposal": null,41
    "PartnerAccount": null,42
    "ProposalPaymentTerm": "Net 30 Days",43
    "PaymentTerm": null,44
    "PODate": null,45
    "PONumber": null,46
    "PresentedDate": null,47
    "PriceList": {48
      "Id": "b01c1010-9381-4335-88a5-8323378b86a0",49
      "Name": "Auto_IncOtoOPromptELevel2_PL001"50
    },51
    "PricingDate": null,52
    "PrimaryContact": null,53
    "ProposalApprovalDate": null,54
    "ProposalCategory": "Quote",55
    "ProposalExpirationDate": null,56
    "ProposalName": null,57
    "PurchaseId": null,58
    "QTCProfile": null,59
    "ReadyForActivationDate": null,60
    "ReadyForBillingDate": null,61
    "ReadyForFulfillmentDate": null,62
    "ReadyForRevRecDate": null,63
    "ReadyToGenerate": true,64
    "ReadyToPresent": true,65
    "RelatedProposal": null,66
    "RFPIntakeDate": null,67
    "RFPResponseDueDate": null,68
    "RFPStage": null,69
    "RFPValue": null,70
    "RiskFactors": null,71
    "SalesTaxAmount": null,72
    "SalesTaxPercent": null,73
    "ShippingHandling": null,74
    "ShipToAccount": null,75
    "SingleTransactionAdjustment": false,76
    "SourceChannel": "Direct",77
    "SpecialTerms": null,78
    "StrategicImportance": null,79
    "SyncAssetChangesToQuote": true,80
    "UseType": "Main",81
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    "ValidUntilDate": null,82
    "Id": "75723d17-937e-4213-89f8-41a8f2c81594",83
    "Name": "Tier_1",84
    "CreatedBy": {85
      "Id": "d717a075-9cbf-480c-b230-837e0e6dee75",86
      "Name": "Test Manish User"87
    },88
    "CreatedDate": "2022-12-27T18:54:56",89
    "ModifiedBy": {90
      "Id": "d717a075-9cbf-480c-b230-837e0e6dee75",91
      "Name": "Test Manish User"92
    },93
    "ModifiedDate": "2022-12-27T21:33:46.3875832",94
    "ExternalId": null,95
    "QuoteAuto_PickList_CstField_c": null,96
    "QuoteAuto_String_CstField_c": null,97
    "QuoteAuto_Double_CstField_c": null,98
    "QuoteAuto_Int_CstField_c": null,99
    "QuoteAuto_Boolean_CstField_c": null,100
    "QuoteAuto_Currency_CstField_c": null,101
    "QuoteAuto_DateTime_CstField_c": null,102
    "QuoteAuto_Multipicklist_CstField_c": null103
  },104
  {105
    "ABOType": "New",106
    "Account": {107
      "Id": "e60f1de6-6b54-4304-a600-31c226b842db",108
      "Name": "AutoQuoteRLPAccount_"109
    },110
    "Amount": null,111
    "ApprovalStage": "Draft",112
    "AutoActivateOrder": false,113
    "AutoCreateBill": false,114
    "AutoCreateRevenue": false,115
    "BillingPreference": null,116
    "BillToAccount": null,117
    "ConfigurationEffectiveDate": null,118
    "ConfigurationFinalizedDate": null,119
    "ConfigurationSyncDate": null,120
    "Currency": "USD",121
    "Description": "Tier 2 Quote",122
    "DisableCartVersioning": false,123
    "DiscountPercent": null,124
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    "ExpectedEndDate": null,125
    "ExpectedStartDate": null,126
    "GrandTotal": null,127
    "Intent": null,128
    "InternalDeadline": null,129
    "IsAutoAccepted": false,130
    "IsPrimary": true,131
    "IsSystemGenerated": false,132
    "IsTaskPending": false,133
    "LegalEntity": null,134
    "Location": {135
      "Id": "7b363b21-2d8b-4277-b14e-0698ccd6bbd8",136
      "Name": "Ahmedabad"137
    },138
    "NetAmount": null,139
    "Opportunity": {140
      "Id": "9129aa7e-2ad5-430f-b456-49d62eeaed87",141
      "Name": "AutoQuoteRLPOpportunity"142
    },143
    "ParentProposal": null,144
    "PartnerAccount": null,145
    "ProposalPaymentTerm": "Net 30 Days",146
    "PaymentTerm": null,147
    "PODate": null,148
    "PONumber": null,149
    "PresentedDate": null,150
    "PriceList": {151
      "Id": "b01c1010-9381-4335-88a5-8323378b86a0",152
      "Name": "Auto_IncOtoOPromptELevel2_PL001"153
    },154
    "PricingDate": null,155
    "PrimaryContact": null,156
    "ProposalApprovalDate": null,157
    "ProposalCategory": "Quote",158
    "ProposalExpirationDate": null,159
    "ProposalName": null,160
    "PurchaseId": null,161
    "QTCProfile": null,162
    "ReadyForActivationDate": null,163
    "ReadyForBillingDate": null,164
    "ReadyForFulfillmentDate": null,165
    "ReadyForRevRecDate": null,166
    "ReadyToGenerate": true,167
    "ReadyToPresent": true,168
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    "RelatedProposal": null,169
    "RFPIntakeDate": null,170
    "RFPResponseDueDate": null,171
    "RFPStage": null,172
    "RFPValue": null,173
    "RiskFactors": null,174
    "SalesTaxAmount": null,175
    "SalesTaxPercent": null,176
    "ShippingHandling": null,177
    "ShipToAccount": null,178
    "SingleTransactionAdjustment": false,179
    "SourceChannel": "Direct",180
    "SpecialTerms": null,181
    "StrategicImportance": null,182
    "SyncAssetChangesToQuote": true,183
    "UseType": "Main",184
    "ValidUntilDate": null,185
    "Id": "8cae6d8a-2a3b-4c1c-bf64-8ddef14dc863",186
    "Name": "Tier_2",187
    "CreatedBy": {188
      "Id": "d717a075-9cbf-480c-b230-837e0e6dee75",189
      "Name": "Test Manish User"190
    },191
    "CreatedDate": "2022-12-27T20:04:29",192
    "ModifiedBy": {193
      "Id": "d717a075-9cbf-480c-b230-837e0e6dee75",194
      "Name": "Test Manish User"195
    },196
    "ModifiedDate": "2022-12-27T21:33:46.3867949",197
    "ExternalId": null,198
    "QuoteAuto_PickList_CstField_c": null,199
    "QuoteAuto_String_CstField_c": null,200
    "QuoteAuto_Double_CstField_c": null,201
    "QuoteAuto_Int_CstField_c": null,202
    "QuoteAuto_Boolean_CstField_c": null,203
    "QuoteAuto_Currency_CstField_c": null,204
    "QuoteAuto_DateTime_CstField_c": null,205
    "QuoteAuto_Multipicklist_CstField_c": null206
  }207
]208
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Example 2
The following table list the API method, endpoints, and sample codes for requests and 
responses, to update a specific quote:

Method PATCH

Endpoint quotes/{quoteId}

Request Parameter The following URL parameter is used to pass the quote ID. This quote 
was generated previously using the POST/quotes API and its ID was 
retrieved using the GET/quotes API.

Parameters Values

quoteID 75723d17-937e-4213-89f8-41a8f2c81594

Request URL https://<URL_of_the_Instance>/api/quote/v1/quotes/ 

75723d17-937e-4213-89f8-41a8f2c81594
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Request Body The below sample code updates the Billing To Account field associated 
with the quote named Tier_1 with 
75723d17-937e-4213-89f8-41a8f2c81594 ID, which was generated in the 
section Creating Quotes. To update a single quote, you must pass the 
entire object with updated fields where required.

In this example, Billing To Account field is changed from null to the 
following values:

Request Body

"BillToAccount": 1
    {2
        "Id": "e60f1de6-6b54-4304- 

a600-31c226b842db",

3

        "Name": "AutoQuoteRLPAccount_"4
    }5

{1
  "ABOType": "New",2
  "Account": {3
    "Id": "e60f1de6-6b54-4304-a600-31c226b842db",4
    "Name": "AutoQuoteRLPAccount_"5
  },6
  "Amount": null,7
  "ApprovalStage": "Draft",8
  "AutoActivateOrder": false,9
  "AutoCreateBill": false,10
  "AutoCreateRevenue": false,11
  "BillingPreference": null,12
  "BillToAccount": {13
    "Id": "e60f1de6-6b54-4304-a600-31c226b842db",14
    "Name": "AutoQuoteRLPAccount_"15
  },16
  "ConfigurationEffectiveDate": null,17
  "ConfigurationFinalizedDate": null,18
  "ConfigurationSyncDate": null,19
  "Currency": "USD",20
  "Description": 

"AutoQuoteService_Description1667823791262_57",

21

  "DisableCartVersioning": false,22
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  "DiscountPercent": null,23
  "ExpectedEndDate": null,24
  "ExpectedStartDate": null,25
  "GrandTotal": null,26
  "Intent": null,27
  "InternalDeadline": null,28
  "IsAutoAccepted": false,29
  "IsPrimary": true,30
  "IsSystemGenerated": false,31
  "IsTaskPending": false,32
  "LegalEntity": null,33
  "Location": {34
    "Id": "7b363b21-2d8b-4277-b14e-0698ccd6bbd8",35
    "Name": "Ahmedabad"36
  },37
  "NetAmount": null,38
  "Opportunity": {39
    "Id": "9129aa7e-2ad5-430f-b456-49d62eeaed87",40
    "Name": "AutoQuoteRLPOpportunity"41
  },42
  "ParentProposal": null,43
  "PartnerAccount": null,44
  "ProposalPaymentTerm": "Net 30 Days",45
  "PaymentTerm": null,46
  "PODate": null,47
  "PONumber": null,48
  "PresentedDate": null,49
  "PriceList": {50
    "Id": "b01c1010-9381-4335-88a5-8323378b86a0",51
    "Name": "Auto_IncOtoOPromptELevel2_PL001"52
  },53
  "PricingDate": null,54
  "PrimaryContact": null,55
  "ProposalApprovalDate": null,56
  "ProposalCategory": "Quote",57
  "ProposalExpirationDate": null,58
  "ProposalName": null,59
  "PurchaseId": null,60
  "QTCProfile": null,61
  "ReadyForActivationDate": null,62
  "ReadyForBillingDate": null,63
  "ReadyForFulfillmentDate": null,64
  "ReadyForRevRecDate": null,65
  "ReadyToGenerate": true,66
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Response The API returns the updated quote object.

  "ReadyToPresent": true,67
  "RelatedProposal": null,68
  "RFPIntakeDate": null,69
  "RFPResponseDueDate": null,70
  "RFPStage": null,71
  "RFPValue": null,72
  "RiskFactors": null,73
  "SalesTaxAmount": null,74
  "SalesTaxPercent": null,75
  "ShippingHandling": null,76
  "ShipToAccount": null,77
  "SingleTransactionAdjustment": false,78
  "SourceChannel": "Direct",79
  "SpecialTerms": null,80
  "StrategicImportance": null,81
  "SyncAssetChangesToQuote": true,82
  "UseType": "Main",83
  "ValidUntilDate": null,84
  "Id": "75723d17-937e-4213-89f8-41a8f2c81594",85
  "Name": "Tier_1",86
  "CreatedBy": {87
    "Id": "d717a075-9cbf-480c-b230-837e0e6dee75",88
    "Name": "Test Manish User"89
  },90
  "CreatedDate": "2022-12-27T18:54:56",91
  "ModifiedBy": {92
    "Id": "d717a075-9cbf-480c-b230-837e0e6dee75",93
    "Name": "Test Manish User"94
  },95
  "ModifiedDate": "2022-12-28T07:31:08",96
  "ExternalId": null,97
  "QuoteAuto_PickList_CstField_c": null,98
  "QuoteAuto_String_CstField_c": null,99
  "QuoteAuto_Double_CstField_c": null,100
  "QuoteAuto_Int_CstField_c": null,101
  "QuoteAuto_Boolean_CstField_c": null,102
  "QuoteAuto_Currency_CstField_c": null,103
  "QuoteAuto_DateTime_CstField_c": null,104
  "QuoteAuto_Multipicklist_CstField_c": null105
}106



Configure Price Quote (CPQ)

493 Copyright ©2024 Conga Corporation. All rights reserved.

•

•
•
•

•

Working with Order APIs
This use case describes how to work with the orders created for a customer before 
delivering the goods or services. 

Sales and customer representatives can use Order APIs in the following scenarios.

Scenario API

To view the list of already created orders GET/orders

To view a specific order GET/orders/{orderId}

To update an order PATCH/orders/{orderId}

To confirm an order POST/orders/{orderId}/confirm

To cancel an order POST/orders/{orderId}/cancel

This section describes the following use case:

Updating Order Details

Updating Order Details
A customer has created an order through a quote using CPQ APIs.  By default, the status of 
the order is  'Created'. Later, for any reason, the customer decided to update the order. 
Sales or customer representatives can update an order based on new requirements from 
the customer. Once the order is created, you can only edit or update the order header 
details (except the order status).

The Update an order API allows you to modify the following header fields: 

Account
Bill To
Ship To 

Primary Contact

To update the order successfully, you must invoke the order APIs in the following order.

You cannot update header fields after confirming the order.
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•
•

Prerequisite:
You must gather the following to update the order.

Order ID
Order Name

You can use the GET/orders  API to retrieve all orders in the system. For more information, 
see Order APIs.

Example 1
The following table lists the API method, endpoints, and sample codes for fetching order 
details.

Method GET

Endpoint /orders

Request URL https://<URL_of_the_Instance>/api/order/v1/orders/{orderId}

Request The following sample code fetches the order.

"https://rlp-dev.congacloud.io/api/order/v1/orders/<order id>"

 You can directly run this API If you know the order id for which the header details 
are to be updated. 


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Response This API returns the structure of the order details of the order id passed in 
the request body.

Response Body:

{

  "ActivatedDate": null,

  "AmendmentEffectiveDate": null,

  "AutoActivateOrder": false,

  "BillingPreference": null,

  "BillToAccount": {

    "Id": "<id of the billing account>",

    "Name": "<name of the bill to account>"

  },

  "CancelledDate": null,

  "CompletedDate": null,

  "ConfigurationEffectiveDate": null,

  "ConfigurationSyncDate": null,

  "Description": "RLPOrder Description",

  "FulfilledDate": null,

  "LegalEntity": null,

  "Location": null,

  "NextVersion": null,

  "OrderAmount": null,

  "OrderDate": null,

  "OrderEndDate": null,

  "OrderReferenceNumber": null,

  "OrderStartDate": null,

  "OriginalOrderNumber": null,

  "ParentOrder": null,

  "PartnerAccount": null,

  "PaymentStatus": null,

  "PaymentTerm": null,

  "PODate": null,

  "PONumber": null,

  "PreviousVersion": null,

  "PriceList": {

    "Id": "e7244530-40fc-4926-a78a-fd4d2c6df962",

    "Name": "AutoQuoteRLP_QuotePL"

  },

  "PricingDate": null,

  "PrimaryContact": {

    "Id": "f2b5232a-deb3-4cd0-a49c-4ac2d50f1e08",
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    "Name": "AutoQuoteRLP_PrimaryContact1"

  },

  "Proposal": {

    "Id": "4cf93b4b-5224-40f9-b0ac-7ca5b63118ce",

    "Name": "AutoQuoteService_Name-736431291667818708925_855"

  },

  "PurchaseId": null,

  "PurchaseOrder": null,

  "ReadyForBillingDate": null,

  "ReadyForRevRecDate": null,

  "ReadyForWorkflow": false,

  "RelatedOpportunity": null,

  "ShipToAccount": {

    "Id": "25c6d8a5-12c7-4970-ac96-87335ea888f1",

    "Name": "AutoQuoteShipToRLPAccount_"

  },

  "SingleTransactionAdjustment": false,

  "SoldToAccount": {

    "Id": "ae80f382-0356-48df-80cf-dd22b550ee81",

    "Name": "AutoQuoteSoldToRLPAccount_"

  },

  "Source": "Account",

  "SourceChannel": "Direct",

  "Status": "Generated",

  "Type": "New",

  "Currency": "USD",

  "Id": "ffea69f1-a4af-4467-afda-eb56185f9034",

  "Name": "RLPOrder Name-157736110",

  "CreatedBy": {

    "Id": "27634e3f-904a-4321-9ce5-c2edbe181d90",

    "Name": "Test User"

  },

  "CreatedDate": "2022-11-07T10:57:54",

  "ModifiedBy": {

    "Id": "11111111-1111-1111-1111-111111111111",

    "Name": "System Admin"

  },

  "ModifiedDate": "2022-11-21T13:59:37",

  "ExternalId": null,

  "QuoteAuto_Boolean_CstField_c": true,

  "QuoteAuto_PickList_CstField_c": "INR",

  "QuoteAuto_Int_CstField_c": 150,
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  "QuoteAuto_Double_CstField_c": 77.89,

  "QuoteAuto_String_CstField_c": "Order_Service",

  "QuoteAuto_DateTime_CstField_c": "2020-07-18T00:00:00",

  "QuoteAuto_Multipicklist_CstField_c": [

    "Red",

    "Blue"

  ],

  "QuoteAuto_Currency_CstField_c": null

}

Example 2
The following table lists the API method, endpoints, and sample codes for request and 
response, to update the order.

Method PATCH

Endpoint /orders

Request URL https://<URL_of_the_Instance>/api/order/v1/orders/id

Request The following sample code updates the description and shipTo account in 
the order 3. 

{

     "AutoActivateOrder": false,

     "ReadyForWorkflow": false,

     "ShipToAccount": {

          "Id": "25c6d8a5-12c7-4970-ac96-87335ea888f1",

          "Name": "AutoQuoteShipToRLPAccount_"

     },

     "SingleTransactionAdjustment": false,

     "Source": "Account",

     "SourceChannel": "Direct",

     "Status": "Pending",

     "Type": "New",

     "Name": "Order3",

     "Description": "This is a sample order"

}

'    
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Response This API returns the structure of the order details, which includes the 
updated primary contact based on the request body.

Response Body:

{

  "Name": "Order3",

  "Id": "f35934bc-b04b-4fe8-990a-5676c7615f2a",

  "CreatedBy": {

    "Id": "ddfec712-8827-4684-8287-1373e4f1f43d",

    "Name": "Conga User"

  },

  "CreatedDate": "2022-07-18T16:23:07",

  "ModifiedBy": {

    "Id": "ddfec712-8827-4684-8287-1373e4f1f43d",

    "Name": "Conga User"

  },

  "ModifiedDate": "2022-07-21T09:03:36",

  "ExternalId": null,

  "ActivatedDate": "2022-07-18T16:23:07",

  "AmendmentEffectiveDate": null,

  "AutoActivateOrder": false,

  "BillingPreference": null,

  "BillToAccount": {

    "Id": "dcb42e39-15c2-4895-aa35-53ee6c140d78",

    "Name": "Conga"

  },

  "CancelledDate": null,

  "CompletedDate": null,

  "ConfigurationEffectiveDate": null,

  "ConfigurationSyncDate": null,

  "Description": "Test DC Order",

  "FulfilledDate": null,

  "LegalEntity": null,

  "Location": null,

  "NextVersion": null,

  "OrderAmount": {

    "Value": 100,

    "DisplayValue": 100,

    "CurrencyCode": "USD",

    "CurrencySymbol": "$"

  },
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  "OrderDate": null,

  "OrderEndDate": null,

  "OrderReferenceNumber": null,

  "OrderStartDate": null,

  "OriginalOrderNumber": null,

  "ParentOrder": null,

  "PartnerAccount": null,

  "PaymentStatus": "Pending",

  "PaymentTerm": null,

  "PODate": null,

  "PONumber": null,

  "PreviousVersion": null,

  "PriceList": {

    "Id": "32c3519a-f190-4f38-b05a-8063ef611492",

    "Name": "Test Price List - 7"

  },

  "PricingDate": null,

  "PrimaryContact": {

    "Id": "ddfec712-8827-4684-8287-1373e4f1f43d",

    "Name": "Conga"

  },

  "ProposalId": null,

  "PurchaseId": null,

  "PurchaseOrder": null,

  "ReadyForBillingDate": null,

  "ReadyForRevRecDate": null,

  "ReadyForWorkflow": false,

  "RelatedOpportunity": null,

  "ShipToAccount": {

    "Id": "dcb42e39-15c2-4895-aa35-53ee6c140d78",

    "Name": "Conga"

  },

  "SingleTransactionAdjustment": false,

  "SoldToAccount": {

    "Id": "dcb42e39-15c2-4895-aa35-53ee6c140d78",

    "Name": "Conga"

  },

  "Source": "Account",

  "SourceChannel": "Direct",

  "Status": "Draft",

  "Type": "New",

  "Currency": "USD"

}
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Example 3
The following table lists the API method, endpoints, and sample codes for request and 
response, to update the order description and ShipTo details for an order 3.

Method PATCH

Endpoint /orders

Request URL https://<URL_of_the_Instance>/api/order/v1/orders/orderid

Request The following sample code updates the primary contact that is associated 
with order3. 

{

     "AutoActivateOrder": false,

     "PrimaryContact": {

          "Id": "<A unique ID of the primary contact>",

          "Name": "<Name of the primary contact>"

     },     



Configure Price Quote (CPQ)

501 Copyright ©2024 Conga Corporation. All rights reserved.

Response This API returns the structure of the order details, which includes the 
updated description and ShipTo details based on the request body.

Response Body:

{

  "ActivatedDate": "2022-07-18T16:23:07",

  "AmendmentEffectiveDate": null,

  "AutoActivateOrder": false,

  "BillingPreference": null,

  "BillToAccount": {

    "Id": "dcb42e39-15c2-4895-aa35-53ee6c140d78",

    "Name": "Conga"

  },

  "CancelledDate": null,

  "CompletedDate": null,

  "ConfigurationEffectiveDate": null,

  "ConfigurationSyncDate": null,

  "Description": "This is a sample order", //Updated order 

description

  "FulfilledDate": null,

  "LegalEntity": null,

  "Location": null,

  "NextVersion": null,

  "OrderAmount": {

    "Value": 100,

    "DisplayValue": 100,

    "CurrencyCode": "USD",

    "CurrencySymbol": "$"

  },

  "OrderDate": null,

  "OrderEndDate": null,

  "OrderReferenceNumber": null,

  "OrderStartDate": null,

  "OriginalOrderNumber": null,

  "ParentOrder": null,

  "PartnerAccount": null,

  "PaymentStatus": "Pending",

  "PaymentTerm": null,

  "PODate": null,

  "PONumber": null,

  "PreviousVersion": null,

  "PriceList": {
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    "Id": "32c3519a-f190-4f38-b05a-8063ef611492",

    "Name": "Test Price List - 7"

  },

  "PricingDate": null,

  "PrimaryContact": {

    "Id": "ddfec712-8827-4684-8287-1373e4f1f43d",

    "Name": "Conga"

  },

  "Proposal": null,

  "PurchaseId": null,

  "PurchaseOrder": null,

  "ReadyForBillingDate": null,

  "ReadyForRevRecDate": null,

  "ReadyForWorkflow": false,

  "RelatedOpportunity": null,

  "ShipToAccount": {

    "Id": "25c6d8a5-12c7-4970-ac96-87335ea888f1", //Updated 

ShipTo account id

    "Name": "AutoQuoteShipToRLPAccount_"

  },

  "SingleTransactionAdjustment": false,

  "SoldToAccount": {

    "Id": "dcb42e39-15c2-4895-aa35-53ee6c140d78",

    "Name": "Conga"

  },

  "Source": "Account",

  "SourceChannel": "Direct",

  "Status": "Pending",

  "Type": "New",

  "Currency": "USD",

  "Id": "f35934bc-b04b-4fe8-990a-5676c7615f2a",

  "Name": "Order3",

  "CreatedBy": {

    "Id": "ddfec712-8827-4684-8287-1373e4f1f43d",

    "Name": "Conga User"

  },

  "CreatedDate": "2022-07-18T16:23:07",

  "ModifiedBy": {

    "Id": "d717a075-9cbf-480c-b230-837e0e6dee75",

    "Name": "Test User"

  },

  "ModifiedDate": "2023-02-07T06:38:18.6814916",
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  "ExternalId": null,

  "ProposalId": null

}
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•

CPQ Features by Release
Review the latest CPQ Features by Release document.

Features by Release

Features by Release
 
This document contains an overview of features introduced in each major release of Conga 
CPQ. For more information, see Conga CPQ Features by Release.
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Conga Copyright and Disclaimer
Copyright © 2024 Conga Corporation (“Conga”) and/or its affiliates. All rights reserved.
No part of this document, or any information linked to or referenced herein, may be reproduced, distributed, or 
transmitted in any form or by any means, including photocopying, recording, or other electronic or 
mechanical methods, without the prior written consent of Conga. All information contained herein is subject 
to change without notice and is not warranted to be error free.
This document may describe certain features and functionality of software that Conga makes available for 
use under a license agreement containing restrictions on use and disclosure and are protected by intellectual 
property laws. Except as expressly permitted in your license agreement or allowed by law, you may not, in 
any form, or by any means, use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, 
exhibit, perform, publish, or display any part of the software. Reverse engineering, disassembly, decompilation 
of, or the creation of derivative work(s) from, the software is strictly prohibited. Additionally, this document 
may contain descriptions of software modules that are optional and for which you may not have purchased 
a license. As a result, your specific software solution and/or implementation may differ from those described 
in this document.
U.S. GOVERNMENT END USERS: Conga software, including any operating system(s), integrated software, any 
programs installed on the hardware, and/or documentation, delivered to U.S. Government end users are 
“commercial computer software” pursuant to the applicable Federal Acquisition Regulation and agency- 
specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the 
programs, including any operating system, integrated software, any programs installed on the hardware, 
and/or documentation, shall be subject to license terms and license restrictions applicable to the programs. 
No other rights are granted to the U.S. Government.
Neither the software nor the documentation were developed or intended for use in any inherently dangerous 
applications, including applications that may create a risk of personal injury. If you use this software or 
hardware in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, 
redundancy, and other measures to ensure its safe use. Conga and its affiliates disclaim any liability for any 
damages caused by use of this software or hardware in dangerous applications.
Apttus, AI Analyze, Conga, Conga AI, Conga AI Discover, Conga Batch, Conga Collaborate, Conga Composer, 
Conga Conductor, Conga Connect, Conga Courier, Conga Grid, Conga Mail Merge, Conga Merge, Conga 
Orchestrate, Conga Sign, Conga Trigger, Digital Document Transformation, True-Up, and X-Author are 
registered trademarks of Conga and/or its affiliates.
The documentation and/or software may provide links to web sites and access to content, products, and 
services from third parties. Conga is not responsible for the availability of, or any content provided by third 
parties. You bear all risks associated with the use of such content. If you choose to purchase any products or 
services from a third party, the relationship is directly between you and the third party. Conga is not 
responsible for: (a) the quality of third-party products or services; or (b) fulfilling any of the terms of the 
agreement with the third party, including delivery of products or services and warranty obligations related to 
purchased products or services. Conga is not responsible for any loss or damage of any sort that you may 
incur from dealing with any third party.
For additional resources and support, please visit https://community.conga.com.

https://community.conga.com
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